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Welcome
Welcome to Sterling Commerce�s GENTRAN:Server® Mapping and Translation 
Guide. This book contains instructions for performing mapping and translation 
tasks with the GENTRAN:Server Visual Mapper software. This guide is for both 
UNIX client/server and Workstation (stand-alone PC) configurations.

Who should use
this guide

This guide is for personnel charged with maintaining maps with the Visual 
Mapper.

UNIX knowledge
required

This guide assumes that you are familiar with basic UNIX concepts and 
commands, including: 

◗ How UNIX identifies users and associates them into groups
◗ File ownership

Client/PC
knowledge

required

This book also assumes that you are familiar with basic Windows concepts and 
commands, including:

◗ How to navigate and operate within the Windows environment
◗ How to use DOS commands and the DOS window from within the Windows 

desktop.
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Chapter Contents
This table describes the content of the chapters in this Mapping and Translation 
Guide.

Chapter Title Description

About This Guide Explains the content, organization, and 
conventions in this guide, and how to get help 
if you encounter problems. 

Understanding the Basics Contains background information about 
GENTRAN:Server that you should know 
before you begin using the software.

Working with Editors 
(Application and Standard/IG)

Describes the features these two editors have 
in common and explains how to use the 
editors.

Defining Application 
Descriptions for ASCII Files

Describes how to create or modify an 
application description that describes data 
stored in an ASCII file. 

Defining Application 
Descriptions for Databases

Describes how to create or modify an 
application description that describes data 
stored in a database. 

Creating an Implementation 
Guide

Describes how to create an implementation 
guide.

Working with Synonym and 
Thesaurus Lists

Describes synonym and thesaurus lists and 
files and how to use the Synonym and 
Thesaurus Editors to work with them.

Mapping Describes how to use the Visual Mapper to 
create, edit, and compile maps. This chapter 
introduces the Visual Mapper and basic map-
making techniques. 

(Continued on next page)
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Working With Mapping 
Instructions

Describes how to create custom mapping 
instructions to have GENTRAN:Server 
perform special operations on data during 
translation. 

Provides an exercise demonstrating how to 
map the relationship between hierarchical 
loops. 

Provides descriptions, explanations, and 
examples of each operator you can use to 
complete mapping instructions and statements 
in GENTRAN:Server.

Describes how to create macros and add 
macros to expressions and other macros.

Troubleshooting Mapping 
Instructions

Describes the Diagnostics Report and explains 
how and when to use the report to analyze 
unexpected results from mapping instructions.

Also describes how to use the Sorting Utility to 
reorder mapping instructions that appear on 
the correct screen, but need to be reordered 
within the screen.

Working with Trading 
Partnerships

Describes the procedures for maintenance of 
your trading partnership files and records.

Running Translation Explains how to set up and run inbound and 
outbound translations from the Translation 
menu and view a translation summary.

Archiving Data Explains how to choose the default archiving 
options and run the archiving program, work 
with archived data, including reconciling 
functional acknowledgments, and move 
archived data with the archive utilities.

Using the Task Scheduler Contains relevant points about creating batch 
files or scripts containing the 
GENTRAN:Server command-line commands 
and operating-system commands, how to use 
the Task Scheduler to specify the date and 
time you want the batch file or script to run, 
and important points about running the batch 
files and scripts.
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 v
Related Publications

GENTRAN:Server
documentation

This table describes additional documentation for the GENTRAN:Server software.

Document Description

Upgrade and 
Conversion Guide

Instructions for upgrading from previous versions of 
GENTRAN:Server Workstation and GENTRAN:Server 
for UNIX. Also includes instructions for converting the 
files that are part of the upgrade.

Installation Checklist Description of the recommended sequence in which 
you should install and configure system components.

GENTRAN:Server for 
UNIX Installation and 
Setup Guide

Instructions for installing the GENTRAN:Server 
software and performing setup tasks, such as setting 
up security.

GENTRAN:Server 
Workstation 
Installation 
Instructions

Instructions for installing the GENTRAN:Server 
Workstation software and performing setup tasks.

Getting Started Guide Instructions for starting and exiting GENTRAN:Server 
and for setting preferences and default values. Also 
includes instructions for checking files in and out and 
saving files.

Application 
Integration User�s 
Guide

Instructions for performing mapping and translation 
tasks. 

NCPCP User�s Guide Instructions for mapping and translating NCPDP files 
with the Application Integration system.

XML User�s Guide Instructions for mapping and translating XML files with 
the Application Integration system.

Note
This guide is provided only if your organization has the 
GENTRAN:Server XML translation option.

(Continued on next page)
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(Continued on next page)

ODBC User�s Guide Instructions for mapping and translating ODBC files 
with the Application Integration system.

Note
This guide is provided only if your organization has the 
GENTRAN:Server ODBC translation option.

GENCOD User�s 
Guide

Instructions for mapping and translating GENCOD files 
with the Application Integration system and the Visual 
Mapper.

VDA User�s Guide Instructions for mapping and translating VDA files with 
the Application Integration system and the Visual 
Mapper.

Technical Reference 
Guide

Describes processes, lists command-line commands in 
alphabetical order, and describes file record layouts 
and data type formats.

Data Flow 
Administration Guide

User instructions for configuring data flows using the 
GENTRAN:Server for UNIX software.

Note
This guide is provided only if you have the 
GENTRAN:Server EC Workbench or higher product 
level. 

Maintenance and 
Troubleshooting 
Guide

Instructions for maintaining your GENTRAN:Server 
installation. Also provides troubleshooting information 
to help determine the cause and solution of problems 
that may occur.

Online Help Context-sensitive help screens describing the 
GENTRAN:Server dialog boxes for the mapping and 
translation features. Also includes procedures for using 
the mapping and translation and the data flow 
administration software.
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Documentation Conventions

Typographic
conventions

This table describes the typographic conventions used in this guide.

Symbols used
within syntax

statements

This table describes symbols used within syntax statements.

Convention Use

Italics This typeface is used for titles of other manuals and 
documents, names of files and file extensions, and to 
emphasize important information.

Example
GENTRAN:Server Mapping and Translation Guide

Bold Bold type is used for program names, key terms the 
first time they are used within a chapter, and entries 
you are to make on-screen.

Example
A password is a set of characters a user must enter to 
gain access to a system.

Symbol Use

< > Substitute a value for any term that appears within 
angle brackets. Do not enter angle brackets unless 
specifically told to do so. 

Example
rm <filename> means that you should type the name 
of the file you want to delete.

{ } Braces indicate a required part of a statement. Do not 
enter the braces.

Example
{-f <filename>} means you must enter the f parameter 
followed by a filename.

(Continued on next page)
Mapping and Translation Guide � February 2002



 viii
[ ] Brackets indicate an optional part of a statement. Do 
not enter the brackets.

Example
[-f <filename>] means you could type the f parameter 
followed by a filename, but you are not required to do 
so.

� An ellipse indicates that the immediately preceding 
item can be repeated indefinitely. Do not enter the 
ellipse.

Example
-e� means that you can repeat -e with other values.

( ) Parentheses should be entered as shown. They are 
part of the syntax of a statement and are not special 
symbols.

Example
(n) means that you should type a number enclosed by 
parentheses.

 (Contd)
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How to Get Help

Introduction This topic explains how to contact Sterling Commerce Product Support if you 
need assistance with GENTRAN:Server.

Scope of
Support

Services

Sterling Commerce Product Support can provide assistance and information for 
the following:
◗ Installing GENTRAN:Server
◗ GENTRAN:Server product questions
◗ Software revisions and upgrades
◗ Implementing a specific feature 
◗ How to use GENTRAN:Server
◗ The status of your support call
◗ Requests for product enhancements

Unfortunately, Sterling Commerce Product Support cannot assist you with 
problems involving the following, but we may be able to suggest a next step or 
another vendor to call:

◗ Your hardware
◗ Your operating system or other system software
◗ Your application or user-written programs
◗ Software not developed by Sterling Commerce
◗ Scripts written by Sterling Commerce consultants or service partners

Try this first Before you call Sterling Commerce Product Support, use your online software 
manuals to locate the section that documents the program or feature where you 
are having problems. The documentation may explain the software�s behavior or 
give you insight to help you solve the problem.

Consult the GENTRAN:Server Maintenance and Troubleshooting Guide to learn if 
your specific problem has been addressed.

(Continued on next page)
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Copy this page Please feel free to make a copy of this page to enable you to contact support 
quickly and with complete information for the Customer Support Representative.

Necessary
information

Be ready to provide this information when you call Product Support.

Your name

Your company name

Your telephone number

Your GENTRAN:Server version number 

Your GENTRAN:Server product level and platform

Any software add-ons to your GENTRAN:Server system

A detailed description of the problem

(Continued on next page)
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How to contact
support

To determine how to contact support for your geographical location, go to the 
Sterling Commerce home page (www.sterlingcommerce.com) and then go to 
Customer Support for GENTRAN.

The sequence of steps that led to the problem

What actions you have taken to try to diagnose or resolve the problem
Mapping and Translation Guide � February 2002
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Overview 0

Introduction

Welcome Welcome to the GENTRAN:Server® Visual Mapper EDI mapping and translation 
software.

GENTRAN:Server�s EDI software enables you to exchange data in standard and 
non-standard formats with your trading partners. When you send application data, 
GENTRAN:Server converts your data into standard EDI formats that can be 
understood by your trading partners. When you receive data in a standardized 
format, GENTRAN:Server translates the data into a format your application can 
understand.

You use GENTRAN:Server to describe your applications, edit standards, maintain 
trading partnership information, and generate translation �maps,� which are sets 
of instructions for translating data.

In this chapter This chapter contains background information about GENTRAN:Server that you 
should know before beginning to use the software.

Key terms This table describes key terms used in this chapter.

Term Description

application The business software generating the business 
information that you are sending or receiving via EDI.

application 
description

Your company�s description of the records and fields in 
an ASCII file used for your data.

check box A square to the left of an option in a dialog. When the 
option is selected, the square contains an X. You click 
the check box to change whether the option is selected. 

click The act of quickly pressing and releasing a mouse 
button.

(Continued on next page)
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client The computer in a client/server network that acts as the 
interface between the user and the server.

client/server A computer network architecture in which data is stored 
and processing is performed on the server, which users 
access through the interface provided on the client. 

collapsed view Within the Visual Mapper, a view that displays all the 
segments, but hides all the elements, composite 
elements, and sub-elements.

default A value that is automatically assigned.

dialog box An application window through which you enter 
information into the application. 

double-click The act of quickly pressing and releasing a mouse button 
twice.

EDI Electronic Data Interchange.

Application-to-application transfer of key business 
transaction information in a standard format via a 
computer-to-computer communication link.

EDI standard A format to regulate syntax, structure, and content of 
transaction data.

expanded view Within the Visual Mapper, the view that displays all 
elements, composite elements, and sub-elements, as 
well as all segments.

implementation 
guide

A standard that was modified to meet the requirements 
of a trading partnership.

map A file that contains the relationships between:

◗ The segments and elements of a standard EDI 
document and the data fields in your application,

◗ The segments and elements of two different 
standards, or

◗ The records and fields of two different applications.

master file The original, source version of a file. 

menu A list of related commands.
(Continued on next page)
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menu bar The row of menu names that runs across the top of a 
window.

option button A round button used to select one option from a mutually 
exclusive set of options.

push-button A symbol or icon that initiates some action when you 
click it.

server The computer in a client/server network that performs 
the system security, data storage, and major computing 
tasks.

standard format A format intelligible to computerized data management 
systems.

temporary file A file on the client that GENTRAN:Server uses during 
editing and compiling.

text box A box into which you enter alphanumeric text to provide 
data needed by GENTRAN:Server.

trading partner The company, division, or group with which you are 
exchanging business data via EDI.

trading partnership An arrangement to exchange information in a specific 
document type with a specific trading partner and using a 
particular standard version.

working file A file that is stored in the user�s working directory on the 
server while the user has it checked out for editing.

working file directory The directory created on the server to hold the files that 
are being edited by a user.
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Getting Started 0

Major Tasks

Introduction This topic provides an overview of the separate tasks required to use 
GENTRAN:Server�s Visual Mapper to create and test translation maps.

The topic contains a process flow diagram followed by a table listing the individual 
tasks in the process and where they are discussed in this manual.

Process flow
diagram

This process flow diagram illustrates the tasks for using GENTRAN:Server to 
create maps and use them to perform EDI translations.

(Continued on next page)

Create
implementation

guide

Create application
description

Create and
compile map

Create Trading
Partnership records

Run translator to
test map

View and reconcile
data

View/verify
functional

acknowledgments
(optional)
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Tasks in using
GENTRAN:Server

This table describes the tasks in using GENTRAN:Server, and lists where each is 
discussed.

Task Description
Discussed in 
Chapter(s)�

Create the 
implementation 
guide

Select an EDI standard or define 
your implementation guide. Use 
the Standard/IG Editor to edit the 
segments and elements.

Working with the 
Application and 
Standard/IG Editors

and

Creating an 
Implementation Guide 
or Standard

Create the 
application 
description

Use the Application Editor to 
create an application description. 
You can edit the records and 
fields as needed. 

Working with the 
Application and 
Standard/IG Editors

and

Defining Application 
Descriptions for ASCII 
Files.

If you have the ODBC 
translation option, see

Defining Application 
Descriptions for 
Databases.
(Continued)
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Create and 
compile the map

Use either the AutoMapping or 
the Visual Mapping feature to 
map your source file to the items 
in the destination file. 

Prepare for AutoMapping by 
setting up value substitutions lists 
with the Thesaurus Editor.

Use the Synonym Editor to create 
lists of substitute values for 
source items.

Compile the new map to identify 
invalid instructions, incomplete 
map groups, and the like. Save 
the map when it compiles without 
errors.

Mapping

Working with Mapping 
Instructions

Working with 
Synonym and 
Thesaurus Lists

Working with 
Synonym and 
Thesaurus Lists

Mapping

Create the Trading 
Partnership record

Set up your Trading Partnership 
records. This task correlates the 
map with the specific transaction 
type and trading partner(s) for 
which the map is used.

You may want to create a generic 
Trading Partnership record to 
enable GENTRAN:Server to do 
generic or wildcard translations.

Working with Trading 
Partnerships

Run the translator Translate some sample data files 
to locate potential problems. 

Running Translation 

View and reconcile 
data

View the archive records. 

Note
You must archive data to use the 
functional acknowledgment 
feature.

Archiving Data

View functional 
acknowledgments

View inbound and outbound 
functional acknowledgments.

Archiving Data

Task Description
Discussed in 
Chapter(s)�
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Specifying Preferred 
Default Values 0

The Preferences Dialog Box

Introduction You can specify the default values and parameters that you want 
GENTRAN:Server Workstation or GENTRAN:Server for UNIX to use in the 
current session and at the start of future sessions for the Visual Mapper. To do so, 
you use the Preferences dialog box.

Comment
The Visual Mapper�s default settings match the most common EDI standards and 
application data formats; you probably will not need to change them. If you 
constantly have to change data type formats within either the Standard/IG Editor 
or the Application Editor, the Preferences dialog box enables you to save time by 
changing the defaults for those data types.

Accessing
Preferences

To view the Preferences dialog box, click Preferences from the Visual Mapper�s 
Settings menu. 

(Continued on next page)
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The Preferences
dialog box

This illustration shows the Preferences dialog box.

Preferences
dialog fields and

functions

This table describes the Preferences dialog fields and their functions.

Data Type

Code

Field Function

General

Expert mode mapping 
instructions

Specifies that the Visual Mapper opens in expert mode 
to allow you to enter mapping instructions directly.

Default set at installation
Standard mode.

Notes
Standard mode leads you through creation of mapping 
instructions and prevents you from making many 
common errors.

Maps created in expert mode must be edited in expert 
mode.

Show Navigator on 
start-up

This option is not available in this release.

(Continued on next page)
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Use �Things To Do� 
lists

Specifies that the Application Editor, Standard/IG 
Editor, and the Visual Mapper display �To Do� lists 
upon opening.

Comment
You can always open or close the To Do list once you 
are in one of those editors.

When you access an editor from the Navigator, the To 
Do list is always displayed initially, regardless of your 
selection for this check box.

Default set at installation
Display the To Do list. 

Data Base (optional feature)

Driver Specifies the database driver.

Database Requires 
Password

Used to indicate that a password is required to access 
the database.

IG Data Options

Format Specifies the format for the selected data type.

Reference
See the chapter Data Type Formats in the 
GENTRAN:Server Technical Reference Guide for a list 
of available formats.

Data type box Specifies the data type for which you want to set a 
format.

Reference
See the chapter Data Type Formats in the 
GENTRAN:Server Technical Reference Guide for a list 
of supported data types.

(Continued on next page)
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Initially collapse 
segments

Specifies that the Standard/IG Editor opens in 
collapsed view.

Comment
You can change the view to expanded or collapsed at 
any time once the editor is open. You can also expand 
or collapse individual segments or composite 
elements.

Note
This does not affect the Standard/IG Editor when you 
open the editor from the Visual Mapper while 
displaying a map.

Include envelope 
segments

Specifies to select the Include Envelope Segments 
check box by default when you select the standard or 
implementation guide to display.

Comment
Whatever the default setting, you have the option of 
changing that check box when you select the standard 
or implementation guide. 

Application Data Options

Format Specifies the format for the selected data type.

Reference
See the chapter Data Type Formats  in the 
GENTRAN:Server Technical Reference Guide for a list 
of available formats.

Data type box Specifies the data type for which you want to set a 
format.

Reference
See the chapter Data Type Formats in the 
GENTRAN:Server Technical Reference Guide for a list 
of data types.

(Continued on next page)
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Initially collapse 
records

Specifies that the Application Editor opens in collapsed 
view.

Comment
You can change the view to expanded or collapsed at 
any time once the editor is open. You can also expand 
or collapse individual records.

Note
This does not affect the Application Editor when you 
open the editor from the Visual Mapper while 
displaying a map.

Type Specifies the type of data length:
◗ Fixed to a specific number of characters.
◗ Variable in length and delimited by unique field 

separators. This is the default.

Comments
The Edit button enables you to change the type from 
variable to fixed or from fixed to variable.

GENTRAN:Server uses this setting when you generate 
an application description from an implementation 
guide.

Compiler Options

Compile for platform Specifies the platform for which the compiler creates 
the mapping table when you use the Compile button 
on the toolbar.

 (Contd)
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How to Set General Preferences
Use this procedure to change the General settings on the Visual Mapper�s 
Preferences dialog box.

Step Action

1 Click Settings on the Visual Mapper�s menu bar.

2 Click Preferences from the Settings menu.

3 Use this table to determine your next step.

IF you want to� THEN�

Enter mapping instructions 
directly

Click Expert mode mapping 
instructions.

View a To Do list whenever you 
start an editor

Click Use �Things To Do� 
lists.

4 Click OK to save your new default settings.
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How to Set Implementation Guide Options
Use this procedure to assign default data formatting codes to data types within the 
Standard/IG Editor. 

Step Action

1 Click Settings on the Visual Mapper�s menu bar.

2 Click Preferences on the Settings menu.

System Response
The system displays the Preferences dialog box for the Visual 
Mapper.

3 In the IG Data Options section, select the type of data you want to 
format from the drop-down list.

Reference
See the chapter Data Type Formats in the GENTRAN:Server 
Technical Reference Guide for descriptions of the data types.

4 Click the Format button.

System Response
GENTRAN:Server displays a dialog box for the selected data type.

(Continued on next page)
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5 Enter your formatting choices and then click OK. 

Reference
See the chapter Data Type Formats in the GENTRAN:Server 
Technical Reference Guide.

System Response
GENTRAN:Server displays the code for the format you selected in 
the text box to the right of the Format button and the Data Types 
list.

6 Do you want the Standard/IG Editor to open in collapsed view by 
default?
◗ If YES, click the Initially collapse segments check box.
◗ If NO, continue with the next step.

7 Do you want the Include Envelope Segments check box selected 
by default when you open a standard or implementation guide?

◗ If YES, click the Include envelope segments check box.
◗ If NO, continue with the next step.

8 Click OK on the Preferences dialog box to save your new default 
settings.

 (Contd)
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How to Set Database Options
Use this procedure to assign the default database driver to use for ODBC 
translations.

Step Action

1 Click Settings on the Visual Mapper�s menu bar.

2 Click Preferences on the Settings menu.

System Response
The system displays the Preferences dialog box for the Visual 
Mapper.

3 In the Data Base section, select the default data base driver from 
the Driver drop-down list.

4 Is a password required to access the data base?
◗ If YES, click the Database Requires Password check box.
◗ If NO, continue with the next step.

5 Click OK on the Preferences dialog box to save your new default 
settings.
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How to Set Application Data Options
Use this procedure to assign a default formatting code to each type of data that 
can be passed in a field of an application description.

Step Action

1 Click Settings on the menu bar.

2 Click Preferences from the Settings menu.

System Response
The system displays the Preferences dialog box for the Visual 
Mapper.

3 In the Application Data Options section, select the type of data 
you want to format from the drop-down list.

Reference
See the chapter Data Type Formats in the GENTRAN:Server 
Technical Reference Guide for descriptions of the data types.

4 Click the Format button.

System Response
GENTRAN:Server displays a dialog box for the selected data type.

(Continued on next page)
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5 Enter your formatting choices and then click OK. 

System Response
GENTRAN:Server displays the code for the format you selected in 
the text box to the right of the Format button and the Data Types 
list.

6 Do you want the Application Editor to display application files in 
collapsed view by default?

◗ If YES, click the Initially collapse records check box.
◗ If NO, continue with the next step.

7 Do you want to set a default format for your application data?

◗ If YES, continue with Step 8.
◗ If NO, GO TO Step 14.

8  Click Edit.

System Response
The system displays the Application Data Description dialog box.

Note
The Default data separator and Special character options are 
active only if the current default is variable length.

(Continued on next page)
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9 Use this table to determine your next step.

IF your most frequently used 
applications use� THEN�

Fixed length fields Click Fixed Length Fields. 

Variable length fields Click Variable Length 
Delimited Fields. 

10 Use this table to determine your next step.

IF you chose� THEN�

Fixed Length Fields GO TO Step 12.

Variable Length Delimited Fields Continue with Step 11.

11 Use this decision table to enter the default data delimiter character 
for variable-length fields.

IF you want to use� THEN�

A printable character Enter the character in the 
Default Data Separator text 
box.

 A non-printable character Click Special Character and 
select the hex equivalent of the 
character from the Special 
Character list.

12 Does your application use character delimiters for alphanumeric 
data types?

◗ If YES, click the Character Data Delimiter check box and type 
the delimiter character into the text box.

◗ If NO, continue with Step 13.

Comment
Any data type can be character delimited. If you click Character 
Data Delimiter, GENTRAN:Server expects all AN and ID data type 
fields to be character-delimited. Some or all of the other data types 
can have character-delimited values, but it is not required.

(Continued on next page)

 (Contd)
Step Action
Mapping and Translation Guide � February 2002



How to Set Application Data Options Understanding the Basics1 - 20
13 After making your selections, click OK.

System Response
GENTRAN:Server returns to the Preferences dialog box. 

14 Click OK to save your changes and exit the dialog box.

 (Contd)
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How to Set Compiler Options
Use this procedure to set the platform automatically used for the mapping tables 
created when you use the Compile button on the toolbar. 

Step Action

1 Click Settings on the Visual Mapper�s menu bar.

2 Click Preferences on the Settings menu.System 
Response
The system displays the Preferences dialog box for the Visual 
Mapper.

3 In the Compiler Options section, click the arrow on the Compile 
for platform list.

4 Select the platform you want to use. 

Comment
You should select the same platform on which translations will be 
performed.

5 Click OK to save your changes and exit the dialog box.
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Overview 0

Introduction

Similarities
between editors

The Application Editor and the Standard/IG Editor are similar in structure and 
function. 

In this chapter This chapter describes the features these two editors have in common and 
explains how to use the editors.

Key Terms This table describes the key terms used in this chapter.

Term Description

application 
description

A definition of the records and fields in an application 
file.

Application Editor The GENTRAN:Server editor that enables you to 
define your application data.

attribute A piece of information about a record, field, segment 
element, sub-element, or composite element. Each of 
these items has its own set of attributes. This attribute 
set may include the item name, minimum and 
maximum length, data type, and data format. 

editor A tool that enables you to create and maintain specific 
types of files, such as application descriptions or 
implementation guides.

composite element An element composed of two or more sub-elements.

element A piece of data in a segment (Standards Editor). 
Elements are analogous to fields in an application 
description. Elements are variable length fields.

field A piece of data in a record (Application Editor).
(Continued on next page)
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implementation guide A version of an EDI standard version that was edited to 
meet the requirements of a particular trading partner, 
or a standard saved as an implementation guide.

loop A sequence of related segments or records repeated 
within a transaction set.

mark Flagging an item in focus for special editing functions 
such as making a loop or designating a record ID.

record A defined sequence of related fields (Application 
Editor).

segment A defined sequence of related elements (Standards 
Editor). Segments are analogous to records, which are 
used in application descriptions. 

standard A major data format model used for EDI (for example, 
X12, EDIFACT). Includes the rules and guidelines for 
formatting or structuring electronically transmitted 
documents.

Standard/IG Editor The GENTRAN:Server feature that enables you to edit 
standards and create implementation guides.

sub-element An element that is a component of another element.

Visual Mapper The GENTRAN:Server graphical tool that enables you 
to create and modify the rules for translating data from 
the source format to the destination format.

 (Contd)
Term Description
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Editor Examples

Application
Editor

This is an illustration of the Application Editor.

(Continued on next page)
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Standard/IG
Editor

This is an illustration of the Standard/IG Editor.
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Parts of an Editor Window

Description The editor window enables you use to create or modify your application 
description, standard, or implementation guide.

Illustration This illustration shows the parts of an editor window. In this illustration, we show 
the Application Editor.

Parts table This table describes the parts of the editor window.

Menu bar
Toolbar

File name

Record/Field or
Segment/Element 
data

Edit box

Status bar 

Name Function

Menu bar Opens menus to display commands applicable to the 
active editor.

Toolbar Starts another GENTRAN:Server function.
(Continued on next page)
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File name Displays the name of the application description, standard, 
or implementation guide.

Record and field 
or segment and 
element data

Displays graphic representations of record and fields or 
segments and elements and information about them. 
Enables you to add, delete, copy, and move these items.

Edit Box Enables you to define the record, field, segment, or 
element attributes by typing in the edit box and selecting 
from drop-down lists.

Status bar Displays a status message, prompt, or toolbar button 
description.

 (Contd)
Name Function
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Editor Symbols

Definition An editor symbol is a graphical representation of a data item.

Editor symbol
table

This table describes the editor symbols.

Symbol Description

A record or segment.

A field or an element or a sub-element that does not have 
any further sub-elements. In EDIFACT terms, this may be a 
component element.

An element with sub-elements that are not displayed. In 
EDIFACT terms, this symbol represents a composite 
element.

An element with displayed sub-elements. In EDIFACT 
terms, this symbol represents a composite element.

A loop. The line connecting two or more records or 
segments indicates the starting and ending items in the 
loop. Nested loops are indicated by connecting lines that 
also are nested.
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Procedures 0

How to Open and Close the Editors

Introduction There are several ways to open and close an editor.

Opening an
editor from the

Main menu

This table describes the ways to open an editor from the Main menu.

Closing an
Editor

To close and editor, click Close on the File menu. 

System Response
If you have unsaved changes in an open application description, 
GENTRAN:Server prompts you to save the changes.

To open the�
Click this 

button
Or click these options on the File 

menu

Standard/IG Editor New, then Implementation Guide

Open, then Implementation Guide

Application Editor New, then Application Description

Open, then Application Description

System Response
The system displays the Open Application dialog box. 
Click Create new to create a new application 
description or Open existing record layout file to 
open an existing application description.

Reference
See the chapter Working with the Application and 
Standard/IG Editors  in this guide.
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How to Load a File

Introduction You may load an existing file when the editor is open or closed.

Loading a file
when the editor

is open

Use this procedure to open an existing application description or implementation 
guide when the editor is open.

Loading an
application
description

when the editor
is closed

Use this procedure to open an application description when the editor is closed.

(Continued on next page)

Step Action

1 Click Open on the File menu.

System Response
The system displays the File Open dialog box.

2 Select the appropriate path and file name on the File Open dialog 
box.

3 Click Open.

Step Action

1 Click Open on the File menu.

2 ����������������	
���������	����	
��������������

System Response
The system displays the File Open dialog box.

3 Select the path and file name.

4 Click Open.

System Response
The system opens the Application Editor and displays the selected 
file.
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Loading an
implementation
guide when the
editor is closed

Use this procedure to open an implementation guide when the editor is closed.

(Continued on next page)

Step Action

1 Click Open on the File menu.

2 Click Implementation Guide on the Open submenu.

System Response
The system displays the File Open dialog box.

3 Select the path and file name.

4 Click Open.

System Response
The system opens the Standard/IG Editor and displays the select file.
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Loading a
standard when

the editor is
closed

Use this procedure to open an existing standard when the editor is closed.

Step Action

1 Click the Std button.

System Response
The system displays the Select Standard/IG dialog box.

2 Click Standard.

System Response
The system displays a list of standard versions in the left column. 
The right column displays a list of documents for the selected 
standard version.

3 Click the standard and version you are using in the Standard/
Version column. 

4 Click the document you want to load in the Document column.

5 Click OK.

System Response
GENTRAN:Server displays the selected file in the Standard/IG 
Editor.
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How to Change the Display View

Introduction You can view GENTRAN:Server editor windows in either an expanded view 
(displaying all records and fields or segments and elements) or a collapsed view 
(displaying only records or segments). You can expand or collapse a single item 
or all items displayed in the window.

Default view Default values set from the GENTRAN:Server Main Menu determine whether the 
editor opens in collapsed view or expanded view. From the Main Menu, click 
Preferences on the Settings menu to view the default values.

Reference
See the Understanding the Basics chapter of this guide.

Collapsed view
example

The following illustration shows the collapsed view in the Standard/IG Editor.

(Continued on next page)
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Expanded view
example

This illustration shows the same file in expanded view. The editor displays the 
elements of each segment along with their item symbols and attributes.

Expanding and
collapsing the

view

This table explains how to expand and collapse the view.

IF you want to� of� THEN�

Expand the view A single item Double-click on the item.

All items Click Expand All on the View menu.

Collapse the view A single item Double-click on the item.

All items Click Collapse All on the View menu.
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How to Edit Data Items

Introduction In an editor window, you may copy and paste one or more selected items, move 
one or more selected items to a new location, or add and delete items. To use 
these editing commands, you must first select or mark the items. When selecting 
multiple items, they must be consecutive.

Selecting items An item line is selected when a dark gray bar appears around it. We refer to this 
as the focus. You can focus on only one line at a time.

There are two ways to move the focus:
◗ Click on a line to place the focus on it.
◗ Use the up-arrow and down-arrow keys to move the focus bar.

Example
This illustration shows the focus on a segment.

(Continued on next page)

Focus
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Marking items Before you can cut, copy, or delete an item, you must mark it. To edit several 
items at once, mark each of the items and then select an editing command.

Marked items appear in blue on your screen. The items remain marked until you 
unmark them or edit them.

Use this procedure to mark items.

Removing marks Use this table to remove the mark from an item.

(Continued on next page)

Step Action

1 Move the focus bar to the line you want to mark.

2 Press F5 or click Toggle Mark Item on the Mark menu. 

System Response
The system displays the name of the marked item in blue.

3 Repeat Steps 1 and 2 for any consecutive items you want to edit at 
the same time. (You cannot edit non-adjacent items.)

Comment
You are now ready to select an editing command.

IF you want to unmark� THEN�

A single item ◗ Move the focus to the line you 
want to unmark.

◗ Press F5 or click Toggle Mark/
Unmark on the Mark menu.

System Response
The system displays the name of the 
item in dark gray.

All marked items Click Clear All Marks on the Mark 
menu.

System Response
The system displays the name of the 
items in dark gray.
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Moving items To move an item or a group of items, you mark, cut, and then paste the item(s) 
into the new location.

Comments
When you move a record or segment, GENTRAN:Server also moves all 
associated fields or elements.

When you cut an item, it remains in the clipboard until you cut or copy another 
item. As long as the item is in the clipboard, you can paste it to a location in the 
editor window. You lose the first item from the clipboard once you cut or copy 
another item.

Use this procedure to move one or more items.

(Continued on next page)

Step Action

1 Move the focus to an item you want to move. 

2 Click Toggle Marked Item on the Mark menu.

System Response
The system displays the name of the marked item in blue.

3 Repeat Steps 1 and 2 to copy adjacent items at the same time.

Comment
You can cut and move only adjacent items at the same time.

4 Click Cut Marked on the Edit menu.

5 Move the focus to the line that you want to precede the item(s) you 
are moving.

6 Click Paste on the Edit menu.

System Response
The item(s) appear in the new position.
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Copying Items To copy an item or a group of items, you mark, copy, and then paste the item(s). 
When you copy a record or segment, GENTRAN:Server also moves all 
associated fields or elements.

Comment
When you copy an item, it remains in the clipboard until you cut or copy another 
item. As long as the item is in the clipboard, you can paste it in a location in the 
editor window. Once you cut or copy another item, the first item is replaced on the 
Clipboard.

Use this procedure to copy items. 

Adding items This procedure explains the basic steps to add data items to the file the editor 
window is displaying.

Reference
For detailed instructions for adding data items, see these chapters in this guide:

◗ Defining Application Descriptions for ASCII Files 
◗ Creating an Implementation Guide or Standard 

(Continued on next page)

Step Action

1 Move the focus to an item you want to copy. 

2 Click Toggle Marked Item on the Mark menu.

System Response
The system displays the name of the marked item in blue.

3 Repeat Steps 1 and 2 to copy adjacent items at the same time.

4 Click Copy Marked on the Edit menu.

5 Click the line that you want to precede the copied item(s).

6 Click Paste on the Edit menu.

System Response
The copied item(s) appear in the new position.
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Use this procedure to add data items.

(Continued on next page)

Step Action

1 Move the focus to the line that you want to precede the new item. 

2 Select the item type you want to add from the Edit menu.

Comment
When you add a record or segment, GENTRAN:Server 
automatically adds one empty field or element as well.

3 Move the focus to the new item and then assign its attributes in the 
edit box at the bottom of the window.

Reference
For attribute descriptions, see these topics:

◗ How to Add an Element, Composite Element, or Sub-element  
in the chapter Creating an Implementation Guide or Standard  
of this guide.

◗ How to Add Records in the chapter Defining Application 
Descriptions for ASCII Files of this guide.

◗ How to Add Fields in the chapter Defining Application 
Descriptions for ASCII Files of this guide.

4 Click OK to save your changes.
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Cutting vs.
discarding and

deleting

This table describes the differences among cutting, deleting, and discarding 
items.

Cutting items Use this procedure to cut items.

(Continued on next page)

When you� The item is� And�

Cut Removed from its position 
and pasted to the Clipboard

Remains on the Clipboard until 
you cut or copy another item.

Discard Retained in the file as an 
inactive item, appearing in 
light gray on the editor 
window

Note
The Visual Mapper does not 
display discarded items. 

Is bypassed by all file 
processing until you reactivate 
it.

Delete Permanently deleted once 
you save the file

Cannot be recovered.

Step Action

1 Move the focus to the line you want to cut. 

2 Click Toggle Marked Item on the Mark menu.

System Response
The system displays the name of the marked item in blue.

3 Click Cut Marked on the Edit menu.

System Response
GENTRAN:Server removes the item from the display and pastes it 
on the Clipboard. The item remains on the Clipboard until you cut 
or copy another item.
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Discarding items WARNING
When you discard a segment, GENTRAN:Server also discards the 
item�s elements. 
Do not cut, discard, or delete the ST, CTT, or SE segments. You do 
not have to map them (make a map group), but they must be present 
in the map file.

Discard is available only in the Standards Editor

This table explains how to discard items.

(Continued on next page)

IF you want to discard� THEN�

A single item ◗ Move the focus to the item to be 
discarded.

◗ Click Toggle Usage on the Use menu.

System Response
The system displays the item line in light gray.

Comment
The Toggle Usage option turns discarding on 
and off. 

Selected items ◗ Move the focus to the first item you want to 
discard.

◗ Click Toggle Mark Item on the Mark menu 
to mark the item.

◗ Repeat the above steps for each 
additional adjacent item you want to 
discard.

◗ Click Discard Marked on the Use menu.

Comment
If you have many items to discard, you may 
discard all items and then activate particular 
items or groups of items.

Reference
See the topic Activating discarded items in this 
chapter.

All items Click Discard All on the Use menu.
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Viewing
discarded items

The View Only Used Items option on the View menu enables you to display or 
hide discarded items in an editor window.

To hide discarded items, click View Only Used Items on the View menu. This is a 
toggle (on/off) command. Therefore, to display all items, including discarded 
items, cancel the selection for View Only Used Items.

Activating
discarded items

When you re-activate an item, the line color changes from light gray to black.

If you activate a discarded segment, you also activate all its elements.

Use this table to activate discarded items.

(Continued on next page)

IF you want to activate� THEN�

A single discarded item ◗ Move the focus to the item you want to 
discard.

◗ Click Toggle Usage from the Use menu.

Comment
The Toggle Usage option turns discarding on 
and off. 

Selected discarded items ◗ Move the focus to the first item you want to 
reactivate.

◗ Click Toggle Mark Item on the Mark 
menu.

◗ Repeat the above steps for each 
additional item you want to activate.

◗ Click Use Marked on the Use menu.

Only the mandatory items Click Use All Mandatory from the Use menu.

All discarded items Click Use All from the Use menu.
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Deleting items Use this procedure to delete items.

Step Action

1 Move the focus to the line you want to delete. 

WARNING
Once you save your file, you cannot recover deleted 
items. If you may need the item in the future, discard it 
instead of deleting it.
When you delete a record or segment, GENTRAN:Server 
also removes the item�s fields or elements.
If you delete a composite element, GENTRAN:Server 
deletes the composite element's sub-elements. 
Do not delete or discard the ST, CTT, or SE segments. 
You do not have to map them (make a map group), but 
you must make sure they are in the map file.

2 Click Toggle Mark Item on the Mark menu. 

3 Repeat Steps 1 and 2 for each additional item you want to delete.

4 Click Delete Marked on the Edit menu.

System Response
GENTRAN:Server displays this confirmation prompt: Permanently 
delete all marked items?

Comment
If you inadvertently delete an item, you can close the file without 
saving. This undoes the deletion. Closing without saving also 
undoes all other changes made since you last saved the file. 

5 Click Yes.

6 Click Save on the File menu to make the changes permanent.
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How to Create and Delete Loops

Introduction Often, a sequence of records or segments is repeated. You can indicate that a 
sequence of records or segments repeats by grouping them together and defining 
the group as a loop�

If you no longer need the loop, you can do one of the following: 
◗ Dissolve the loop, but keep its component records or segments
◗ Delete both the loop and its component records or segments at the same 

time.

How loops are
displayed

When you define a sequence of records or segments as a loop, 
GENTRAN:Server displays a thin, red line that connects the first and last record. 

The Loop Cnt column displays the number of times the sequence repeats.

Before you begin All items in a loop must be sequential. Move records as necessary to make them 
sequential before you add the loop.

Discarded
segments

You must display discarded segments before you create, modify, or delete a loop 
in the Standard/IG editor.

CAUTION
If you do not display discarded items before creating, modifying, or 
deleting a loop, your map may fail.

(Continued on next page)
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Optional
Segments

If a segment that begins a loop is optional, then that segment MUST be present in 
the application file if any of the other segments in the loop are also present. 

Example
If you have the following record structure in an application-to-application map, 
then REC 1 must exist if REC 2 exists:

Adding a loop Use this procedure to add a loop.

REC1 (Optional)

REC2

REC#

Step Action

1 Click Collapse All on the View menu so that the editor displays 
only the records or segments. 

Note
If you are using the Standard/IG editor, make sure that all items 
(including unused or discarded items) are displayed. Under the 
View menu, the View Only Used Items option must be unselected 
(no check mark) to view all items.

2 Move the focus to a record or segment that you want to include in 
the loop.

3 Click Toggle Marked Item on the Mark menu.

4 Repeat Steps 2 and 3 for each item you want in the loop.

5 Click Make Loop on the Edit menu.

System Response
GENTRAN:Server responds by adding the loop markers (red con-
necting lines) to the records or segments in the loop. The edit box 
for the first item in the loop includes a text box for the loop count.

(Continued on next page)
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Dissolving the
loop association

Use this procedure to remove the loop and keep the records or segments.

(Continued on next page)

6 Type the number of times the loop repeats in the LP CNT edit box 
of the first item in the loop.

Comment
This value must be a positive integer between 0 and 99999. The 
symbol >1 indicates that the number of repetitions varies.

7 Click OK to save your changes.

 (Contd)
Step Action

Step Action

1 Move the focus to the first record in the loop. 

Note
If you are using the Standard/IG editor, make sure that all items 
(including unused or discarded items) are displayed. Under the 
View menu, the View Only Used Items option must be unselected 
(no check mark) to view all items.

2 Click Remove Loop on the Edit menu.

System Response
GENTRAN:Server deletes the loop association and removes the 
red line.
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Deleting the loop
and its

components

Use this procedure to delete the loop and all the records or segments in the loop.

Step Action

1 Move the focus to the first item in the loop. 

Note
If you are using the Standard/IG editor, make sure that all items 
(including unused or discarded items) are displayed. Under the 
View menu, the View Only Used Items option must be unselected 
(no check mark) to view all items.

2 Click Toggle Mark Item on the Mark menu.

System Response
The system displays the name of the marked item in blue.

3 Click Delete Marked on the Edit menu.

System Response
GENTRAN:Server displays this confirmation prompt: Permanently 
delete all marked items?

Caution
You cannot recover deleted items.

4 Click Yes.

System Response
GENTRAN:Server displays a confirmation prompt informing you 
that deleting the marked item deletes all the items in the loop as 
well.

5 Click Yes.

System Response
GENTRAN:Server deletes all the items in the loop and the loop 
markings.
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How to Set Item Attributes

What are
attributes?

Attributes are the values and identifying information you assign to records, fields, 
segments, and elements. The editor window displays an item�s attributes.

Example This example shows the attributes of segments and elements in a Standard/IG 
Editor window. The columns titled Max Occ, Min, Max, Type, Req, and Loop Cnt 
display the attributes. 

Where to set
attributes

The edit box at the bottom of an editor window sets the attributes of a file item. 
When the focus is on an item, the editor displays the item�s attributes in the edit 
box. 

(Continued on next page)
Mapping and Translation Guide � February 2002



Working with the Application and Standard/IG Editors How to Set Item Attributes 2 - 29
How to set
attributes

Use this procedure to set or change item attributes.

Step Action

1 Move the focus to the item.

System Response
The editor displays the item�s attributes in the edit box.

2 Enter the values in the edit box and select values from the lists.

References
For definitions of item attributes, see these chapters in this guide:

◗ Defining Application Descriptions for ASCII Files 
◗ Creating an Implementation Guide or Standard 

3 Click OK to save the attribute changes.

4 Click Save on the File menu to save the changes.
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Overview 0

Introduction

In this chapter You will learn how to create or modify an application description that describes 
data stored in an ASCII file, and how to use the Standard/IG Editor to create an 
application description from a standard or implementation guide. 

Application
documents

An application document is a document your business computer application 
produces or processes. The data that is associated with these documents can be 
stored in an ASCII file. Your business computer application can be either the 
source of documents you want to send to your trading partners or the destination 
for documents your trading partners send to you. 

Example
Your application may produce or process purchase orders, invoices, shipping 
notices, requests for quotations, or other types of standard business documents 
that can be transferred electronically.

Application
descriptions

To prepare for mapping and translation, you must describe the format of the data 
in each application document you exchange with your trading partners. The result 
will be an application description file. 

Why you need to
create

application
descriptions

You use application descriptions as a source or destination document when you 
create your translation maps. Recall that a translation map tells 
GENTRAN:Server�s translator how to convert an inbound document into a format 
your application understands: EDI standard, implementation guide, or another 
application. The translation map also tells the system how to convert outbound 
documents from your application into another format. The application description 
identifies the data items that your application uses so that you can relate each to a 
data item in another format.

Output files You can translate a single ASCII file application description to more than one 
output file only by using the text database driver.

(Continued on next page)
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Key terms This table lists the key terms used in this chapter.

Term Description

application description Your company�s description of the records and 
fields in an ASCII file used for your data.

Application Editor The GENTRAN:Server tool that enables you to 
describe your application data.

attributes The values you assign to describe a record or field.

data type The type of information in a field (for example, 
alphanumeric, binary, numeric, date, time).

delimiter A symbol used to separate data items in an 
application file.

field A discrete piece of data in a record, such as 
quantity or unit price.

loop A sequence of related items repeated within a 
transaction set.

marking The process of flagging or selecting a field or record 
with which you want to work.

record A defined sequence of related fields.

record ID The field that identifies the record to 
GENTRAN:Server.

Trading Partnership 
Code

The unique code that identifies a Trading 
Partnership record. The record describes a unique 
trading partner and document combination. The 
Trading Partnership Code must have from 1-15 
alphanumeric characters. Spaces and special 
characters are NOT allowed.
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Components of an Application Description

Introduction Application descriptions that describe the data in an ASCII file have two main 
components:
◗ Records�the defined sequence of related fields. Each record consists of 

one or more items of data. For example, in a purchase order, the record 
PURCHASE ORDER LINE ITEM contains the several items of data, such as 
the part name, quantity being ordered, and the unit price.

◗ Fields�the items of data in a record. For example, in the record PURCHASE 
ORDER LINE ITEM, the fields include item name, quantity, and unit price.

Record loops Often, a sequence of records in your application data is repeated multiple times. 
To indicate that a sequence of records repeats or reiterates, you mark the data 
loops within the file.

When you mark a sequence of records as a loop, you will see a thin, red line 
connecting the first and last record.

Example
This is an example of a loop in the Application Editor.

Record
attributes

Attributes are the values you assign to describe a record. Two of the attributes you 
assign to a record are the record identifier and the record name. Each record must 
have a unique name. The name can be up to 128 characters in length and can 
contain any keyboard characters.

(Continued on next page)
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Field attributes In addition to the attributes that you assign to a record, you also assign attributes 
to describe a field.

Field attributes include:
◗ Field name
◗ Data type (for example, binary, numeric, alphanumeric, date/time) 
◗ Data format (for example, left-justified).

The field name must be unique. The name can be up to 128 characters in length 
and can contain any keyboard characters.

Reference
For a list of the allowable formats for each data type, see Data Type Formats in 
the GENTRAN:Server Technical Reference Guide.

Field lengths Field lengths may be:
◗ Fixed to a specific number of characters.
◗ Variable in length and delimited by unique field separators.
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The Trading Partnership Code and Record ID

Introduction If you plan to use the application description as the source document in a map, 
you must:
◗ Define a way for GENTRAN:Server to determine the Trading Partnership 

Code in the application document
◗ Designate one field in each record as the record ID.

Comment
If the application description is used as the destination document in a map, you do 
not need to mark the Trading Partnership Code.

Ways to define
the Trading
Partnership

Code

Identifying the Trading Partnership Code is essential because the code enables 
GENTRAN:Server to locate the Trading Partnership file. This file contains the 
name of the map GENTRAN:Server uses to translate the data for this trading 
partner.

There are two ways to define the Trading Partnership Code in an application 
description:

◗ Designate one field in the first record as the Trading Partnership Code. 
◗ Define application/Trading Partnership rules that extract values from multiple 

fields in the first record. GENTRAN:Server uses the result to determine the 
Trading Partnership Code.

References
For information about designating one field as the Trading Partnership Code, see 
Designating a Trading Partnership Code Field and Record ID.

For information about using multiple fields to determine the Trading Partnership 
Code, see the Defining Trading Partnership Rules for Application Files chapter in 
this guide.

The record ID The translator uses the record ID field to distinguish the records in a document.

For outbound translation in which the application is the source document, each 
record must contain a record ID. Record IDs are optional for inbound translation.

Comment
The layout you select for the Trading Partnership Code may affect the field 
positions you use for the record ID.
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Designating a Trading Partnership Code Field and 
Record ID

The Trading
Partnership

Code field

You can designate one field as the Trading Partnership Code field in your 
application description to tell the translator where to look for the Trading 
Partnership Code.

When you use one field, the position of the record ID may be affected.

Methods of
describing

There are two ways to describe the layout of the Trading Partnership Code and 
record ID layout of your ASCII application data.

Method 1
The Trading Partnership Code is a required field in the first record of a document, 
and may also appear elsewhere in the data or application description.

The record ID is positioned in any field of each record, but is positioned 
consistently in the same field for all records of the same type. For example, if the 
record ID is in field 03 of the first �detail� record, it must be positioned in field 03 of 
all other �detail� records. In other record types, it may be in a different position.

Example

In this example,

The record ID = HEADER, NAMEREC, Detail

The Trading Partnership Code = XYZ850OUT.

(Continued on next page)

HEADER  0234  12/31/1999  XYZ Company, Inc.  123 Anystreet Howtown  MI 48106 XYZ850OUT NL

XYZ Company  Payables  Terry Smith  313-222-1234 313-555-8000VN20046-AV NAMEREC NL

PONumber0234 Detail   84each 9.95  stainless steel NL

PONumber0234 Detail   173dozen 50.00 1043775829 screwdriver NL

PONumber0234 2  2257  SU NL
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Method 2

The Trading Partnership Code is in positions 1 through 15 of each record in your 
application description, and a blank is in position 16. (The code can be less than 
15 characters in length, but the unused positions must be padded out with 
blanks.) The code itself cannot contain spaces or special characters.

A two-digit record ID is in positions 17 and 18 of each record in your application 
description file, immediately after the Trading Partnership Code. (The record ID is 
an arbitrary two-digit number from 01 to 99.) You can designate up to 99 different 
record IDs.

Example

In this example,

Record IDs are in the second column.

The Trading Partnership Code = XYZ850002040IB.

CAUTION
If you intend to use the dnld personality intelligent agent to process 
the application files in GENTRAN:Server, you must use method 2 and 
you must set the record ID of the first record in the file to 01.

XYZ850002040IB 10 PONumber0234 12/31/1999XYZ Company, Inc. 123 Anystreet Howtown  MI 48106 NL

XYZ850002040IB 15 XYZ Company  Payables  Terry Smith  313-222-1234 313-555-8000VN20046-AV NL

XYZ850002040IB 20 PONumber0234 84each 9.95 stainless steel NL

XYZ850002040IB 20 PONumber0234 173dozen   50.00   1043775829  screwdriver NL

XYZ850002040IB 30 PONumber0234 2   2257 SUM NL NL
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ASCII File Application Descriptions

Introduction ASCII files have no explicit structure. In an ASCII file, no record is subordinate to 
any other record. An ASCII file can be either a sequential or a direct access file. 
Generally, non-database files are ASCII files.

Identifying ASCII
files

In ASCII files, each line is a separate record. The file may contain either variable 
or fixed-length fields. Variable length fields are separated by delimiters.

ASCII file
example

This is an example of an ASCII file.

CEPA 863V3R5RVPAVER UYYYYYYY
D863V3R5HBTR001995113001809RV
D863V3R5HBTM45819950629
D863V3R5HBTM09019950701
D863V3R5HBTM09119950930
D863V3R5HLN1N1PV????EP5004
D863V3R5HLN1REF4A4240
D863V3R5HLN1PERCEJAMES J. SIMNICK
D863V3R5HLN1PREF4AV615
D863V3R5HLN1PERAAERNEST C. SCHUTTTE312/856-5620
D863V3R5DLLINLINB850040032895000000
D863V3R5DLLINPIDS VCEPV1
D863V3R5DLLINQTY01 000000000000000GA
D863V3R5DLLINCID60
D863V3R5DLLINMEARGRVP 000000000000000000PS
D863V3R5DLLINMEAAGRVP 000000000000000000PS::G
D863V3R5DLLINMEAAFRVP 000000000000000000PS::G
D863V3R5DLLINMEAAHRVP 000000000000000000PS::G
D863V3R5DLLINLINB850040032895000000
D863V3R5DLLINPIDS VCEPV2
D863V3R5DLLINQTY01 00000308880529GA
D863V3R5DLLINCID60
D863V3R5DLLINMEARGRVP 000000000000000000PS
D863V3R5DLLINMEAAGRVP 000000000000000000PS::G
D863V3R5DLLINMEAAFRVP 000000000000000000PS::G
D863V3R5DLLINMEAAHRVP 000000000000000000PS::G
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Creating an ASCII 
Application Description 0

Application Description Creation Process

Creation process This table describes the process of creating an application description.

Stage Description

1 Obtain the data specifications for your application data. 

You collect and manage your data through application software that 
is independent of GENTRAN:Server. Become familiar with the ASCII 
application file contents before you create or edit the 
GENTRAN:Server application descriptions.

2 Create a file that describes the data.

Make an application description file containing the records and fields 
from your application. You create and modify your application 
description with GENTRAN:Server�s Application Editor. You describe 
your application once, and tailor it later in the map to meet specific 
trading partner requirements.

3 Verify that your data size and data types are correct.

4 Specify the correct formatting for the data in the application data 
fields.

Reference
See Data Type Formats in the GENTRAN:Server Technical 
Reference Guide for information about the formats available for each 
data type.

5 Set up special options, (such as batch total or special delimiting 
character) as necessary.

6 Create loop structures that reflect your repeating data records.
(Continued on next page)
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7 Do one of the following:
◗ Mark the field in the first record that contains the Trading 

Partnership Code and mark the record IDs.
◗ Create Trading Partnership rules for the application description.

8 Save the changes and name the application description.

Later, map your application description to an EDI standard, to an 
implementation guide, or to another application.

 (Contd)
Stage Description
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The Application Editor

Introduction The tool that you use to create and maintain application descriptions is the 
Application Editor. This tool provides you with a graphic view of the layout of your 
records and fields. It also enables you to see the loops you have built into your 
application description to process repeated records of your business data.

Application
Editor example

This example shows the Application Editor.

(Continued on next page)

Edit box
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Application
Editor fields and

functions

This table describes the fields and functions of the Application Editor window.

Field Function

Record/Field Describes the records and fields.

Max Occ Indicates the maximum number of times this record 
can appear in a row.

Min Len Indicates the minimum field length.

Max Len Indicates the maximum field length.

Type Indicates the field�s data type (alphanumeric, numeric, 
date/time, or binary).

Req Indicates the requirement indicator:

◗ O for optional: the presence of the record is at the 
option of the sending party.

◗ M for mandatory: the record must be present.
◗ C for conditional/relational: the presence of the 

record depends on the presence of specific other 
items.

Loop Cnt Indicates the number of times this group of records can 
repeat as a loop.

Delimiter Indicates the data separator for variable-length data.

Edit box Modifies the record or field that has the focus.
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Deciding How to Create Your Application Description

Methods for
creating new

application
descriptions

There are four ways to create application descriptions:
◗ Adapt an existing application description
◗ Create an application description from a standard or implementation guide
◗ Build an application description from a record layout file
◗ Manually build an application description 

Decision table Use the following table to determine how to create your application description.

IF you have� THEN follow the procedure�

An application description that can be 
adapted for the new application 
document

How to Adapt an Existing Application 
Description in this chapter.

A standard or implementation guide 
from which to base your application 
description and you want the 
application description to have 
variable-length fields

How to Create a Description from a 
Standard or IG in this chapter.

An ASCII file that specifies some or all 
of the characteristics needed to 
describe your application data

How to Build from a Record Layout 
File in this chapter.

No data or files on which you can base 
the application description

How to Manually Describe an ASCII 
File in this chapter.
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Procedures 0

How to Adapt an Existing Application Description 

Introduction The easiest way to create a new application description is to modify an existing 
application description. This may be an application description created for either 
another application or for this application. You may have created the original 
application description earlier or someone else in your organization may have 
given it to you. 

There are two ways you can use an existing application description in the 
Application Editor as the basis for a new application description:

◗ Open and edit an application description
If you are using the client/server version of GENTRAN:Server, the application 
description is on the UNIX host.

If you are using the Workstation version of GENTRAN:Server, the application 
description must be on your PC. 

Once the application description is open, you may modify it and then save it 
under a new file name. You must save it in the directory specified for 
application descriptions.

◗ Copy, open, and edit an application description
You can also make a copy of an existing application description and then edit 
the copy. This assures that you will not make any inadvertent changes to the 
original application description.

Recognizing and
locating

application
descriptions

When you create or edit an application description and save it with the Save or 
Save As commands, GENTRAN:Server gives the file a default file name 
extension of .app.

GENTRAN:Server automatically stores application descriptions in the directory 
specified for application descriptions, which was created and named during 
installation. To learn the name of the directory, select Location of Files on the 
Preferences menu.

(Continued on next page)
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Before you begin Before you adapt an existing application description:
◗ Make sure the application description you are using as a base is in the 

directory specified for application descriptions. 
◗ Know what your record IDs are and where they appear in the application file.

Procedure flow
diagram

This diagram shows the flow of work for adapting an existing application 
description.

(Continued on next page)
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Editing an
existing

application
description

Use this procedure to open and edit an existing application description file.

Step Action

1 Open the Application Editor.

2 Click Open existing UDF application file and click OK.

CAUTION
Remember, you must use an ASCII application 
description to describe non-database application data.

System Response
The system displays the Open File dialog box. The system 
automatically selects the directory specified for application 
descriptions. The File list displays all files with the .app extension.

3 Select the file name of the application description you want to open 
and click OK.

System Response
GENTRAN:Server displays the file in the Application Editor 
window.

Comment
The display shows the names of all records and their current 
characteristics. It may or may not show the names of all fields and 
their current characteristics, depending upon whether you selected 
Collapsed or Expanded as the default view for the Application 
Editor in the User Setup dialog box.

4 Do you want to save the original application description?

◗ If NO, skip to Step 6.
◗ If YES, click Save As on the File menu to copy the file, and 

continue with Step 5.

5 Type a new file name for the new application description in the File 
box of the Save As dialog box and click Save.

6 You are now ready to modify the new application description. 

GO TO How to Modify an Application Description in this chapter.
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How to Create a Description from a Standard or IG

Introduction You can automatically create an application description from a standard or 
implementation guide. Because you start with a standard or implementation guide 
open, you must be in the Standard/IG Editor rather than in the Application Editor. 
The resulting application description has variable or fixed length fields, depending 
on the settings in Preferences.

Comment
If you are translating from a standard to an application or from an application to a 
standard, you can automate every part of the EDI mapping process. Use 
AutoTrim to create an implementation guide from a standard and sample input 
data, use AutoCreate to create the application description from the 
implementation guide, and use AutoMap to map the implementation guide and 
application description.

Before you begin If you intend to use AutoTrim on a standard to create the implementation guide 
and then use AutoCreate on the implementation guide to create this application 
description, you must use AutoTrim first. Both the AutoTrim and the AutoCreate 
commands are found in the Standard/IG Editor.

Procedure flow
diagram

This diagram shows the flow of work for creating an application description from 
an existing standard or implementation guide.

(Continued on next page)
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Creating an
application

description from
a standard or IG

Use this procedure to automatically create an application description from a EDI 
standard or from an implementation guide.

Step Action

1 Open the Standard/IG Editor and display the standard or 
implementation guide you want to use.

Comment
This must be the same standard or implementation guide you intend 
to use in the map that translates to or from the new application 
description.

Reference
See the chapter Creating an Implementation Guide or Standard for 
information about selecting, editing, and displaying standards and 
implementation guides.

2 Click Tools on the Standard/IG menu bar.

3 Select AutoCreate Application Description on the Tools menu.

System Response
The system displays the Save As dialog box and automatically 
selects the directory specified for application descriptions and the 
.app extension.

4 Name the new application.

System Response
GENTRAN:Server creates an application description file consistent 
with the standard or implementation guide.

5 You are now ready to modify the application description to match the 
data in your ASCII files.

GO TO How to Modify an Application Description in this chapter.
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How to Build from a Record Layout File

Introduction A record layout file is an ASCII file that shows the layout of each record in your 
application. You can automatically build an application description from a record 
layout file. 

Reference
See Example Record Layout Files in the GENTRAN:Server Technical Reference 
Guide for example files and information about file requirements.

Procedure flow
diagram

This diagram shows the flow of work for building an application description from a 
record layout file.

(Continued on next page)
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Building an
application

description from
an ASCII record

layout file

Use this procedure to build an application description from an ASCII record layout 
file.

Step Action

1 Open the Application Editor.

2 Click Create new on the Open Application dialog box.

3 Click Read UDF attributes from a flat file and click OK.

System Response
GENTRAN:Server displays the Read Application Data Description 
Layout dialog box.

4 Use this decision table to select the format of your data.

IF field length�
THEN 
select� AND�

Varies (The same field may have 
different lengths in different 
records.)

Variable 
length DATA 
fields

Continue with 
Step 5

Is constant (Every line has the 
same length and the same field 
has the same length in every 
record.

Fixed length 
DATA fields

Go to Step 5.

5 In the Filename box, type the path and filename of the file that you 
want GENTRAN:Server to use to build the application description, 
or click the button to the right of the box to select the filename.

(Continued on next page)
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6 Create an ordered list of the Description Fields in the record layout 
file:

a) Select an attribute from the Data Field Attributes list.

b) Press the >> button to copy the data field attribute to 
the Description Fields side. Use the << button to 
remove a table you copied in error.

Make sure you list the attributes in the order 
that they appear in the layout file The 
translator will process the records in the order 
you specify here.

c) When you have finished moving the items to the 
Description Fields side, click OK.

System Response
GENTRAN:Server creates an application description file from the 
fields you selected and displays the Application Editor window.

4 Select a delimiter for the record layout file.

5 Click OK.

System Response
GENTRAN:Server displays the Application Editor for an ASCII file. 
The window contains records and fields as described in the record 
layout file.

6 You are now ready to add records to your application description.

GO TO How to Add Records in this chapter

 (Contd)
Step Action
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How to Manually Describe an ASCII File

Introduction If you do not have the required data, you can manually build an application 
description. For an ASCII application, your application description must be in 
record-and-field format.

Before you begin Before you manually describe an ASCII file:
◗ Become familiar with the layout of the application files you want to describe.
◗ Check the number of field delimiters in your application data. An application 

description can have only one field delimiter. If the file containing your 
application data uses two or more different field delimiters, the translator will 
not translate the data correctly.

CAUTION
If your application data uses two or more different field delimiters, 
use your application to modify the data files so that only one field 
delimiter is used.

(Continued on next page)
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Procedure flow
diagram

This diagram shows the flow of work for manually describing your application 
data.

Manually
describing an

ASCII file

Use this procedure to manually describe an ASCII file.

Step Action

1 Open the Application Editor.

2 Click Create new on the Open Application dialog box.
(Continued on next page)
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3 Click Enter UDF (flat file) attributes manually and click OK.

System Response
GENTRAN:Server displays the Application Data Description dialog 
box.

4 Use this decision table to select the format of your data.

IF field length� THEN select� AND�

Varies Variable length 
DATA fields

Continue with Step 5

Is constant Fixed length DATA 
fields

Skip to Step 6.

5 Use this decision table to determine what data separator to use.

IF data separator 
is� THEN�

Printable Type the Default data separator. It may be 
any printable character: one or more blanks 
( ), a comma (,), or an asterisk (*).

Non-printable Check the Special Character check box and 
type the HEX equivalent of the non-
printable character.

6 If you want to delimit your character data, check the Character 
Data Delimiter option and type the desired character.

Comment
The delimiter may be a comma (,), an asterisk (*), or one or more 
blanks ( ). Blanks are not recommended.

You can character delimit any data type.

If you select Character Data Delimiter, all AN and ID data type 
fields must be character delimited. Values in other data types can 
be character delimited, but it is not required.

(Continued on next page)

 (Contd)
Step Action
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7 Click OK.

System Response
GENTRAN:Server displays the Application Editor for an ASCII file. 
The window contains one record and one field.

8 You are now ready to add records to your application description.

GO TO How to Add Records in this chapter.

 (Contd)
Step Action
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How to Modify an Application Description

Introduction After you have created an application description, you may need to modify it.

Before you begin Make a copy of the application description and modify the copy.

Action table Use the following table to locate the instructions for modifying, renaming, or 
deleting your application description.

TO� FOLLOW the procedure�

Add new records How to Add Records in this chapter.

Add new fields How to Add Fields in this chapter.

Mark or unmark the Trading 
Partnership Code field

How to Mark the Trading Partnership 
Code Field in this chapter.

Designate data that repeats How to Add Loops in this chapter.

Change record attributes How to Change Record Attributes in this 
chapter.

Change field attributes How to Change Field Attributes in this 
chapter.

Change character or field 
delimiter

How to Change Delimiters in this chapter

Change existing loops How to Modify Loops in this chapter

Rename an application 
description

How to Manage Application Descriptions 
in this chapter

Delete an application 
description

How to Manage Application Descriptions 
in this chapter
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How to Add Records

Introduction Records hold fields. Every new application description comes with one record and 
one field. You may add more records. When you add a new record, 
GENTRAN:Server automatically adds one empty field as well.

Reference
To add fields, see How to Add Fields in this chapter.

Requirements These are the record requirements:

◗ The maximum record size is 6144 bytes. You must have a New Line at the 
end of each record, and you must include the New Line character in the total 
record size.

◗ For outbound translation, you must designate a record ID in each record to 
enable the translator to identify the record during translation. The record ID 
may be up to 128 characters in length, can contain any keyboard characters, 
and must be marked as the record ID. For inbound translation the record ID is 
optional.

Record edit box When you add a record, you assign attributes to it. This is the edit box that 
enables you to assign or change record attributes. GENTRAN:Server displays the 
edit box the bottom of the window when the focus is on a record.

(Continued on next page)
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Edit box fields,
functions, and

values

This table describes the fields, functions, and values in the Record edit box.

Field Function Value

ID Indicates the unique name 
or record identifier you 
assign to label the record. 
Record identifiers are 
optional for inbound 
translation and for database 
records. For outbound 
translation, record identifiers 
are required in the 
application description.

Alphanumeric characters up 
to 128 positions in length.

RECORD 
NAME

Describes this record. Alphanumeric characters up 
to 128 positions in length.

MX OCC Indicates the maximum 
number of times this record 
can appear in a row. 

A positive integer between 0 
and 999999. Alternatively, 
you can type >1 to permit an 
unspecified number of 
repetitions during 
translation. The default is 1.

LP CNT Indicates the number of 
times this group of records 
can repeat as a loop. This 
box is displayed only if the 
record is the first record in a 
loop.

A positive integer between 0 
and 99999 Alternatively, you 
can type >1 to permit an 
unspecified number of 
repetitions during 
translation. The default is 1.

(Continued on next page)
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Adding records Use this procedure to add records.

REQ Indicates the conditions 
under which the item must 
be present.

One of the following:

◗ O (optional): 
The presence of the 
item is at the option of 
the sending party.

◗ M (mandatory): 
The item must be 
present.

◗ C (conditional):
The presence of the 
item depends on the 
presence of specific 
other data elements or 
values.

 (Contd)
Field Function Value

Step Action

1 Move the focus to the line that will precede the new record.

2 Click Add a Record on the Edit menu.

System Response
GENTRAN:Server places a generic record in your description file.

3 Move the focus to the new record and complete the fields on the edit 
box at the bottom of the window:

◗ ID
◗ RECORD NAME
◗ MX OCC
◗ LP CNT (If the record is in a loop.)
◗ REQ

Reference
For functions and values, see Edit box fields, functions, and values in 
this chapter.

4 Click OK to save your changes.
(Continued on next page)
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5 Repeat Steps 1 through 4 until you have added all the records you 
need.

6 You are now ready to add fields to the records in your application 
description.

GO TO How to Add Fields in this chapter.

 (Contd)
Step Action
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How to Add Fields

Introduction Fields contain the actual information for your application. Whenever you add a 
record, GENTRAN:Server includes one empty field. You can add more fields to 
the record.

Requirements For outbound files, the Trading Partnership Code ID field must be in the first 
record and marked as the Trading Partnership Code, however the Trading 
Partnership Code ID may appear in other records. Only one field may be marked 
as the Trading Partnership Code field and that field must be in the first record.

Field edit boxes When you add a field, you assign its attributes in the edit box. GENTRAN:Server 
displays the edit box the bottom of the window when the focus is on a field.

This is the edit box for fixed-length fields.

This is the edit box for variable-length fields.

Default value for
a destination

field

When you assign attributes to a destination field, you have the option to retain the 
default value. If you choose to retain the default value, GENTRAN:Server 
determines the default value this way:
◗ When you have multiple source fields mapped to the destination item, 

GENTRAN:Server uses the first value received as the default.
◗ When you have a single source field mapped to a destination item, 

GENTRAN:Server uses each new value as the default.
◗ GENTRAN:Server places the default value into every repetition of the 

destination field/element until it encounters a new source value from this field 
for this destination.

(Continued on next page)
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Edit box fields,
functions, and

values

This table describes the fields in both types of edit boxes.

Field Function Value

FIELD 
NAME

Describes the item Alphanumeric characters up 
to 128 positions in length. 
The default field name is 
FIELD.

If the name contains 
embedded blanks, the field 
delimiter must not also be a 
blank.

FIXED 
LENGTH

Indicates the field length for 
data files containing fields 
that are the same length in 
every record

Numeric characters not 
exceeding 6144 bytes.

MIN LEN Indicates the minimum field 
length for data file 
containing variable-length 
fields preceded and followed 
by a delimiter character

Numeric characters less 
than or equal to the 
maximum field length. The 
default is 1. Cannot exceed 
99 characters.

MAX LEN Indicates the maximum field 
length for data file 
containing variable-length 
fields preceded and followed 
by a delimiter character

Numeric characters not 
exceeding 6144 bytes. The 
default size is the value in 
the MIN LEN box. Must be 
greater than or equal to the 
minimum length.

TYPE Indicates the field�s data 
type (alphanumeric, 
numeric, date/time, or 
binary). Application field 
data types default to AN 
(alphanumeric).

See Data Type Formats in 
the GENTRAN:Server 
Technical Reference Guide 
for data types.

FORMAT Indicates the specified 
format for the data type 

Example 
Left-justified or right-justified

See Data Type Formats in 
the GENTRAN:Server 
Technical Reference Guide 
for data type formats.

(Continued on next page)
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Before you begin Before you add a field, you should add all your records.

(Continued on next page)

REQ Indicates the conditions 
under which the item is 
required.

The values are:

◗ O for optional
Item presence is at the 
option of the sending 
party.

◗ M for mandatory
Item must be present.

◗ C for conditional
Item presence depends 
on the presence of 
specific other data 
elements or values.

◗ X for relational
Item presence depends 
on 
(1) presence of other 
items in its pair or 
group, (2) the absence 
of other items in its 
group, or 
(3) on the presence of 
the first item in the 
group.

Item exclusion depends 
on the presence of 
another item.

Opt

 (Contd)
Field Function Value
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Adding a field Use this procedure to add a field.

Step Action

1 Move the focus to the line that will precede the new field.

2 Click Edit on the menu bar.

3 Click Add a Field on the Edit menu.

System Response
GENTRAN:Server places a generic field in your description file.

4 Move the focus to the new field.

5 Type the field attributes in the edit box at the bottom of the window:

◗ FIELD NAME
◗ FIXED LENGTH or MIN and MAX
◗ TYPE
◗ FORMAT
◗ REQ

Reference
For functions and values, see the Edit box fields, functions, and 
values in this chapter.

6 Do you want to add optional attributes to the field?

◗ If NO, click OK to save your changes and then repeat Steps 1 
through 8 until you have added all fields.

◗ If YES, click OPT and continue with Step 7.

7 If this is a destination document, do you want to retain the default 
value for a destination field?
◗ If NO, continue with Step 8.

CAUTION
You cannot retain field values that will be mapped as 
a literal (for example, a fixed text string, number, or 
system variable).

◗ If YES, click Retain Field Value. Then, click OK to save the 
value and close the dialog box.

(Continued on next page)
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8 Repeat Steps 1 through 7 until you have added all fields.

9 You are now ready to mark the Trading Partnership Code field.

GO TO How to Mark the Trading Partnership Code Field in this 
chapter.

 (Contd)
Step Action
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How to Mark the Trading Partnership Code Field

Introduction The Trading Partnership Code field in your application description tells the 
translator where to look for the Trading Partnership Code. 

Before you begin Before you mark the Trading Partnership Code, make sure that the field 
containing the Trading Partnership Code is in the first record.

Marking the
Trading

Partnership
Code field

Use this procedure to designate a field as the Trading Partnership Code field.

Step Action

1 In the first record, move the focus to the field that contains the 
Trading Partnership Code.

2 Click Mark on the menu bar.

3 Click Mark TP Code on the Mark menu.

System Response
The field symbol changes to red.

Comment
If you marked the wrong field, move the focus to the field you 
marked, and then select Unmark TP Code from the Mark menu.

4 Edit the field attributes as necessary.

5 Click Save on the File menu.

6 You are ready to mark the record ID in your data.

GO TO How to Designate the Record ID Field in this chapter.
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How to Designate the Record ID Field

Introduction When you create an application description for outbound translations, you must 
designate one field in each record as the record ID. The record ID enables the 
translator to recognize the record.

Comment
This procedure is not necessary for inbound translations.

Marking the
record ID field

Use this procedure to designate a field as the record ID.

Step Action

1 Move the focus to the field you want to mark as the Record ID.

2 Click Record ID on the menu bar.

3 Click Mark field as Record ID on the Record ID menu.

System Response
The record symbol changes to blue.

Comment
If you marked the wrong field, move the focus to the field marked 
as the record ID, select Unmark field as Record ID Edit the field 
attributes as necessary.

4 Click Save on the File menu.

5 You are now ready to identify records that repeat in your data.

GO TO How to Add Loops in this chapter.
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How to Add Loops

Introduction You can make a loop from existing records by marking them and defining them as 
a loop. 

Before you begin Before you add a loop, there are two items of information you should know:
◗ All records in a loop must be sequential and contiguous. Move records as 

necessary to make them contiguous before you add the loop.
◗ It is a good idea to collapse the view before making a loop.

Adding a loop Use this procedure to add a loop.

Step Action

1 Collapse the view so that only the records show.

2 Move the focus to the first record of the loop and mark it by 
selecting Toggle Marked Item from the Mark menu.

3 Working from top to bottom, move the focus to each record that will 
be part of the loop and mark it by selecting Toggle Marked Item 
from the Mark menu.

Comment
You may create nested loops (loops within other loops) inside to 
out.

4 Click Make Loop on the Edit menu.

System Response
GENTRAN:Server adds the loop markers (red connecting lines) to 
the window display. The edit box for the first record in the loop now 
includes a box for the loop count.

(Continued on next page)
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5 In the LP CNT edit box, type the number of times the loop repeats.

Comment
This value must be a positive integer between 0 and 99999. 
Alternatively, you can type >1 to permit an unspecified number of 
repetitions during translation. 

If you made a mistake, see the instructions in How to Modify Loops.

6 Click OK to save your changes.

 (Contd)
Step Action
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Miscellaneous Application 
Description Tasks 0

How to Change Record Attributes

Introduction You may change any attribute of a record. When you make changes to a record in 
the Application Editor, these changes do not affect any map previously created 
with the application description.

Changing record
attributes

Use this procedure to change record attributes.

Step Action

1 Move the focus to the record you want to change.

System Response
The system displays the record�s attributes in the edit box at the 
bottom of the window.

2 Type the new value in the edit box (or select a new value from a 
list).

3 Click OK to save the attribute changes.

4 Click Save on the File menu.
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How to Change Field Attributes

Introduction You may need to edit fields as part of the process of adapting an application 
description created for one application for use with another application. Or you 
may need to make changes to an application description because the data does 
not translate properly. Finally, you may need to change an application description 
in order to use it with the same application but with a different standard version.

This section describes how to change field attributes in the Application Editor.

Comment
When you change field attributes in the Application Editor, maps are not affected. 
If you want to change the field attributes in a map, refer to the instructions in the 
chapter Mapping.

Changing fixed-
length field

attributes

Use this procedure to change the attributes of a fixed or variable length field.

Step Action

1 Move the focus to the field you want to change.

System Response
GENTRAN:Server displays an edit box at the bottom of the 
window.

2 Type the new field attribute for any of the following in the edit box at 
the bottom of the window:

◗ FIELD NAME
◗ FIXED LENGTH (fixed length fields) or 

MIN LEN and MAX LEN (variable length fields)

◗ TYPE
◗ FORMAT
◗ REQ

Reference
For attribute descriptions, see Field edit boxes in this chapter.

(Continued on next page)
Mapping and Translation Guide � February 2002



How to Change Field Attributes Defining Application Descriptions for ASCII Files3 - 44
3 Do you want to add optional attributes to the field?
◗ If NO, click OK to save your changes and then repeat Steps 1 

through 3 until you have made all desired changes to fields.
◗ If YES, click OPT and continue with Step 4.

4 If this is a destination document, do you want to retain the default 
value for a destination field?

◗ If NO, continue with Step 5.

CAUTION
You cannot retain field values that will be mapped as 
a literal (for example, a fixed text string, number, or 
system variable).

◗ If YES, click Retain Field Value. Then, click OK to save the 
value and close the dialog box.

5 Click Save on the File menu.

 (Contd)
Step Action
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How to Modify Loops

Changing the
loop count

Use this procedure to change the loop count (the number of times the loop 
repeats).

Removing loops You can dissolve the loop association without deleting the records (and, therefore, 
the fields) in the loop.

Use this procedure to dissolve only the loop association.

(Continued on next page)

Step Action

1 Move the focus to the first record in the loop.

2 In the editing box, move to the LP CNT edit box and replace the 
existing number with the desired number of repetitions.

3 Click OK to save your changes.

Step Action

1 Move the focus to the first record in the loop.

2 Click Edit on the menu bar.

3 Click Remove Loop on the Edit menu.

System Response
GENTRAN:Server permanently deletes only the loop association.
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Deleting a loop,
its records, and

fields

You may want to delete the records in the loop while removing the loop 
association.

Use this procedure to delete all contents of the loop.

Step Action

1 Mark the first record in the loop.

2 Click Edit on the menu bar.

3 Click Delete Marked on the Edit menu.

WARNING
You cannot recover deleted items. 

System Response
GENTRAN:Server asks you to confirm this action. After you 
confirm, the system removes all the items in the loop and the loop 
markings.
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How to Change Delimiters

Introduction Delimiters include character delimiters (for application descriptions with fixed or 
variable length data) and field delimiters (for application descriptions with variable 
length data). You can use character delimiters with data of any data type.

You can modify the field delimiter if the application description was originally 
created for variable length fields and a delimiter specified. (If the application 
description was created for fixed length fields, recreate the application description 
for variable length fields and specify the desired delimiter.)

Application Data
Description

dialog boxes

This dialog box is used to change delimiters for fixed-length fields.

(Continued on next page)
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This dialog box is used to change delimiter for variable-length fields.

Changing data
delimiters

Use this procedure to change field and character data delimiters.

Step Action

1 Click Edit on the Application Editor menu bar.

2 Click Change Attributes on the Edit menu.

System Response
GENTRAN:Server displays the appropriate dialog box, depending 
on whether the application description has fixed-length or variable-
length fields. The Field Type option (i.e., fixed length or variable 
length) is already selected.

(Continued on next page)
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3 Use this decision table to determine what delimiter to use

IF your data length 
is� AND you want� THEN�

Variable A printable field 
delimiter

Type any printable 
character as the 
default data 
separator.

Variable A non-printable field 
delimiter

Click Special 
Character and type 
the HEX equivalent 
of the non-printable 
character.

Variable or fixed To character delimit 
one or more data 
types

Click Character 
Data Delimiter and 
type the desired 
character data 
delimiter. The 
delimiter may be any 
printable character.

CAUTION
A single application description should have only one 
field delimiter. If the ASCII file containing your 
application data uses two or more different field 
delimiters, the translator may not correctly translate the 
data.

Notes
You can character delimit any data type. The delimiter may be a 
comma (,), an asterisk (*), or one or more blanks ( ). Blanks are not 
recommended.

If you select Character Data Delimiter, all AN and ID data type 
fields must be character delimited. Values in other data types can 
be character delimited, but it is not required.

Reference
See Data Type Formats in the GENTRAN:Server Technical 
Reference Guide for information about the formats available for 
each data type.

4 Click OK.

 (Contd)
Step Action
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How to Manage Application Descriptions

Introduction If your applications change, you need to maintain your application descriptions. 
You may need to list all of your application descriptions, rename application 
descriptions, or even delete them.

Listing
application

descriptions

Use this procedure to list all the application descriptions in the directory specified 
for application descriptions.

Renaming
application

descriptions

Use this procedure to rename an application description.

Step Action

1 Click List on the File menu.

2 Click Application Description on the List submenu.

System Response
The system displays the Application File Listing box and 
automatically selects the directory specified for application 
descriptions. The File list displays all files with the .app extension.

3 Click Print on the Application File Listing dialog box.

4  Click OK.

Step Action

1 Click Rename on the File menu.

2 Click Application Description on the Rename submenu.

System Response
The system displays the File Rename dialog box and automatically 
selects with the directory specified for application descriptions. The 
File list displays all files with the .app extension.

3 Select the current file name of the application description you want 
to rename.

(Continued on next page)
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Deleting
application

descriptions

You can delete an application description at any time. Deleting the application 
description does not affect any map(s) already created with that application 
description. However, you cannot create any new maps with the application 
description after you have deleted it. Be aware that some GENTRAN:Server 
components, such as the appm personality data manager, require the application 
description for product levels PCM and higher.

Use this procedure to delete an application description.

4 Click Open to close the File Rename dialog box and open the File 
Rename - Save As dialog box.

5 Type the desired name in the File field.

WARNING
The GENTRAN:Server appm personality data manager 
for product levels PCM and higher requires both the 
compiled map (*.tbl file) and the application description 
file (*.app) as the application description existed at the 
time the map was compiled. If you delete the application 
description after creating and compiling a map from it, 
GENTRAN:Server appm personality data manager will 
not work.

6 Click OK.

 (Contd)
Step Action

Step Action

1 Click Delete on the File menu.

2 Click Application Description on the Delete menu. 

System Response
The system displays the File Delete dialog box and automatically 
selects the directory specified for application descriptions. The File 
list displays all files with the .app extension.

(Continued on next page)
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3 Select the file name of the application description you want to 
delete.

WARNING
The GENTRAN:Server appm personality data manager 
for product levels PCM and higher requires both the 
compiled map (*.tbl file) and the application description 
file (*.app) as the application description existed at the 
time the map was compiled. If you delete the application 
description after creating and compiling a map from it, 
GENTRAN:Server appm personality data manager will 
not work.

4 Click OK.

System Response
GENTRAN:Server prompts you to confirm the deletion and deletes 
the file after you confirm the deletion.

 (Contd)
Step Action
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How to Print an Application Description

Introduction To verify an application description against the actual ASCII file, it helps to have a 
print of the application description.

Procedure Use this procedure to print an application description.

Step Action

1 Open or create the desired application description.

2 Click Print on the File menu.

System Response
The system displays the Print Application dialog box.

3 Use this decision table to determine your next step.

IF you wish to print� THEN�

All records and fields in the 
application description

Click Print Records and 
Fields.

Only the records in the 
application description

Click Print Records Only.

4 Click OK.

System Response
GENTRAN:Server sends the application description to the printer 
you identified in the Print Setup dialog box.
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Overview 0

Introduction

GENTRAN:Server
database options

Using a database as a source or destination of data for GENTRAN:Server is an 
option provided through the purchase of Sterling Commerce ODBC database 
drivers. Once you install and configure the database drivers, GENTRAN:Server 
can translate to and from your database tables. Contact your GENTRAN:Server 
representative for a list of supported databases and hardware platforms.

CAUTION
You must purchase the ODBC option from Sterling Commerce to map 
and translate data to and from database tables.

In this chapter In this chapter, you will learn how to create or modify an application description 
that describes data stored in a database table. 

Database
application
documents

A database application document is a table your relational database application 
produces or processes. This database application is either the source of 
application documents you are sending to your trading partners or the destination 
for application documents your trading partners send to you. 

Example
Your database application may contain tables for purchase orders, invoices, 
shipping notices, requests for quotations, or other types of standard business 
documents that you can transfer electronically.

Database
application

descriptions

To prepare for mapping, you must describe the format of the data in each 
application document exchanged with your trading partners. The result is a 
database application description. 

(Continued on next page)
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Why you need to
create database

application
descriptions

Database application descriptions are a source or destination document when you 
create translation maps. A translation map tells GENTRAN:Server�s translator 
how to convert an inbound document into a format your database application 
understands. A translation map also tells the translator how to convert outbound 
documents from your database application into another format: EDI standard, 
implementation guide, or another application. 

The database application description identifies the data items in your database 
application so that the GENTRAN:Server translator can relate each to a data item 
in the new electronic data interchange (EDI) format.

Key terms This table lists the key terms used in this chapter.

Term Definition

Application Editor The GENTRAN:Server tool that enables you to 
describe your application data.

attributes The values you assign to describe a record or field.

database application 
description

A description of the tables and fields in a database 
application used to map and translate your data.

database driver A set of shared libraries that allows GENTRAN: 
Server to write data to or read data from database 
files.

Data Source Name 
(DSN)

A user-defined name that associates a database 
location with a particular database driver.

data type The type of information in a field (for example, 
alphanumeric, binary, numeric, date, or time).

delimiter A symbol used to separate variable length data 
items in an application file.

field A discrete piece of data in a record, such as 
quantity or unit price.

join The linking of fields to connect two database tables 
to each other. Joins form the relationship for a 
relational database.

loop A sequence of related items repeated within a 
transaction set.

(Continued on next page)
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marking The process of flagging a field that you want to work 
with.

ODBC Open Database Connectivity. Microsoft 
Corporation�s® standard for database access 
methods and tools.

record A defined sequence of related fields that is derived 
from a separate table or view in a database.

SQL Structured Query Language. A language that the 
database driver uses to provide a standard method 
for controlling and communicating with a relational 
database.

SQL Command File 
(<filename>.SQL)

A set of commands grouped in a file and used to 
select and extract the data to be translated from the 
proper database tables.

table A set of related database fields used to create a 
record within a database application description.

Trading Partnership 
Code

The unique code that identifies a Trading 
Partnership record.

 (Contd)
Term Definition
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Components of an Application Description

Introduction Application descriptions that describe the data in a database have two main 
components: records and fields.

Records
Each record within a database application description corresponds to the related 
table from a database. 

The fields within a database application description record contain the related 
data fields in the database table. 

Example
This example displays the records and fields that a purchase order might contain. 
Each of the records represents a table in your database. Each of the fields 
correspond to a field in the database table that forms the Purchase Order Line 
Item record.

◗ HEADER (record)
◗ BILL TO (record)
◗ PURCHASE ORDER LINE ITEM (record)
◗ ITEM NAME (field)
◗ QUANTITY (field)
◗ UNIT PRICE (field)
◗ SUMMARY (record)

Record
attributes

Attributes are the values you assign to describe a record. Two of the attributes you 
assign to a record are the record identifier and the record name.

Record identifier
Record identifiers are not required with database application descriptions 
because each record corresponds to a defined table. GENTRAN:Server uses the 
table name to identify the record.

Record name
Each record and table must have a unique name. Record names and table can 
contain any alphanumeric characters and should describe the record. The record 
name must match the name of the corresponding table. 

Note
GENTRAN:Server accepts record names up to 128 characters in length, but 
some databases accept a maximum of only 32 characters for table names. You 
should check the rules for your database when assigning table names. 

(Continued on next page)
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Fields attributes You must assign attributes to describe fields within each record. Field attributes 
include:
◗ field name
◗ data type (for example, binary, numeric, alphanumeric, date/time)
◗ data format (for example, left-justified).

Reference
For a list of the allowable formats for each data type, see the chapter Data Type 
Formats in the GENTRAN:Server Technical Reference Guide.

Field length Field lengths may be:
◗ Fixed to a specific number of characters
◗ Variable in length and delimited by unique field separators.

Note
Database applications created by reading in tables are delimited with NULL 
separators. However, the field lengths for these applications have minimum and 
maximum values that are equal in value. This means the application is really a 
fixed-length-field application.

Join statements GENTRAN:Server join statements enable you to extract data from the database 
from two separate tables based on a common field. Data is extracted when the 
two fields contain matching data.

Reference
For details, see How to Create Database Joins in this chapter.

Database
application

description rules

The following are rules specific to database applications:

◗ Each record in a database application description is an exact copy of a 
database table and must contain at least one field.

◗ You may only use a particular database table once within a database 
application description. You may not create multiple records from the same 
database table.

◗ All dates in database application descriptions must be a minimum of 10 
characters in length and have the format D15 (standard database date 
format).

(Continued on next page)
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Reference
See the chapter Data Type Formats in the GENTRAN:Server Technical 
Reference Guide for details.

◗ The maximum table size in GENTRAN:Server is 6144 bytes.
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The Trading Partnership Code

Introduction If you plan to use a database application description as the source document in a 
map, you must designate one field in the first record as the Trading Partnership 
Code.

Comment
If the database application description is used as the destination document in a 
map, you do not need to mark the Trading Partnership Code.

The Trading
Partnership

Code field

The Trading Partnership Code field in your database application description 
tells the translator where in the database table to look for the Trading Partnership 
Code. 

This field is essential because the Trading Partnership Code points to the Trading 
Partnership Record, which in turn determines the map GENTRAN:Server uses to 
translate the data.

Example
This is an example of a trading partnership code field in a database table.

Trading Partnership Code = XYZ2850OUTTP

Field Location The Trading Partnership Code is a required field in the first record of an 
application document. The TP code can be included elsewhere in the data or 
application, but must be marked only in the first record.

Field Size The maximum length of the Trading Partnership Code is 15 characters.
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Creating a Database 
Application Description 0

Database Application Description Creation Process

Introduction This section describes the method for building application descriptions for 
databases. After all of your database tables are fully defined you can build an 
application description from those tables. 

Automatically
building from

existing tables

Process flow

This diagram shows the flow of work for building an application description from 
existing database tables.

Create description

Mark the Trading Partner
Code field

DONE!

from list of Tables

Create Joins
Between Tables
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The Application Editor

Introduction The tool that you use to create and maintain database application descriptions is 
the Application Editor. This tool provides you with a graphic view of the layout of 
your database application records and fields. 

You use the options on the Database menu of the Application Editor to perform 
most of the work in creating a database application description.

Application
Editor example

This illustration shows the Application Editor.

(Continued on next page)
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Application
Editor fields and

functions

This table describes the fields of the Application Editor window.

WARNING
If you create your database application description from existing 
database tables, then you must not edit any of the fields in the tables 
or in the application description.

Field Function

Record/Field Describes the records and fields and is listed in the 
data.

Max Occ Indicates the maximum number of times this record 
can appear in a row.

Min Indicates the minimum field length.

Max Indicates the maximum field length.

Typ Indicates the field�s data type (alphanumeric, numeric, 
date/time, or binary).

Req Indicates the requirement indicator:

◗ O for optional: the presence of the record is at the 
option of the sending party.

◗ M for mandatory: the record must be present.
◗ C for conditional/relational: the presence of the 

record depends on the presence of specific other 
items.

Loop Cnt Indicates the number of times this group of records can 
repeat as a loop.

Delimiter Indicates the data separator for variable-length data. 
Databases always use null (which displays as 0x00) 
for the delimiter. 

Edit box Modifies the record or field that has the focus.
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Before You Begin
This section contains a checklist of the items that must be ready before you can 
successfully create a database application description file.

Completed Task

Make sure that the Sterling Commerce ODBC database drivers 
are installed and configured.

On the Preferences menu of the main Application Editor 
window, select User Setup. Make sure the database group 
fields are active on the displayed dialog box. 
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Procedures 0

How to Build from Existing Database Tables

Introduction You can build an application description automatically by specifying existing 
database tables.

Before you begin Before you perform this procedure, be sure your database tables are completely 
configured as follows:
◗ You must assign a unique name to each table and to each field within each 

table. 

Note
GENTRAN:Server accepts record names up to 128 characters in length, but 
some databases accept a maximum of only 32 characters for record names. 
You should check the rules for your database when assigning record names. 

◗ The Trading Partnership Code ID must be a field in the first table of any 
application description you will use for outbound translation. 

Procedure Use this procedure to create an application description from existing database 
tables.

Step Action

1 Open the Application Editor.

2 Click Create New on the Open Application dialog box.

3 Click Read Database Attributes from Database and click OK.

System Response
If your database requires a login password, the system prompts for a 
login and displays a list of database tables.

(Continued on next page)
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4 Build an ordered list of tables to be used:
◗ On the Available Tables list, select a database table. Press the 

>> button to copy the table to the Selected Tables side. 
Make sure you list the tables in the order in which you 
want them to be translated, beginning with the table for 
the first record. The translator will process the records 
in the order you specify here.

◗ Use the << button to remove a table copied in error.

5 Click OK when you finish moving items to the Selected Table side.

System Response
GENTRAN:Server creates an application description file from the 
tables you selected and displays it in the Application Editor window.

6 Set up special options, such as retain.

7 You are now ready to identify the Trading Partnership Code field in 
your database application description.

GO TO the topic How to Mark the Trading Partnership Code Field in 
this chapter. 

 (Contd)
Step Action
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How to Mark the Trading Partnership Code Field

Introduction The Trading Partnership Code field in your application description tells the 
translator where to look for the Trading Partnership Code. 

Before you begin Make sure that the field containing the Trading Partnership Code is in the first 
record.

Marking the
Trading

Partnership
Code field

Use this procedure to designate a field as the Trading Partnership Code field.

Step Action

1 Under the first record, move the focus to the field that contains the 
Trading Partnership Code.

2 Click Mark on the menu bar.

3 Click Mark TP Code on the Mark menu.

System Response
The field symbol changes to red.

Comment
If you marked the wrong field, move the focus to the field you 
marked, and then select Unmark TP Code from the Mark menu.

4 Click Save on the File menu.

System Response
The system saves the file. You are now ready to create database 
joins. 

Reference
See How to Create Database Joins in this chapter for more 
information about this process.
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How to Create Database Joins 

Introduction A join relates one database table to another. Join statements can only join a field 
within one table to a field in the preceding table.

Rules for making
joins

Note the following rules for creating joins in GENTRAN:Server.
◗ You form a join from one record up to the previous record; you cannot form a 

join from a record down to the next record.
◗ You can join a field only once. You can not join Field A to both Field B and 

Field C.

Example This example shows the joins connecting tables in the database. A thin yellow line 
around fields indicates a join.

Procedure Use this procedure to set up join information.

!�
�

�
������

Step Action

1 Click Database on the menu bar.

2 Select View/Edit Joins on the Database menu.

System Response
GENTRAN:Server displays a new edit box at the bottom of the 
window.

(Continued on next page)
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3 Move the focus to a field in a record to join to the record above it. 
Select the lowest record you want to join to another and work from 
the bottom up.

System Response
The Field Name box displays the name of the selected field. This 
must be a field in a record after the first record.

4 Select the name of the Join Record from the list.

Note
This must be a record above the record containing the selected 
field.

5 Choose the name of the Join Field from the list and click OK.

System Response
GENTRAN:Server displays in yellow the field symbol for the joined 
field.

6 Repeat Steps 3 through 6 to set up each remaining join.

7 Click List Joins on the Database menu to review the joins you 
established.

8 Click Save on the File menu.

9 You are now ready to create the SQL command file to be used with 
this application definition.

GO TO the topic How to Create the SQL Command File in this 
chapter.

 (Contd)
Step Action
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How to Create the SQL Command File

Description The SQL Command File contains the name of the Data Source Name the 
translator is to use and the commands that extract or write data to or from the 
proper database tables.

CAUTION
You must create an SQL Command File before attempting to translate 
to or from a database application. 

Procedure Use this procedure to create an SQL Command File.

Step Action

1 Save and name the application description.

2 Click Database on the menu bar.

3 Click Autocreate SQL file on the Database menu.

4 Use this decision table to determine your next step.

IF� AND� THEN�

You have 
saved the file

No errors are 
detected

GENTRAN:Server creates the file 
and gives it an .sql extension. 
Continue with Step 5.

You have 
saved the file

Errors are 
detected

GENTRAN:Server displays error 
messages. You must correct the 
errors before continuing.

Go to the Error Messages section.

5 Click OK.

Your application definition is now ready to use when translating 
data.
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Miscellaneous Application 
Description Tasks 0

How to Manage Application Descriptions

Introduction Occasionally you may need to list all of your application descriptions, rename 
application descriptions, or even delete them altogether.

Listing
application

descriptions

Use this procedure to list all the application descriptions in the directory specified 
for application descriptions.

(Continued on next page)

Step Action

1 Click List on the File menu.

2 Click Application Description on the List submenu.

System Response
GENTRAN:Server displays the Application File Listing dialog box. 
The system automatically selects the directory specified for 
application descriptions and lists all files with the .app extension on 
the File list.

3 Click Print to print a hardcopy of the list.

4 Click OK.
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Renaming
application

descriptions

Use this procedure to rename an application description.

(Continued on next page)

Step Action

1 Click Rename on the File menu.

2 Select Application Description.

System Response
GENTRAN:Server displays the File Rename dialog box. The 
system automatically selects the directory specified for application 
descriptions and lists all files with the .app extension on the File 
list.

3 Select the current file name of the application description you want 
to rename.

4 Click Open to close the File Rename dialog box and open the File 
Rename - Save As dialog box.

5 Type the desired file name in the File box.

WARNING
The GENTRAN:Server appm personality data manager is 
available for product levels PCM and higher. The appm 
requires both the compiled map (*.tbl file) and the 
application description file (*.app) to be unchanged after 
the map is compiled. If you rename the application 
description after creating and compiling a map from it, 
the GENTRAN:Server appm personality data manager 
will not work.

6 Click Save.
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Deleting
application

descriptions

You can delete an application description at any time without affecting the map or 
maps created from it. Be aware that some GENTRAN:Server components, such 
as the appm personality data manager, require the application description.

Use this procedure to delete an application description.

Step Action

1 Click Delete on the File menu.

2 Click Application Description on the Delete menu.

System Response
GENTRAN:Server displays the File Delete dialog box. The system 
selects the directory specified for application descriptions and lists 
all files with the .app extension in the File list.

3 Select the file name of the application description you want to 
delete.

WARNING
The GENTRAN:Server appm personality data manager is 
available for product levels PCM and higher. The appm 
requires both the compiled map (*.tbl file) and the 
application description file (*.app) to be unchanged 
since the map was compiled. If you delete the 
application description after creating and compiling a 
map from it, GENTRAN:Server appm personality data 
manager will not work.

4 Click Open.

System Response
GENTRAN:Server prompts you to confirm the deletion. After you 
confirm the deletion, GENTRAN:Server deletes the file.
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How to Print an Application Description

Printing an
application
description

Use this procedure to print an application description. 

Step Action

1 Open the application description you want to print.

2 Click Print on the File menu.

System Response

GENTRAN:Server displays the Print Application dialog box.

3 Use this decision table to determine your next step.

IF you wish to print� THEN�

All records and fields in the 
application description

Select Print Records and 
Fields.

Only the records in the 
application description

Select Print Records Only.

4 Click OK.

System Response
GENTRAN:Server sends the application description to the printer 
you identified in the Print Setup dialog box.
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Overview 0

Introduction

In this chapter This chapter explains how to define rules for an application description or a file 
definition that you want GENTRAN:Server to use to determine the Trading 
Partnership Code in a data file.

How your
system uses

these rules

GENTRAN:Server uses this method to identify the Trading Partnership Code 
when the application description or file definition does not have a field marked as 
the Trading Partnership Code. The system also uses it when you run the lftran 
translation command with the A [ ] option.

Key terms This table lists the key terms used in this chapter.

Term Description

cross reference table The table that associates identification strings with 
specific Trading Partnership Codes.

identification string The value that results from applying a set of Trading 
Partnership rules to an application document.

Trading Partnership 
rule

An instruction that specifies the position of the 
information that you want GENTRAN:Server to extract 
from a particular field in an application document. A set 
of Trading Partnership rules derives an identification 
string from the document. GENTRAN:Server uses this 
string to determine the Trading Partnership Code 
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Configuration Process

Introduction You can configure your system to determine the Trading Partnership Code from 
multiple fields in the first record of an application file. This topic describes the 
stages in the configuration process.

Stage table This table describes the stages in the process.

Stage Description

1 Create a set of Trading Partnership rules that will yield a unique 
identification string for a specific application description (*.app) or 
file definition (*.ddf).

Reference
See Defining Trading Partnership Rules for instructions.

2 Add the identification string to the TP Cross Reference table and 
link it to a Trading Partnership Code.

Reference
See Linking Rules to a Trading Partnership Code for 
instructions.
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Defining Trading 
Partnership Rules 0

Overview

Introduction The first stage in configuring your system to determine the Trading Partnership 
record from multiple fields is to create a set of Trading Partnership rules for a 
particular application description or file definition.

In this stage, you:

◗ Select the application description or file definition to which you want the rules 
to apply

◗ Build the rules.

Purpose of
Trading

Partnership
rules

GENTRAN:Server uses the set of Trading Partnership rules to derive a unique 
identification string from an application document. Once the system has the 
identification string, it checks the cross reference table to find the Trading 
Partnership Code associated with the string.

In this section This section describes:

◗ Trading Partnership rules
◗ How to start the rule-definition process
◗ How to add a new Trading Partnership rule to a set
◗ How to display a picture that shows the place of each Trading Partnership rule 

in the identification string
◗ How to edit or delete a Trading Partnership rule in a set.
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Trading Partnership Rules

Definition Trading Partnership rules are instructions that specify the field names and 
positions in an application file that you want to extract from a document to build a 
unique identification string.

A Trading Partnership rule specifies the position of the information that you want 
GENTRAN:Server to extract from a field in an application document. A rule 
stipulates the:
◗ Field name
◗ Position of the characters to be extracted
◗ Place in the identification string that the extracted characters will occupy

Guidelines for
building rules

These are the guidelines for Trading Partnership rules:

◗ The total number of characters that a set of rules extract to make an 
identification string cannot exceed 40.

◗ You can associate multiple string combinations to the same Trading Partner 
Code as long as each combination is unique.

◗ The characters extracted to make strings are case sensitive. For example, 
AyZ is NOT equal to AYZ.

◗ Leading and trailing spaces are retained. They are placeholders in the string.
◗ Substrings cannot overlap.

TP Rule table The system stores the rules you define in a DISAM table named apptptbl.dat/idx. 
Each record in this table contains the:

◗ Name of the application description or file definition
◗ Record ID
◗ Field name and character-identification information for the rule.

Reference
See the GENTRAN:Server Technical Reference Guide for the layout of the 
apptptbl.dat/.idx file.
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Application TP Rules Dialog Box

Introduction The Application TP Rules dialog box is used to choose the name of the 
application description or file definition that describes the layout of the application 
documents to which the set of Trading Partnership rules apply.

Illustration This illustration shows the Application TP Rules dialog box.

Fields and
functions

This table describes the fields in the Application TP Rules dialog box and their 
functions.

Field Function

Select Application/File 
Definition Filename

Identifies the name of the application description or 
file definition that describes the records and fields 
in the application documents that 
GENTRAN:Server will process with the set of 
Trading Partnership rules.

Edit Displays the Define TP Rules dialog box, which 
shows the Trading Partnership rules defined for 
the application description or file definition.

Close Closes the dialog box.
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Add New TP Rule Dialog Box

Introduction The Add New TP Rule dialog box is used to create a new Trading Partnership 
rule.

Illustration This illustration shows the Add New TP Rule dialog box.

Fields and
functions

This table describes the fields in the Add New TP Rule dialog box and their 
functions.

Field Function

Record ID Displays the record ID value for the first record. 
GENTRAN:Server always uses the fields from the 
first record for Trading Partnership rules.

Field Name Specifies the name of the field used for this 
Trading Partnership rule.

Start Position within Field Designates the position of the beginning 
character you want to extract from the field.

From Indicates the side of the field (left or right) 
you are counting from for the Start Position 
within Field position.

(Continued on next page)
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Length Specifies the number of characters you want 
to extract.

Marker Designates the character that you want to 
represent the part of the string that these 
extracted characters will occupy.

String Position Indicates the beginning character number in 
the string that the characters from this rule 
will occupy.

OK Saves the Trading Partnership rule to the 
Application/TP table.

Cancel Closes the dialog box without saving 
changes.

Help Displays the Help text for this dialog box.

 (Contd)
Field Function
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Define TP Rules Dialog Box

Introduction The Define TP Rules dialog box is used to:
◗ Display an existing set of Trading Partnership rules for an application 

description or a file definition
◗ Access the Add New TP Rule dialog box
◗ Delete a Trading Partnership rule from the set
◗ Modify a Trading Partnership rule
◗ Access the View TP Rule dialog box to display a graphical representation of 

the Trading Partnership rules in the identification string.

Illustration This illustration shows the Define TP Rules dialog box.

Fields and
functions

This table describes the fields in the Define TP Rules dialog box and their 
functions.

Field Function

Record ID Displays the record ID value for the first record. 
GENTRAN:Server always uses the fields from the 
first record for Trading Partnership rules.

Field Name Shows the name of the field used for this Trading 
Partnership rule.

Field Start Shows the position of the beginning 
character to extract from the field.

(Continued on next page)
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Length Shows the number of characters to extract 
from this field.

String Position Shows the beginning character number in 
the string that the characters from this rule 
will occupy.

Marker Shows the character that represents the part 
of the string that these extracted characters 
will occupy. This character is used in the 
View TP Rule dialog box.

New Displays the Add New TP Rule dialog box, 
which is used to create a new Trading 
Partnership rule.

Edit Displays the Edit TP Rule dialog box for the 
selected Trading Partnership rule.

Delete Deletes the selected Trading Partnership 
rule.

View Displays a graphical representation of the 
Trading Partnership rules that comprise a 
unique string.

Close Closes the dialog box.

Help Displays the Help text for this dialog box.

 (Contd)
Field Function
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How to Start the Rule-Definition Process

Introduction This topic describes how to start the rule-definition process by selecting the 
application description or file definition and opening the Define TP Rules dialog 
box. You can use this procedure to add, edit, delete, or view a rule.

Procedure Use this procedure to start the process of defining Trading Partnership rules.

Step Action

1 Select Application TP Rules from the Application File 
Configuration menu on the GENTRAN:Server Main window.

System Response
GENTRAN:Server displays the Application TP Rules dialog 
box.

2 Click the drop-down arrow in the Select Application/File Definition 
Filename box to display a list of application descriptions and file 
definitions; then click the name of the file to which you want the 
rules to apply.

Note
Only those files checked into the directory for file definitions 
and application descriptions are displayed in the drop-down 
list.

(Continued on next page)
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3 Click Edit.

System Response

IF GENTRAN:Server�
THEN the system displays 
the�

Finds a record for the file you 
selected

Define TP Rules dialog box.

Does not find a record for the 
file you selected

Add New TP Rule dialog box

4 GO TO one of the following:

How to Add a New Trading Partnership Rule

How to Display a Picture of the String

How to Edit a Trading Partnership Rule

How to Delete a Trading Partnership Rule

 (Contd)
Step Action
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How to Add a New Trading Partnership Rule

Introduction To add a new Trading Partnership rule, you must enter information into the Add 
New TP Rule dialog box.

Procedure Use this procedure to add a new Trading Partnership rule.

Step Action

1 Start the rule definition process to display the Define TP Rule 
dialog box.

Reference
See How to Start the Rule-Definition Process for instructions.

2 Click New and continue with the next step.

System Response
GENTRAN:Server displays the Add New TP Rule dialog box.

3 From the drop-down list of the Field Name box, select the 
name of the field from which you want to extract characters 
for the identification string.

Note
The Record ID field is not available for editing because 
GENTRAN:Server always uses the fields in the first record of 
the application document for Trading Partnership 
information.

(Continued on next page)
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4 Type the position of the beginning character you want to 
extract from the field into the Start Position within Field 
box.

Example
If you want to begin with the third character in the field, type 3 
in the box.

5 In the From box, select left or right to indicate the side of the 
field you are counting from.

Example
If you want to begin with the third character in the field from 
the left, select left from the drop-down box in the From field.

6 Type the number of characters you want to extract into the 
Length field.

Example
If you want to extract four characters beginning with the third 
character in the field from the left, type 4 into the Length 
field.

7 In the Marker field, type the character that you want to 
represent the part of the string that these extracted 
characters will occupy.

Note
GENTRAN:Server uses this character in the View TP Rule 
dialog box, which graphically depicts the position of each 
Trading Partnership rule in the string.

8 In the String Position box, type the beginning character 
number in the string that the characters from this rule will 
occupy.

Example
If you want the four characters from this rule to occupy 
positions 9, 10, 11, and 12 in the string, type 9 in the String 
Position box.

(Continued on next page)

 (Contd)
Step Action
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9 Click OK to save the rule.

System Response
GENTRAN:Server displays the Define TP Rules dialog box. 
The new rule is displayed.

10 Select another task.

IF you want to� THEN�

Add another Trading 
Partnership rule

Repeat Steps 2 through 9.

View a picture that shows 
each rule�s place in the 
unique string

GO TO How to Display a Picture 
of the String.

Modify or delete a Trading 
Partnership rule

GO TO How to Edit a Trading 
Partnership Rule.

Add the unique string to 
the TP cross reference 
table

GO TO Linking Rules to a 
Trading Partnership Code.

 (Contd)
Step Action
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How to Display a Picture of the String

Introduction This topic explains how to display a graphical representation of the Trading 
Partnership rules that comprise a unique identification string. In the picture, 
GENTRAN:Server uses the marker specified for each Trading Partnership rule to 
mark the rule�s place in the string.

View TP Rule
dialog box

This illustration shows an example of an identification string displayed in the View 
TP Rule dialog box. The set of markers show that this string is comprised of three 
Trading Partnership rules.

Procedure Use this procedure to display a graphical representation of the unique string.

Step Action

1 Open the Define TP Rules dialog box for the application description 
or file definition.

Reference
See How to Start the Rule-Definition Process for instructions.

2 Click View on the Define TP Rules dialog box.

System Response
GENTRAN:Server displays the View TP Rule dialog box.

3 When you are finished, click Close to exit the picture and return to 
the Define TP Rules dialog box.
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How to Edit a Trading Partnership Rule

Introduction You can modify a Trading Partnership rule from the Define TP Rules dialog box.

Procedure Use this procedure to modify an existing Trading Partnership rule.

Step Action

1 Open the Define TP Rules dialog box for the application description 
or file definition.

Reference
See How to Start the Rule-Definition Process for instructions.

2 Select the Trading Partnership rule that you want to modify.

3 Click Edit.

System Response
GENTRAN:Server displays the Edit TP Rule dialog box.

4 Replace the values you want to edit with new values.

5 Click OK to save your changes.
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How to Delete a Trading Partnership Rule

Introduction You can delete a Trading Partnership rule from the Define TP Rules dialog box.

Procedure Use this procedure to delete a Trading Partnership rule.

Step Action

1 Open the Define TP Rules dialog box for the application description 
or file definition.

Reference
See How to Start the Rule-Definition Process for instructions.

2 Select the Trading Partnership rule that you want to delete.

3 Click Delete.

System Response
GENTRAN:Server displays the prompt:

Do you want to delete this record?

4 Confirm that the rule is the one you want to delete.

5 Is this the rule that you want to delete?

◗ If YES, click Yes to delete the rule.
◗ If NO, click No to cancel the action and retain the rule.

System Response
GENTRAN:Server returns to the Define TP Rules dialog box. 
The rule you deleted has been removed.
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Linking Rules to a Trading 
Partnership Code 0

Overview

Introduction To enable GENTRAN:Server to determine a Trading Partnership Code from the 
identification string it extracts from an application file, you build a table that cross-
references the string with a Trading Partnership Code.

Guidelines These are the guidelines for linking strings to Trading Partnership Codes:
◗ Each identification string built from applying Trading Partnership rules must 

be unique. You cannot have the same combination of strings point to different 
Trading Partnership Codes.

◗ You can link two or more sets of strings to one Trading Partnership Code as 
long as each string is unique.

◗ Identification strings are case-sensitive. "AbC" does NOT equal "ABC."
◗ Leading and trailing spaces are place holders in the string.
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Application TP Cross Reference Dialog Box

Introduction The Application TP Cross Reference dialog box is used to choose the name of the 
application description or file definition that describes the layout of the application 
documents to which the set of Trading Partnership rules apply.

Illustration This illustration shows the Application TP Cross Reference dialog box.

Fields and
functions

This table describes the fields in the Application TP Cross Reference dialog box 
and their functions.

Field Function

Select Application/File 
Definition Filename

Identifies the name of the application description or 
file definition that describes the records and fields 
in the application documents that 
GENTRAN:Server will process with the set of 
Trading Partnership rules.

Edit Displays the Define TP Cross Reference dialog 
box, which shows the string value and 
corresponding TP Code. 

Close Closes the dialog box.
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Define TP Cross Reference Dialog Box

Introduction The Define TP Cross Reference dialog box is used to 
◗ Display the cross references in the Application TP Cross Reference table
◗ Access the Add New String and TP Code Cross Reference dialog box
◗ Modify a cross reference
◗ Delete a cross reference from the table

Illustration This illustration shows the Define TP Cross Reference dialog box.

Fields and
functions

This table describes the fields in the Define TP Cross Reference dialog box and 
their functions.

Field Function

String Value Indicates the identification string that results 
from applying a set of Trading Partnership 
rules to an application document.

TP Code Indicates the Trading Partnership Code that 
the system uses when it processes 
application documents that yield the 
identification string in the String Value field.

(Continued on next page)
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New Displays the Add New String and TP Code 
Cross Reference dialog box, which is used 
to create a new cross reference.

Edit Displays the Edit String and TP Code Cross 
Reference dialog box for the selected cross 
reference.

Delete Deletes the selected cross reference.

Close Closes the dialog box.

Help Displays the Help text for this dialog box.

 (Contd)
Field Function
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Add New String and TP Code Cross Reference Dialog 
Box

Introduction The Add New String and TP Code Cross Reference dialog box is used to create a 
new cross reference for a string and Trading Partnership Code and add it to the 
Application TP Cross Reference table.

Illustration This illustration shows the Add New String and TP Code Cross Reference dialog 
box.

Fields and
functions

This table describes the fields in the Add New String and TP Code Cross 
Reference dialog box and their functions.

Field Function

String Value Specifies the identification string that results 
from applying a set of Trading Partnership 
rules to an application document.

TP Code Specifies the Trading Partnership Code that 
you want the system to use when it 
processes application documents that yield 
the specified identification string.

OK Saves the String Value and TP Code set to 
the Application/TP cross reference table.

Cancel Closes the dialog box without saving 
changes.

Help Displays the Help text for this dialog box.
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The Application TP Cross Reference Table

Introduction GENTRAN:Server stores the information from the TP Cross Reference dialog box 
in the Application TP Cross Reference table.

Application TP
Cross Reference

table

The Application TP Cross Reference table links the string values built from the 
Trading Partnership rules to Trading Partnership Codes. 

The Application TP Cross Reference table is a DISAM file named appxref.dat/idx.

Reference
See the GENTRAN:Server Technical Reference Guide for the layout of the 
appxref table.
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How to Build the Cross Reference Table

Introduction To add an entry to the Application TP Cross Reference table, you enter the unique 
string value and the Trading Partnership Code that you want to associate with the 
string into the Add New String and TP Code Cross Reference dialog box.

Procedure Use this procedure to add entries to the Application TP Cross Reference table.

Step Action

1 Select Application TP Cross Reference from the Application File 
Configuration menu of the GENTRAN:Server Main window.

System Response
GENTRAN:Server displays the Application TP Cross 
Reference dialog box.

2 Click the drop-down arrow in the Select Application/File Definition 
Filename box to display a list of application descriptions and file 
definitions; then click the name of the file to which the Trading 
Partnership rules apply.

Note
Only files checked into the directory that holds your file 
definitions and application description files are displayed in 
the drop-down list.

(Continued on next page)
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3 Click Edit.

System Response
GENTRAN:Server displays the Define TP Cross Reference 
dialog box.

4 Click New.

System Response
GENTRAN:Server displays the Add New String and TP 
Cross Reference dialog box.

5 In the String Value box, type the value that will result when 
GENTRAN:Server uses the Trading Partnership rules to extract a 
string value from an application file.

(Continued on next page)

 (Contd)
Step Action
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6 In the TP Code box, type the Trading Partnership Code that you 
want to associate with the string value.

Tip
To display the Trading Partner Search dialog box, click the 
search icon (binoculars) next to the TP Code box.

7 Click OK to add the cross reference to the Application TP Cross 
Reference table.

System Response
GENTRAN:Server displays the new entry in the Define TP 
Cross Reference dialog box.

 (Contd)
Step Action
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How to Sort the Cross References

Introduction On the Define TP Cross Reference dialog box, you can sort the cross reference 
entries by the string value or the Trading Partnership Code, in either ascending 
order or descending order.

Sorting toggle
switches

This illustration shows the location of the sorting toggle switches.

Sorting
instructions

To change the sorting order of the cross-reference entries, click the String Value 
or Trading Partnership Code toggle switch once.
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How to Edit a Cross Reference

Introduction To edit an entry in the Application TP Cross Reference table, you open the cross 
reference from the Define TP Cross Reference dialog box and then change the 
Trading Partnership Code that is associated with the string.

Procedure Use this procedure to edit a cross references.

Step Action

1 Select Application TP Cross Reference from the Application File 
Configuration menu of the GENTRAN:Server Main window.

System Response
GENTRAN:Server displays the Application TP Cross 
Reference Filename dialog box.

2 Click the drop-down arrow in the Select Application/File Definition 
Filename box and then click the name of the application description 
or file definition associated with the cross reference you want to 
edit.

(Continued on next page)
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3 Click Edit.

System Response
GENTRAN:Server displays the Define TP Cross Reference 
dialog box.

4 Select the cross reference that you want to edit and then click Edit.

System Response
GENTRAN:Server displays the Edit String and TP Code 
Cross Reference dialog box.

5 In the TP Code box, type another Trading Partnership Code or use 
the search button to choose another Trading Partnership Code.

6 Click OK to save your changes.

System Response
GENTRAN:Server updates the Application TP Cross 
Reference table (appxref) and displays the modified entry in 
the Define TP Cross Reference dialog box.

 (Contd)
Step Action
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How to Delete a Cross Reference Entry

Procedure Use this procedure to delete an entry from the Application TP Cross Reference 
table.

Step Action

1 Select Application TP Cross Reference from the Application File 
Configuration menu of the GENTRAN:Server Main window.

System Response
GENTRAN:Server displays the Application TP Cross 
Reference dialog box.

2 Click the drop-down arrow in the Select Application/File Definition 
Filename box; then click the name of the application description or 
file definition associated with the cross reference.

(Continued on next page)
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3 Click Edit.

System Response
GENTRAN:Server displays the Define TP Cross Reference 
dialog box.

4 Select the cross reference that you want to delete.

5 Click Delete.

System Response
GENTRAN:Server displays a confirmation prompt.

6 Is this the cross reference that you want to delete?

◗ If YES, click Yes to delete the cross reference.
◗ If NO, click No to cancel the action and retain the cross 

reference.

System Response
GENTRAN:Server deletes the cross reference from the 
Application TP Cross Reference table (appxref) and from the 
Define TP Cross Reference dialog box.

 (Contd)
Step Action
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How the System Uses the TP Rules

Process This table explains how the system uses the Trading Partnership rules with an 
application file.

Stage Description

1 GENTRAN:Server locates the application description or file 
definition that defines the layout of the application document.and 
determines that it 

2 GENTRAN:Server determines that the application description or 
file definition does not have a field defined as the Trading 
Partnership Code.

3 GENTRAN:Server reads the application document and uses the 
Trading Partnership rules to determine the string value.

4 GENTRAN:Server compares the string value to entries in the 
Application TP Cross Reference table to find the 15-character 
Trading Partnership Code associated with the string value.

5 GENTRAN:Server locates the Trading Partnership record and uses 
the information it contains to process the application document.
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Overview

Introduction In some cases, your application data or that of your trading partner may not 
conform precisely to an EDI standard. If that is the case, you can open a copy of a 
set (a group of segments that represent a common business document) within the 
specific standard in the Standard/IG Editor and modify the standard as needed.

The modified set is called an implementation guide (IG). When you create a 
map, the implementation guide serves as either a source or destination document 
for data translation. The implementation guide describes the segments, elements, 
and sub-elements so that GENTRAN:Server�s translator can process them 
correctly.

If you have a sample data file that is representative of your EDI requirements, you 
can use the Standard/IG Editor�s AutoTrim feature to create the implementation 
guide. AutoTrim compares the data file to a standard and inactivates the 
segments and elements that are not in the sample file.

You can also use the Standard/IG Editor to create a new standard by copying and 
modifying an existing one.

In this chapter In this chapter, you will learn how to create and modify an implementation guide. 
This chapter also explains how to create a new standard by copying and changing 
an existing one.

Supported
standards

Standards you can modify in GENTRAN:Server include:

◗ X12
◗ X12 subsets (WINS, VICS, UCS, TDCC) 
◗ EDIFACT
◗ TRADACOMS
◗ ODETTE.

(Continued on next page)
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Key terms This table describes key terms used in this chapter.

Function keys
used when
creating an

implementation
guide

The following function keys are used on the Standard/IG Editor.

Term Description

composite element An element composed of two or more sub-elements.

element A piece of data in a segment. Elements are analogous 
to fields in an application description. Elements are 
variable length fields.

Implementation guide 
(IG)

A special form of a standard that was edited to meet 
the requirements of a particular trading partnership.

segment A defined sequence of related elements. Segments are 
analogous to records, which are used in application 
descriptions. A segment begins with a segment ID and 
ends with a segment terminator.

set A specific group of segments that represent a common 
business document. A set contains a set header (for 
example, ST or UNH) as the first segment and at least 
one segment in addition to the set trailer (for example, 
SE or UNT).

simple element An element that cannot be divided into sub-elements.

standard A major data format model used for EDI (for example, 
X12 or EDIFACT). Includes the rules and guidelines for 
formatting or structuring electronically transmitted 
documents.

Standard/IG Editor The GENTRAN:Server feature that enables you to edit 
standards and create implementation guides.

sub-element An element that is a component of another element.

Function Key Usage

F2 Toggles between expanded view and collapsed view.

F3 Toggles between using and discarding items.

F5 Toggles between marking and unmarking an item.
(Continued on next page)
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F8 Activates all marked discarded items.

SHIFT+F8 Activates all discarded items.

F9 Discards marked items.

SHIFT+F9 Discards all items.

F10 Adds a segment.

F11 Adds an element.

SHIFT+DELETE Cuts marked items.

SHIFT+INSERT Copies item(s) from the clipboard to the insertion point.

CTRL+C Clears all marked items.

CTRL+P Prints the opened standard or implementation guide.

CTRL+INSERT Copies marked items to the clipboard.

 (Contd)
Function Key Usage
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The Standard/IG Editor

Introduction To create an implementation guide or a new standard, you use the Standard/IG 
Editor.

Standard/IG
Editor window

This illustration shows the Standard/IG Editor window.

(Continued on next page)

Edit box

������
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Standard/IG
Editor fields and

functions

This table describes the fields and functions of the Standard/IG Editor window.

Field Function

Segment/Element Displays the descriptive label listed in the standards for 
this segment or element.

Max Occ Displays the maximum number of times this segment 
can appear in a row.

Min Len Displays the minimum element length.

Max Len Displays the maximum element length.

Type Displays the element�s data type (alphanumeric, 
numeric, date/time, or binary).

Req Displays the requirement indicator:

◗ O for optional: the presence of the segment is at 
the option of the sending party.

◗ M for mandatory: the segment must be present.
◗ C for conditional/relational: the presence of the 

segment depends on the presence of specific 
other items.

Loop Cnt Displays the number of times this group of segments 
can repeat as a loop. 

Edit box Provides the means to modify the segment or element 
that has the focus.
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Creating an 
Implementation Guide 0

The IG Creation Process

Introduction To create an implementation guide, you:
◗ Open a copy of a set within a specific standard in the Standard/IG Editor 

window
◗ Edit it by adding, deleting or inactivating, and modifying segments and 

elements.

When you edit and save an edited set, GENTRAN:Server stores the file as an 
implementation guide with a default file name extension of .ig. 

Stage table This table describes the process of creating an implementation guide.

Stage Description

1 Determine the required modifications to the standard document that 
you are exchanging with your trading partner by:

◗ Work with your trading partner to learn what the EDI data needs 
are. 

◗ Become familiar with the standard and with the changes needed 
to make an implementation guide. 

◗ Check the list of standards supported by GENTRAN:Server.

2 Load a copy of a set within the specified standard into the Standard/
IG Editor and modify it to create a custom implementation guide.

3 Make an implementation guide containing the EDI segments and 
elements that you send to or receive from your trading partner.

Note
If you have a sample file, you can use the AutoTrim feature to simplify 
the process.

(Continued on next page)
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Later, when you create the map, you can edit the implementation guide for use 
with a specific trading partner by discarding unused segments and elements and 
adjusting field values, as necessary.

4 Verify that your data lengths and types are correct in the 
implementation guide.

CAUTION
GENTRAN:Server cannot correctly translate incorrect data 
lengths and types.

5 Set up any special formatting in the implementation guide that you 
want the translator to use to convert data.

6 Set up special options (batch totals and/or retain field values) in the 
implementation guide.

7 Modify existing loops and create new loops to reflect repeating data 
segments in the implementation guide.

8 Save the changes and name the implementation guide.

 (Contd)
Stage Description
Mapping and Translation Guide � February 2002



Creating an Implementation Guide or Standard How to Use AutoTrim to Create an IG from a Standard 6 - 9
How to Use AutoTrim to Create an IG from a Standard

Definition AutoTrim is a GENTRAN:Server tool that enables you to create an 
implementation guide by comparing a sample data file to a standard set you 
specify. This tool examines a transaction set (for example, ST/SE) from the 
sample file and the standard set you specify and inactivates the segments and 
elements that are not included in the sample file. The unused items are not 
permanently deleted, so you can select them later if necessary.

When to use If you have a sample data file that is representative of your EDI requirements, you 
can use AutoTrim to create an implementation guide. 

AutoTrim
procedure

Use this procedure to modify a standard set with AutoTrim.

Step Action

1 Open the Standard/IG Editor.

System Response
GENTRAN:Server displays the Select Standard/IG dialog box.

2 On the dialog box, select the name of the standard and the document 
you want to trim and click OK.

System Response
GENTRAN:Server displays a copy of the set within the selected 
standard in the Standard/IG Editor.

3 Click AutoTrim on the Tools menu.

4 Specify the sample data file that you want to compare to the 
standard.

System Response
As GENTRAN:Server compares the sample data to the standard, 
unused segments and elements turn light gray. These items are 
discarded.

5 Select Save As from the File menu and give the trimmed standard a 
unique name with the .ig extension.

The trimmed standard is now an implementation guide.
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How to Modify a Standard to Create an IG

Introduction If you do not have a sample data file similar to your EDI requirements, you can 
create an implementation guide by opening a standard set in the Standard/IG 
Editor and modifying it to meet your requirements. 

Example
If you remove all the segments about special handling instructions from the X12 
version 3030 standard 204 (Motor Carrier Shipment Information) and then save 
the modified file, you create a new implementation guide. You might name this 
implementation guide mcarrier.ig.

Procedure Use this procedure to modify a standard to create an implementation guide.

Step Action

1 Open the Standard/IG Editor.

System Response
GENTRAN:Server displays the Select Standard/IG dialog box.

2 From the dialog box, select the name of the standard and the 
document you want to use to create the implementation guide and 
click OK.

System Response
GENTRAN:Server displays a copy of the set within the specified 
standard in the Standard/IG Editor window.

Reference
If you want to create a new standard based on an existing one, see 
Creating a New Standard in this chapter.

3 Click Save As on the File menu and enter a unique file name with 
the .ig extension.

System Response
The file is now an implementation guide.

(Continued on next page)
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4 Use this table to determine how to modify the file.

IF you want to� THEN refer to the topic�

Add or modify segments How to Add a Segment in this 
chapter. 

Add or modify elements How to Add an Element, 
Composite Element, or Sub-
element in this chapter.

Create or modify loops How to Mark Repeating Segments 
(Loops) in this chapter. 

Discard or delete segments or 
elements

How to Discard and Delete 
Segments and Elements in this 
chapter. 

5 Click Save on the File menu to save the implementation guide.

 (Contd)
Step Action
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How to Add a Segment

Introduction When you need to describe a data group that is not in the standard version set, 
you need to add a segment. 

Comment
When you add a new (empty) segment, the Standard/IG Editor automatically adds 
one empty element as well.

Segment edit
box

This illustration shows the segment edit box. You use this box to assign the 
segment name and attributes to a new segment.

Segment edit
box fields and

functions

This table describes the fields and functions of the segment edit box.

Field Function

ID Indicates the segment identifier listed in the standard 
for this segment. The segment identifier consists of two 
or three uppercase letters and/or digits.

SEGMENT NAME Indicates the descriptive label listed in the standards 
for this segment. Can be up to 128 characters in 
length.

MAX OCC Indicates the maximum number of times this segment 
can appear in a row. This value must be a positive 
integer between 0 and 999999. Alternatively, you can 
enter �>1� to permit an unspecified number of 
repetitions during translation. The default is 1.

(Continued on next page)
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Adding a
segment

Use this procedure to add a segment to an implementation guide.

LP CNT Indicates the number of times this group of segments 
can repeat as a loop. This value must be a positive 
integer between 0 and 99999. 

You can also enter �>1� to permit an unspecified 
number of repetitions during translation. The default is 
1.

Note
The system displays this edit box only if the segment is 
the first segment in a loop.

REQ Indicates the requirement indicator:

◗ O for optional: the presence of the segment is at 
the option of the sending party.

◗ M for mandatory: the segment must be present.
◗ C for conditional/relational: the presence of the 

segment depends on the presence of specific 
other items.

◗ F for floating: this segment is an NTE segment 
that may appear anywhere in the transaction set 
between the transaction set header and the 
transaction set trailer.

 (Contd)
Field Function

Step Action

1 Move the focus to the line that will precede the new segment.

2 Click Add a Segment on the Edit menu.

System Response

GENTRAN:Server places a generic segment in your implementation 
guide.

3 Enter the attributes you want to assign to this segment in the edit 
box at the bottom of the window.

(Continued on next page)
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Changing
segment

attributes

Use this procedure to change the attributes of a segment in an implementation 
guide.

4 Click OK to save your segment changes and move to the next 
segment or element.

5 Click Save on the File menu to save the file.

 (Contd)
Step Action

Step Action

1 Move the focus to the element you want to change.

2 Go to the edit box at the bottom of the window.

3 Enter the new value in the edit box (or select a new value from a 
drop-down list).

4 Click OK to save the attribute changes.

5 Click Save on the File menu to save the changes to the file.
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How to Add an Element, Composite Element, or Sub-
element

Definitions Elements, composite elements, and sub-elements are different units of data. This 
table defines each term.

Element edit box This illustration shows the element edit box. You use this edit box to assign the 
element name and its attributes.

(Continued on next page)

Term Definition

Element A piece of data in a segment. Invoice numbers, 
addresses, quantities, and item descriptions are 
examples of elements. 

Composite element An intermediate unit of information. It consists of two or 
more component data elements preceded by a data 
element separator. Each component data element, 
except the last, is followed by a component element 
separator. The final component is followed by either 
the next data element separator or the segment 
terminator. 

Sub-element A component of a composite element.
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Element edit box
fields and
functions

This table describes the fields and functions of the element edit box��

Field Function

SEQ# Indicates the sequence number showing the position of 
the item within the segment. This number is assigned 
by the standard and increments by units greater than 
1.

You can change this number to any value between 0 
and 32760. The value does not affect the order in 
which the elements are displayed. The default is 1.

REF# Indicates the data element reference number as listed 
in the data element dictionary of the published 
standard.

ELEMENT NAME Indicates the descriptive label listed in the standard for 
this element. The element name can be up to 128 
characters in length.

MIN Indicates the minimum element length. The standard 
assigns a default length for each element, but you can 
change it. The minimum element length must be less 
than or equal to the maximum element length. The 
minimum length of any element cannot exceed 99.

MAX Indicates the maximum element length. The standard 
assigns a default length for each element, but you can 
change it. The minimum element length must be less 
than or equal to the maximum element length. The 
maximum length of any element cannot exceed 32760.

TYPE Indicates the element�s data type (for example, 
alphanumeric, numeric, date/time, or binary.

Note
This attribute is not available for composite elements 
because they contain sub-elements instead of values.

Reference
For allowable formats for each data type, see Data 
Type Formats chapter in the GENTRAN:Server 
Technical Reference Guide.

(Continued on next page)
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(Continued on next page)

FORMAT Indicates the specified format for the data type (for 
example, left-justified). The available formats depend 
on the data type.

Note
This attribute is not available for composite elements 
because they contain sub-elements instead of values.

References
Click the FMT button to display a list of formats for the 
data type.

See the Data Type Formats chapter in the 
GENTRAN:Server Technical Reference Guide for 
more information about valid data formats.

FMT push-button Displays a list of formats appropriate for the data type 
in the TYPE field.

REQ Identifies the requirement indicator:

◗ O for optional: the presence of the item is at the 
option of the sending party.

◗ M for mandatory: the item must be present.
◗ C for conditional: the presence of the item 

depends on the presence of specific other data 
elements or values.

◗ X for relational: The exclusion of the segment 
depends on the presence of another segment.
The presence of the segment depends on the:
� presence of others in its pair or group

� absence of other segments in its group

� presence of the first segment in the group.

OPT (OPTIONS) 
push-button

Displays the Options dialog box. This dialog box 
enables you to use batch totals for certain X12 and 
UCS documents or define default values for a 
destination field in a standard document.

Note
This attribute is not available for composite elements 
because they contain sub-elements instead of values. 

Reference
For details about optional attributes, see How to Add 
Optional Attributes to an Element in this chapter. 

 (Contd)
Field Function
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Adding an
element,

composite
element, or sub-

element

Use this procedure to add an element, composite element, or sub-element.

Step Action

1 Move the focus to the line that will precede the new element.

2 Use this decision table to determine your next step.

IF you want to add� THEN�

An element Click Add an Element on the Edit menu.

System Response
GENTRAN:Server places a generic 
element in your implementation guide. 

A composite element Click Add a Composite Element on the 
Edit menu.

System Response
GENTRAN:Server places a generic 
composite element in your description file 
and automatically adds four empty sub-
elements.

A sub-element Copy one or more existing sub-elements 
and paste them into the composite 
element.

Reference
For copying instructions, see the Working 
with the Application and Standard/IG 
Editors chapter in this guide.

3 Assign attributes to this element in the edit box at the bottom of the 
window.

4 Do you need to redefine the element�s data type format to specify 
how GENTRAN:Server reads the input (source) data or adjust the 
format to conform to your application data?
◗ If NO, continue with Step 5.
◗ If YES, Click the FMT button to display a list of formats for 

the data type. Select the data format you want to assign to 
this element.

Reference
If you need help making choices, click the Help push-button. See 
the topic Data Type Formats in the GENTRAN:Server Technical 
Reference Guide for format descriptions.

(Continued on next page)
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Changing
element

attributes

If your data differs from the standard or if you need to change your data 
representation, you must change one or more of the assigned element attributes 
in your implementation guide.

Use this procedure to change the attributes of an element.

5 Do you need to assign supplemental optional attributes to the 
element?
◗ If NO, continue with Step 6.
◗ If YES, click the Opt push-button.     

System Response
GENTRAN:Server displays different Option dialog boxes 
depending on the standard you are using. The X12 and UCS 
standards give you the option of using batch totals for certain 
documents, other standards do not. 

Reference
How to Add Optional Attributes to an Element for details.

6 Click OK to save your changes and move to the next segment, 
element, composite element, or sub-element.

Reference
If you need to change element attributes, see Changing element 
attributes in this chapter.

 (Contd)
Step Action

Step Action

1 Open the implementation guide and move the focus to the element 
you want to change.

2 Go to the edit box at the bottom of the window.

3 Enter the new value in the edit box (or select a new value from a list).

4 Click OK to save the attribute changes.

5 Select Save from the File menu to save the changes to the file.
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How to Add Optional Attributes to an Element     

Introduction The Opt (Options) button on the edit box enables you to assign optional attributes 
to the element. This button is available only when a simple element or sub-
element is selected; it is not available for composite elements.

Option dialog
boxes

GENTRAN:Server displays different Option dialog boxes depending on the 
standard you are using. The X12 standards give you the option of using batch 
totals for certain documents, other standards do not.

X12 standards

If you are using X12 standards, GENTRAN:Server displays the following Option 
dialog box:

Standards other than X12 

If you are using any standard other than X12, GENTRAN:Server displays only the 
Retain Field Value option.

(Continued on next page)
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Option dialog
box fields and

functions

This table describes the fields and functions of the Option dialog boxes.

(Continued on next page)

Field Function

Retain Field Value Defines the default value for a destination field.

If you click this box, GENTRAN:Server does one of the 
following during translation:
◗ If multiple source elements are mapped to the 

destination item, GENTRAN:Server uses the first 
value received as the default.

◗ If a single source element is mapped to a 
destination item, GENTRAN:Server uses each 
new value as the default.

Note
GENTRAN:Server places the default value into every 
repetition of the destination field/element until it 
encounters a new source value from this element for 
this destination.

Batch Total Generates a Functional Group Totals transaction set 
(X12, 980). The Functional Group Totals transaction 
set totals the values in the selected elements of all 
documents in the group or interchange and puts the 
sum in the Total segment of the 980 (BT1).

Note
GENTRAN:Server uses this field only for outbound 
documents with an implementation guide for the 
destination.

Comment
Batch totals do not have meaning for many document 
types. Do not click the Batch Total check box unless 
batch totals are meaningful for the document you are 
translating.
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Adding optional
attributes

Use this procedure to retain field values or automatically generate a Functional 
Group Totals transaction set (X12, 980).

Step Action

1 Click the Opt button on the element edit box.

2 Use this decision table to determine your next step.

IF you want to� THEN� AND�

Define the default 
value for a 
destination field 
(retain field values)

Click Retain Field 
Values.

Continue to step 3.

Generate a 
Functional Group 
Totals transaction 
set 

Click Batch Total.

System 
Response
The three batch total 
options appear on 
the dialog box:

◗ B1 - total placed 
in element 
BT105

◗ B2 - total placed 
in element 
BT108

◗ B3 - total placed 
in element 
BT111

Select the option 
that indicates where 
the total is to be 
placed, and then 
continue to step 3.

3 Click OK to save the option and close the dialog box.
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How to Mark Repeating Segments (Loops)

Introduction Often, your standard set contains a sequence of segments that repeats. 
GENTRAN:Server displays segments that repeat as a loop, with red lines 
connecting the first and last segment in the loop. You can modify these loops, and 
you can add new loops to indicate that another sequence of segments repeats.

Example of a
loop

This is an example of a loop in the Standard/IG Editor.

 The Loop Cnt column of the Standard/IG Editor displays the number of times the 
sequence repeats.

Before you begin Segments in a loop must be contiguous and sequential. Move segments as 
necessary to make them contiguous.

Note

You can create or change loops only when the Standard/IG Editor is set to Full 
Access mode. Editing functions are unavailable in View mode.

(Continued on next page)
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Adding a loop Use this procedure to add a loop.

(Continued on next page)

Step Action

1 Click Collapse All on the View menu so that the system displays only 
segments.

2 Move the focus to each segment that you want to include in the loop 
and click Toggle Marked Item on the Mark menu.

You can create loops within other loops (a process referred to as 
�nesting�). Create the inside loops first; then create the outside loops.

3 Click Make Loop on the Edit menu.

System Response
GENTRAN:Server adds the loop markers (red connecting lines) to 
the window display. 

The edit box for the first segment in the loop now includes a box for 
the loop count.

4 In the LP CNT edit box of the first segment in the loop, enter the 
number of times the loop repeats.

Note
This value must be a positive integer between 0 and 99999. 
Alternatively, you can enter �>1� to permit an unspecified number of 
repetitions during translation.

5 Click OK to save your changes.
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 Modifying loops Use these procedures to modify loops.

IF you want to� THEN�

Change the number of 
times the loop repeats

1. Move the focus to the first segment in the loop.

2. In the editing box, move to the LP CNT edit box 
and replace the existing number with the 
desired number of repetitions.

3. Click OK to save your changes.

Discard an entire loop 1. Mark the first segment in the loop.

2. Click Discard Marked on the Use menu.

System Response
All the items in the segment become inactive. The 
system displays these items in light gray.

Activate a discarded loop 1. Mark the first segment in the discarded loop.

2. Click Use Marked on the Use menu.

System Response
All the items in the loop become active. The system 
displays these items in dark gray.

Dissolve the loop 
association (but retain the 
segments that were in 
the loop)

1. Move the focus to the first segment in the loop.

2. Click Remove Loop on the Edit menu.

System Response
The system removes the red loop markings.

Delete an entire loop 
(including all the 
segments and elements in 
the loop)

1. Mark the first segment.

2. Click Delete Marked on the Edit menu.

3. Click YES in the confirmation dialog box.

System Response
The system removes all the items in the loop and 
the loop markings. 

CAUTION
You cannot recover deleted items.
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How to Discard and Delete Segments and Elements

Introduction Your implementation guide may contain segments and elements you do not need. 
You can either discard (temporarily inactivate) segments and elements or 
permanently delete them.

The system retains discarded segments or elements in the implementation guide 
file, but all file processing bypasses them. Discarding is safer than deleting 
because you can reactivate discarded items if you should need them later. You 
cannot recover a deleted item.

Cautions Before you discard or delete an item, observe these cautions:
◗ Deleting permanently removes items. If you may need the segment or 

element in the future, discard the item instead of deleting it.
◗ Do not discard or delete the ST, CTT, or SE segments. It is not necessary to 

map them (make a map group), but they must be present in the map file.
◗ Do not discard the beginning or ending segments of a loop.
◗ If you discard or delete a segment, you also discard or delete all its elements.
◗ If you discard a composite element, the system retains the sub-elements as 

discarded. If you delete a composite element, you also delete the sub-
elements. 

Ways to discard
items

There are four ways to discard items: 

◗ Identify items to discard and leave the remaining ones activated.
◗ Discard all items and then identify items to activate.
◗ Discard all items and activate all mandatory items.
◗ Discard a specific item with the Toggle Usage switch.

(Continued on next page)
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Selecting a
method

Use this decision table to select the discarding method that best meets your 
needs.

 Discarding
segments and

elements

Use the procedures in this table to discard segments and elements.

(Continued on next page)

IF you need to discard� THEN�

A few items Use the Toggle Usage switch to 
discard one item at a time.

Several items Mark the items to be discarded and 
discard them all at once.

Most of the items Discard all items and then activate the 
items you want to use.

Only the non-mandatory items Discard all items and then activate all 
mandatory items.

TO discard� THEN�

A single item 1. Move the focus to the item you want to discard. 

2. Click Toggle Usage on the Use menu.

Note

The F3 key toggles between discarding and using lines.

Selected items 1. Move the focus to the item you want to discard.
2. Click the Toggle Mark Item on the Mark menu to 

mark the first item you want to discard. 

3. Repeat Step 1 for each additional item you want to 
discard.

4. Click Discard Marked on the Use menu.

All items Click Discard All on the Use menu.
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Viewing
discarded items

The Visual Mapper does not display discarded items. 

The Standard/IG Editor displays discarded segments in light gray text. Click View 
Only Used Items to display or hide discarded segments/elements.

Activating
discarded items

When you reactivate an item, the system changes the color of the item from light 
gray to black.

If you activate a discarded segment, you also activate all its elements. Similarly, if 
you activate a discarded composite element, you also activate any related 
discarded sub-elements.

Use the procedures in this table to activate discarded items.

(Continued on next page)

TO� THEN�

Hide discarded items Click View Only Used Items on the View menu.

Display all items, 
including discarded items

Cancel the View Only Used Items selection.

TO activate� THEN�

A single item 1. Move the focus to the discarded item to be 
activated. 

2. Click Toggle Usage on the Use menu.

Note
The F3 key toggles between discarding and using 
lines.

Selected items 1. Move the focus to the discarded item to be 
activated.

2. Click Toggle Mark Item on the Mark menu to 
mark the first discarded item you want to 
activate. 

3. Repeat Step 1 for each additional discarded 
item you want to activate.

4. Click Use Marked on the Use menu.

All mandatory items Click Use All Mandatory on the Use menu.

All items Click Use All on the Use menu.
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Cutting vs.
deleting

It is safer to cut an item with the Cut command in the Edit menu than to delete it. 
When you cut an item, it remains in the clipboard until you cut or copy another 
item. When you delete an item, it is lost immediately. 

If you inadvertently delete an item, you can close the implementation guide 
without saving it. This restores the deleted item, but it also reverses all other 
changes made since you last saved the implementation guide.

Deleting
segments and

elements

Use this procedure to delete a segment, an element, a composite element, or a 
sub-element.

Step Action

1 Move the focus on the first item you want to delete. 

2 Click Toggle Mark Item on the Mark menu.

3 Repeat Steps 1 and 2 for each additional item you want to delete.

4 Click Delete Marked on the Edit menu. 

5 Click YES on the confirmation dialog box.

6 After you delete the items, click Save on the File menu.

System Response
The system saves the changes, making them permanent.
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Creating a New Standard 0

Overview

Introduction GENTRAN:Server enables you to create a special or modified standard that is not 
in the standards list by copying an existing one.

You may need to create a new standard if one of your trading partners uses a 
standard that they have modified for their own needs.

Example
Main Imports, one of your trading partners, uses X12 standard 004020, but has 
modified it slightly. To translate Main Imports� documents, you need to create and 
map Main Imports� version of standard 004020. You copy standard 004020 and 
give the copy a new name (004020MI). You modify 004020MI in the Standard/IG 
Editor so that it matches Main Imports� version. You then use 004020MI as the 
source document in a map that you build to translate Main Imports� documents. 

New standard
added to list of

standards

When you create a new standard, GENTRAN:Server copies all the necessary 
files to the new standard name you specify and adds the new standard to the 
standards list, stdlist.txt. This enables you to choose the new standard from the 
Select Standard/IG dialog box just as you would select any other standard.
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The Standard Creation Process

Stage table This table describes the process of copying and creating a standard.

Stage Description

1 Check the list of standards that GENTRAN:Server supports to 
determine which standard most closely matches the standard you 
want to create.

2 Determine the required modifications to the standard.

3 Create the new standard.

4 Modify the standard as needed.

5 Save the changes.

6 Use the new standard as the source or destination in a map.

7 Include the new standard when you create your Trading Partnership 
records for the Trading Partner who uses the new standard.
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How to Copy and Create a New Standard

Introduction This topic explains how to create a new standard by copying an existing standard.

The Create New
Standard Dialog

Box

This illustration shows the Create New Standard dialog box.

Create New
Standard dialog

box fields and
functions

This table describes the fields of the Create New Standard dialog box and their 
functions.

(Continued on next page)

Field Function

From Selects the name of the standard you want to copy.

Standard Name Displays the name of the new standard. This is the name 
you entered on the Select Standard/IG dialog box.

Description Describes the new standard.
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Procedure Use this procedure to create a new standard.

Step Action

1 Open the Standard/IG Editor.

System Response
GENTRAN:Server displays the Select Standard/IG dialog box.

Note
You can use this procedure any time the Select Standard/IG dialog 
box is displayed.

2 Select Standard.

3 Select the Standard/Version text box and type the name you want 
to give the new standard.

System Response
GENTRAN:Server disables the document selection list. This is 
because the standard does not exist, so GENTRAN:Server cannot 
find any documents for the standard.

4 Click OK.

System Response
GENTRAN:Server displays this prompt:

Standard [name] not found. Do you want to create it?

5 Click Yes.

System Response
GENTRAN:Server displays the Create New Standard dialog box.

(Continued on next page)
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6 Select the name of the standard you want to copy from drop-down 
list.

7 Type a description of the new standard in the Description box. 

8 Click OK.

System Response
GENTRAN:Server copies the standard you selected and adds the 
name of the new standard to the list of standard names displayed on 
the Select Standard/IG dialog box.

9 Select the new standard and document from the lists. 

System Response
GENTRAN:Server displays the standard in the Standard/IG Editor.

10 Use this table to modify the file.

IF you want to� THEN refer to the topic�

Add or modify segments How to Add a Segment in this 
chapter. 

Add or modify elements How to Add an Element, 
Composite Element, or Sub-
element in this chapter.

Create or modify loops How to Mark Repeating Segments 
(Loops) in this chapter. 

Discard or delete segments or 
elements

How to Discard and Delete 
Segments and Elements in this 
chapter. 

11 Click Save on the File menu to save the changes.

 (Contd)
Step Action
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Miscellaneous 
Procedures 0

How to Print a Standard or an IG

Introduction You can print a standard set or implementation guide if you want to compare it 
with your data or share it with others. 

From the Print Standard dialog box, you can print all records and fields or only the 
records. You can also print discarded items.

Print Standard
dialog box

This illustration shows the Print Standard dialog box.

Print Standard
fields and
functions

This table describes the fields and functions of the Print Standard dialog box.

(Continued on next page)

Field Function

Print Records and Fields Prints both records and fields.

Print Records Only Prints records only.

Print Discarded Items Prints discarded items in addition to one of the 
above selections.
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Printing a
standard or IG

Use this procedure to print a standard or an implementation guide.

Step Action

1 Open the desired standard or implementation guide.

Note
You can create a new implementation guide and keep it open if you 
want to print it.

2 Click Print on the File menu.

System Response
GENTRAN:Server displays the Print Standard dialog box.

3 Use this decision table to determine your next step.

IF you want to print� THEN select�

All segments, elements, and 
sub-elements

Print Records and Fields

Only the segments Print Records Only

4 Do you want to print discarded items as well as used items?

◗ If NO, continue with Step 5.
◗ If YES, click Print Discarded Items, then continue with Step 5.

5 Click OK.

System Response
GENTRAN:Server sends the standard or implementation guide to 
your printer. 

Reference
For more information about setting up a default printer, refer to the 
user�s guides for your operating system.
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Overview

Introduction This chapter describes synonym and thesaurus lists and files and how to use the 
Synonym and Thesaurus Editors to work with them.

Key terms This table lists the key terms used in this chapter. 

(Continued on next page)

Term Description

AutoMap The GENTRAN:Server feature that compares specific 
source and destination files and creates a map 
between them based on criteria such as field or 
element name, record or segment name, and loop 
structure. 

generic synonym list A synonym list that you can use in any map.

synonym A substitute value.

Synonym Editor The GENTRAN:Server feature that enables you to 
create or change synonym lists.

synonym list A list of values that GENTRAN:Server substitutes for 
original elements or application field values during 
translation.

specific synonym list A synonym list you use in a specific map.

Thesaurus Editor The GENTRAN:Server feature that enables you to 
create or change thesaurus lists.

thesaurus list A list of element names that you want 
GENTRAN:Server to consider a match for the original 
element name during AutoMapping.
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Generic and
specific

synonym lists

A synonym list is a data substitution list that GENTRAN:Server uses during 
translation. There are two types of synonym lists: specific and generic. The files 
that make up these lists reside in your map directory.
◗ You link a specific synonym list to a single map source. This is the only map 

source affected by that list. The two files that comprise each specific synonym 
list are named for the map to which they apply: <mapname>.idx and 
<mapname>.dat. The name of each synonym list contained in the file is the 
same as the source label to which it is attached (for example, S10). 

◗ You can use a generic synonym list in any map. You must assign each 
generic list a unique name. The generic synonym lists are stored in two files: 
generic.idx and generic.dat. 

When to use a
synonym list

You use a synonym list to direct GENTRAN:Server to replace a particular source 
data value with another value during translation. The synonym list is a useful tool 
if the terminology that the source document uses is different from the terminology 
that the destination document uses. 

For example, you would use a synonym list if your inventory system names a 
product �#A123XY,� but the shipping papers you send to your trading partner must 
read �RED BLOCKS.�

Thesaurus lists A thesaurus list is a list of substitute values that you want GENTRAN:Server to 
consider as matches for original names during AutoMapping. You can create and 
use multiple thesaurus lists, all of which are stored in two files, thesaurus.idx and 
thesaurus.dat. These files reside in your map directory.

When to use a
thesaurus list

You want to use a thesaurus list when you plan to use the AutoMap feature 
frequently and many of your source and destination documents use the same 
cross-references. You must set up the thesaurus list prior to AutoMapping.

Careful use of thesaurus lists can greatly increase the matches found by the 
AutoMapper, helping to automate and expedite the mapping process. 
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The List Editors

Introduction The Synonym Editor and the Thesaurus Editor (the list editors) are very similar in 
structure and use. There are some differences in the way you use the windows, 
however. Those differences and the purposes of the list editors are discussed 
later in this chapter.

Note
The list editors can display up to 100,000 entries.

The list editors This illustration shows the Synonym Editor.    

(Continued on next page)

Text entry box
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List editor
window fields
and functions

This table describes the fields and functions of the list editor.

Field Function

Text entry box Enables you to enter the original and substitute values. 
The active (outlined) cell displays the text you enter in 
this field. You can use the mouse, arrow keys, or TAB 
and SHIFT-TAB keys to move the focus to a different cell.

Original Value 
Column

◗ For synonym lists: displays the original values for 
which you want to substitute values during 
translation.

◗ For thesaurus lists: displays the original names 
for which alternative names exist.

Substitute Value 
Column 

◗ For synonym lists: displays the values you want 
to substitute for the corresponding original values 
during translation.

◗ For thesaurus lists: displays the names that 
GENTRAN:Server should consider a match for the 
corresponding original names during 
AutoMapping. 
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How to Work with Generic Synonym Lists

Introduction Generic synonym lists can be used by any map during translation. This section 
describes how to create, modify, and delete generic synonym lists.

For example, you might create one generic synonym list for X12 810s and another 
for X12 850s. Or, you might create one generic synonym list for European maps, a 
second for North American maps, and a third for Asian maps. 

The Open
Generic

Synonym List
dialog box

This illustration shows the Open Generic Synonym List dialog box.

 

This dialog box displays the name of every existing synonyms list. The example 
above displays only the New List option as there are no existing lists.

General notes on
Synonym lists

You should keep these notes in mind when creating Synonym lists. 
◗ The Synonym Editor is case-sensitive.
◗ The only printable character that you cannot use in a synonym list entry 

(either original or substitute) is the pipe (¦) character.
◗ You can include spaces in a synonym list entry, but not empty cells between 

entries. GENTRAN:Server prevents you from entering an empty cell between 
entries or empty rows between entries

(Continued on next page)
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Creating a
generic

synonym list

Use this procedure to create a generic synonym list.

(Continued on next page)

Step Action

1 Click Synonyms on the Edit menu. 

System Response
GENTRAN:Server displays the Open Generic Synonym List dialog 
box. 

2 Click New List and click OK.

System Response
GENTRAN:Server displays the Synonym Editor dialog box for a 
generic list. The system automatically locates the focus at the first 
cell in the Original Value column. The cursor is always located in 
the text box. 

3 Enter the source document value that you want to replace during 
translation.

4 Press TAB to move the focus to the corresponding cell in the 
Substitute Value column.

5 Enter the value that you want GENTRAN:Server to use in place of 
the original value entered in Step 3.

6 Repeat Steps 3 and 4 to build your list. 

Note
You can enter up to 100,000 value pairs.

7 Click Save List or Save List As on the File menu. 

System Response
GENTRAN:Server prompts you to name the list.

8 Type the name you want to assign the list you are creating.

Note
The list name you enter can be any value from 1 to 19 characters in 
length.

9 Click OK.
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Modifying a
generic

synonym list

Use this procedure to modify a generic synonym list. 

Step Action

1 Click Synonyms on the Edit menu. 

System Response
GENTRAN:Server displays the Open Generic Synonym List dialog 
box. 

2 Select the list you want to modify and click OK.

System Response
GENTRAN:Server displays the selected list. 

3 Use this table to determine your next step.

IF you want to� THEN...

Add a synonym Press TAB to move the focus to an empty 
cell in the Original Value column and enter 
the source document value that you want to 
replace during translation.

Next, press TAB move the focus to the 
corresponding cell in the Substitute Value 
column and enter the value that you want 
GENTRAN:Server to use in place of the 
original.

Change a value Move the focus to the value you want to 
change and enter the new value.

Delete a row Move the focus to the row you want to 
delete and press CTRL+R.

Note
You are unable to delete only a source 
value from a synonym list. 
GENTRAN:Server requires that you delete 
the entire row.

4 Click Save List or Save List As on the File menu. 

System Response
GENTRAN:Server saves your changes. If you click Save List As, 
GENTRAN:Server prompts you for a file name.

(Continued on next page)
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Deleting a
generic

synonym list

Use this procedure to delete a generic synonym list. 

5 Type the name you want to assign the list you are creating.

Note
The list name you enter can be any value from 1 to 19 characters in 
length.

6 Click OK.

 (Contd)
Step Action

Step Action

1 Click Synonyms on the Edit menu. 

System Response
GENTRAN:Server displays the Open Generic Synonym List dialog 
box. 

2 Select any list and click OK.

Note
You do not have to specify the list you want to delete yet.

System Response
GENTRAN:Server displays the selected list in the Synonym Editor 
window. 

3 Click Delete List on the File menu.

System Response
GENTRAN:Server displays the Delete Synonym List dialog box.

4 Select the synonym list you want to delete and click OK. 

System Response
GENTRAN:Server prompts you to confirm the deletion.

5 Click YES to confirm the deletion.

System Response
GENTRAN:Server deletes the synonym list you specified.
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How to Work with Specific Synonym Lists 

Introduction A specific synonym list is linked to a single Map file (<mapname>.vmp) and, if one 
exists, to the corresponding working map (<mapname>.mas). You can link a 
specific synonym list to one or more mapped source items within the selected 
Map file. 

This section describes how to create, modify, and delete specific synonym lists.

Before you begin Before you can create specific synonym lists, you must create or open a map that 
contains at least one mapping instruction. 

Reference
See the chapter Mapping in this guide for instructions on creating and opening a 
map. 

Creating a
specific

synonym list

Use this procedure to create a specific synonym list.

Note
◗ The Synonym Editor is case-sensitive.
◗ The only printable character that you cannot use in a synonym list entry 

(either original or substitute) is the pipe (¦) character. 
◗ You can include spaces in a synonym list entry, but not empty cells between 

entries. GENTRAN:Server prevents you from entering an empty cell between 
entries or empty rows between entries.

Step Action

1 Click Open from the File menu and choose the .vmp file for which 
you want to create the specific synonym list.

System Response
GENTRAN:Server displays the Visual Mapper and the selected 
map.   

2 Click on the mapped source element or application field to which 
you want to assign substitute values.

(Continued on next page)
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3 Click Synonyms on the Edit menu.

System Response
GENTRAN:Server displays the Open a Synonym List for Editing 
dialog box.

4 Click Synonym List is specific to this map, then click OK.

System Response 
GENTRAN:Server displays the Synonym Editor. 

Note
The list is named <mapname>.vmp:<label>, where <mapname> is 
the name of your map and <label> is the element label. The system 
automatically locates the focus at the first cell in the Original Value 
column. The cursor is always located in the text box.

5 Enter the value from the source document that you want 
GENTRAN:Server to replace during translation.

6 Press TAB to move the focus to the corresponding cell in the 
Substitute Value column.

7 Enter the value that you want GENTRAN:Server to use in place of 
the original value you entered in Step 5.

8 Repeat Steps 5 through 7 to build your list. 

Note
You can enter up to 100,000 value pairs.

9 Click Save List on the File menu. 

System Response
GENTRAN:Server saves the synonym list and creates mapping 
instructions for the entered items.

10 Click Close on the File menu.

System Response
The system prompts you to automatically change all mappings 
associated with the selected source to use this synonym list. 

(Continued on next page)

 (Contd)
Step Action
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Modifying a
specific

synonym list

Use this procedure to modify a specific synonym list. 

11 Use this table to determine your next response.

If you want to... THEN...

Change all mappings associated with the 
selected source to use this synonym list

Click Yes.

Change only the selected mapping to use 
this synonym list

Click No.

Return to the Visual Mapper without 
changing any mappings

Click Cancel.

 (Contd)
Step Action

Step Action

1 Click Open on File menu and select the .vmp file to which the 
specific synonym list you want to modify is linked.

System Response
GENTRAN:Server displays the Visual Mapper and the selected 
map.   

2 Click on the source element or application field to which the 
synonym list is assigned.

3 Click Synonyms on the Edit menu.

System Response 
GENTRAN:Server displays the Open a Synonym List for Editing 
dialog box. Make sure that the map and label name are correct.

4 Click Synonym List is specific to this map, then click OK.

System Response
GENTRAN:Server displays the selected list in the Synonym Editor.

(Continued on next page)
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(Continued on next page)

5 Use this table to determine your next step.

IF you want to� THEN...

Add a synonym Press TAB until the focus selects an empty 
cell in the Original Value column and enter 
the source document value that you want to 
replace during translation.

Next, press TAB to select the corresponding 
cell in the Substitute Value column and 
enter the replacement value.

Change a value Press TAB until the focus selects the value 
you want to change and enter the new 
value.

Delete a row Press TAB until the focus selects the row you 
want to delete and press CTRL-R.

6 Click Save List on the File menu. 

System Response
GENTRAN:Server saves your changes. 

7 Click Close on the File menu.

System Response
The system prompts you to automatically change all mappings 
associated with the selected source to use this synonym list. 

8 Use this table to determine your next response.

If you want to... THEN...

Change all mappings associated with the 
selected source to use this synonym list

Click Yes.

Change only the selected mapping to use 
this synonym list

Click No.

Return to the Visual Mapper without 
changing any mappings

Click Cancel.

 (Contd)
Step Action
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Deleting the
reference to a

specific
synonym list

Use this procedure to delete the reference to a specific synonym list. 

Step Action

1 Click Open on the File menu and choose the .vmp or file for which 
you want to delete the reference to a specific synonym list.

System Response
GENTRAN:Server displays the Visual Mapper and the selected 
map. 

2 Click on the source element or application field to which the 
synonym list is assigned.

3 Click the MI button on the toolbar.

System Response
GENTRAN:Server displays the Mapping Instructions window for 
the element or field.

4 Click on the synonym mapping instruction and press the DELETE key.

System Response
GENTRAN:Server prompts you to confirm the deletion.

5 Click YES to confirm the deletion.

System Response
GENTRAN:Server deletes the mapping for the specified synonym 
list.
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How to Use a Default Synonym 

Introduction You can designate a value as the default synonym value. 

During translation, GENTRAN:Server uses the default synonym value in the 
destination document when
◗ It is unable to satisfy any of the existing substitute conditions 
◗ The source document does not contain the item involved in the substitution.

Using a default
synonym

To use a default synonym, you enter an asterisk (*) as the original value and enter 
the default value you want to use as the substitute value. 

Example of
using a default
synonym value

Assume that you use a mapping instruction that contains this statement:

MAP specific synonym for S01 to D15

This mapping instruction uses this substitute value table. 

This results of this instruction are:

◗ If item S01 has the value A123XY, then the system enters RED BLOCKS as 
item D15. 

◗ If item S01 has the value B999ZX, then the system enters WATERCOLOR 
SET as item D15. 

◗ If item S01 has a value other than A123XY or B999ZX, the system enters the 
value MISC TOYS in D15.

Point to
remember about

using default
synonyms

You should remember that if you do not include a default substitute value, then the 
destination item will be the value of the source item.

Original value... Substitute value...

A123XY RED BLOCKS

B999ZX WATERCOLOR SET

* MISC TOYS
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How to Use the Audit System Variable 

Introduction If you want to store a special source value in the audit record, you can map one or 
more source values to a special pre-defined system variable, $USRBUF. Used 
appropriately, mapping to this variable does not affect the output of your map.

GENTRAN:Server writes the values for the $USRBUF variable to the User Buffer 
field in the audit record (edistat.i/o, and edihist.dat/idx). 

Reference
See the edistat.i/o, edihist.dat/idx topic in the File Record Layouts chapter of the 
GENTRAN:Server Technical Reference Guide for the layout of the audit record.

Mapping to the
User Buffer field

in the Audit
record

Use this procedure to write the value of the source item in $USRBUF to the User 
Buffer field in the audit record. 

Step Action

1 In your map, create a mapping GROUP that includes:

◗ The source item whose value you want to write to the User 
Buffer field

◗ A destination item.

Note
You can map multiple source fields to $USRBUF. The data of each 
field is separated by a tilde (~) character. The maximum size is 52 
characters. The tildes are counted as part of the data.

CAUTION
If you map $USRBUF to a destination item to which you 
are mapping other data, GENTRAN:Server may create a 
second copy of the destination item.

2 Click on the source element or application field to which you want 
to assign the $USRBUF variable.

Note
Select a destination item that you will not be mapping to. 

(Continued on next page)
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Reference
See the chapter Working with Mapping Instructions in this guide for more 
information about mapping instructions.

3 Click Synonyms on the Edit menu.

System Response
GENTRAN:Server displays the Open a Synonym List for Editing 
dialog box.

4 Click Synonym List is specific to this map, then click OK.

System Response 
GENTRAN:Server displays the Synonym Editor. 

5 Create a synonym by typing the wildcard (*) symbol in the Original 
Value column and $USRBUF in the Substitute Value column.

6 Click Save List on the File menu. 

System Response
GENTRAN:Server saves the synonym list and creates a mapping 
instruction similar to this:

MAP specific synonym of source S3 to D5

7 Verify that the system created the mapping instruction as follows:

◗ Single-click either the source item or the destination item.
◗ Click the right mouse button and click Mapping Instruction 

Toolbar to display the Mapping Instructions window.

CAUTION
The mapping instruction shows a synonym of a source 
item mapped to a destination item, not to the $USRBUF 
variable. Do not change this mapping instruction. 

 (Contd)
Step Action
Mapping and Translation Guide � February 2002



Thesaurus Lists Working with Synonym and Thesaurus Lists7 - 18
Thesaurus Lists 

Introduction You use GENTRAN:Server�s Thesaurus Editor to create a list of substitute values 
that you want GENTRAN:Server to consider a match for the original name during 
AutoMapping. 

Careful use of thesaurus lists can greatly increase the matches found by 
AutoMap. This helps to automate and expedite the translation process. 

Note
You must set up the thesaurus list prior to AutoMapping.

When to use a
thesaurus list

You should consider using a thesaurus list when:

◗ You plan to use AutoMap frequently and many of your source and destination 
documents use the same cross-references. 

◗ The elements or fields in the source and destination files do not have similar 
naming conventions. 

Example
One element or field may refer to �address� while the corresponding element or 
field refers to �routing.� 

Example of
using a

thesaurus list

You use AutoMap to create a map with an application as the source and an 
implementation guide as the destination. AutoMap does not match these items: 

Before running AutoMap again, you create the thesaurus list below. AutoMap is 
now able to matches those items. 

(Continued on next page)

Source field... Destination element...

ID Code Identification Code

Zip Postal Code

Original value... Substitute value...

ID Code Identification Code

Zip Postal Code
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The Open
Thesaurus List

dialog box

This illustration shows the Open Thesaurus List dialog box.   

This dialog box will display the name of every existing thesaurus list. The example 
above displays only the New List option as there are no existing lists.

The Thesaurus
Editor window

This illustration shows the Thesaurus Editor.

The Original Value column displays the names of the source items. The Substitute 
Value column displays the corresponding destination items. 

(Continued on next page)

Text entry box
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List editor
window fields
and functions

This table describes the fields and functions of the list editor window.

Field Function

Text entry box Enables you to enter the original and substitute values. 
The text you enter in this field appears in the active cell 
(outlined). You can use the mouse, arrow keys, or TAB 
and SHIFT+TAB keys to move the focus.

Original Value 
Column

◗ For synonym lists: displays the original values for 
which you want to substitute values during 
translation.

◗ For thesaurus lists: displays the original names 
for which alternative names exist.

Substitute Value 
Column 

◗ For synonym lists: displays the values you want 
to substitute for the corresponding original values 
during translation.

◗ For thesaurus lists: displays the names that 
GENTRAN:Server should consider a match for the 
corresponding original names during 
AutoMapping. 
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How to Work with Thesaurus Lists 

Introduction This section describes how to create, modify, and delete thesaurus lists.

General notes on
Thesaurus lists

You should keep these notes in mind when creating Thesaurus lists. 
◗ You can use spaces in entries with two or more words. Capitalization does not 

matter because the Thesaurus Editor is not case-sensitive.
◗ The only printable character that you cannot use in a thesaurus list entry 

(either original or substitute) is the pipe (¦) character.
◗ You can include spaces in a Thesaurus list entry, but not empty cells between 

entries. GENTRAN:Server prevents you from entering an empty cell between 
entries or empty rows between entries.

Creating a
thesaurus list

Use this procedure to create a thesaurus list. 

Step Action

1 Click Thesaurus Entries on the Edit menu. 

System Response
GENTRAN:Server displays the Open Thesaurus List dialog box. 

2 Click New List and click OK.

System Response
GENTRAN:Server displays the Thesaurus Editor. The system 
automatically locates the focus at the first cell in the Original Value 
column. The cursor is always located in the text box.

3 Enter a record, field, segment, or element name from the source 
document.

4 Press TAB until the focus selects the corresponding cell in the 
Substitute Value column. 

5 Enter the name that you want GENTRAN:Server to consider a 
match for the original name you entered in Step 3.

(Continued on next page)
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Modifying a
thesaurus list

Use this procedure to modify a thesaurus list. 

6 Repeat Steps 3 - 5 to build your list. 

Note
You can enter up to 100,000 value pairs.

7 Click Save List or Save List As on the File menu. 

System Response
GENTRAN:Server prompts you to name your list.

8 Type the name you want to assign the list you are creating

Note
The list name you enter can be any value from 1 to 19 characters in 
length.

9 Click OK.

 (Contd)
Step Action

Step Action

1 Click Thesaurus Entries on the Edit menu. 

System Response
GENTRAN:Server displays the Open Thesaurus List dialog box. 

2 Select the list you want to modify and click OK.

System Response
GENTRAN:Server displays the selected list in the Thesaurus 
Editor. 

(Continued on next page)
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Deleting a
thesaurus list

Use this procedure to delete a thesaurus list. 

3 Use this table to determine your next step.

IF you want 
to� THEN...

Add a row Press TAB to move the focus to a cell in the 
Original Value column and enter the source 
document name that you want to match during 
automapping.

Next, press TAB to select the corresponding cell in 
the Substitute Value column and enter the 
replacement value.

Change the 
name of an 
item

Press TAB to move the focus to the name you 
want to change and enter the new name.

Delete a row Press TAB to move the focus to the row you want 
to delete and press CTRL+R.

4 Click Save List on the File menu. 

System Response
GENTRAN:Server saves your changes. 

 (Contd)
Step Action

Step Action

1 Click Thesaurus Entries on the Edit menu. 

System Response

GENTRAN:Server displays the Open Thesaurus List dialog box.   

2 Select any list and click OK.

Note
You do not have to specify the list you want to delete yet.

System Response
GENTRAN:Server displays the list you selected in the Thesaurus 
Editor. 

(Continued on next page)
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3 Click Delete List on the File menu.
System Response

GENTRAN:Server displays the Delete Thesaurus List dialog box.

4 Select the thesaurus list you want to delete and click OK. 

System Response
GENTRAN:Server prompts you to confirm the deletion.

5 Click YES to confirm the deletion.

System Response
GENTRAN:Server deletes the selected thesaurus list.

 (Contd)
Step Action
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How to Convert Flat Files to Synonym Lists

Introduction In some cases, a trading partner may provide you with a text file containing a list 
of original values and their synonyms. The file may also include the list name.

Procedure Follow this procedure to convert a flat file to a Synonym list. 

Synonym file
structure

Each line of a Synonym file must contain three elements. The elements must be 
aligned in the following order:

◗ <List name>

To create a generic Synonym file, use the name of a specific list within the generic 
file.

To create a specific Synonym file, use the name of the source for the list you are 
creating.
◗ Original value
◗ Replacement value.

Delimit the entries with pipe symbols (¦).

(Continued on next page)

Step Action

1 Edit the text file, adding or modifying the information as needed.

Note
To retain a copy of the original file, save it under another name 
before editing the file.

2 Save the edited file as a Synonym file (.unl)

3 Use the synmv program to load the file to a Synonym table.

Reference
See the heading synmv in the Command Reference chapter of 
the Technical Reference Guide for more information about this 
program.
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Example
Each line of the edited flat file must have the following structure:

<list_name>¦<first_original_value>¦<first_replacement_value>
<list_name>¦<second_original_value>¦<second_replacement_value>
<list_name>¦<third_original_value>¦<third_replacement_value>

Saving the
edited file

Once you finish editing the text file, save it as a Synonym file. Use these criteria 
when selecting a name for the new file.

◗ To create a generic Synonym file, name the file generic.unl.
◗ To create a specific Synonym file, name the file <mapname>.unl, where 

<mapname> represents the map that will use this list.

Once you save the text file as a .unl, you are ready to load it to a Synonym list. 

Reference
See the heading synmv in the Command chapter of the Technical 
Reference Guide for more information about this program.
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Overview 0

What is a Map?

Introduction At the heart of the translation process, GENTRAN:Server translates data from a 
source document to a destination document. To do this, GENTRAN:Server needs 
information about the location of each piece of data (field or element) in your 
source document relative to its counterpart in the destination document. This 
collection of information is the map. This chapter provides the information you 
need to create maps for GENTRAN:Server. 

In this chapter You learn how to use the Visual Mapper to create, edit, and compile maps. This 
chapter introduces the Visual Mapper and basic map-making techniques. 

Special mapping
instructions

In many cases, the fields or elements in your source files map directly to fields or 
elements in the destination file. Sometimes, however, you must give 
GENTRAN:Server special mapping instructions to tailor the data. For example, 
you may want to move the contents of the source field to the destination field only 
if another source field equals a specific value.

Reference
See the Working with Mapping Instructions chapter in this guide for detailed 
information on including special mapping instructions.

Key terms This table lists the key terms used in this chapter.  

Term Description

alphanumeric expression An expression that results in alphanumeric data. 
Also called a string expression.

arithmetic expression An expression that results in numeric data.
(Continued on next page)
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AutoMap The GENTRAN:Server feature that compares 
specified source and destination files and maps 
items between them based on criteria such as field 
or element name, record or segment name, and loop 
structure. 

conditional expression A complete WHEN expression that may be part of a 
longer condition.

logical expression An expression that results in a logical value; either 
false (=0) or true (not=0).

macro A set of commands used within GENTRAN:Server to 
simplify and organize mapping instructions.

map A file containing instructions for translating between 
one standard, implementation guide, or application 
description data file and another.

Map File A <mapname>.vmp file that contains a defined map. 

mapping The process of associating data fields or elements in 
your source document to corresponding data fields 
or elements in your destination document.

mapping condition Qualifying term used in some mapping instructions 
to indicate when the mapping part of the instruction 
should be performed and when it should be ignored. 
Mapping conditions begin with �When.�

mapping expression A complete �Map to� expression that may be part of 
a longer mapping instruction.

mapping GROUP A specific mapping association between source and 
destination data.

mapping instruction A set of information that controls special operations 
on mapped data during translation.

Mapping Table File The file that contains the result of compiling a map. 
The file extension is .TBL. (See TBL File)

Working Map File A <mapname>.vmp file containing the working copy 
of a defined (<mapname>.vmp). GENTRAN:Server 
creates this file when a user opens a .vmp file. (See 
map file)

(Continued on next page)

 (Contd)
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Before you begin
mapping

Before you begin creating a map, you must identify the business information you 
and your trading partner will exchange. This information is usually presented in an 
implementation guide (IG).

Next, you should plan your map. You must determine how the fields in your 
source files relate to the fields in the destination files. If you cannot account for 
each piece of data, you must discuss it with your trading partner. 

Consider using a
mapping

worksheet

Consider using a worksheet as a tool to help you visualize the map. If you 
attended the GENTRAN:Server training class, you are familiar with this type of 
worksheet. 

Example
You might use a worksheet divided into three sections: 

◗ One containing columns that describe the source file data
◗ Another containing columns that describe the destination file data, and
◗ A third section with columns for any special instructions, qualifiers, or 

synonym values. 

TBL File A mapping table file containing the result of 
compiling a map file. This file is created in the 
working directory.

Visual Mapper The GENTRAN:Server window that enables you to 
create a map visually. The source document is 
displayed on the left side of the window and the 
destination document on the right.

 (Contd)
Term Description
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Flow of Work

Introduction Once you identify the information you want to map, you must decide the method 
to use to create the map in GENTRAN:Server. There are two methods for creating 
maps. You can:
◗ Map items automatically using AutoMap.
◗ Create the map manually with the Visual Mapper.

Decision table Use this table to help you decide whether to create maps using AutoMap or 
whether to create the map with the Visual Mapper. 

Map creation
process

This table describes the process of creating a map.

IF the documents are... THEN use...

Similar in structure (the records and fields are 
named similarly)

Comment
When AutoMapping finishes, you must review 
the map and make adjustments to the mapped 
items if necessary.

AutoMap to automatically 
map items.

The items are named differently in the source 
and destination documents or you want more 
control over the mapping of each piece of data

The Visual Mapper to 
manually map items.

Stage Description

1 Create a new map. 

Note
You can create a new map manually with the Visual Mapper or use 
AutoMap.

Result
GENTRAN:Server creates a map file (<mapname>.vmp).

2 Edit the map, using the Visual Mapper.
(Continued on next page)
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3 Save and compile the map.

Result
The map compiler identifies errors, provides a compiler report, and 
generates a mapping table file (<mapname>.TBL).

4 Test the map.

Using GENTRAN:Server, test the map by translating data. 

 (Contd)
Stage Description
Mapping and Translation Guide � February 2002



Mapping Map Files 8 - 7
Map Files

Introduction The process of creating and compiling a map creates working copies of two files:
◗ Map file
◗ Mapping table file

Map file When you create a map, GENTRAN:Server saves the information in a map file. 
You assign the map a name and GENTRAN:Server adds the file extension .vmp.

Example
You create a map and name it INVO123. GENTRAN:Server creates the map file, 
INVO123.vmp, and stores it in the directory for maps.

Mapping table
file

When you compile a map file, GENTRAN:Server creates a mapping table file, 
which is a form of the map file that the translator can read and understand. The 
file name for a mapping table file is the map name with a .TBL extension.

Example
You compile the INVO123.vmp. GENTRAN:Server creates the mapping table file, 
INVO123.TBL.

Master directory GENTRAN:Server stores the map files that it uses to translate data in the master 
directory. Your system administrator specified the path to this directory in the 
Setup Directories dialog box under the Settings menu.

Working map file When you create a new map or open an existing map to edit it, GENTRAN:Server 
creates a working map file for you. The name of the file is the same as your 
master map file, but it is stored in the working directory.

GENTRAN:Server Workstation and GENTRAN:Server for UNIX have different 
working directories:

◗ For GENTRAN:Server Workstation, the working directory is a single folder on 
the Windows computer. 

◗ For GENTRAN:Server for UNIX, the working directory is the directory of the 
user who opens the file, so individual users have their own working 
directories.

(Continued on next page)
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Note
When you approve (GENTRAN:Server Workstation) or check in a map 
(GENTRAN:Server for UNIX), GENTRAN:Server replaces the original map with a 
working map. GENTRAN:Server saves the maps in the master directory, 
regardless of their original locations.

Working
mapping table

file

When you compile a working map file, GENTRAN:Server creates a working 
mapping table file. The name of the file is the same as your working mapping 
table file, but is stored in the same working or user directory as the .vmp file.

Example
You compile the working map file, INVO123.vmp. GENTRAN:Server creates the 
working mapping table file, INVO123.TBL.

Purpose of the
Working files

GENTRAN:Server stores your map files and mapping table files in the working 
directory until you approve or check them into the master directory. The purpose 
of the working map file and the working mapping table file is to enable you to 
make and test changes without overwriting your original map. 

You can edit a working map file, compile it, and use the resulting working mapping 
table file in a translation to test your changes. If the translation does not produce 
the expected results, you still have your original map file. After you use the new 
map files successfully, you can replace the original map file with the working map 
file.

Reference
See the GENTRAN:Server for UNIX and Workstation Getting Started Guide 
for the procedures you will use to move (check in) working map files 
into the master directory. 
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Visual Mapper

Introduction The Visual Mapper is a graphical tool that enables you to view the segments and 
elements within each of the files in a map and easily create mapping GROUPs 
and mapping instructions.

The Visual Mapper displays the source file on the left side and the destination file 
on the right.

Visual Mapper
window

This illustration shows the Visual Mapper window. 

(Continued on next page)
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Visual Mapper
window fields
and functions

This table describes the fields and functions of the Visual Mapper window.

(Continued on next page)

Field Function

Label Displays the source and destination labels as 
assigned by GENTRAN:Server. Source items 
are labeled Snnn, and Destination items are 
labeled Dnnn. Each item receives a unique 
label, and labels are sequential.

Note 
When you delete an item, the label assigned to 
that item is also deleted and is not used again.

Record/field or 
Segment/element

Displays the descriptive label for individual 
records and fields, or segments and elements.

Tree mode button Displays the components of the source and 
destination files.

Reference
See Visual Mapper Display Modes in this 
chapter for more information.

Fast-entry mode button Displays a dialog box that you can use to 
quickly enter map assignments.

Reference

See Visual Mapper Display Modes in this 
chapter for more information.

Mini-report button Displays a report that shows each mapping 
association (mapping GROUPs and the field 
or element it belongs to) in the map.

Reference
See Visual Mapper Display Modes in this 
chapter for more information.
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Visual Mapper
symbols

This table describes the symbols used by the Visual Mapper.

Opening the
Visual Mapper

There are several ways to open the Visual Mapper.
◗ Click the Map button on the toolbar.

◗ Click Open/Map or New/Map on the File menu.

◗ Click Map on the Edit menu.

Symbol Description

An item that is part of a mapping GROUP. The map 
mini-report shows all the mapping GROUPs 
associated with the element or field.

A destination item that has a hard-coded value (0-to-1 
single GROUP).

A segment or record.

An element with sub-elements that are not displayed. 
This symbol represents a composite element.

An element with sub-elements that are displayed. This 
symbol represents a composite element.

A field or an element or sub-element that does not 
have any further sub-elements.

A loop. The line connecting two segments indicates the 
starting and ending items in the loop. Nested loops are 
indicated by connecting lines that also are nested.
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Visual Mapper Display Modes

Introduction The Visual Mapper has two display modes: tree mode and fast-entry mode. The 
display of the source and destination descriptions and the method by which you 
make or edit your map depend on the mode you select. 

(Continued on next page)

Mode Description

Tree mode The default Visual Mapper display mode. The illustration in 
the Visual Mapper topic in this chapter shows the Visual 
Mapper in tree mode.

◗ The source (�map from�) and destination (�map to�) 
files are displayed side-by-side, so you can quickly 
make the mapping GROUPs simply by clicking the 
items in the window.

◗ In tree mode the map is displayed in its columnar form, 
which you can collapse or expand so the fields or 
elements are hidden or displayed.

Fast-entry mode Displays a dialog box that enables you to enter the mapped 
element�s name and attributes in text boxes, so that you 
work with only those elements you need. 

Comment
Optionally, you can specify labels to make a 1-to-1 
mapping between the field or element that has the focus 
and the label you enter. If you know the destination or 
source label from the label column, you may move the 
focus to the field or element you want to map and then 
enter the label (for example, S1, S2, or D1, D2) of the item 
you want to associate with the field or element.
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Decision table Use this decision table to consider the Visual Mapper display mode in which you 
want to work. 

IF you... THEN use...

Are new to mapping or you want to see the layout of the 
source and destination files and their components

Tree mode.

Are very familiar with the source and destination files and 
you know exactly which components you want to map

Fast-entry mode.

Need to make only a few map associations Either mode.
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Visual Mapper Mini-report

Introduction The Visual Mapper Mini-Report displays map associations.

By comparing the Mini-Report to mapping GROUPs displayed in tree mode, you 
can evaluate the map associations in the GROUPs.

Sample Mini-
Report

This illustration shows a sample Mapping Mini-Report.

Displaying the
Mini-Report

Click the Visual Mapper Mini-Report button when you want to see the results of 
your work in the form of the Mini-Report as illustrated above.
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Mapping Concepts

Introduction To create and work with maps effectively, take a few minutes to become familiar 
with the concepts described in this section.

Mapping
GROUPs

A mapping GROUP is an association between source and destination elements or 
fields. A mapping GROUP follows one of these patterns:
◗ One source item to one destination item (1-to-1 relationship)
◗ Several source items to one destination item (many-to-1 relationship)
◗ One source item to several destination items (1-to-many relationship)
◗ Several source items to several destination items (many-to-many 

relationship)
◗ No source item to one destination item (0-to1 relationship)

A mapping GROUP must contain at least one destination field or element.

Mapping
multiple items

To easily map multiple items, select and mark them by double-clicking the left 
mouse button and then map them by clicking the right mouse button. You can 
then apply mapping instructions. 

You can also mark items by selecting Toggle Mark Item from the Mark menu. You 
then map them by selecting Group/New from the Map Items menu.

Reference
See the Working with Mapping Instructions chapter in this guide for detailed 
information on including mapping instructions.

Required
segments

For X12 standards, your map must contain the ST, CTT, and SE envelope 
segments. You are not required to map these segments, but they must be present 
in the standard or implementation guide. You can map the ST segment on an 
outbound map and the ST and SE segments on an inbound map. 

Unmapped
segments

The source side of the map must contain all records/segments that appear in the 
input data file. If GENTRAN:Server receives a segment not present in the source 
side of a map file, it issues an �Unexpected Segment� error. You can leave 
unmapped records/segments in your map if they do not relate to expected output 
data. 
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Procedures 0

How to Start a New Map

Introduction GENTRAN:Server displays the New Map dialog box when you open the Visual 
Mapper to create a new map. You use this dialog box to specify the source and 
destination files you want to map.

Before you begin Before you begin mapping, modify the application description, standard, or 
implementation guide that you will use. To simplify the mapping procedure, 
remove unnecessary segments, elements, records, and fields. 

References
See Mapping Concepts in this chapter and the chapters Defining Application 
Descriptions for ASCII Files, Defining Application Descriptions for Databases, and 
Creating an Implementation Guide or Standard in this guide for editing 
instructions.

New Map dialog
box

This illustration shows the New Map dialog box. 

(Continued on next page)
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Selecting the
source and

destination files

Use this procedure to select the source and destination files for a new map.�

Step Action

1 Click File on the menu bar.

2 Click New/Map on the File menu.

System Response

GENTRAN:Server displays the New Map dialog box.

3 Click the type of source file:

◗ Application
◗ Implementation Guide
◗ Standard.

System Response
GENTRAN:Server displays a dialog box from which you can 
choose the file name.

Reference
If you want to create a new standard by copying an existing one, 
see the Creating a New Standard section in the Creating an 
Implementation Guide or Standard chapter for information about 
creating a new standard.

4 Select the file name of the source file.

System Response 
The New Map dialog box displays the selected file name.

Note
GENTRAN:Server searches for the file in the directory specified in 
the Setup Directories dialog box for files of that type (application 
descriptions, implementation guide, or standards).

5 Click the type of destination file:
◗ Application
◗ Implementation Guide
◗ Standard.

System Response 
GENTRAN:Server displays a dialog box from which you can 
choose the file name.

(Continued on next page)
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6 Select the file name of the destination file.

System Response 
The New Map dialog box displays the file name you select.

Note 
GENTRAN:Server searches for the file in the directory specified in 
the Setup Directories dialog box for files of that type (application 
descriptions, implementation guide, or standards).

7 Click OK.

System Response 
GENTRAN:Server creates the map and displays the Visual Mapper 
window (in tree mode) for the files you selected. 

8 Tailor the source information, destination information, or both. 

Reference
See How to Tailor Source or Destination Information in this chapter 
for instructions.

 (Contd)
Step Action
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How to Tailor Source or Destination Information 

Introduction You may want to discard or delete segments and elements or records and fields 
that you are not going to map. You may also want to change the attributes of an 
element or field, such as the minimum or maximum field length.

You can use the Visual Mapper to make changes to the source information, 
destination information, or both. You can:
◗ Change only source or destination information in the map (without changing 

the source or destination file)
◗ Change only the source or destination file (without changing the map)
◗ Change both the source or destination file and source or destination 

information in the map. 

Before you begin When you edit a map, you can work only with active segments, elements, records, 
and fields. If you want to work with items you discarded, you must first activate 
and modify them with the Standard/IG Editor.

Reference
See the Creating an Implementation Guide or Standard chapter in this guide for 
instructions on editing maps.

If you want to
change a map

file

If you decide to change the map file, you need to determine whether a working 
map file exists. If a working map file does exist, you can edit it, compile it to create 
a working mapping table file, and then use the working mapping table file in a 
translation to test your changes. If the working mapping table file gives you the 
results you want, you can then replace the contents of the map file with the 
working map file.

Reference
See the GENTRAN:Server for UNIX and Workstation Getting Started Guide for 
instructions on checking in working map files.

(Continued on next page)
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Decision table Use this decision table to decide how to edit the source or destination.   

Editing only the
map

Use this procedure to edit only the map or working map file. 

IF you want your changes to affect� THEN edit�

Only the current map or working map Only the map or working map (but not 
the source or destination file).

Only future maps Only the source or destination file (but 
not the current map file).

Both the current map or working map 
and future maps

Both the map or working map and the 
source or destination file.

Step Action

1 Click File on the menu bar.

2 Click Open on the File menu.

3 Click Map on the Open submenu.

4 Use the table below to determine your next response.

IF you want to open� THEN click�

A map file From Master

A working map file From Working

System Response
GENTRAN:Server then displays the File Open dialog box.

(Continued on next page)
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5 Select the map file (.vmp) you want to edit.

Note 
The Visual Mapper allows you to open only one map at a time. If 
another map is open, Visual Mapper closes it after prompting you to 
save recent changes.

System Response
GENTRAN:Server Workstation

IF you open� THEN GENTRAN:Server�

A map file, but a working 
map file exists

Informs you that a working file exists.

Click OK to open the working file 

A working map file or a 
map file for which no 
working map file exists

Opens a working map file in the Visual 
Mapper

GENTRAN:Server for UNIX

IF you open� THEN GENTRAN:Server�

A map file, but a working 
map file exists

Opens the working map file.

A working map file or a 
map file for which no 
working map file exists

Prompts you to check out a working 
copy of the map or open for view only.

Click Working Copy and OK to open 
the working map file for editing. 

6 Make your changes, but do not save the changes in the editor.

7 Click File on the menu bar.

8 Click Close on the File menu.

System Response
The system closes the editor and returns to the Visual Mapper.

9 Click File on the menu bar.

10 Click Save on the File menu.
(Continued on next page)
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Editing only the
source or

destination file

Use this procedure to edit only the source or destination file. The file can be an 
application description or an implementation guide. 

11 Use this table to determine your next step.

IF you want to create the 
mapping associations� THEN continue with the topic�

With AutoMap How to Create Mapping Associations 
with AutoMap in this chapter.

Manually How to Create Mapping Associations 
Manually in this chapter.

 (Contd)
Step Action

Step Action

1 Click File on the menu bar.

2 Click Open on the File menu.

3 Click Implementation Guide or Application Description.

System Response
GENTRAN:Server (Client/Server product level and higher) displays 
a submenu for Master Directory or Working Directory. Click the 
appropriate item.

GENTRAN:Server (Workstation product level) displays a list of 
available items. 

4 Select the .app or .ig file you want to edit.

System Response

The correct editor opens and displays the selected .app or .ig file.
(Continued on next page)
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Editing both the
map and the

source or
destination files

Use this procedure to edit the map file or working map file as well as the 
application description or implementation guide file��

5 Click Save on the File menu.

Comment
These changes apply to future maps you create using the edited 
.app or .ig, but do not affect existing maps.

Reference
See the chapters Defining Application Descriptions for ASCII Files, 
Defining Application Descriptions for Databases and Creating an 
Implementation Guide or Standard in this guide for instructions.

6 Click Close on the File menu.

7 Use this table to determine your next step.

IF you want to create the 
mapping associations� THEN see the topic�

With AutoMap How to Create Mapping Associations 
with AutoMap in this chapter.

Manually How to Create Mapping Associations 
with AutoMap in this chapter.

 (Contd)
Step Action

Step Action

1 Click File on the menu bar.

2 Click Open on the File menu.

3 Click Map on the Open submenu.

4 Use the table below to determine your next response.

IF you want to open� THEN click�

A map file From Master

A working map file From Working

System Response
GENTRAN:Server then displays the File Open dialog box.

(Continued on next page)
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5  Select the map file (.vmp) you want to edit.

Note 
The Visual Mapper allows you to open only one map at a time. If 
another map is open, Visual Mapper closes it after prompting you to 
save recent changes.

System Response
GENTRAN:Server Workstation

IF you open� THEN GENTRAN:Server�

A map file, but a working 
map file exists

Informs you that a working file exists.

Click OK to open the working file.

A working map file or a 
map file for which no 
working map file exists

Opens a working map file in the Visual 
Mapper.

GENTRAN:Server for UNIX

IF you open� THEN GENTRAN:Server�

A map file, but a working 
map file exists

Opens the working map file.

A working map file or a 
map file for which no 
working map file exists

Prompts you to check out a working 
copy of the map or open for view only.

Click Working Copy and OK to open 
the working map file for editing. 

6 Open the appropriate editor by selecting the standard or application 
button.

System Response
The editor opens and displays the .app or .ig file for editing.

(Continued on next page)
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7 Using the editor, make your changes to the .app or .ig file.

System Response
The changes are made to the current map as well as the .app or .ig 
file

References
See the chapters Defining Application Descriptions for ASCII Files 
and Creating an Implementation Guide or Standard in this guide for 
editing instructions.

8 Click Save on the File menu to save the changes in the .app or .ig.

9 Click Close on the File menu to close the editor.

10 Click Save on the File menu. 

System Response

The system saves your changes in the .vmp.

11 Use this table to determine your next step.

IF you want to create the 
mapping associations� THEN see the topic�

With AutoMap How to Create Mapping Associations 
with AutoMap in this chapter.

Manually How to Create Mapping Associations 
Manually in this chapter.

 (Contd)
Step Action
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How to Create Mapping Associations with AutoMap

Introduction AutoMap provides a convenient method for creating a new map. It reads the 
source file, distills the elements that can be mapped to the destination document, 
and associates the items in the source and destination files. 

When determining possible matches, AutoMap considers several criteria, 
including the following:
◗ Name of the field or element
◗ Name of the record or segment containing the item
◗ Loop structure.

Before you begin If you plan to use a thesaurus list, you must create the list prior to AutoMapping.

Reference
See the chapter Working with Synonym and Thesaurus Lists in this guide for 
instructions.

AutoMap
Options dialog

box

This illustration shows the AutoMap Options dialog box. 

(Continued on next page)
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AutoMap
Options dialog
box fields and

functions

This table describes the fields and functions of the AutoMap Options dialog box.

(Continued on next page)

Field Function

Restrict matches to 
similar data types

Matches only if the data types are the same 
(matches AN to AN types, matches R to R types).

Use the Standard�s 
additional text files

Include information from ancillary text files related 
to the Standard in use.

Match from both sides of 
the map

AutoMaps two times. Matches source items to 
destination items and then tries to match 
unmapped destinations to unmapped source 
items.

AutoMapping Thesaurus Uses a thesaurus list to match items. Enables you 
to select the names of the thesaurus lists that you 
want GENTRAN:Server to use when AutoMapping 
the active map.

Reference
See chapter Working with Synonym and 
Thesaurus Lists in this guide for information.

How certain should 
matches be?

Increases or decreases how exact a match the 
AutoMapper looks for. Low means a close match; 
high means the match must be exact.

Do you want to verify the 
matches?

Displays the following choices:

◗ Verify doubtful mappings 
◗ Verify all
◗ Verify none
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Using AutoMap
to create
mapping

associations

Use this procedure to create a map using the AutoMap feature. 

Step Action

12 Click AutoMap on the Map Items menu.

System Response
GENTRAN:Server displays the AutoMap Options dialog box.

13 Use this decision table to determine which mapping options to use.

IF you want to� THEN use�

Select one or more ways to 
match items

Match options.

Indicate the degree of 
certainty you require for 
matches

Certainty level.

Verify matches or suppress 
verification

Verify options.

Select the names of the 
thesaurus lists that you want 
GENTRAN:Server to use 
when AutoMapping the 
active map. 

A thesaurus contains lists of 
element names 
GENTRAN:Server can use 
to match items. 

AutoMapping Thesaurus. 

Select the name of a thesaurus list 
in the Available Thes. list and click 
the Move to Right button (>>) to 
place the thesaurus in the Use 
Thesaurus list. 

Reference
See the chapter Working with 
Synonym and Thesaurus Lists in 
this guide.

Comment
The number of verifications during processing is directly related to 
the certainty threshold you specify: the more certainty you require 
the more times you will see the verification messages.

(Continued on next page)
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14 Click OK.

System Response 
When the map is completed, GENTRAN:Server displays a report 
showing the percent of items mapped. Elements that were mapped 
display an M symbol. 

Example

15 Use the mini-report to check the results. 

Click an element and then click the mini-report button to see its 
mapping GROUP listing.

16 Edit the map.

Reference
See the topic Editing Maps in this chapter for instructions.

 (Contd)
Step Action
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How to Create Mapping Associations Manually 

Introduction Once you have created a new map by selecting the source and destination files, 
you can create the mapping associations. You can manually create the mapping 
associations in either tree mode or fast-entry mode.

WARNING
Do not map to control numbers.

Comment
You can use fast-entry mode to enter the source, the destination, or both. 

Reference
See Visual Mapper for a discussion of tree mode vs. fast-entry mode.

Creating
mapping

associations in
tree mode

Use this procedure to make a map in tree mode��

Step Action

1 Mark the source and destination items you want to include in a 
mapping GROUP. 

Marking
To mark items, double-click the source fields or elements and then 
double-click the destination fields or elements. You can work back 
and forth between the two sides of the window until you select all 
the items you want to include in the mapping GROUP.

CAUTION
You cannot include records and segments in mapping 
GROUPs.

2 Click the right mouse button to create the mapping GROUP. 

System Response 
The items in the mapping GROUP are designated with the M 
symbol.

If the mapping GROUP contains more than two items, 
GENTRAN:Server displays the Mapping Instructions window.

(Continued on next page)
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(Continued on next page)

3 If necessary, assign mapping instructions to the mapping GROUPs. 
To assign mapping instructions to a mapping GROUP, click the 
Mapping Instructions button.

Comments
◗ If your mapping GROUP consists of only one source element 

or field and only one destination element or field, mapping 
instructions are optional. 

◗ If the mapping GROUP contains more than two items, you 
must specify how GENTRAN:Server maps the elements or 
fields by assigning mapping instructions.

System Response
GENTRAN:Server displays the Mapping Instructions window.

Reference
See the Working with Mapping Instructions chapter in this guide for 
details.

4 Repeat Steps 1 through 3 until you have finished mapping source 
to destination items. 

5 Display the mini-report to verify your map.

Reference
See Visual Mapper Display Modes in this chapter for details on 
displaying a mini-report.

6 Click File on the menu bar.

7 Click Save on the File menu to save the map.

System Response
GENTRAN:Server saves your file with the extension .vmp. 

8 Edit the map.

Reference
See Editing Maps in this chapter for instructions.

 (Contd)
Step Action
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Creating a
mapping

association in
fast-entry mode

Use this procedure to create mapping associations in fast-entry mode��

Step Action

1 Display the fast-entry text boxes for the source and destination 
files. 

◗ Click Source/Fast Entry on the Mode menu. 
◗ Click Destination/Fast Entry on the Mode menu. 

2 Use the fast-entry text boxes to enter information about the 
mapped items.

Navigational Information
Use the TAB key to move from one box to the next box and the 
SHIFT+TAB keys to move from one box to the previous box.

Option
To use item labels, click Use LABELS.

3 When you are finished, click ENTER to make the mapping GROUP.

4 Repeat Steps 2 and 3 until you finish mapping source to destination 
items. 

5 Return to Tree mode.

6 If necessary, assign mapping instructions to the mapping 
GROUPs. To assign mapping instructions to a mapping 
GROUP, click the Mapping Instructions button. 

Comment
◗ If your mapping GROUP consists of only one source element 

or field and only one destination element or field, mapping 
instructions are optional. 

◗ If the mapping GROUP contains more than two items, you 
must specify how the elements or fields are to be mapped by 
assigning mapping instructions.

System Response
GENTRAN:Server displays the Mapping Instructions window.

Reference

See the Working with Mapping Instructions chapter in this guide for 
details.

(Continued on next page)
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7 Display the mini-report to verify your map.

Reference

See Visual Mapper in this chapter for details on displaying a mini-
report.

8 Click File on the menu bar.

9 Click Save or Save As on the File menu.

System Response

GENTRAN:Server saves your file with the extension .vmp. 

10 Edit the map.

Reference

See Editing Maps in this chapter for instructions.

 (Contd)
Step Action
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Editing Maps

Introduction If the layout of your source file has changed, you need to update the Application 
Description in the map. If the map is not producing the results you want, you must 
change source or destination information in the map.

You can use the Visual Mapper to edit a map in several ways. You can:
◗ Edit source or destination information
◗ Edit source or destination files 
◗ Edit mapping GROUPs
◗ Edit mapping instructions.

Where to go
from here

Use this table to decide which procedure to follow next. 

IF you want to edit... THEN see the topic...

Source or destination 
information

How to Tailor Source or Destination Information 
in this chapter.

Mapping GROUPs How to Edit Mapping GROUPs in this chapter.

Mapping Instructions Working with Mapping Instructions in this guide.
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How to Edit Mapping GROUPs 

Introduction You can use the Visual Mapper to change your mapping GROUPs. You can 
perform the following changes:
◗ Add a mapping GROUP
◗ Delete a mapping GROUP
◗ Add an item to a mapping GROUP
◗ Delete an item from a mapping GROUP.

Note
You must compile your map after editing and check in or approve the working file 
for the changes to take effect during translation.

Displaying the
map

To display the map, follow this procedure.

Step Action

1 Click File on the menu bar.

2 Click Open on the File menu.

3 Click Map on the Open submenu.

4 Use the table below to determine your next response.

IF you want to open� THEN click�

A map file From Master

A working map file From Working

System Response
GENTRAN:Server then displays the File Open dialog box.

5  Select the map file (.vmp) you want to edit.

Note 
The Visual Mapper allows you to open only one map at a time. If 
another map is open, Visual Mapper closes it after prompting you to 
save recent changes.

(Continued on next page)
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Adding a
mapping GROUP

Use this procedure to add a mapping GROUP.  

System Response
GENTRAN:Server Workstation

IF you open� THEN GENTRAN:Server�

A map file, but a working 
map file exists

Informs you that a working file exists.

Click OK to open the working file 

A working map file or a 
map file for which no 
working map file exists

Opens a working map file in the Visual 
Mapper

GENTRAN:Server for UNIX

IF you open� THEN GENTRAN:Server�

A map file, but a working 
map file exists

Opens the working map file.

A working map file or a 
map file for which no 
working map file exists

Prompts you to check out a working 
copy of the map or open for view only.

Click Working Copy and OK to open 
the working map file for editing. 

 (Contd)
Step Action

Step Action

1 In the source and destination descriptions, double-click the fields or 
elements you want to include in the mapping GROUP.

2 Click Make GROUP on the Map Items menu.
(Continued on next page)
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Deleting a
mapping GROUP

Use this procedure to delete a mapping GROUP.  

Adding an item
to a mapping

GROUP

Use this procedure to add a field or element to a mapping GROUP.  

(Continued on next page)

Step Action

1 Examine the map mini-report to find the mapping GROUP that you 
want to delete.

2 Click the mapping GROUP number you want to delete.

3 Click Map Items on the menu bar.

4 Click Group/Delete on the Map Items menu.

System Response
GENTRAN:Server displays a confirmation prompt.

Note
Deleting a mapping GROUP removes the map association; it does 
not delete the source or destination fields or elements.

5 Click YES to confirm the deletion.

Step Action

1 Examine the map mini-report to find the mapping GROUP to which 
you want to add an item.

2 Click the mapping GROUP.

3 Click Map Items on the menu bar.

4 Click Group/Add Item to GROUP on the Map Items menu.

System Response
GENTRAN:Server displays the Add Item to GROUP dialog box.

5 Type the label of the item you want to add and click OK.
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Deleting an item
from a mapping

GROUP

 Use this procedure to delete a field or element from a mapping GROUP.  

Recompiling You must recompile the map any time you make changes to it.

Reference
See Compiling Maps in this chapter for instructions.

Step Action

1 Click the item you want to delete from a GROUP.

2 Display the mini-report, then click the item in the mini-report.

3 Click Map Items on the menu bar.

4 Click Group/Ungroup on the Map Items menu.

System Response
GENTRAN:Server prompts you to confirm the deletion.

Note
Deleting an item from a mapping GROUP removes it from the map 
association; it does not delete the source or destination field or 
element.
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Compiling Maps

Introduction After you create and edit a map, you must compile it before using it to translate 
data. When you change a map, you must also save and recompile it. 

Map files and
mapping tables

When you create a map, GENTRAN:Server creates a map file (.vmp). When you 
compile the map, GENTRAN:Server creates a Mapping Table (.TBL). 
GENTRAN:Server uses only the mapping table file during data translation. 

When you make changes to the map, GENTRAN:Server updates only the .vmp 
file. You must recompile in order to update the .TBL file.

Working map
files and

mapping table
files

When you compile a map, GENTRAN:Server creates a working mapping table file 
(<mapname>.TBL) in the working .TBL directory.

You should test the working .TBL file to be sure it works as intended. When you 
know the working mapping table is correct, you can replace both the original map 
file and mapping table file with the working versions. 

Reference
See the GENTRAN:Server for UNIX and Workstation Getting Started Guide for 
information.

Choosing to
compile for
Windows or

UNIX platforms

You can compile maps for either Windows or UNIX. If you have both Windows and 
UNIX versions of GENTRAN:Server, you can create maps on one platform and 
compile them for use in translation on the other platform. The list in the Compile 
Map dialog box enables you to choose the platform for which to compile the map. 

Use these guidelines when you have a platform choice:

◗ Compile maps for the platform on which you intend to translate, not the 
platform used to edit the maps

◗ You must move the map file or working map file and then compile the map on 
the destination platform. 

(Continued on next page)
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How the
compiler orders

mapping
instructions

The map compiler sorts mapping instructions and places them into a default order. 
This table describes the compiler�s sorting process.

Comment
A map created on versions of GENTRAN:Server prior to version 1.5 may be 
executed differently under this version.

Two methods There are two ways to compile maps:

◗ Compile the open map from inside the Visual Mapper
◗ Compile multiple closed maps from the GENTRAN:Server main window. 

(Continued on next page)

Stage Description

1 The compiler lists all mapping instructions sequentially, starting with 
the first record/segment and ending with the last record/segment.

2 The compiler looks at the mapping instructions for each source 
record/segment and arranges them in the order in which to execute 
them during translation.

Ordering criteria
The compiler uses the following criteria to order the mapping 
instructions for each source record/segment:

◗ The group number, lowest to highest
◗ The mapping instruction screen order, last to first
◗ Within a mapping instruction screen, the order in which the 

mapping instructions were encountered
◗ The order of the items in the source record/segment.

Note
If a mapping instruction spans multiple records, the mapping 
instruction for the first record is not executed until it receives all its 
source items.
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Where to go
from here

Use this table to decide which procedure to follow next. 

IF you want to compile... THEN see the topic...

Only the open map How to Compile the Open Map in this chapter.

One or more closed maps How to Compile Closed Maps in this chapter.
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How to Compile the Open Map

Introduction You can compile the open map from the Visual Mapper.

Compiling the
open map

Use this procedure to compile the open map. 

Step Action

1 Click File on the menu bar.

2 Click Save on the File menu to save changes to the map.

3 Use this table to decide how to compile.

IF you want to... THEN...

Choose the platform a) Click Compile Maps on the File 
menu to display the Compile 
Visual Map dialog box.

b) Select the platform from the 
Compile for platform list.

c) Click OK to display the Select 
Maps To Compile dialog box.

d) Select a map from the 
Available Maps list or click 
Compile all Maps and OK.

e) Click on the double right arrows 
to move the selected map to the 
Maps to Compile box.

f) Repeat Steps F and G until all 
maps are selected.

g) Click OK.

Use the platform set 
in preferences

Click the Compile button on the Visual 
Mapper toolbar.

System Response
The Compiler Messages window opens and displays status, 
warning, and error messages about the compilation.

8 Click OK to close the Compiler Messages window.
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How to Compile Closed Maps

Introduction You can compile single or multiple closed maps from the GENTRAN:Server main 
window. You can compile: 
◗ All maps in a specified directory
◗ Only the maps you specify. 

The Compile
Maps dialog box

This illustration shows the Compile Maps dialog box.

(Continued on next page)
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The Select Maps
to Compile
dialog box

This illustration shows an example of the Select Maps To Compile dialog box. 

Compiling
closed maps

Use this procedure to compile closed maps. 

Step Action

1 Click Compile Maps on the Translate menu.

System Response
GENTRAN:Server displays the Compile Visual Maps dialog box.

2 Select a compiling option to indicate whether you want to compile 
all map files in the specified directory or only ones you select:

◗ SELECT Maps To Compile
◗ Compile ALL Map Files

3 From the Compile for platform drop-down list, select the platform 
on which you intend to translate data.

4 Click OK.

System Response 
The system displays the Select Maps To Compile dialog box.

(Continued on next page)
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5 Did you select the SELECT Maps To Compile option in Step 2?
◗ If YES, continue with the next step.
◗ If NO, (you selected the Compile ALL Map Files option), 

GENTRAN:Server starts compiling the maps. GO TO Step 8.

6 Move the maps you want to compile from the Available Maps 
column to the Maps to Compile column.

IF you want to... THEN Click...

Select individual maps The maps in the Available Maps 
column and then click the (>>) button.

Deselect individual maps The maps in the Maps to Compile 
column and then click the (<<) button.

Select all maps Select All.

Deselect all maps Put All.

7 Click OK.

System Response 
The system opens the Compiler Messages window. This window 
displays status, warning, and error messages about the 
compilation.

8 Do you want to print the messages in the Compiler Messages 
window?

◗ If YES, click Print.
◗ If NO, continue with the next step.

9 Click OK to close the Compiler Messages window.

 (Contd)
Step Action
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How to Delete Maps 

Introduction GENTRAN:Server enables you to delete the map files or working map files you 
are no longer using.

CAUTION
When you delete a map, GENTRAN:Server deletes all files 
comprising the map; the corresponding .vmp, .TBL, .idx, and .dat 
files.

Deleting maps Use this procedure to delete maps.  

Step Action

1 Click File on the menu bar.

2 Click Delete/Map on the File menu.

System Response 

GENTRAN:Server displays the File Delete dialog box.

3 From the scroll list, select the name of the map file or working map 
file you want to delete.

System Response 
GENTRAN:Server displays the file name in the File Name text box.

4 Click Open.

System Response 
GENTRAN:Server displays a confirmation prompt.

5 Click Yes to confirm that you want to delete the file.

System Response 
GENTRAN:Server deletes the following files:

◗ <mapname>.vmp 
◗ <mapname>.TBL (if you have compiled the map)
◗ <mapname>.idx and <mapname>.dat files (which contain 

specific synonym lists, if any).
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How to Print a Mapping Report

Introduction A mapping report provides a printed report that describes how a map was built, 
and what its source and destination links consist of. Accessed through the Visual 
Mapper, mapping reports are most useful to troubleshoot incorrect mapping.

Types of
mapping reports

The two types of mapping reports are the Mapping Report and the Macros Report. 
Both types allow users to easily view information contained within a map.

Mapping Report
A Mapping Report displays all mapping information. Used more commonly than 
the Macros Report, a Mapping Report contains information sorted by source or 
destination and is arranged by field or element headings.

Macros Report 
A Macros Report displays mapping information including macros. This report also 
allows a user to choose to print mapping instructions and discarded items in 
addition to mapped items.

Print menu
diagram

This is an illustration of the GENTRAN:Server Workstation Print menu. You print 
both types of mapping reports from this menu.

(Continued on next page)
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Printing a
mapping report

Use this procedure to print a mapping report.

Step Action

1 Open the map you want to print.

2 Click File on the menu bar.

3 Click Print on the File menu.

System Response
The Print menu displays the following submenus: 

4 Indicate whether you want to print a Mapping Report or a 
Macros Report.

IF you want to print a... THEN click...

Mapping Report Mapping Report.

Macros Report Macros Report.

System Response
The system displays the Sort By... submenu.

(Continued on next page)
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5 Indicate whether you want the Mapping Report ordered by 
source or by destination.

IF you want to sort the 
report by... THEN Click...

Source items Sort by Source.

Destination items Sort by Destination.

System Response
If you are printing the Mapping report, GENTRAN:Server 
sends the Mapping Report to the default printer and the 
process is complete.

If you are printing the Macro report, GENTRAN:Server 
displays the Print Macros Report dialog box. Continue with 
Step 6.

6 From the Print Macros dialog box, select your printing 
preferences for a Macros Report.

(Continued on next page)

 (Contd)
Step Action
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(Continued on next page)

IF you want to print the... THEN Select...

Mapped items only Mapped Items Only.

Note 
The Include Discard option is 
unavailable if you select 
Mapped Items Only.

System Variable Mapping 
items only

Only System Variable 
Mappings.

Note
All other options are unavailable 
if you select Only System 
Variable Mappings.

Mapping instructions and 
the mapped items

Include Mapping Instructions.

Discarded items and the 
mapped items

Include Discarded Items.

Note 
The Include Discarded Items 
option is unavailable if you 
select Mapped Items Only.

6 Click OK.

System Response 
GENTRAN:Server sends the Macros Report to the default 
printer.

 (Contd)
Step Action
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Mapping Report
fields and
functions

This table describes the fields and functions used in a Mapping Report. 

(Continued on next page)

Field Function

DESCRIPTION Describes the segment/element.

DEST Indicates a destination item.

FORMAT Describes the field format.

LEN Indicates the length of the destination field.

LOOP Indicates the record ID of the segment positioned at the head 
of the loop. 

M Indicates whether the record is mandatory (M), optional (O), 
conditional (C), floating (F), or relational (X).

MAX Indicates the maximum length of the source field.

MAX U Indicates the maximum number of times the record can occur 
within the map (sorted by source).

Note
If the record is positioned at the head of a loop, MAX U 
indicates the number of times the loop can occur.

MIN Indicates the minimum length of the source field.

NAME Indicates the name of the record.

Rec/Fld Indicates that the record name and field number is part of an 
application description.

SRC Indicates a source item.

Seg/Elem Indicates the segment name and element sequence number 
is part of an implementation guide.

SEQ Indicates the application record sequence number.

START Indicates the character position that the destination field data 
starts at within the record.

TYP Indicates the type of data.
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Mapping Report
example

This diagram illustrates a portion of a Mapping Report.

Note 
This report is sorted by the identified field labels (Seg/Elem or Rec/Fld) on the left 
side of the report.

Macros Report
example

This diagram illustrates a portion of a Macros Report.

Note 
This report is sorted by source, as indicated by item S306 in bold type. Macros are 
referenced to GROUP275.

SEQ   M REC ID           LOOP     MAX U DESCRIPTION
SEQ   M REC ID           LOOP     MAX U DESCRIPTION
  SEQ M Seg/Elem SRC TYP FORMAT MIN MAX NAME                    SEQ   M Rec/Fld  DEST  NAME          
0001  M ST                            1 Carrier Details
 0001 M ST:1     S1  ID  LK       3   3 TRANSACTION    SET ID
 0001 M ST:2     S2  AN  LK       4   9 TRANS SET   CONTROL NO

0002  M B3                            1 Beginning Segment For
 0002 O B3:1     S4  ID  LK       3   3 TRANSACTION    SET ID    0002 O B3:2     D6    TRANSLATION   
                                        MAP S4 TO D6

 0002 M B3:2     S5  AN  LK       1  22 INVOICE       NUMBER     0002 M B3:3     D7    INVOICE       
                                        MAP S5 TO D7

 0002 C B3:3     S6  AN  LK       1  30 SHIPMENT ID NUMBER (SID) 0002 C B3:4     D8    SHIPMENT ID   

__________________________________________________________
S306    SE : 002  - TRANS SET    CONTROL NO

    D346    SE : 002  - TRANS SET    CONTROL NO   GROUP398

                MAP S306 TO D43
__________________________________________________________
**********************************************************
Macros for the map:
__________________________________________________________

     Macros     in GROUP275

         M1
         [  portion of text S4 starting at position 1 for 4 characters ; ]
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Mapping Instructions 
Basics 0

Overview

Introduction You can create custom mapping instructions to have GENTRAN:Server perform 
special operations on data during translation. 

You enter these instructions on the Mapping Instructions dialog box.

Key terms This table lists the key terms used in this chapter.  

Term Description

alphanumeric expression An expression that results in alphanumeric data. 
Also called a string expression.

arithmetic expression An expression that results in numeric data.

AutoMap The GENTRAN:Server feature that compares 
specified source and destination files and maps 
items between them based on criteria such as field 
or element name, record or segment name, and loop 
structure. 

conditional expression A complete WHEN expression that may be part of a 
longer condition.

logical expression An expression that results in a logical value; either 
false (=0) or true (not=0).

macro A collection of commands used within 
GENTRAN:Server to simplify and organize mapping 
instructions.

Map File The <mapname>.vmp file containing a defined map.

mapping association The process of associating data fields or elements in 
your source document to corresponding data fields 
or elements in your destination document.

(Continued on next page)
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Basic concepts Keep in mind the following basic concepts.

◗ Each mapping GROUP can have many mapping instructions.
◗ Each mapping instruction must contain a mapping expression. It may contain 

a conditional expression. Both the mapping expression and the conditional 
expression may contain one or more macros (collections of commands).

◗ Depending on the kind of operator and values used, the result of an 
expression can be a numeric value, an alphanumeric string, or a comparison 
of two items (a true or false evaluation).

◗ You can also create macros to simplify and organize mapping instructions. 

Reference
See the How to Create Macros topic in this chapter for more information on 
creating and using macros.

(Continued on next page)

mapping condition Qualifying term used in some mapping instructions 
to indicate when the mapping part of the instruction 
should be performed and when it should be ignored. 
Mapping conditions begin with WHEN.

mapping expression A complete �Map to� expression that may be part of 
a longer mapping instruction.

mapping GROUP A specific mapping association between source and 
destination data.

mapping instruction A set of information that controls special operations 
on mapped data during translation.

Visual Mapper The GENTRAN:Server window on which you create 
a map. The Visual Mapper displays the source 
document on the left side of the window and the 
destination document on the right.

 (Contd)
Term Description
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Mapping
instruction types

This table lists the types of mapping instructions.

Mapping instruction type Description

condition Controls when the mapping instruction is 
applied.

substitution Replaces a value in the source field or element 
with another value (synonym).

evaluated expression Evaluates any valid set of operators, variables, 
numbers, strings, and/or functions that 
GENTRAN:Server can reduce to a single 
result.
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Mapping Instructions Dialog Box

Introduction The GENTRAN:Server Mapping Instructions dialog box has everything you need 
to create mapping instructions for the mapping GROUPs you select.

Mapping
Instructions

dialog box

This illustration shows the Mapping Instructions dialog box. 

Mapping
Instructions

dialog box fields
and functions

This table describes the fields and functions of the Mapping Instructions dialog 
box.

Mapping

Condition�
box

box

Source�
box

Destination �
box

Operations�
box

Macro
box

Field Function

Source box Lists the source items in the GROUP. 

Destination box Lists the destination items in the GROUP. 

Comment
The source and destination lists indicate the items by 
label rather than name or ID. They are not in any 
particular order.

(Continued on next page)
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Mapping
Instructions

push-buttons

This table describes the Mapping Instructions buttons available.

Mapping Instruction 
buttons

Activate special features for the mapping instructions. 
See the next topic for more information. 

Condition box Serves as a place for constructing conditions. 

Mapping box Servers as a place for constructing and displaying 
mapping instructions for the current mapping GROUP. 

Macro box Serves as a place for constructing a macro. 

This area is active only when you click Macro. 

Operations box Lists operations available in valid syntax. 

You can select items from the operations lists to enter 
the mapping instructions. 

Reference
See the Using Operators topic in the Mapping chapter 
of this guide for a list of operators and descriptions of 
their use.

 (Contd)
Field Function

Button Function

Makes a new mapping screen.

Accesses the previous mapping screen for the 
GROUP.

Accesses the next mapping screen for the GROUP.
(Continued on next page)
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Opening the
Mapping

Instructions
dialog box

The Mapping Instructions dialog box opens automatically whenever you create a 
mapping GROUP that contains more that two items. If you want to assign 
mapping instructions to a one-item mapping GROUP, you can click the Mapping 
Instructions (MI) button while the focus is on the source item.

Standard and
expert entry

modes

GENTRAN:Server provides two levels of proficiency (standard and expert) for 
working with mapping instructions. You set the mode in the Preferences option of 
the Settings menu.
◗ The standard mode is the default entry mode. You select statements and 

values from lists that the Mapping Instructions dialog box displays. This helps 
ensure that the syntax is correct and that the instructions are meaningful. 

◗ When you work in expert mode, you type instructions directly into dialog 
boxes. You have at hand more extensive expressions and a more powerful 
syntax, but the potential for making errors is greater. 

Comment
If you create a mapping GROUP in expert mode, GENTRAN:Server automatically 
places you in expert mode when you begin editing the mapping GROUP. 

Deletes the currently displayed mapping instruction.

Note 
◗ To delete an individual conditional expression, a 

mapping expression, or a macro, select it and 
press DELETE. 

◗ To delete a part of an expression or macro, click 
the Edit button to go into edit mode, select the 
part to delete, and press DELETE.

Permits editing of the current condition or 
expression.

Button Function
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Rules for Mapping Instructions 

Introduction When including instructions with a mapping GROUP, consider this list of rules.

These rules are assigned to the following categories:
◗ General rules
◗ Conditional expressions
◗ Operations
◗ Characters
◗ Macros.

Comment
We recommend that you read all of the rules before you begin creating mapping 
instructions and refer to them as necessary.

General rules This section lists some general rules for creating mapping instructions:

◗ A mapping GROUP can have multiple mapping instructions.
◗ A mapping instruction can have one or more mapping expressions.
◗ A mapping expression can contain more than one destination item.
◗ A single map can contain up to 1,000 system variables.
◗ A mapping expression can contain more than one source item.

Conditional
expressions

This section lists rules that apply to the use of conditional expressions in mapping 
instructions:
◗ A mapping instruction can multiple conditional expressions or none at all.
◗ You can link multiple conditional expressions by ANDs or ORs within the 

same mapping instruction.
◗ GENTRAN:Server completes the parts of a conditional expression enclosed 

in parentheses first.
◗ The AND or OR button determines whether multiple conditional expressions 

are linked by an AND or an OR (click the appropriate button to change from 
AND to OR or vice versa).

◗ In expert mode, there can be conditions linked by both ANDs or ORs within 
the conditional expression.

(Continued on next page)
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◗ In a conditional expression or a mapping expression, GENTRAN:Server 
executes all zero-argument or one-argument operations first.

◗ In a conditional expression or a mapping expression, GENTRAN:Server 
executes all two-argument operations after it executes all zero-argument or 
one-argument operations.

◗ In a conditional expression or a mapping expression, GENTRAN:Server 
executes all other operations after it executes all zero-argument or one-
argument operations and two-argument operations.

Comment
The order of execution stated above is the default sort order. You can use the 
Sorting Utility if you want GENTRAN:Server to execute the instructions in a 
different order.

Reference
See the Troubleshooting Mapping Instructions topic in this guide more information 
about sorting instructions.

Operations These rules apply to the use of operations in mapping instructions:
◗ Within the same priority level, multiplication (*) and division (/) operations 

have a higher priority than addition (+) and subtraction (-) operations.
◗ Enclose the parts of the expression you want GENTRAN:Server to execute 

first in parentheses.
◗ When two or more mapping expressions use the Sum Over Loop mapping 

operator and have the same destination, enclose each mapping expression in 
a separate mapping instruction.

◗ When two or more mapping instructions with the Sum Over Loop mapping 
operator have the same destination, GENTRAN:Server creates a copy of the 
segment containing the element that receives the sum.

◗ In expert mode, you can nest all operations as long as the data type returned 
by the inner operation matches the data type of the argument of the outer 
operation.

Characters These rules apply to the use of characters in mapping instructions: 
◗ The maximum length of a single conditional expression, mapping expression, 

or macro is 499 characters.

(Continued on next page)
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◗ The following characters are invalid as part of a text string, a synonym list 
name, a system variable name, and in a mapping expression, a condition, or 
a macro:
� Backslash (\)

� Double quotes (")

� Single quotes (')

◗ The following characters are invalid as part of a number or other value in a 
mapping expression, a condition, or a macro:
� Backslash (\)

� Double quotes (")

� Single quotes (')

� Pound sign (#)

� Percent sign (%)

� Ampersand (&)

� Apostrophe (')

� Comma (,)

� Parentheses (( ))

� Tilde (~)

Macros These rules apply to the use of macros in mapping instructions:

◗ Mapping instructions and conditions can both use macros.
◗ Macros cannot include any destination label.
◗ Macros cannot include the commands MAP or MAP TO. 
◗ Only one mapping GROUP can use a specific macro (although you can 

redefine the same action in macros in two or more mapping GROUPs).
◗ Two or more mapping expressions or conditional expressions in the same 

mapping instruction can use the same macro.
◗ A mapping GROUP can use up to 99 macros.
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Instruction Options (Standard Mode)

Introduction In standard mode, you select statements and values from lists that the Mapping 
Instructions dialog box displays.

Instruction
options table

Use this table to determine which mapping instructions to use.

Use this instruction... To perform this action...

conditional operations Describe the conditions under which the 
mapping(s) apply.

arithmetic operations Specify one of several mathematical 
operations. 

string operations Specify one of several character operations.

enter destination Specify the destination field or element by 
clicking on the appropriate label. (Labels for 
destination items begin with �D�.)

enter source Specify the source field or element by clicking 
on the appropriate label. (Labels for source 
items begin with �S�.)

enter macro Specify the desired macro by clicking it in the 
displayed list.

enter name Open a dialog box into which you type a 
synonym list name.

enter number Open a text box into which you type an integer 
or decimal number.

enter system variable name Open a text box into which you type the name 
of a system variable. Naming the system 
variable automatically creates it.

enter text Open a text box into which you type 
characters.
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Mapping Instruction Examples

Introduction This section contains illustrations that show you how GENTRAN:Server displays 
mapping instructions and two examples of using mapping instructions to control 
data translation.

Example
illustration

This illustration shows sample mapping instructions as they appear in the 
Mapping Instructions dialog box. 

Example 1 In this example, assume you have an application that contains the following 
record:

You want to map that information to the elements in the following segment in an 
X12 2040 810 document (invoice): 

(Continued on next page)
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You use this map to invoice two different trading partners, and you have a list of 
department numbers and names (descriptions) for each trading partner, listed by 
Trading Partnership Code. 

Therefore, the mapping GROUP consists of S31, S33, D96, D97, and D98. These 
are the labels of the fields or elements in the mapping GROUP. The map displays 
labels to the left of each field or element name. The mapping instructions are: 

(Continued on next page)

TP Code 
(S31)

Department Number 
(S33)

Department Name 
(D98)

SellMore810 10 Accounting

20 Finance

AlsWows810 9 Accounts Payable

10 Treasurers Office

Mapping instruction Description

MAP 'DP' TO D96 Defines the Reference Number Qualifier 
as DP, since this is the code for 
Department Number used in this element 
in the 2040 standards. This is not part of 
the data.

MAP S33 TO D97 Maps the Department Number to the 
Reference Number.

WHEN S31 equals 'SellMore810' 
And S33 = 10, MAP 'Accounting' to 
D98

WHEN S31 equals 'SellMore810' 
And S33 = 20, MAP 'Finance' to 
D98

Specifies the correct description for the 
department number when the Trading 
Partnership Code is �SellMore810�. 

These mapping instructions define the 
correct information. Although the user 
knows this information, it is not in the 
data.

WHEN S31 equals 'AlsWows810' 
And S33 = 9, MAP 'Accounts 
Payable' to D98

WHEN S31 equals 'AlsWows810' 
And S33 = 10, MAP 'Treasurers 
Office' to D98

Specifies the correct description for the 
department when the Trading Partnership 
Code is �AlsWows810�. 

These mapping instructions define the 
correct information. Although the user 
knows this information, it is not in the 
data.
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Example 2 In this example, assume you have an application that contains the following 
record: 

You want to map the Quantity field to the Quantity Ordered element. You also 
want to use the data in the Unit Price field to map the correct value to the Unit 
Price element in the following segment in an X12 2010 850 document (purchase 
order): 

Mapping the Unit Price value is not as simple as it seems. The seller gives a 10% 
discount to customers if they buy over 1000 of any particular product. Therefore, 
the correct unit price for any particular product depends upon the quantity 
ordered.

The mapping GROUP consists of S21, S24, D306, and D308. The mapping 
instructions are: 

Mapping instructions Description

MAP S21 TO D306 Maps the Quantity field value to the Quantity 
Ordered element.

WHEN S21 < 1000, MAP S24 
TO D308

Maps the Unit Price field value to the Unit 
Price element for products ordered in 
quantities of less than 1000.

WHEN S21 >= 1000, MAP 
(S24*.90) TO D308

Multiplies the Unit Price field value by .90 
(100% - 10%) and maps that value to the Unit 
Price element for products ordered in 
quantities of 1000 or more.
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System Variables in Mapping Instructions

Introduction You can use the mapping operator Enter System Variable Name to create your 
own system variables for use in GENTRAN:Server and to map to or from them. 
This option is available in both standard and expert mode.

When you might
use system

variables

You can use system variables for calculations to increment or combine values. 
System variables also provide a method for storing data for later or repeated use. 
This reserves a place in memory to store data that GENTRAN:Server will use 
when translating the transaction set. 

Example
You may want to save a value received in the first iteration of a loop and use it 
after other iterations of the loop are complete.

WHEN $VARA = 1 MAP $VARA TO $VARB

How system
variables are

created

When you are in standard mode and select the Enter System Variable Name 
operator, the Enter System Variable Name dialog box opens. You then enter the 
desired variable name and click OK.

How system
variable values

are assigned

You automatically create the system variable when you map or assign a value to 
it. The system variable retains the value you assign until you change it or the map 
ends. Each time GENTRAN:Server begins to translate using a new map, it resets 
the values of the system variables to null.

The new value overwrites any previous value for the system variable(s). You must 
use a condition referring to one or more source items if the mapping statement 
does not include one. 

System variable
name

You assign the variable name. It must be from two to twenty alphanumeric 
characters (including the dollar sign).

(Continued on next page)
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Dollar sign ($)
marks a system

variable

A dollar sign ($) precedes the variable name to identify it as a system variable. 
When creating mapping instructions in standard mode, GENTRAN:Server 
automatically adds this dollar sign when you enter the name of the system 
variable. In expert mode, however, you must remember to type the dollar sign just 
before the variable name with no intervening spaces.
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Sort Mapping Instructions Utility

Introduction You can use the Sort Mapping Instructions Utility to view and change the order in 
which GENTRAN:Server executes mapping instructions set for source records or 
segments.

When to use the
Sort Mapping

Instructions
Utility

You can use the Sort Mapping Instructions Utility when:
◗ You need to learn the current order of the mapping instructions for the items in 

a particular record or segment.
◗ The mapping instructions in the map use one or more system variables.
◗ The Diagnostics Report indicates that you need to change the order of the 

mapping instructions.

Reference 
Refer to the chapter Troubleshooting Mapping Instructions in this guide for 
detailed instructions on using the Diagnostics Report and the Sort Mapping 
Instructions Utility.

The Default Sort
Order

During translation, GENTRAN:Server executes mapping instructions in the order 
set during map compilation.

The map compiler first lists all mapping instructions for the first record or segment, 
then lists all mapping instructions for the next record or segment and so on, until it 
lists all records or segments.

The map compiler next looks at the mapping instructions for each source record 
or segment and arranges them in the order in which it will execute them during 
translation. The map compiler uses the following criteria to order the mapping 
instructions:

◗ The group number, lowest to highest
◗ The mapping instruction screen order, last to first
◗ Within each mapping instruction screen, the order in which the mapping 

instructions were encountered
◗ The order of the items in the source record or segment.

Note
If a mapping instruction spans multiple records, the mapping instruction for the 
first record is not executed until all source items are received.
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Mapping Operators 0

Using Operators 

Introduction Operators are symbols that denote mathematical operations. These are useful 
tools for creating special mapping instructions for GENTRAN:Server to use during 
translation. 

This chapter contains descriptions, explanations, and examples of each operator 
you can use to complete mapping instructions and statements in 
GENTRAN:Server. 

The Operators Use this table to learn more about operators that you can use in 
GENTRAN:Server mapping instructions and statements.

Notes
◗ You can use a system variable in place of a source field or element.
◗ Shading indicates that the operator is available only in expert mode.    

Use this 
operator... To perform this action...

+ Add two numbers or values.
EXP1 + EXP2

Where: EXP1=Either a source field or element of 
numeric data type or an arithmetic 
expression

EXP2=Either a source field or element of 
numeric data type or an arithmetic 
expression

/ Divide two numbers or values.

EXP1 / EXP2

Where: EXP1=Either a source field or element of 
numeric data type or an arithmetic 
expression 

EXP2=Either a source field or element of 
numeric data type or an arithmetic 
expression

(Continued on next page)
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- Determine the difference between two numbers or values.
EXP1 - EXP2

Where: EXP1=Either a source field or element of 
numeric data type or an arithmetic 
expression

EXP2=Either a source field or element of 
numeric data type or an arithmetic 
expression

* Multiply two numbers or values.

EXP1 * EXP2

Where: EXP1=Either a source field or element of 
numeric data type or an arithmetic 
expression

EXP2=Either a source field or element of 
numeric data type or an arithmetic 
expression

= Compare two expressions to see if their values are equal.
EXP1 = EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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<> Compare two expressions to see if their values are 
unequal.

EXP1 <> EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

<= Determine if the value on the left is either less than or 
equal to the value on the right.

EXP1 <= EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

>= Determine if the value on the left is either greater than or 
equal to the value on the right.

EXP1 >= EXP2

Where: EXP1=Either a source item of numeric or 
alphanumeric data type or an 
arithmetic or alphanumeric expression

EXP2=Either a source item of numeric or 
alphanumeric data type or an 
arithmetic or alphanumeric expression

Note
This operation can be used only in a condition.

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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< Determine if the value on the left is less than the value on 
the right.

EXP1 < EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

> Determine if the value on the left is greater than the value 
on the right.

EXP1 > EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

( ) Specify the order in which operations are performed in 
mathematical expressions. 

In nested parenthetical expressions, operations are 
performed first in the innermost parentheses.

Example

In the following expression, the negative value of S1 is 
added to the product of S2 and S3:

-S1+(S2*S3)

In the following expression, the negative of the sum of S1 
and S2 is multiplied by S3:

-(S1+S2)*S3

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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& Concatenate two strings into one.
EXP1 & EXP2

Where: EXP1=Either a source field or element of 
alphanumeric data type or an 
alphanumeric expression

EXP2=Either a source field or element of 
alphanumeric data type or an 
alphanumeric expression

Example

The mapping operation
'ABC' & 'EFG' 

produces 'ABCEFG'.

all in loop Evaluate as true if all occurrences of the source field or 
element in the document contain data that satisfies the 
expression.

all [in loop] ITEM1 such [that] EXP1

Where: ITEM1=A source field or element
EXP1=A logical expression

Note
◗ Text in brackets is optional when in expert mode.
◗ This operation can be used only in a condition.

and Evaluate two expressions to determine if both of the 
expressions are true.

EXP1 and EXP2

Where: EXP1=A logical expression
EXP2=A logical expression

Example
When S11 = �required�

and S12 = �mandatory�

Note
This operation can be used only in a condition.

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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count over 
source loop 

Count the number of times that a field or element occurs in 
the source loop.

count [over source loop] ITEM1

Where: ITEM1= A source field or element of 
alphanumeric data

Note
Text in brackets is optional in expert mode.

data found in Evaluate as true if the field or element contains data.

data found in <ITEM1>

Where: ITEM1=A source field or element

The mapping operation data found in evaluates as true if 
the present occurrence of the field or element ITEM1 
contains data.

Note
◗ This operation can be used only in a condition.
◗ GENTRAN:Server considers an item containing all 

blanks to not contain data.
◗ GENTRAN:Server considers an item containing all 

nulls to contain no data. In implementation guides and 
variable length application descriptions, two 
consecutive field delimiters bracket an item containing 
null data. In a fixed length application description, 
blanks are used to indicate no data for a field. 

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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decrement 
date_time 

Subtract a specified value from the current date or time 
item.

decrement [date_time] EXP1 by EXP2

Where: EXP1=Either a source field or element with a 
date-time data type or a date-time 
expression

EXP2=Either a source field or element with a 
numeric data type or an arithmetic 
expression

The mapping operation decrement date_time subtracts 
EXP2 from the lowest-order units in EXP1, carrying over to 
the next higher-order units after all lowest-order units are 
subtracted. In other words, if the date is in year-month-day 
format and 500 days are subtracted, the months, and the 
years will be decreased by an appropriate amount.

Example

The mapping operation
decrement [date_time] S1 by 40

Where: S1= 95-05-25 in YY-MM-DD format

produces 95-04-15.

Notes
◗ Text in brackets is optional in expert mode.
◗ This operator does not function for system variables 

containing dates. 

does_not_equal Compare two expressions to see if they are unequal.

EXP1 does_not_equal EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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equals Compare two expressions to see if their values are equal.
EXP1 equals EXP2

Where: EXP1=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

EXP2=Either a source field or element of 
numeric or alphanumeric data type or 
an arithmetic or alphanumeric 
expression

Note
This operation can be used only in a condition.

generic 
synonym of 

source 

Substitute a synonym from a generic synonym list for the 
value of the source field, element, or system variable.

generic [synonym of source] ITEM1 using [the list 
named] NAME1

Where: ITEM1=A source field or element
�NAME1�=An alphanumeric expression, the value 

of which is the name of the generic 
synonym list that specifies the 
synonym

Note
Text in brackets is optional in expert mode.

greenwich 
date_time 

Provide the Greenwich date and time of the translation 
process.

greenwich [date_time]

Note
Text in brackets is optional in expert mode.

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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increment 
date_time 

Add a specified value to the current date or time item.
increment [date_time] EXP1 by EXP2

Where: EXP1=Either a source field or element with a 
date-time data type or a date-time 
expression

EXP2=An arithmetic expression

The mapping operation increment date_time adds EXP2 to 
the lowest-order units in EXP1, carrying over to the next 
higher-order units after the lowest-order units reach a 
maximum. In other words, if the date is in year-month-day 
format and 400 days are added, the months, and perhaps 
even the years will be increased by an appropriate amount.

Example

The mapping operation

increment [date_time] S1 BY 15,

Where: S1= 95-09-25 in YY-MM-DD format

produces 95-10-10.

Note
◗ In expert mode, text in brackets is optional and you 

can use a source field or element with a numeric data 
type instead of an arithmetic expression for EXP2.

◗ This operator does not function for system variables 
that contain dates.

(Continued on next page)

Use this 
operator...

 (Contd)
To perform this action...
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max value of 
source loop 

Check all occurrences of a particular field or element and 
determine the maximum (highest) value.

max value of source loop EXP1

Where: EXP1=An arithmetic expression that has to 
contain at least one source field or 
element

Note
In standard mode, EXP1 must be exactly one source field 
or element.

Purpose
The purpose of this operator is find the highest value of the 
source field or element in the document.

You can use a combination of fields or elements with this 
mapping operation. When used with a more complex 
arithmetic expression, such as

max value of source loop (S1 + S2 * S3)

the mapping operation calculates the value of each 
occurrence of (S1 + S2 * S3) and then determines the 
maximum value.

Example
4 + 8 * 2 = 24 

3 + 4 * 4 = 28 (maximum value of source loop)

2 + 4 * 3 = 18

Caution
Use this mapping operation only if your data is totally 
predictable. If one of the values {S1, S2, S3} is missing in a 
particular iteration of the loop, do not use this mapping 
operation. Try using system variables instead.

(Continued on next page)
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min value of 
source loop 

Check all occurrences of a particular field or element and 
determine the minimum (lowest) value.

min value of source loop EXP1

Where: EXP1=An arithmetic expression that has to 
contain at least one source field or 
element

Note
In standard mode, EXP1 must be exactly one source field 
or element.

Purpose
The purpose of this operator is find the lowest value of the 
source field or element in the document.

You can use a combination of fields or elements with this 
mapping operation. When used with a more complex 
arithmetic expression, such as

min value of source loop (S1 + S2 * S3)

the mapping operation calculates the value of each 
occurrence of (S1 + S2 * S3) and then determines the 
lowest value.

Example
4 + 8 * 2 = 24

3 + 4 * 4 = 28

2 + 4 * 3 = 18 (minimum value of source loop)

Caution
Use this mapping operation only if your data is totally 
predictable. If one of the values {S1, S2, S3} is missing in a 
particular iteration of the loop, do not use this mapping 
operation. Try using system variables instead.

not Evaluate a term to determine if it is untrue.

not EXP1

Where: EXP1=A logical expression

Note
This operation can be used only in a condition.

(Continued on next page)
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one in loop Evaluate as true if at least one occurrence of the source 
field or element in the document contains data that 
satisfies the expression.

one [in loop] ITEM1 such [that] EXP1

Where: ITEM1=A source field or element
EXP1=A logical expression

Note
◗ Text in brackets is optional in expert mode. 
◗ This operation can be used only in a condition.

or Evaluates two expressions to determine if at least one of 
the expressions is true.

EXP1 or EXP2

Where: EXP1=A logical expression
EXP2=A logical expression

Example
When S11 = �required�

or S11 = �mandatory�

Note
This operation can be used only in a condition.

place Incorporate a text value into an empty text value at a 
specified point.

place EXP1 beginning [at position] EXP2

Where: EXP1=Either a source field or element with an 
alphanumeric data type or an 
alphanumeric expression

EXP2=An arithmetic expression

The mapping operation place results in alphanumeric data 
consisting of spaces up to the position specified by EXP2, 
followed by the characters produced by EXP1.

Example

The mapping operation place 'ABC' beginning at position 4 
produces '   ABC'. Where there are three spaces preceding 
ABC.

Note
Text in brackets is optional in expert mode.

(Continued on next page)
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portion of text Extract a series of alphanumeric characters from a 
specified value according to the starting position and 
length specified.

portion [of text] EXP1 starting [at position] EXP2 for 
EXP3 [characters]

Where: EXP1=Either a source field or element with an 
alphanumeric data type or an 
alphanumeric expression

EXP2=An arithmetic expression
EXP3=An arithmetic expression

This mapping operation produces data consisting of some 
of the characters of the original data (EXP1). The part 
returned by this operation starts with the character at the 
position specified by EXP2 and continues for EXP3 
characters.

Example

The mapping operation portion of text 'ABCDE FG' starting 
at position 3 for 5 characters produces 'CDE F'.

Note
Text in brackets is optional in expert mode.

(Continued on next page)
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put Incorporate a text value into another text value at a 
specified point.

put EXP1 into EXP2 beginning [at position] EXP3

Where: EXP1=Either a source field or element with an 
alphanumeric data type or an 
alphanumeric expression

EXP2=Either a source field or element with an 
alphanumeric data type or an 
alphanumeric expression

EXP3=An arithmetic expression

The mapping operation put results in alphanumeric data 
consisting of data produced by EXP2, followed by the 
characters produced by EXP1 placed starting at the 
position specified by EXP3.

Example

The mapping operation put 'ABC' into '123' beginning at 
position 7 produces '123   ABC'. Where there are three 
spaces between 123 and ABC

Note
Text in brackets is optional in expert mode.

(Continued on next page)
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record_count of 
destination on 

loop level 

Count the number of times that a destination item is 
repeated in the loop.

record_count [of destination on loop level] EXP1

Where: EXP1=An arithmetic expression

This operation maps the current number of iterations of the 
destination item at this point in the translation.

If an item is not in a loop, the loop level is 0. The first loop 
level is 1; the second loop is level 2, etc. After each 
iteration of a loop, it and all nested loops are reset to level 
1.

Example
The following mapping instructions map the number of 
occurrences in record 3 of D7, D8, and D9:

map record_count [of destination on loop level] 1 to D7

map record_count [of destination on loop level] 2 to D8

map record_count [of destination on loop level] 3 to D9

This illustration shows the value mapped to D7, D8, and 
D9 for the destination loops.
 

Note
Text in brackets is optional in expert mode.

(Continued on next page)
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source_element Determine whether the source item is a specific iteration 
out of a specified number of iterations (for example, 
second of five, third of six, etc.).

source_element ITEM1 is_repetition EXP1 out [of] 
EXP2

Where: ITEM1=A source field or element
EXP1=An arithmetic expression (must be an 

integer less than or equal to EXP2)
EXP2=An arithmetic expression (must be an 

integer greater than or equal to EXP1)

The mapping operation source_element is true whenever 
ITEM1 is the n*EXP2 + EXP1 iteration, where n is any 
integer. EXP1 specifies the iteration number within a block 
(the consecutive repetition of a record/segment). EXP2 
specifies the number of records/segments in a block.

Example
For the mapping operation

source_element S2 is_repetition 1 out of 3

the condition is true if this is the first of every three 
iterations of ITEM1.

Note
This operation can only be used in a condition.

spaces Indicate that the mapping condition is valid if there are only 
spaces (blanks) in the source item. You can also map 
spaces to a destination item.

Example
The following condition

When S7 = spaces

is true if S7 = �        � and is false if S7 = �Sterl   �.

Note
◗ Use this When condition when the source or 

destination item has a data type of AN or ID. 
◗ Use the zeros operation when the source or 

destination item has a data type of N, Nn, R, or Rn.
(Continued on next page)
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specific 
synonym of 

source 

Substitute synonyms as entered in the Specific Synonym 
File for the values of the source field or element.

specific [synonym of source] ITEM1

Where: ITEM1=A source field or element

Note
Text in brackets is optional in expert mode.

sum over source 
loop 

Add the values for the source field or element as it iterates 
in a document. This operator functions only with numeric 
data types.

sum over source loop EXP1

Where: EXP1=An arithmetic expression that has to 
contain at least one source field or 
element

Note
In standard mode, EXP1 must be exactly one source field 
or element.

Purpose
The purpose of this mapping operation is to produce the 
sum of all the values of the source field or element that 
occur in the document.

Example 1
sum over source loop S1

S1=3 in first loop.
S1= 2 in second loop.
S1 = 7 in third loop.

Result:
3 + 2 = 5 + 7 = 12

(Continued on next page)
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sum over source 
loop 

(contd)

Example 2
This mapping operation can be used with a more complex 
arithmetic expression, such as

sum over source loop (S1 + S2 * S3)

In this case, the operation first calculates the value of the 
first iteration of (S1 + S2 * S3) and then adds the result to 
the value calculated from the next iteration of (S1 + S2 * 
S3), and so on.

(S1 + S2 * S3) + (S1 + S2 * S3) + (S1 + S2 * S3) �

Note

If one of the values {S1, S2, S3} is missing in a particular 
iteration of the loop, GENTRAN:Server assumes 0 for that 
value (unless the value is the denominator of a fraction, in 
which case GENTRAN:Server assumes a value of 1).

system 
date_time 

Provide the system date and time of the translation, based 
on the clock of the computer performing the translation.

trading partner Provide the Trading Partnership Code for mapping. You 
can use the trading partner operator in the following ways.

◗ For outbound maps that are used for multiple trading 
partners use trading partner in a condition. For 
example,
When trading partner = XYZ810

MAP S5 to D122

◗ Map the current trading partner code to a destination 
field. For example,
MAP trading partner to D12

Note
The system automatically inserts the trading partner code 
into the first record of the record file layout if you have the 
code marked on your application description. Use the 
trading partner operator if you want the trading partner 
code in subsequent records.

(Continued on next page)
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zeros Indicate that the mapping condition is valid if there are only 
zeros (00) in the source item. You can also map zeros to a 
destination item.

Example

The following condition
When S9 = zeros

is true if S9 = �00000000� and is false if S9 = �00000156�.

Note
◗ Use this when the source or destination item has a 

data type of N, Nn, R, or Rn. 
◗ Use the spaces operation when the source or 

destination item has a data type of AN or ID.

Use this 
operator...

 (Contd)
To perform this action...
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Working with Macros in 
Mapping Instructions 0

Mapping Instructions

Introduction Mapping instructions can sometimes become intricate and cumbersome. This can 
make them difficult to read and interpret and slow map correction or maintenance. 
You can often use macros to simplify and organize mapping instructions.

Macros within
mapping

instructions

You add macros to the following parts of mapping instructions:
◗ conditional expressions 
◗ mapping expressions 
◗ other macros. 

Example For example, consider a mapping instruction to map the City field, the State field, 
and the Zip field on the Address 2 record to the Address Information element on 
the Address Information segment of an X12 invoice. Assume the following is true 
of the application:

◗ The application uses fixed length fields
◗ City field has 15 positions
◗ State field has 15 positions
◗ Zip field has 5 positions
◗ Blanks fill unused positions.

(Continued on next page)
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Example
mapping

instruction

One possible mapping instruction for the example is:
MAP place S23 beginning at position 1 TO D86 And MAP place S24 
beginning at position 16 TO D86 And MAP place S25 beginning at position 
31 TO D86

Where S23 = AD2 City

S24 = AD2 State

S25 = AD2 Zip

D86 = N3 Address Information

Adding macros
to simplify the

example
mapping

instruction

To reduce the example mapping instruction to a manageable size, you might use 
macros to map the City, State, and Zip fields to the Address Information element.

First, you would create the following macros:

M1(place S23 beginning at position 1)

M2(put S24 into M1 beginning at position 16)

M3(put S25 into M2 beginning at position 31)

Then, you would create the following mapping instruction:

Map M3 to D86

Where S25 = AD2 Zip

S24 = AD2 State

S23 = AD2 City

D86 = N3 Address Information
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How to Create Macros 

Introduction You must create a macro before using it in a mapping instruction. You create 
GENTRAN:Server macros using the Mapping Instructions dialog box.

Creating macros Use this procedure to create macros for use in mapping instructions.

Step Action

1 Open the Mapping Instructions dialog box. 

(Continued on next page)
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2 Click the Macro button.

System Response
GENTRAN:Server adds the Add a Macro operation to the 
Operations list.

3 Click Add a Macro.

System Response
GENTRAN:Server displays the macro box.

(Continued on next page)
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4 Create the macro by putting together operations, constants, and 
source and destination items as required.

Example

5 Click OK in the macro box.

System Response
GENTRAN:Server assigns the macro a label, starting with M1 and 
incrementing the number for each new macro in a mapping 
GROUP. The macro is now available for use.

 (Contd)
Step Action
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How to Add Macros to Expressions or to Other Macros 

Introduction You can use macros in conditional expressions, mapping expressions, and other 
macros. The process for adding macros is similar whether you are adding the 
macro to an expression or to another macro. In either case, you must create the 
macro first.

Adding a macro
to a mapping

expression

Follow these steps to add a macro to a mapping expression.  

Step Action

1 Open the Mapping Instructions dialog box.

System Response
GENTRAN:Server displays the available macros in the macro box.

(Continued on next page)
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2 Click Add a Mapping on the Operations list.

System Response
GENTRAN:Server opens the mapping box and selects the 
underscore after MAP. 

3 Click Enter Macro on the Operations list.

System Response
GENTRAN:Server displays a list of all available macros in the 
Operations list. 

(Continued on next page)
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4 In the Operations list, click the desired macro.

System Response
GENTRAN:Server adds the macro label to the mapping 
expression. 

5 In the Destination box, click the desired destination item.

The mapping expression is now complete.

6 Click OK in the mapping box.

7 When you have completed the mapping instruction, click Done.

 (Contd)
Step Action
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Procedures 0

How to Create Mapping Instructions

Introduction You use the Mapping Instructions dialog box to assign mapping instructions to a 
mapping GROUP. 

Displaying the
Mapping

Instructions
dialog box

The Mapping Instructions dialog box opens both automatically and manually:
◗ For a new mapping GROUP, GENTRAN:Server automatically opens the 

Mapping Instructions dialog box if:
� The GROUP has more than two source fields or two destination fields in 

the GROUP

� The GROUP has no source fields or elements. 

If the Mapping Instructions dialog box does not open automatically, click the 
source item in the mapping GROUP, and then click the Mapping Instructions (MI) 
button.

◗ For an existing mapping GROUP, click the source or destination item in the 
mapping GROUP, and then click the Mapping Instructions (MI) button.

Comment
The mapping instructions that are valid for a selected mapping GROUP vary 
according to the data types collected into that GROUP. They also vary according 
to whether you are in standard or expert mode.

About macros Putting macros together in a sequence is a good way to build complex 
expressions that contain nested string or numeric manipulations. 
GENTRAN:Server assigns a unique label (M1, M2, etc.) to each macro. You can 
enter the macro�s label in any mapping instruction. 

Reference
See the Working with Macros in Mapping Instructions section in this chapter for 
more information on creating and using macros.

(Continued on next page)
Mapping and Translation Guide � February 2002



Working with Mapping Instructions How to Create Mapping Instructions 9 - 47
Creating
instructions

Use this procedure to create mapping instructions for the current mapping 
GROUP. 

Step Action

1 Select one of the operations on the Operations list.

Use this decision table to select an operation.

IF you want to... THEN select�

Create an instruction Add a mapping.

Assign the circumstances in which the 
mapping instruction will be carried out

Add a condition.

Create a set of commands to organize 
your mapping instructions

The Macro button, add a 
macro from the operations 
list, and then enter the 
expression in the macro 
editing box.

2 If you are in standard mode, create mapping instructions by using 
the TAB key to move from one fill-in area to the next area and the 
SHIFT+TAB keys to move to the previous areas. You can also click 
the destination area. 

Reference
See the Using Operators section in this chapter for a description of 
operators you can use in mapping instructions.

3 Fill in the remaining terms until the expression is complete, noting 
the syntax of the expression as it fills the Mapping Expression line.

Comment
You can complete the terms either by clicking on list items 
(standard mode) or by typing characters into the text box (expert 
mode).

(Continued on next page)
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4 Click the OK button to compile the mapping instruction.

System Response
GENTRAN:Server checks the syntax and validity of the mapping 
instruction statements. If it detects faulty syntax or illogical 
operations, it displays a warning message or error message. 

5 Click Done to exit the Mapping Instructions dialog box. 

System Response
If a mapping instruction did not compile properly or was found to be 
incomplete, GENTRAN:Server prompts you to indicate whether you 
want the work saved. Click Yes to save the instructions in their 
current form. Click No to discard the invalid instructions.

 (Contd)
Step Action
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How to Map Literal Values to System Variables

Introduction A mapping instruction can have one or more mapping statements, any of which 
can be literal. 

Definition of
literal mapping

statement

A literal mapping statement maps a constant value (text or numbers) to the 
destination item.

Example
The following is a literal mapping statement with a system variable in the 
destination:

MAP '1234' TO $SYSTEMVARIABLE

You can create a literal mapping statement that maps a constant value to one or 
more system variables in the destination as long as you use a condition that refers 
to one or more source items. 

Example
WHEN data found in S5

Comment
When you map a literal value to a system variable, the source and destination 
items are simply placeholders for that mapping instruction. They are not actually 
mapped to one another.

(Continued on next page)
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Mapping a literal
value to a

system variable

Use this procedure to create a mapping statement with a system variable as the 
destination and with a constant as the source.

Note
You can use either standard or expert mode to create a mapping statement with a 
system variable. This procedure demonstrates the procedure in standard mode.

Step Action

1 Double-click the source item(s) you want to use in the condition.

2 Double-click one or more destination item(s).

Comment
Every mapping GROUP must include at least one destination item, 
even if you are not mapping anything to that item.

3 Use this table to decide how to create the mapping instruction.

IF you selected... THEN...

Only one source 
item and only one 
destination item

1. Click the right mouse button.

2. Click Mapping Instruction Toolbar.

System Response 
The Mapping Instructions dialog box opens. 
This mapping GROUP contains a mapping 
instruction that maps the source item to the 
destination item. 

3. Click Del and then confirm that you want 
to delete the mapping instruction.

System Response
GENTRAN:Server deletes the mapping 
instruction.

Multiple source 
items and one or 
more destination 
items

Click the right mouse button. 

System Response
The Mapping Instructions dialog box opens; 
it contains no mapping instructions.

4 Click Add a Condition on the Operations list.

5 Create the condition, making sure you refer to at least one source 
item.

Example 
WHEN data found in S7

(Continued on next page)
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6 Click OK in the condition box.

7 Click Add a Mapping on the Operations list.

8 Use this table to determine how to enter the constant you want to 
map to the system variable.

IF you want to 
enter a� THEN�

Text string 1. Click Enter Text on the Operations list.

System Response
The system displays the Enter Text dialog 
box.

2. Type the string.

3. Click OK on the Enter Text dialog box.

Number 1. Click Enter Number in the Operations 
list.

System Response
The system displays the Enter Number 
dialog box.

2. Enter the number.

3. Click OK on the Enter Number dialog 
box.

9 Press TAB to move the cursor to the underscore (_) after �TO� in the 
mapping instruction.

10 Click Enter System Variable Name on the Operations list.

System Response
The system displays the Enter System Variable Name dialog box.

11 Type the name of the system variable.

Comment 
The system variable name must be between two and twenty alpha-
numeric characters, including the dollar sign ($). In standard mode, 
you do not need to include the $; GENTRAN:Server enters it 
automatically.

(Continued on next page)
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12 Click OK on the Enter System Variable Name dialog box.

13 Click OK in the mapping box.

14 Click Done.

System Response 
The source and destination items you selected and marked now 
have �M� marks on them.

 (Contd)
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How to Map Source Items to System Variables (1-to-1)

Definition of a 1-
to-1 mapping

statement

A mapping instruction can have one or more mapping statements, any of which 
can map a source value (or a function of the source value) to a destination item or 
one or more system variables. This is a 1-to-1 mapping statement.

Example

This is an example of a 1-to-1 mapping statement with a system variable in the 
destination:

MAP S15+360 TO $SYSVAR

Creating a 1-to-1
mapping

statement

Use this procedure to create a mapping instruction with a system variable as the 
destination and with a source item (or a function of a source item) as the source.

Note

You can use either standard or expert mode to create a mapping instruction with a 
system variable. This procedure demonstrates the procedure in standard mode. 

Step Action

1 Double-click the source item whose value you want to map to a 
system variable.

2 Double-click one or more destination items.

Comment
Every mapping GROUP must include at least one destination item, 
even if you are not mapping anything to that item.

3 Click the right mouse button to map the items.

4 Click the Mapping Instructions Toolbar button.

System Response
The Mapping Instructions dialog box opens. It contains a 
GENTRAN:Server generated mapping instruction that maps the 
source item to the destination item. 

(Continued on next page)
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5 Use this decision table to determine your next action.

IF you want to... THEN...

Change the mapping instruction that 
GENTRAN:Server created

Continue with Step 
6.

Keep the mapping instruction that 
GENTRAN:Server created

Go to Step 11.

6 Click the mapping instruction to select it.

7 Click Edit on the Mapping Instructions dialog box.

8 Press TAB to move the cursor to the destination item label in the 
mapping instruction and then press DELETE.

9 Create the system variable you want as the destination.

10 Click Enter System Variable Name on the Operations list.

System Response

The system displays the Enter System Variable Name dialog box.

11 Type the name of the system variable.

Comment 
The system variable name must be between two and twenty alpha-
numeric characters, including the dollar sign ($). In standard mode, 
you do not need to include the $; GENTRAN:Server enters it 
automatically.

12 Click OK on the Enter System Variable Name dialog box.

13 Click OK in the mapping box.

14 Do you want to create additional mapping instructions?
◗ If yes, repeat from Step 1.
◗ If no, continue with Step 12.

15 Click Done.

System Response
GENTRAN:Server displays an �M� mark on the selected and 
marked destination item.

 (Contd)
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How to Map Source Items to System Variables (Many-
to-1)

Definition A mapping instruction can have one or more mapping statements, any of which 
can be many-to-1 mapping statement. A many-to-1 mapping statement maps two 
or more source values (or functions of the source values) to a destination item or 
one or more system variables.

Example
This example shows a many-to-1 mapping statement with a system variable in the 
destination:

MAP S5 & S13 &S20 TO $VAR

Creating a many-
to-1 mapping

statement

Use this procedure to create a mapping statement with a system variable as the 
destination and with two or more source values (or functions of the source values) 
as the source.

Note
You can use either standard or expert mode to create a mapping statement with a 
system variable. This procedure demonstrates this procedure in standard mode. 

Step Action

1 Double-click the source item whose value you want to map to a 
system variable.

2 Repeat Step 1 until you select and mark all of the source items you 
want to map to system variables.

3 Double-click one or more destination items.

Comment
Every mapping GROUP must include at least one destination item, 
even if you are not mapping anything to that item.

4 Click the right mouse button to map the items.

System Response
The Mapping Instructions dialog box automatically opens.

5 Click Add a Mapping on the Operations list.
(Continued on next page)
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6 Create or select the source value you want to map to a system 
variable, using a system variable and any combination of the 
source item, operations, or macros.

7 Press TAB to move the cursor to the underscore (_) after �TO� in the 
mapping instruction.

8 Click Enter System Variable Name on the Operations list.

System Response
The Enter System Variable Name dialog box opens.

9 Enter the name of the system variable.

Comment
The system variable name must be from two to twenty alpha-
numeric characters, including the dollar sign ($). In standard mode, 
you need not include the $; GENTRAN:Server enters it for you.

10 Click OK on the Enter System Variable Name dialog box.

11 Click OK in the mapping box.

12 Do you want to create additional mapping instructions?

◗ If YES, REPEAT FROM STEP 1.
◗ IF NO, continue with Step 13.

13 Click Done.

System Response
The system displays an �M� mark on the destination item you 
selected and marked.

 (Contd)
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How to Map System Variables to Destination Items

Introduction A source can be one or more system variables. It can also be a function of one or 
more system variables and one or more source items. In this section, each source 
is mapped to a destination item.

Source item
required

Each mapping instruction must contain a source item or a conditional expression 
containing one. This tells GENTRAN:Server what source value signals the point 
at which the system variable is mapped to the destination item. 

Example
WHEN S25=18

GENTRAN:Server is able to map the system variable to the destination item at the 
correct time only if the mapping instruction contains a source item and/or the 
conditional expression. 

You can use one or more macros in the source.

Literal mapping
statements

A mapping instruction can have one or more mapping statements, any of which 
can be literal mapping statements. A literal mapping statement maps text or 
numbers (a constant value) or one or more system variables to a destination item.

Example
The following is an example of a literal mapping statement with a system variable 
in the source:

MAP $SYSVAR TO D18

You can create a literal mapping statement that maps one or more system 
variables to a destination item by using a condition that refers to one or more 
source items.

(Continued on next page)
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Creating a literal
mapping

statement

Use this procedure to create a mapping statement with a system variable as the 
source and a mapping item as the destination. 

Note
You can use either standard or expert mode to create a mapping statement with a 
system variable. This procedure demonstrates the procedure in standard mode. 

Step Action

1 Double-click one or more source items, including those you want to 
use in the condition.

2 Double-click one or more destination items, including the one to 
which you want to map the system variable.

Comment
Every mapping GROUP must include at least one destination item, 
even if you are not mapping anything to that item.

3 Use this table to determine your next action.

IF you selected... THEN...

One source item and 
one destination item

Continue with Step 4.

Two or more source 
items

Click the right mouse button.

System Response
The Mapping Instructions dialog box opens; 
it contains no mapping instructions.

Go to Step 7.

4 Click the right mouse button.

5 Click the Mapping Instruction Toolbar button.

System Response
The system displays the Mapping Instructions dialog box. It 
contains the GENTRAN:Server-generated mapping instruction that 
maps the source item to the destination item. 

6 Click Del and then click Yes to confirm that you want to delete the 
mapping instruction.

System Response

GENTRAN:Server deletes the entire mapping instruction.
(Continued on next page)
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7 Click Add a Condition on the Operations list.

8 Create the condition, making sure you refer to at least one source 
item.

9 Click OK on the condition box.

10 Click Add a Mapping in the Operations list.

11 Click Enter System Variable Name on the Operations list.

System Response
The system displays the Enter System Variable Name dialog box.

12 Enter the name of the system variable.

Comment
The system variable name must be from two to twenty alpha-
numeric characters, including the dollar sign ($). In standard mode, 
you need not include the $; GENTRAN:Server enters it for you.

13 Click OK in the Enter System Variable Name dialog box.

14 Press TAB to move the cursor to the underscore (_) after �TO� in the 
mapping instruction.

15 Click the desired destination item in the destination box.

16 Click OK in the mapping box.

17 Click Done.

System Response
The system displays �M� marks on the source and destination items 
you selected and marked. At this point however, nothing is mapped 
from the source item(s).

 (Contd)
Step Action
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How to Map System Variables to Destination Items (1-
to-1)

Definition A 1-to-1 mapping statement maps a source item or a function of a source item to 
a destination item. You can create a 1-to-1 mapping statement that maps a 
function of a source item and one or more system variables to a destination item.

Example
The following is a 1-to-1 mapping statement with a system variable in the source:

MAP S5*$SYSTEMVARIABLE TO D45

Creating a 1-to-1
mapping

statement

Use this procedure to create a mapping statement with a function involving one or 
more system variables, operators, a source item, and one or more macros as the 
source, with a mapping item as the destination.

Note
You can use either standard or expert mode to create a mapping statement with a 
system variable. This procedure demonstrates the procedure in standard mode. 

Step Action

1 Double-click the source item whose value you want as part of the 
function.

2 Double-click the destination item to which you want to map 
information.

3 Click the right mouse button to map the two items.

4 Click the Mapping Instructions Toolbar button.

System Response
The system displays the Mapping Instructions dialog box. The 
window displays a mapping instruction that maps the source item 
to the destination item. 

(Continued on next page)
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5 Use this decision table to determine your next action.

IF you want to... THEN...

Change the mapping instruction that 
GENTRAN:Server created

Continue with Step 
6.

Keep the mapping instruction that 
GENTRAN:Server created

Go to Step 11.

6 Click the mapping instruction to select it.

7 Click Edit in the Mapping Instructions dialog box.

8 Press TAB to move the cursor to the source item label in the 
mapping instruction to select it and press DELETE.

9 Create or select the source value you want, using a system 
variable and any combination of the source item, operations, or 
macros.

10 Click OK in the mapping box.

11 Do you want to create additional mapping instructions?

◗ If YES, repeat from Step 1.
◗ If NO, continue with Step 13.

12 Click Done.

System Response
The system displays �M� marks on the source and destination items 
you selected and marked. The destination item has a value that is a 
function of the source item and the system variable mapped to it.

 (Contd)
Step Action
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How to Map Variables to Destination Items (Many-to-1)

Introduction A mapping instruction can have one or more mapping statements, any of which 
can map two or more source values to a destination item. 

Definition A many-to-1 mapping statement maps a function of two or more source values 
and one or more system variables to a destination item.

Example
The following is a many-to-1 mapping statement with a system variable in the 
source:

MAP S5 & $VAR & S18 TO D12

Creating a many-
to-1 mapping

statement

Use this procedure to create a mapping statement with a function of a system 
variable and two or more source values as the source and with a destination item.

Note

While you can use either standard or expert mode. This series of steps 
demonstrates the procedure in standard mode. 

Step Action

1 Double-click a source item whose value you want as part of the 
source function.

2 Repeat Step 1 Repeat Step 1 until you select and mark all of the 
source items you want to map.

3 Double-click the destination item to which you want to map the 
function.

4 Click the right mouse button to map the items.

System Response
The system displays the Mapping Instructions dialog box.

5 Click Add a Mapping on the Operations list.
(Continued on next page)
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6 Select or create the function you want to map to the destination 
item.

Comment
Use any combination of source items in this GROUP, the system 
variable, operations, and macros.

7 Press TAB to move the cursor to the underscore (_) after �TO� on the 
Mapping Instructions dialog box.

8 Click the appropriate mapping item in the destination box.

9 Click OK on the Mapping Instructions dialog box.

10 Repeat Steps 5 through 9 until you finish creating all of the 
mapping statements you want to include in this mapping 
instruction.

11 Click the New button, create any conditions you want, and repeat 
Steps 5 through 9 until you finish creating any additional mapping 
instructions you want.

12 Click Done.

System Response
The system now displays an �M� mark on the source and 
destination items you selected and marked. The destination item 
has a function of the source item and the system variable mapped 
to it.

 (Contd)
Step Action
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How to Map System Variables to System Variables

Introduction You can use system variables as both the source and destination of a mapping 
expression. You can also use a function of a system variable as the source and 
the same system variable as the destination.

You can combine an existing value (a constant or a source value) and one or 
more operators with a system variable and then map that result to the same 
system variable.

When no source
item is specified

If the mapping statement does not specify a source item, you must enter a 
conditional expression containing a source item to the left of the mapping 
expression. 

Example
WHEN S11 does_not_equal 'order'

In this example, 

WHEN is the conditional expression

S11 is the source item

does_not_equal 'order' is the mapping expression

You use the conditional expression containing a source item to tell 
GENTRAN:Server when to change the value of the system variable. Conditional 
expressions add flexibility to the mapping process. 

Example
With a conditional expression, you can increment a system variable every time a 
certain value is received. Without a conditional expression, GENTRAN:Server 
would be unable to determine the correct time to execute the mapping statement.

(Continued on next page)
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Same system
variable in the

source and
destination

A mapping instruction can have one or more mapping statements. Any of the 
mapping statements can have a function of a system variable in the source, and 
the same system variable in the destination. 

Example
MAP $ITERATION+1 TO $ITERATION

Note
You can map a function of a system variable to the same system variable within 
the same GROUP in which you are mapping the system variable to a destination 
field, but the system must execute the instructions in the proper order. 
GENTRAN:Server must first execute the instruction that maps a function of a 
system variable to the same system variable. Then, the system can safely 
execute the second instruction.

You can use the Sort Mapping Instructions Utility to sort these instructions so 
that they execute one before the other.

Reference
See Sort Mapping Instructions Utility in this chapter for information about sorting 
instructions.

Different system
variables in the

source and
destination

You can use one system variable (or a function of one system variable) in the 
source and a separate system variable in the destination.

You must use a conditional expression referring to one or more source items if 
there are no source items in the mapping statement. This tells GENTRAN:Server 
when it is to execute the mapping statement.

A mapping instruction can have one or more mapping statements, any of which 
can have one system variable in the source and a different system variable in the 
destination. 

Example
MAP $SYSTEMVARIABLE TO $VAR
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Mapping Instruction 
Exercise 0

Overview

Introduction The exercise in this chapter demonstrates how to map the relationship between 
hierarchical loops. Hierarchical loops use loop level segments to represent nested 
information.

The source and
destination used

in this exercise

This exercise maps an application file containing a shipping notice to the 856 
(Ship Notice/Manifest) document of the 3050 version of the X12 standard. 

This illustration shows example records from the application. 

(Continued on next page)
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Notice that the hierarchy of the information fields in the application file is as 
follows:

◗ The item (I) level items are subordinate to the order (O) level items
◗ The order (O) level items are subordinate to the shipment (S) level items.

The standard stores this information as hierarchical loops. 

This illustration shows part of the standard. 

Using system
variables to map
the relationship

between
hierarchical

loops

Translation of data is source driven. That is, translators (using a map) look to the 
source document for the information it needs to create the destination data. In 
cases where you want a mapping to occur without specifying a source item, you 
can create a condition based on the source data that, when met, triggers the 
mapping of a value to a destination item. 

In the case of this exercise, we create conditions using system variables to trigger 
translation. We use system variables to map the relationships between 
hierarchical loops. 

(Continued on next page)
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Mapping the
relationship
between the

source and the
destination

The standard uses hierarchical loops for the items in the application example. 
Since this is an outbound translation, you must map the hierarchical information 
from the application to the hierarchical loops in the standard.

The next four procedures step you through the creation of four sets of mapping 
GROUPs and corresponding mapping instructions.
◗ The first mapping GROUP creates and initializes the value of the system 

variable $HL1$HL1.
◗ The second mapping GROUP maps the shipment-level information.
◗ The third mapping GROUP maps the order-level information.
◗ The fourth mapping GROUP maps the item-level information.

Note
By default, the mapping statements you create do not always appear in the order 
in which you entered them in the Mapping Instructions dialog box. Nor are they 
necessarily executed in the order in which they appear. The compiler determines 
the optimum order when it compiles the map. If necessary, you can use the Sort 
Mapping Instructions Utility to change the execution order. 

Reference
See the Sort Mapping Instructions Utility topic in this chapter for more information.

(Continued on next page)
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Before you begin
this exercise

Using the Visual Mapper, create a map with an application shipping notice 
matching the illustration below as the source and the X12 version 3050 document 
856 (Ship Notice/Manifest) as the destination.

Reference
See the Mapping chapter in this guide for instructions on creating a map. 

Example 

When you are ready to begin the exercise, see the How to Create the First 
Mapping GROUP topic in this chapter.
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How to Create the First Mapping GROUP

Introduction This section steps you through creating the first mapping GROUP of the exercise, 
which sets up the initial value for the $HL1 system variable. 

The system variable $HL1 stores the current value of the hierarchical level ID 
number.

Creating the
mapping GROUP

Use this procedure to create the first mapping GROUP and its mapping 
instruction. 

Step Action

1 Double-click the following source items:

S3 Number

S4 Chars

2 Double-click the following destination items:

D4 Transaction Set Purpose

D5 Shipment Identification

3 Click the right mouse button.

System Response
The Mapping Instructions dialog box opens.

4 Create the condition:
WHEN data found in S3

Comment
You should execute the mapping statement in this mapping 
instruction only when there is a value in the S3 field (number). This 
assigns the initial value to the $HL1 system variable at the 
beginning of translation and before mapping any values from the 
loop.

(Continued on next page)
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You are now ready to map the shipment-level information.

See the How to Map the Shipment-level Information topic in this chapter.

5 Create the mapping statement:
MAP 1 TO $HL1

Comment
You map a �1� to a system variable that you call �$HL1� to store the 
current hierarchical level ID. Since you are initializing the value of 
$HL1, which changes during the translation, the current value is 1. 
You can then use $HL1 in subsequent mapping instructions, 
incrementing it as necessary.

The mapping instruction you create looks like this: 

6 Click Done on the Mapping Instructions dialog box.

 (Contd)
Step Action
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How to Map the Shipment-level Information

Introduction This section steps you through creating the second mapping GROUP of the 
exercise, which maps the shipment-level information.

Creating the
mapping GROUP

Use this procedure to create the second mapping GROUP and compose the 
mapping instruction. 

Step Action

1 Double-click the following source items:

S8 Level ID

S9 S Level Detail

2 Double-click the following destination items:

D23 Hierarchical ID Number

D24 Hierarchical Parent ID Number

D25 Hierarchical Level Code

D28 Assigned Identification

D29 Product/Service ID Qualifier

D60 Assigned Identification

D61 Number of Units Shipped

D98 Purchase Order Number

D99 Release Number

3 Click the right mouse button.

System Response
The Mapping Instructions dialog box opens.

4 Create the condition:
WHEN S8 equals 'S'

Comment
You should execute the mapping statements in this mapping 
instruction only when the hierarchical level ID is �S� for shipment.

(Continued on next page)
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5 Create the first mapping statement:
MAP $HL1 TO D23

Comment
You map the current value (1 for the first iteration) of $HL1 to the 
Hierarchical ID Number because this is the first hierarchical level.

6 Create the second mapping statement:

MAP 0 TO D24

Comment
Because this is the first level of the hierarchical loop, it has no 
parent; therefore, the hierarchical level parent ID number is �0�.

7 Create the third mapping statement:
MAP S8 TO D25

Comment
The level ID in the record file layout (�S� for this level) is the same 
as the Hierarchical Level Code in the standard.

(Continued on next page)
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You are now ready to map the order-level information.

See the How to Map the Order-level Information topic in this chapter.

8 Create the fourth mapping statement:
MAP $HL1+1 TO $HL1

Comment
You increment the hierarchical ID number system variable in 
preparation for mapping the next hierarchical level.

The mapping instruction looks like this: 

9 Click Done in the Mapping Instructions dialog box.

 (Contd)
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How to Map the Order-level Information

Introduction This section contains the instructions for creating the third mapping GROUP of the 
exercise, which maps the order-level information.

Creating the
mapping GROUP

Use this procedure to create the third mapping GROUP and compose the 
mapping instruction. 

Step Action

1 Double-click the following source items:

S18 O Level Detail

S19 O Level Detail 2

S24 Level ID

2 Double-click the following destination items:

D23 Hierarchical ID Number

D24 Hierarchical Parent ID Number

D25 Hierarchical Level Code

D28 Assigned Identification

D29 Product/Service ID Qualifier

D60 Assigned Identification

D61 Number of Units Shipped

D98 Purchase Order Number

D99 Release Number

3 Click the right mouse button.

System Response
The Mapping Instructions dialog box opens.

4 Create the condition:
WHEN S24 equals 'O'

Comment
You should execute the mapping statements in this mapping 
instruction only when the hierarchical level ID is �O� for order.

(Continued on next page)
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5 Create the first mapping statement:
MAP 1 TO D24

Comment
You map 1 to the Hierarchical Parent ID Number because the first 
hierarchical level (shipment) is the parent to the order level.

6 Create the second mapping statement:

MAP $HL1 TO D23

Comment
You map the current value (2 for the first iteration) of $HL1 to the 
Hierarchical ID Number because this is the second hierarchical 
level.

7 Create the third mapping statement: 
$HL1 TO $HPARENT

Comment
You map the current value (2 for the first iteration) of $HL1 to the 
Hierarchical Parent ID Number because this hierarchical level 
(order) is the second level and the parent to the next level, item. 
When you assign a name ($HPARENT) to a system variable, you 
automatically create it.

8 Create the fourth mapping statement:

MAP $HL1+1 TO $HL1

Comment
You increment the hierarchical ID number system variable in 
preparation for mapping the next hierarchical level.

(Continued on next page)
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You are now ready to map the item-level information.

See the How to Map the Item-level Information topic in this chapter.

9 Create the fifth mapping statement: 
MAP S24 TO D25

Comment
The level ID in the record file layout (�O� for this level) is the same 
as the Hierarchical Level Code in the standard.

The mapping instruction looks like this: 

10 Click Done in the Mapping Instructions dialog box.

 (Contd)
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How to Map the Item-level Information

Introduction This section steps you through creating the fourth and final mapping GROUP of 
the exercise, which maps the item-level information.

Creating the
mapping GROUP

Use this procedure to create the fourth mapping GROUP and compose the 
mapping instruction. 

Step Action

1 Double-click the following source items:
S20 I Level Detail

S21 I Level Detail 2

S25 Level ID

2 Double-click the following destination items:
D23 Hierarchical ID Number

D24 Hierarchical Parent ID Number

D25 Hierarchical Level Code

D28 Assigned Identification

D29 Product/Service ID Qualifier

D60 Assigned Identification

D61 Number of Units Shipped

D98 Purchase Order Number

D99 Release Number

3 Click the right mouse button.

System Response
The Mapping Instructions dialog box opens.

4 Create the condition:

WHEN S25 equals 'I�

Comment
You should execute the mapping statements in this mapping 
instruction only when the hierarchical level ID is �I� for item.

(Continued on next page)
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5 Create the first mapping statement:
MAP S25 TO D25

Comment
The level ID in the record file layout (�I� for this level) is the same as 
the Hierarchical Level Code in the standard.

6 Create the second mapping statement:

MAP $HL1 TO D23

Comment
You map the current value (3 for the first iteration) of $HL1 to the 
Hierarchical ID Number because this is the third hierarchical level.

7 Create the third mapping statement:
$HPARENT TO D24

Comment
You map the current value (2 for the first iteration) of $HPARENT to 
the hierarchical parent ID number because this hierarchical level 
(item) is the third level and its parent is the second level, order.

(Continued on next page)
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Summary In this exercise you practiced the following mapping techniques:

◗ Initializing system variables
◗ Creating many-to-many mapping GROUPs
◗ Incrementing system variable
◗ Mapping system variables to destination items
◗ Mapping multiple hierarchical levels.

8 Create the fourth mapping statement:
MAP $HL1+1 TO $HL1

Comment
You increment the hierarchical ID number system variable in 
preparation for mapping item information in subsequent iterations 
of the loop.

The mapping instruction looks like this:

9 Click Done in the Mapping Instructions dialog box.

 (Contd)
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Overview 0

Introduction Troubleshooting mapping instructions is necessary only if maps used in 
translation produce unexpected results. GENTRAN:Server provides you with two 
troubleshooting tools: the Sorting Utility and the Diagnostics report. 

This chapter provides the information you need to diagnose and correct a map 
that produces unexpected results when used in translation.

Key terms This table lists the key terms used in this chapter.  

Term Description

Map File The <mapname>.vmp file containing a defined map.

mapping association The process of associating data fields or elements in 
your source document to corresponding data fields 
or elements in your destination document.

mapping condition Qualifying term used in some mapping instructions 
to indicate when the mapping part of the instruction 
should be performed and when it should be ignored. 
Mapping conditions begin with �When.�

mapping expression A complete �Map to� expression that may be part of 
a longer mapping instruction.

mapping GROUP A specific mapping association between source and 
destination data.

mapping instruction A set of information that controls special operations 
on mapped data during translation.

Visual Mapper The GENTRAN:Server window on which you create 
a map. The Visual Mapper displays the source 
document on the left side of the window and the 
destination document on the right.
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Sorting Utility 0

Overview

Introduction In this section, we describe how to use the Sorting Utility to reorder mapping 
instructions that are listed on the correct screen, but must be executed in an order 
other than the default. 

Purpose of the
Sorting Utility

The Sorting Utility enables you to view and change the order in which the 
translator executes mapping instructions. You can change the sort order only for 
one source record or segment at a time. 

The default sort order is usually the optimum order. However, there may be cases 
in which you need to change the sort order before the translation test will produce 
the correct results. You use the Sorting Utility to modify the order in which 
GENTRAN:Server processes mapping instructions.

What you can do
with the Sorting

Utility

You can use the Sort Utility only to change the order in which GENTRAN:Server 
executes the mapping instructions. To change, add, or delete the actual mapping 
instructions, you must use the Mapping Instructions window in the Visual Mapper.

Reference
For information about using the Mapping Instructions window, see the Working 
with Mapping Instructions chapter in this guide.
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The Default Sort Order

Introduction The translator executes mapping instructions in the order set during map 
compilation. You can use the Sorting Utility to change the execution order of the 
items in a source record/segment. 

The ordering
process

This table describes the process that the map compiler uses to determine the 
execution order of the mapping instructions.

Stage Description

1 The map compiler first lists all mapping instructions for the first 
record/segment. It then lists all mapping instructions for the next 
record/segment. 

This process continues until the mapping instructions for all 
records/segments are listed.

2 The map compiler looks at the mapping instructions for each 
source record/segment and arranges them according to the default 
order in which the translator will execute them. 

Criteria
The map compiler uses the following criteria to order the mapping 
instructions for each source record/segment:

◗ The group number of the source record, lowest to highest
◗ The Mapping Instruction screen order, last to first
◗ Within a Mapping Instruction screen, the order in which the 

mapping instructions were entered
◗ The order of the items in the source record/segment.

Comment
If a mapping instruction spans multiple records, then the system 
executes the mapping instruction for the first record only after 
receiving all its source items.
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When to Use the Sorting Utility

Introduction Use the Sorting Utility when:
◗ You need to know the current order of the mapping instructions for the items 

in a particular record/segment
◗ You need to know the order in which the translator will use the system 

variables.
◗ The Diagnostics Report indicates that you need to reorder some mapping 

instructions because the output is not what you expected.

Finding the
current

execution order
of the mapping

instructions

You can quickly see the order in which the translator executes the mapping 
instructions for items in a specific record/segment by displaying the Sort Mapping 
Instructions dialog box for that record/segment. 

The Sort Mapping Instructions dialog box displays either the default order or, if 
changes were made, the latest order saved. 

The Sort Mapping Instructions dialog box may provide the information you need 
to determine the appropriate sort order. If you need more detailed information, run 
a Diagnostics Report.

When using
system variables

You may need to change the sort order when source fields/elements are 
referenced by one or more mapping instructions containing system variables.

System variables are very powerful and flexible, allowing you precise control over 
your output. For this reason, the order in which the translator executes system 
variables is especially critical.

Example
The following combination of mapping instructions can cause unanticipated 
results:

MAP $sysvar+1 TO $sysvar
MAP $sysvar * S12 TO D32

(Continued on next page)
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It makes a great deal of difference which of the following GENTRAN:Server does 
first:

◗ Increments the system variable and then maps it to a destination item.

If the initial value of $sysvar is 2, then incrementing it by one and mapping it to 
the destination item results in a value of 3 in the first destination item.

◗ Maps the system variable to a destination item and then increments it.

If the initial value of $sysvar is 2, then mapping it to the destination item and 
incrementing it by one results in a value of 2 in the first destination item.

Note
GENTRAN:Server does not accept system variables used with data types DT or 
TM.

When the
Diagnostics

Report indicates
reordering is

needed

The Diagnostics Report provides details about the value of source items at each 
point in the translation. If the output file indicates that the translation gives 
unexpected results, the Diagnostics Report can tell you the point in the translation 
at which the results first differ from what you expected.

Often, a careful study of the Diagnostics Report will indicate that you can achieve 
the desired results by reordering the mapping instructions.
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How to Open the Sort Mapping Instructions Dialog Box 

Introduction The Sort Mapping Instructions dialog box is available from the Map Items menu of 
the Visual Mapper.

Before you open
the dialog box

If you have made any changes to your map, you must save and compile the map 
you are using for translation before you open the Sort Mapping Instructions dialog 
box.

Comment
Use the GENTRAN:Server Visual Mapper to save the map and start the compiler. 
For more information about saving and compiling maps with the Visual Mapper, 
see the Mapping chapter in this guide.

Opening the Sort
Mapping

Instructions
dialog box

Use this procedure to open the Sort Mapping Instructions dialog box.

Step Procedure

1 In the Visual Mapper, open the map containing the mapping 
instructions you want to sort.

System Response
When you select a MAP file, GENTRAN:Server opens a working 
MAP file. 

2 Make the source side of the map the active side by clicking once on 
that side.

3 Move the focus to the desired source record or segment.
(Continued on next page)
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4 Click Sort Mapping Instructions on the Map Items menu.

System Response
The Sort Mapping Instructions dialog box opens and displays all 
mapping instructions that reference a field/element in the specified 
source record/segment. 

Note that this window does not include mapping instructions for 
fields/elements that are part of another record, even though the 
fields/elements are part of the mapping group.

Example
For example, you may have a mapping group that contains one or 
more sources and one or more destinations. The only mapping 
instructions displayed are those that include the source items 
contained in the specified record/segment in the conditional 
expression, the mapping expression, or both. The system does not 
display any 0-to-1 mapping instructions. These instructions map a 
literal to a destination without including the source item in either the 
conditional or the mapping expression.

 (Contd)
Step Procedure
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The Sort Mapping Instructions Window

Introduction The Sort Mapping Instructions dialog box displays the mapping instructions for a 
single record/segment only. The window does not display instructions for fields in 
other records/segments that may be part of the same group.

Example This is the Sort Mapping Instructions dialog box. Note the example mapping 
instructions in the Current Execution Order box. 

(Continued on next page)
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Parts and
function of the

Sort Mapping
Instructions

dialog box

This table describes the parts and functions of the Sort Mapping Instructions 
dialog box.

Part Function

Current Execution Lists all mapping instructions for the specified record/
segment in the current execution order.

New Execution Order Lists all mapping instructions for the specified record/
segment in the selected execution order.

Details Displays the complete text of the highlighted mapping 
instruction.

Sources Lists all sources in the highlighted mapping 
instruction.

Destinations Lists all destinations in the highlighted mapping 
instruction.

Move to the Right Moves the mapping instruction highlighted in the 
Current Execution box to the position immediately 
after the mapping instruction highlighted in the New 
Execution Order box. 

If no mapping instruction is highlighted in the New 
Execution Order box, this button moves the mapping 
instruction to the end of the list in the New Execution 
Order box.

When the New Execution Order box is empty, this 
button moves the mapping instruction highlighted in 
the Current Execution box to the top of the New 
Execution Order box.

(Continued on next page)
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Move to the Left Moves the mapping instruction highlighted in the New 
Execution Order box to the position immediately after 
the mapping instruction highlighted in the Current 
Execution box. 

If no mapping instruction is highlighted in the Current 
Execution Order box, this button moves the mapping 
instruction to the end of the list in the Current 
Execution Order box.

When the Current Execution box is empty, this button 
moves the mapping instruction highlighted in the New 
Execution Order box to the top of the Current 
Execution box.

Move All Moves all mapping instructions in the Current 
Execution box to the position immediately after the 
mapping instruction highlighted in the Current 
Execution box.

When the New Execution Order box is empty, this 
button moves all the mapping instructions in the 
Current Execution box to the top of the New 
Execution Order box.

If no mapping instruction in the New Execution Order 
box is highlighted, this button moves all the mapping 
instructions in the Current Execution box to 
immediately after the last mapping instruction in the 
New Execution Order box.

Restore All Moves all the mapping instructions in the New 
Execution Order box back to the Current Execution 
box and orders them as they were when you opened 
the Sort Mapping Instructions window.

This may or may not be the default sort order.

Use Default MI 
Ordering

Moves all the mapping instructions in the New 
Execution Order box back to the Current Execution 
box and puts them in the default sort order. You can 
also use this function to restore the default sort order 
for a compiled map. 

(Continued on next page)

 (Contd)
Part Function
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Print Prints the contents of the Current Execution box and 
the New Execution Order box.

 (Contd)
Part Function
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How to Sort Mapping Instructions

Introduction This topic describes the procedure for using the Sort Mapping Instructions dialog 
box to manually sort the mapping instructions for a particular record/segment.

Before you begin Use this procedure to prepare for manually sorting mapping instructions.

(Continued on next page)

Step Action

1 Open the Visual Mapper and then open the working map file or the 
master MAP file.

Note

If you have a MAP file open, continue with step 2

2 Create a current sort order. 

Comment
If you have modified the map since the last time you saved it, you 
must save it again to create a current sort order.

If you modified the mapping instructions, you must also compile the 
new version of the map.

3 Use this decision table to determine if you need to recompile the 
map.

IF you add mapping instructions that� THEN...

Reference the record or segment that you are 
sorting in the mapping expression

Recompile the 
map.

Do not reference the record or segment that 
you are sorting in the mapping expression

Examples
◗ 0-to-1 literal mapping instructions
◗ Mapping instructions that reference other 

source items
◗ Mapping instructions that reference only 

system variables in the source

Do not recompile 
the map.
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Sorting mapping
instructions

Use this procedure to sort the mapping instructions for a source record/segment.

Step Action

1 Move the focus to the source record/segment referenced in the 
mapping instructions you want to sort.

2 Click Sort Mapping Instructions on the Map Items menu.

System Response
The system displays the Sort Mapping Instructions dialog box is 
displayed on your screen. The Current Execution box displays the 
mapping instructions in the current order.

Hint
Click the Print button to print a list of the mapping instructions.

3 Select the mapping instruction you want to reorder.

System Response
GENTRAN:Server displays the following information about the 
selected mapping instruction:

◗ The Details box displays the complete mapping instruction.
◗ The Sources box lists the source items.
◗ The Destinations box lists the destination items.

Comment
The information in the Details, Sources, or Destinations boxes is 
view only. You cannot edit these values.

4 In the New Execution Order box, select the mapping instruction 
that you want to precede the mapping instruction you are moving. 

Comment
If the box is empty or if you want to move the instruction to the last 
position in the list, skip this step.

5 Click the Move to the Right button to move the mapping 
instruction into the New Execution Order box.

System Response
If you did not select a mapping instruction in the New Execution 
Order box, GENTRAN:Server moves the mapping instruction to the 
last position in the list.

6 Repeat Steps 3 through 5 until you reorder all the mapping 
instructions and move them into the New Execution Order box.

(Continued on next page)
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7 Use this table to determine your next step.

IF you want to� THEN�

Move a mapping instruction back 
into the Current Execution box so 
that you can add one or more 
mapping instructions before it is in 
the New Execution Order box

◗ Select the mapping 
instruction you want to 
move.

◗ Select the mapping 
instruction in the Current 
Execution box that is to 
precede the moved 
mapping instruction.

◗ Click Move to the Left.

Keep the order of all mapping 
instructions remaining in the 
Current Execution box

Click Move All to move them 
to immediately after the 
mapping instruction selected 
in the Current Execution box.

Restore the execution to the order 
displayed when the Sort Mapping 
Instructions window opened

Click Restore All.

Print a list of the mapping 
instructions in the Current 
Execution box and the New 
Execution Order box.

Click Print. 

Quit sorting before all mapping 
instructions are in the New 
Execution Order Box

Click Cancel.

Comment
You lose all changes made 
since opening the Sort 
Mapping Instructions window.

8 Click OK.

Note
Remember, you must compile the MAP file to generate the 
translation table file GENTRAN:Server uses during translation.

 (Contd)
Step Action
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How to Restore the Default Sort Order

Introduction You can restore the default sort order of mapping instructions if the changes you 
made do not produce the desired results or are no longer needed. 

Restoring the
default sort

order

Use this procedure to restore the original sort order:

Step Action

1 Open the Sort Mapping Instructions dialog box and display the 
mapping instructions you want to restore to the original sort order.

2 Check Use Default MI Ordering. 

System Response
GENTRAN:Server returns all mapping instructions in the Sort 
Mapping Instructions window to the default order it originally 
assigned. GENTRAN:Server also disables the Move to the Right, 
Move to the Left, Move All, and Restore All buttons.

Note
If the mapping instructions were saved previously, the system 
displays the instructions in the default order only after you compile 
the new version of the map. 

3 Click OK.

4 Save and compile the map file.
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Sorting Utility Example

Introduction Using the Sorting Utility to change the sort order of mapping instructions is usually 
the most effective way of correcting the mapping instructions. In some cases, it is 
the only way to correct the mapping instructions

About this
example

This example demonstrates how to use the Sorting Utility to correct a problem by 
reordering the mapping instructions.

The map Begin by opening a map. The illustration below shows the map for this example.

(Continued on next page)
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Output file After opening the map, look at the output file. This is the generated outbound EDI 
for the output file:
ISA*00*          *00*          *01*1111111111     *01*2222222222     
*961122*1436*U*00200*
GS*PT*1111111111*2222222222*961122*1436*17*X*003020
ST*867*0001
BPT*00*0*960722
N1*SF*Company XYZX
N4*Someplace*CA*94128
PTD*SD

We expected two N1
loops with N1, N3,

N4, and PER
segments.

N1*ST*Destination ABCD*91*106008
N3*3080 Scenic Boulevard
N4***95051*US
N4*SANTA CRUZ*CA*95111*US
PER*ZZ**TE*2283331111
PER*ZZ**TE*1112422211
N1*BT*Destination EFGH*91*106008
N3*2456 LAWRENCE EXPRESSWAY
N4*SANTA CLARA*CA
QTY*32*1
LIN**MG*6264401830
UIT*EA*1197
PID*F****Large Things in a box
DTM*011*960715
QTY*32*1
LIN**MG*6264401830
UIT*EA*1197
PID*F****More Things in a box
DTM*011*960715
SE*25*0001
GE*1*17
IEA*1*000000017

(Continued on next page)
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Input file After examining the output file, look at the input file. This is the source 
GENTRAN:Server uses with translation. 

Normally, all the fields in a record appear on one line. However, we arranged this 
figure to identify the fields with their source labels.

LOC*0*960722*Company XYZX*Someplace*CA*94128*NOV867
HDR* S10 record ID

Destination ABCD* S11
106008* S12

Fields S11-S18 for
�Ship To� N1-PER

Loop

3080 Scenic Boulevard** S13, S14
SANTA CRUZ* S15
CA* S16
95051** S17
2283331111* S18
Destination EFGH* S19
106008* S20
2456 LAWRENCE EXPRESSWAY** S21, S22

Fields S19-S27 for
�Bill To� N1-PER

Loop

SANTA CLARA* S23
CA* S24
95111* S25
USA* S26
1112422211 S27

DTL*1*    1197.00*6264401830*Large Things in a box*960715
DTL*1*    1197.00*6264401830*More Things in a box*960715

Notice that the data in the HDR record generates the N1 through PER segments 
and the source data comes from distinctly different fields. 

(Continued on next page)
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The mini-report Now check the mapping instructions. To display the following screen, move the 
focus to the destination field and then click the mini-report button on the source 
side.

Notice that all the fields in the N1 loop are in two groups: GROUP 105 and 
GROUP 131.

(Continued on next page)
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Mapping
instructions

On the Mapping Instructions screens, GROUP 105 for the N1 - ST loop contains 
three screens. The first screen has these mapping instructions:

WHEN data found in S12
MAP ‘91’ TO D109
MAP S14 TO D116
MAP ‘ST’ TO D107
MAP S15 TO D118
MAP S11 TO D108
MAP S16 TO D119
MAP S12 TO D110
MAP S17 TO D120
MAP S13 TO D115

The second screen has these mapping instructions:

WHEN S12 > ‘0’ AND WHEN not data found in S18
MAP ‘US’ TO D121

The third screen has these mapping instructions:
WHEN data found in S19
MAP ‘22’ TO D129
MAP S19 TO D132
MAP ‘TE’ TO D131

GROUP 131 for the N1 - BT loop contains three screens as well. The first screen 
has the following mapping instructions:

WHEN data found in S21
MAP ‘BT’ TO D107
MAP S23 TO D116
MAP S20 TO D108
MAP S24 TO D118
MAP ‘91’ TO D109
MAP S25 TO D119
MAP S21 TO D110
MAP S26 TO D120
MAP S22 TO D115

The second screen has these mapping instructions:

WHEN S26 > ‘0’
MAP S27 TO D121

(Continued on next page)
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The third screen has these mapping instructions:

WHEN data found in S28
MAP ‘22’ TO D129
MAP ‘TE’ TO D131
MAP S28 TO D132

The mapping instructions seem correct, but GENTRAN:Server may not execute 
them in the expected order. To determine this, run a Diagnostics Report.

Diagnostics
Report

To generate the Diagnostics Report, run the outbound translation by using the 
command line program lftran with the �d� parameter:

Note
GENTRAN:Server overwrites the report name and location with each translation.

Input File = c:\server\data\input
Table File = c:\server\maps\BEFORE.TBL
------------------------------------------------------------
File Line = 1
Record ID = LOC
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
002   0                S2   -> D5   BPT    002
003   960722           S3   -> D6   BPT    003
004   Company XYZX     S4   -> D52  N1     002
005   Someplace        S5   -> D62  N4     001
006   CA               S6   -> D63  N4     002
007   94128            S7   -> D64  N4     003
------------------------------------------------------------
File Line = 2
Record ID = HDR
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   HDR              S10  -> D78   PTD   001   Conditional
009   (null)           S18  -> D121  N4    004   Part 2 of 2
003   106008           S12  -> D121  N4    004   Part 1 of 2

Field 010 creates
the first PER

segment.

010   2283331111       S19  -> D129  PER   001   Conditional
010   2283331111       S19  -> D131  PER   003   Conditional
008   95051            S17  -> D120  N4    003   Conditional
010   2283331111       S19  -> D132  PER   004   Conditional

Field 019 creates
the second PER

segment.

019   1112422211       S28  -> D129  PER   001   NEW RECORD
019   1112422211       S28  -> D131  PER   003   Conditional
019   1112422211       S28  -> D132  PER   004   Conditional
018   USA              S27  -> D121  N4    004   NEW RECORD
017   95111            S26  -> D120  N4    003   Conditional

Field 003 creates
the first N1

segment.

003   106008           S12  -> D109  N1    003   Conditional
003   106008           S12  -> D107  N1    001   Conditional
002   Destination ABCD S11  -> D108  N1    002   Conditional
003   106008           S12  -> D110  N1    004   Conditional
004   3080 Scenic Rd   S13  -> D115  N3    001   Conditional

(Continued on next page)
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005   (null)           S14  -> D116  N3    002   Conditional
006   SANTA CRUZ       S15  -> D118  N4    001   Conditional
007   CA               S16  -> D119  N4    002   Conditional

Field 012 creates
the second N1

segment.

012   106008           S21  -> D107  N1    001   NEW RECORD
012   106008           S21  -> D109  N1    003   Conditional
011   Destination EFGH S20  -> D108  N1    002   Conditional
012   106008           S21  -> D110  N1    004   Conditional
013   2456 LAWRENCE EX S22  -> D115  N3    001   Conditional
014   (null)           S23  -> D116  N3    002   Conditional
015   SANTA CLARA      S24  -> D118  N4    001   Conditional
016   CA               S25  -> D119  N4    002   Conditional
------------------------------------------------------------
File Line = 3
Record ID = DTL
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
002   1                S31  -> D154 QTY    001   Conditional
002   1                S31  -> D155 QTY    002   Conditional
004   6264401830       S33  -> D160 LIN    003
003       1197.00      S32  -> D191 UIT    002
005   Large Things in  S34  -> D216 PID    005
006   960715           S35  -> D254 DTM    002
------------------------------------------------------------
File Line = 4
Record ID = DTL
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- ----------
002   1                S31  -> D154 QTY    001   NEW RECORD
002   1                S31  -> D155 QTY    002   Conditional
004   6264401830       S33  -> D160 LIN    003
003       1197.00      S32  -> D191 UIT    002
005   More Things in   S34  -> D216  PID   005
006   960715           S35  -> D254  DTM   002
------------------------------------------------------------

Analysis Look at the Diagnostics Report section for the input file line 2, input record HDR. 
In the Record column, you can see that GENTRAN:Server executes the mapping 
instruction that maps to the PTD (top of loop) first. GENTRAN:Server should 
create the output EDI segments in the following order. 
◗ N1
◗ N3
◗ N4
◗ PER.

(Continued on next page)
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Looking at the Record column, you see further down that GENTRAN:Server 
creates the output EDI segments in a different order. For this one input record 
(HDR), create one N1 - PER loop of Ship To information, then another N1 - PER 
loop of Bill To information. So, GENTRAN:Server should create the output EDI 
segments in the following order: 

◗ N1
◗ N3
◗ N4
◗ PER
◗ N1
◗ N3
◗ N4
◗ PER. 

The Diagnostics Report shows that the output includes the data and that it seems 
as though the mapping conditions were met. However, GENTRAN:Server is 
creating the output segments in the wrong order.

Now it is time to use the Sorting Utility to change the order in which 
GENTRAN:Server executes the instructions.

Sort Mapping
Instructions
Dialog Box

To display the Sort Mapping Instructions dialog box, move the focus to the HDR 
record and click Sort Mapping Instructions on the Map Items menu. 

(Continued on next page)
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Current sort
order of mapping

instructions

This illustration shows Sort Mapping Instructions dialog box for the HDR record. 
Notice that the title bar displays the text name of the record, �Header Group.� 

Here are the complete mapping instructions in the current order.

WHEN S10 = ‘HDR’ THEN MAP ‘SD’ TO D78
WHEN S12 >'0'  AND WHEN not data found in S18  THEN MAP 
'US' TO D121
WHEN data found in S19 THEN MAP 'ZZ' TO D129
WHEN data found in S19 THEN MAP 'TE' TO D131
WHEN data found in S12 THEN MAP S17 TO D120
WHEN data found in S19 THEN MAP S19 TO D132
WHEN data found in S28  THEN MAP 'ZZ' TO D129
WHEN data found in S28  THEN MAP 'TE' TO D131
WHEN data found in S28  THEN MAP S28 TO D132
WHEN S26 >'0'  THEN MAP S27  TO D121
WHEN data found in S21  THEN MAP S26 TO D120
WHEN data found in S12  THEN MAP '91' TO D109
WHEN data found in S12  THEN MAP 'ST' TO D107
WHEN data found in S12  THEN MAP S11 TO D108
WHEN data found in S12  THEN MAP S12 TO D110
WHEN data found in S12  THEN MAP S13 TO D115
WHEN data found in S12  THEN MAP S14 TO D116

(Continued on next page)
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WHEN data found in S12  THEN MAP S15 TO D118
WHEN data found in S12  THEN MAP S16 TO D119
WHEN data found in S21  THEN MAP 'BT' TO D107
WHEN data found in S21  THEN MAP '91' TO D109
WHEN data found in S21  THEN MAP S20 TO D108
WHEN data found in S21  THEN MAP S21 TO D110
WHEN data found in S21  THEN MAP S22 TO D115
WHEN data found in S21  THEN MAP S23 TO D116
WHEN data found in S21  THEN MAP S24 TO D118
WHEN data found in S21  THEN MAP S25 TO D119

Reordering the
mapping

instructions

Since the source fields are all in the same input record, order the mapping 
instructions by the destination fields, placing the earliest first. 

Ordering by destination fields
First, identify the instructions that map to each output segment. Put the mapping 
instructions that create the Ship To N1 - PER loop first, followed by the 
instructions that create the Bill To loop. The mapping instructions that create each 
segment must be in the following order: the N1 instructions first, the N3 
instructions second, the N4 instructions forth, and the PER instructions last. 

Ordering the first mapping instruction to be executed
The mapping to the PTD segment (D78) must occur first because this is the start 
of the outer loop. Move the mapping instruction �WHEN S10 = �HDR� THEN MAP 
�SD� TO D78� from the Current Execution list to the New Execution Order list. 
When this instruction is at the top of the list, the translator executes it first.

Mapping instructions from Ship To fields to N1 segment
The mapping instructions from the Ship To fields to the N1 segment are:

WHEN data found in S12  THEN MAP '91' TO D109
WHEN data found in S12  THEN MAP 'ST' TO D107
WHEN data found in S12  THEN MAP S11 TO D108
WHEN data found in S12  THEN MAP S12 TO D110

Select these instructions in the Current Execution box and move them over to the 
New Execution Order box. They now follow the first instruction.

(Continued on next page)
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The screen now resembles the illustration below.

The mapping instructions from the Ship To fields to the N3 segment are:

WHEN data found in S12  THEN MAP S13 TO D115
WHEN data found in S12  THEN MAP S14 TO D116

The mapping instructions from the Ship To fields to the N4 segment are:

WHEN data found in S12  THEN MAP S15 TO D118
WHEN data found in S12  THEN MAP S16 TO D119
WHEN data found in S12  THEN MAP S17 TO D120
WHEN S12 >'0'  AND WHEN not data found in S18  THEN MAP 
'US' TO D121

The mapping instructions from the Ship To fields to the PER segment are:
WHEN data found in S19  THEN MAP 'ZZ' TO D129
WHEN data found in S19  THEN MAP 'TE' TO D131
WHEN data found in S19  THEN MAP S19 TO D132

Moving remaining instructions
Now move, in order, the mapping instructions to the N3 segment, the N4 segment, 
and the PER segment. Then follow the same sequence for the mapping 
instructions from the Bill To fields.

Next, identify the mapping instructions to the N1 segment and move those to the 
New Execution Order box. We follow with the N3, N4, and PER mapping 
instructions. Once all the mapping instructions are on the New Execution Order 
box, click OK to change the old order and save the new one. Finally, save and 
compile the map file.

(Continued on next page)
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Revised results When using the revised map to run translation, the system produces the following 
output file.

ISA*00*          *00*          *01*1111111111     *01*2222222222     
*961125*1621*U*00200
GS*PT*1111111111*2222222222*961125*1621*18*X*003020
ST*867*0001
BPT*00*0*960722
N1*SF*Company XYZX
N4*Someplace*CA*94128
PTD*SD

We now have two
separate N1 - PER

loops.

N1*ST*Destination ABCD*91*106008
N3*3080 Scenic Boulevard
N4*SANTA CRUZ*CA*95051*US
PER*ZZ**TE*2283331111
N1*BT*Destination EFGH*91*106008
N3*2456 LAWRENCE EXPRESSWAY
N4*SANTA CLARA*CA*95111*US
PER*ZZ**TE*1112422211
QTY*32*1
LIN**MG*6264401830
UIT*EA*1197
PID*F****Large Things in a box
DTM*011*960715
QTY*32*1
LIN**MG*6264401830
UIT*EA*1197
PID*F****More Things in a box
DTM*011*960715
SE*24*0001
GE*1*18
IEA*1*000000018

(Continued on next page)
Mapping and Translation Guide � February 2002



Troubleshooting Mapping Instructions Sorting Utility Example 10 - 29
Diagnostics
Report

To verify that these are the desired results, generate a new Diagnostics Report. 
The report shows the new mapping instruction execution order for only the HDR 
input record.

File Line = 2
Record ID = HDR
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   HDR              S10  -> D78  PTD    001   Conditional

This is the first
N1-PER loop.

003   106008           S12  -> D109 N1     003   Conditional
003   106008           S12  -> D107 N1     001   Conditional
002   Destination ABCD S11  -> D108 N1     002   Conditional
003   106008           S12  -> D110 N1     004   Conditional
004   3080 Scenic Rd   S13  -> D115 N3     001   Conditional
005   (null)           S14  -> D116 N3     002   Conditional
006   SANTA CRUZ       S15  -> D118 N4     001   Conditional
007   CA               S16  -> D119 N4     002   Conditional
008   95051            S17  -> D120 N4     003   Conditional
009   (null)           S18  -> D121 N4     004   Part 2 of 2
003   106008           S12  -> D121 N4     004   Part 1 of 2
010   2283331111       S19  -> D129 PER    001   Conditional
010   2283331111       S19  -> D131 PER    003   Conditional
010   2283331111       S19  -> D132 PER    004   Conditional

This is the second
N1-PER loop.

012   106008           S21  -> D107 N1     001   NEW RECORD
012   106008           S21  -> D109 N1     003   Conditional
011   Destination EFGH S20  -> D108 N1     002   Conditional
012   106008           S21  -> D110 N1     004   Conditional
013   2456 LAWRENCE EX S22  -> D115 N3     001   Conditional
014   (null)           S23  -> D116 N3     002   Conditional
015   SANTA CLARA      S24  -> D118 N4     001   Conditional
016   CA               S25  -> D119 N4     002   Conditional
017   95111            S26  -> D120 N4     003   Conditional
018   USA              S27  -> D121 N4     004   Conditional
019   1112422211       S28  -> D129 PER    001   Conditional
019   1112422211       S28  -> D131 PER    003   Conditional
019   1112422211       S28  -> D132 PER    004   Conditional
------------------------------------------------------------

Notice that for each Ship To and Bill To mappings, GENTRAN:Server now creates 
the N1 through PER segments in the proper order and the exercise is finished.
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Diagnostic Report 0

Overview

Introduction This chapter describes the Diagnostics report and explains how and when to use 
the report to analyze unexpected results from mapping instructions.

Purpose of the
Diagnostics

report

The Diagnostics report utility associates each translated source field with all 
destination fields or system variables that receive part or all of the source field�s 
value. The report also indicates the source of the input value (either the value in 
the current field, a calculation using the value in the current field, or a system 
variable) and the current value of the source field. 

Comment
Each line of the Diagnostics report indicates the current value of the source field 
at each point in the translation; a line may not indicate the final value that 
GENTRAN:Server writes to the destination. That final value includes the current 
value and any additions, subtractions, or other modifications dictated by the 
remainder of the mapping instructions.

Translation
tables you can

analyze

You can analyze any MAP File translation table (.tbl) and generate a Diagnostics 
report whenever you run a translation.

When to use the
Diagnostics

Report Utility

Use a Diagnostics report for the following purposes:

◗ To aid in learning the translation order that GENTRAN:Server uses. Knowing 
the translation order can help you learn to write efficient mapping instructions 
that give the desired translation results.

◗ To document and track complex mapping instructions that may include 
system variables or macros.

◗ To help locate mapping instructions that give unexpected results, such as

� Extra records/segments
� Missing fields/elements
� Unexpected values in fields or elements

◗ To identify which input record/segment caused the translator to produce 
unexpected results.
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How to Generate a Diagnostics Report

Introduction There are two ways to generate a Diagnostics report:
◗ Within GENTRAN:Server, click Enable Debugging on the Translate Inbound/

Outbound Document dialog box.
◗ On the command line or in a batch file, enter the lftran command with the �d� 

parameter.

Preparing to
generate a

Diagnostics
Report

Before generating a Diagnostics report, you must first use the GENTRAN:Server 
Visual Mapper to save and compile the map you are using for the translation. 
Compiling the Map produces the translation table file.

For more information about saving and compiling maps with the Visual Mapper, 
see the Mapping chapter in this guide.

Generating the
report from

within
GENTRAN:Serve

r

To generate a Diagnostics Report from within GENTRAN:Server, follow this 
procedure. 

(Continued on next page)

Step Action

1 Open GENTRAN:Server

2 Click Translate on the Main menu.

3 Click Inbound or Outbound on the Translate menu.

4 Click Translation Option on the Translate Document dialog box.

5 Click List Segment IDs in the Select Options box.

6 Click OK.

System Response
GENTRAN:Server translates the input file, generates the 
Diagnostics report, names the report trans.ord, and writes it to the 
GENTRAN:Server temporary directory.
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Generating the
report from the
command line

To generate a Diagnostics report from the command line, use the lftran command 
line program with the �d� parameter. The �d� parameter prompts lftran to generate 
the Diagnostics report after the translation is complete.

UNIX command line example
This is an example of a command-line command in UNIXTM.

lftran <input file name> -id

Reference
For more information about lftran command parameters, see the 
GENTRAN:Server Technical Reference Guide.

Command Part Description

<input file name> Contains the name of the input file (i.e., the file containing 
the EDI data you are translating)

i Indicates inbound translation

d Writes the segment IDs to xlcntl.err during translation and 
writes the Diagnostics report file, trans.ord, to the 
GENTRAN:Server temporary directory
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How to View and Print the Diagnostics Report

Introduction The Diagnostics report file, trans.ord, is an ASCII text file. 

On-screen
viewing

You can use any text editor to read the report on the screen.

Printing the
report

The most effective use of the report comes from reviewing a printed copy.

Use either your text editor�s print command or an operating system print 
command to print the trans.ord file. The system stores this file in the 
GENTRAN:Server report directory (Workstation product level) or the appropriate 
user directory (GENTRAN:Server product level and higher).
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How to Use a Diagnostics Report

Before you begin Before you begin to study the mapping instructions and their results, have the 
following available:
◗ A hard copy of the translation output file

This shows you the translated application or EDI data, in the order in which 
the translator writes it.

◗ A hard copy of the Diagnostics report

This shows you the order in which the translator executes the mapping 
instructions for a specified source record/segment.

◗ A hard copy of the input file you are translating

This shows the source application or EDI data that was translated, in the 
order in which the translator received it.

◗ Your computer screen with the Mapping Instructions window open and 
displaying the mapping instructions of interest.

Analyzing your
mapping

instructions

Use this table to determine how to analyze your mapping instructions.

Comment
You may have to close the Mapping Instructions window to return to the Visual 
Mapper and select another GROUP of mapping instructions (single record/
segment) for display in the Mapping Instructions window.

IF you want to determine� THEN�

Whether GENTRAN:Server translated 
your input data exactly as you 
intended

Study the output file. Take note of any 
output record/segment and field/
element that differs in any way from 
your expectations.

Why GENTRAN:Server did not 
translate your input data as expected

Study the Diagnostics report to find 
the order the translator used to 
execute the mapping instructions.

The order in which the translator 
received the data

Study the input file.

Which mapping instructions translated 
the input data into the output data

Check the instructions displayed in the 
Mapping Instructions window. 
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How to Read a Diagnostics Report

Introduction This topic contains a sample Diagnostics report and a table that describes the 
report�s lines and columns.

Sample
Diagnostics

Report

This is a sample Diagnostics report. For the purpose of printing the report in this 
guide, the spacing differs from the actual report.

Input File = c:\server\data\input
Table File = c:\server\maps\BEFORE.TBL
------------------------------------------------------------
File Line = 1
Record ID = ST
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 2
Record ID = BEG
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
003   AAA96226         S38  -> D82  005    003
008   Z01224D          S43  -> D87  005    005
003   AAA96226         S38  -> D7   001    003
008   Z01224D          S43  -> D51  001    024
------------------------------------------------------------
File Line = 3
Record ID = N1
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
002   PAUL STANLEY     S83  -> D15  001    004   Conditional
------------------------------------------------------------
File Line = 4
Record ID = N2
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 5
Record ID = N3
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   SUPERSTAR FILMS  S90  -> D30  001    005   Conditional
002   1166 ELM ST      S91  -> D31  001    006   Conditional
------------------------------------------------------------

(Continued on next page)
Mapping and Translation Guide � February 2002



How to Read a Diagnostics Report Troubleshooting Mapping Instructions10 - 36
File Line = 6
Record ID = PO1
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   001              S209 -> D84  005    004
002   1                S210 -> D88  005    006
007   911122122        S215 -> D89  005    007   Conditional
007   911122122        S215 -> D90  005    008   Conditional
007   911122122        S215 -> D91  005    009   Conditional
003   EA               S211 -> D92  005    010
------------------------------------------------------------
File Line = 13
Record ID = SE
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------

Contents of the
Diagnostics

report

This table describes the contents of the Diagnostics report. 

Column Description

Input File Name of the input file.

Table File Name of the table file, which is the compiled map used to translate 
the input file.

File Line Line number of the input file.

Record 
ID

Identifier of the source record/segment.

Field Number of the source field/element generating output.

Input The current value of the source item. This value can be:

◗ The current value of the source field/element.
If the source field/element is blank, this value is also blank.
If the source field/element is empty or not present in a delimited 
record, the system displays <null>.

◗ The current value of the system variable.
(Continued on next page)
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Source The source field/element you are mapping. This item can be a:
◗ Source field/element label, displayed as an S followed by a 

number.
◗ System variable name, displayed as a dollar sign ($) followed 

by a string.
◗ Literal value, such as a date, character string, or number

Dest The destination of a mapped source field/element. This item can 
be:
◗ Destination field/element labels. These begin with D and are 

followed by a number. 
◗ System variable names. These begin with a dollar sign ($).

Record User-defined name or label for the record or segment that contains 
the destination field/element. 

Field Number of the destination field or element on this line.

Comment Description of the mapping for the source field/element:

Value Meaning

NO MAPPINGS The fields or elements in this source record or 
segment are empty and did not generate data. 

blank An unconditional mapping instruction 
generated the data.

NEW RECORD* The source field or element generates a new 
copy of the destination record or segment.

Part <N1> of 
<N2>

The field or element is one of two or more 
sources used in mapping instructions or 
conditions.

◗ N1 = the number for this part of the value.
◗ N2 = the total number of parts in the value.

(Continued on next page)

 (Contd)
Column Description
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CAUTION
A field/element does not generate output when:

◗ No mapping instruction uses it as a source item
◗ The mapping instruction using it as a source item is conditional and the 

condition is not satisfied.
Within a section (denoted by dashed lines), the information lines are in the order 
in which GENTRAN:Server will map them.

Conditional� The mapping instruction using the source field 
or element is conditional and the condition is 
satisfied.

Table footnotes
If a mapping instruction that uses two or more source values to 
determine the destination value also generates a new record, the 
Comment column displays NEW RECORD instead of Conditional 
or Part <N1> of <N2>.

If a conditional mapping instruction uses two or more source values 
to determine the destination value, the Comment column displays 
Part <N1> of <N2> instead of Conditional.

 (Contd)
Column Description
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Diagnostics Report Example

Introduction This topic describes a typical situation that you may have with your mapping 
instructions and shows how you can use a Diagnostics report to understand why 
the output file data contains an unexpected duplicate record. The example steps 
you through the process of identifying and correcting a problem in a set of 
mapping instructions.

About the
example

In this example, EDI data was translated to application data. We will look at the 
input file, the output file, the map, the Diagnostics report, and the mapping 
instructions.

Input file First, we look at the source EDI data from the input file to see the order in which 
the translator received the data.

ISA*00*          *00*          *01*b              *01*a              
*951129*2225*U*00200
GS*PO*b*a*951129*2225*1439*X*002000
ST*850*1439001
BEG*00*SA*AAA96226***951129**Z01224D
N1*ST*PAUL STANLEY*12*9999999999999
N2*XXXZZZ            ORD 01111222

Notice the two N3
segments in a row.

N3*SUPERSTAR FILMS INC.*1166 ELM ST
N3*LOBBY Z*RM 1101
N4*NYC*NY*11136
PO1*001*1*EA*3.75*PZ*IN*911122122*VN*ZXX222
J2X*TI*F*RED VINYL RECORD
CTT*1*1
SE*29*1439001
GE*1*1439
IEA*1*000001438

(Continued on next page)
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Inbound map Next, we look at the inbound map that was used to translate the EDI data in the 
input file.

Using the above map to translate the EDI data in the input file should produce one 
001 header record and one 005 detail record.

Output file Now let�s look at the output file. This is the resulting output file for the first 80 
columns:

00154547   AAA96226  PAUL STANLEY   SUPERSTAR FILMS INC.        1166 ELM ST

00154547                                                          RM 1101    

00554547   AAA96226  00001Z01224D

Notice that the output file contains two 001 records. To find out why, we generate 
a Diagnostics report.

(Continued on next page)
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Diagnostics
report

To generate the Diagnostics report, we run the translation again by entering lftran 
with the �d� parameter on the command line. Here is the result:
Input File = c:\server\data\input
Table File = c:\server\maps\BEFORE.TBL
------------------------------------------------------------
File Line = 1
Record ID = UNKNOWN
------------------------------------------------------------
File Line = 2
Record ID = UNKNOWN
------------------------------------------------------------
File Line = 3
Record ID = ST
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 4
Record ID = BEG
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
003   AAA96226         S38  -> D82  005    003
008   Z01224D          S43  -> D87  005    005

Field 003 creates
the first 001 record.

003   AAA96226         S38  -> D7   001    003
008   Z01224D          S43  -> D51  001    024
------------------------------------------------------------
File Line = 5
Record ID = N1
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
002   PAUL STANLEY     S83  -> D15  001    004   Conditional
------------------------------------------------------------
File Line = 6
Record ID = N2
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 7
Record ID = N3
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   SUPERSTAR FILMS  S90  -> D30  001    005   Conditional
002   1166 ELM ST      S91  -> D31  001    006   Conditional
------------------------------------------------------------
File Line = 8
Record ID = N3
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------

Field 002 creates
the

second 001 record.

002   RM 1101          S91  -> D31  001    006   NEW RECORD
001   LOBBY Z          S90  -> D33  001    007   Conditional
------------------------------------------------------------
File Line = 9

(Continued on next page)
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Record ID = N4
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   NYC               S93  -> D35  001   008   Conditional
002   NY                S94  -> D36  001   009   Conditional
003   11136             S95  -> D38  001   011   Conditional
------------------------------------------------------------
File Line = 10
Record ID = PO1
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   001              S209 -> D84  005    004
002   1                S210 -> D88  005    006
007   911122122        S215 -> D89  005    007   Conditional
007   911122122        S215 -> D90  005    008   Conditional
007   911122122        S215 -> D91  005    009   Conditional
003   EA               S211 -> D92  005    010
------------------------------------------------------------
File Line = 11
Record ID = J2X
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
003   RED VINYL RECORD S288 -> D97  005    015
------------------------------------------------------------
File Line = 12
Record ID = CTT
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 13
Record ID = SE
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------

Finding the
cause

To find the cause of the extra record, we follow this three-step procedure:

(Continued on next page)

Step Action

1 Review the Record column to find the identifier of the repeated 
record.

2 Review the Comment column to see if a mapping instruction 
generated a NEW RECORD (in this example, the 001 record).

3 If we find a copy of the 001 record with NEW RECORD in the 
Comment column, check the Record ID for the source record and 
the source Field column for the field that created the new record 
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Locating the
input file line

number

Recall that the File Line numbers in the Diagnostics report refer to the lines in the 
source file. The line number is based on the records in the source side of the map. 
In this example, the header segments are included, so the count starts at the ISA 
record as line 1. (If the ST segment was the first record in the map, then the ST 
segment would be line 1.)

Here is the input file with the lines numbered:

1  ISA*00*          *00*          *01*b              *01*a    
   *951129*2225*U*00200
2  GS*PO*b*a*951129*2225*1439*X*002000
3  ST*850*1439001
4  BEG*00*SA*AAA96226***951129**Z01224D
5  N1*ST*PAUL STANLEY*12*9999999999999
6  N2*XXXZZZ            ORD 01111222
7  N3*SUPERSTAR FILMS INC.*1166 ELM ST

Line 8 is the cause
of the second 001

record

8  N3*LOBBY Z*RM 1101
9  N4*NYC*NY*11136
10 PO1*001*1*EA*3.75*PZ*IN*911122122*VN*ZXX222
11 J2X*TI*F*RED VINYL RECORD
12 CTT*1*1
13 SE*29*1439001
14 GE*1*1439
15 IEA*1*000001438

Locating the cause of the extra record
Notice that line 8 in the source file, an N3 segment 02 element, is the cause of the 
second 001 record. Since we expected only one 001 record, we need to check the 
mapping instructions associated with the N3 segment 02 element.

(Continued on next page)
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Mapping
instructions

To begin, we open the map in the Visual Mapper, select the N3 segment 02 
element, and then click on the mini-report button (the eyeglasses icon).

Notice that there is only one group. 

Examining the mini-report
All the elements for the N1 segment through the PER segment loop are in the 
same group. Notice that the N3 segment 02 element has the item label S91. S91 
is part of a GROUP with multiple sources and destinations.

Displaying the mapping instructions for the GROUP
To display the mapping instructions for the GROUP, we place the focus on the 
GROUP number on the mini-report and then click on the Mapping Instructions 
(MI) button.

(Continued on next page)
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Here is the first screen of mapping instructions.

On this screen, we see that S91, the N3 segment 02 element, is mapped to D31 
when S82, the N1 segment 01 element, is ST. 

(Continued on next page)
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Viewing the next screen of mapping instructions
To view the second screen of mapping instructions, we click Next.

Here, we see that S90, the N3 segment 01 element, is mapped to D30 when the 
N1 segment 01 element is ST and this is the first repetition of the N3 segment. 

(Continued on next page)
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Viewing the third screen of mapping instructions
We click Next again to view the third screen of mapping instructions.

On this last screen, notice that the following happens when the N1 segment 01 
element is ST and this is the second repetition of the N3 segment:

◗ S90, the N3 segment 01 element is mapped to D33.
◗ S91, the N3 segment 02 element, is mapped to D34.

Recall from the first mapping instructions screen that S91 is mapped to D31 when 
the N1 segment 01 element is ST.

Analysis In the N1 loop of the input data, the N1 segment 01 element is ST, so the mapping 
conditions from the first screen are met. We see that there are two N3 segments 
in the data. In the trans.ord file, line 8 contains the second N3 segment the 
translator processes. This tells us that the N3 segment 02 element caused a 
second 001 record in the output file.

(Continued on next page)
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How the source data was processed
This table describes how the source data was processed.

(Continued on next page)

Stage Description

1 The compiler evaluated all three of these screens for each source 
segment that has elements in this group. 

2 When the N1 segment with 01 element equal to ST arrived in the 
data, the translator executed the mapping instructions on the first 
screen.

3 When the N2 segment arrived in the data, nothing happened 
because there are no mappings on elements in the N2 segment.

4 When the N3 segment arrived in the data, the 01 element was 
mapped to D30 from the second screen. The N3 segment 02 
element was then mapped to D31 from the first screen, because 
the N1 segment 01element still equaled ST for this loop. 

5 When the second N3 segment appeared in the data, the N3 
segment 02 field was mapped from the first screen, because its 
destination field (D31) came before the others mapped from N3 
segment (D33 and D34). 

6 The N3 segment 01element was then mapped from the third 
screen, because this was the second repetition of this segment in 
the data.

7 The N3 segment 01 element was mapped again, this time to D34, 
which came from the third screen.

8 The mapping of S91 to D31 was made for each N3 segment for this 
loop. 

Conclusion
This mapping statement should be on the second screen. The 
mapping of S91 to D31 would occur for the first instance of the N3 
segment and the mapping of S91 to D34 would occur for the 
second N3 segment.
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Revising the
mapping

instructions

This table describes the procedure used to eliminate creation of the extra 001 
record.

New output file Running translation again produced this output file:
00154547   AAA96226  PAUL STANLEY   SUPERSTAR FILMS INC. 1166 ELM ST   LOBBY Z

00554547   AAA96226  00001Z01224D

This file shows that translation produced one 001 record and one 005 record, 
which is what we expected.

New results For additional proof that we have produced the data we want, we generate a new 
Diagnostics report. Notice that the N3 segment 002 element does not create a 
second 001 record.
Input File = c:\server\data\input
Table File = c:\server\maps\AFTER.TBL
------------------------------------------------------------
File Line = 1
Record ID = UNKNOWN
------------------------------------------------------------
File Line = 2
Record ID = UNKNOWN
------------------------------------------------------------
File Line = 3
Record ID = ST
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 4
Record ID = BEG
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
003   AAA96226         S38  -> D82  005    003
008   Z01224D          S43  -> D87  005    005
003   AAA96226         S38  -> D7   001    003
008   Z01224D          S43  -> D51  001    024

(Continued on next page)

Step Action

1 Remove the mapping statement of S91 to D31 from the first 
screen.

2 Add the mapping statement of S91 to D31 to the second screen.

3 Save and recompile the map.
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------------------------------------------------------------
File Line = 5
Record ID = N1
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
002   PAUL STANLEY     S83  -> D15  001    004   Conditional
------------------------------------------------------------
File Line = 6
Record ID = N2
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 7
Record ID = N3
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   SUPERSTAR FILMS  S90  -> D30  001    005   Conditional

The N3 segment
002 element does

not create a second
001 record.

002   1166 ELM ST      S91  -> D31  001    006   Conditional
------------------------------------------------------------
File Line = 8
Record ID = N3
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   LOBBY Z          S90  -> D33  001    007   Conditional
------------------------------------------------------------
File Line = 9
Record ID = N4
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   NYC              S93  -> D35  001    008   Conditional
002   NY               S94  -> D36  001    009   Conditional
003   11136            S95  -> D38  001    011   Conditional
------------------------------------------------------------
File Line = 10
Record ID = PO1
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
001   001              S209 -> D84  005    004
002   1                S210 -> D88  005    006
007   911122122        S215 -> D89  005    007   Conditional
007   911122122        S215 -> D90  005    008   Conditional
007   911122122        S215 -> D91  005    009   Conditional
003   EA               S211 -> D92  005    010
------------------------------------------------------------
File Line = 11
Record ID = J2X
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
003   RED VINYL RECORD S288 -> D97  005    015
------------------------------------------------------------

(Continued on next page)
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File Line = 12
Record ID = CTT
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
File Line = 13
Record ID = SE
Field Input (18 chars) Source  Dest Record Field Comment
----- ---------------- ------  ---- ------ ----- -----------
                                                 NO MAPPINGS
------------------------------------------------------------
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Suggestions for Using a Diagnostics Report

Introduction This topic contains suggested steps for using a Diagnostics report in three 
common mapping situations:
◗ Extra records/segments
◗ Missing fields/elements
◗ Unanticipated data.

Once you identify the cause, use the Mapping Instructions window in the Visual 
Mapper to modify the mapping instructions, or use the Sorting Utility to reorder the 
mapping instructions for the source record/segment.

References
For information on using the Mapping Instructions window to add, edit, or delete 
mapping instructions, see the Mapping chapter in this guide. 

For information on using the Sorting Utility, see the Sorting Utility topic in this 
chapter.

Finding the
cause of extra

records/
segments

Use this procedure to find the cause of an extra record/segment.

Step Action

1 Look down the Record column to find instances of the repeated 
destination record/segment.

2 Whenever you see the identifier of the repeated record/segment, 
check the Comment column on the same line.

System Response
If the system created a second or subsequent copy of a record/
segment, the Comment column contains NEW RECORD.

3 On the same line, check the source Field column to determine the 
number of the field/element that actually created the new record/
segment.

System Response
The system displays the Record ID for the source record/segment 
immediately above the column headings.

(Continued on next page)
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Finding the
cause of missing

fields/elements

Use this procedure to find the cause of a missing field/element.

4 Open the map in the Visual Mapper and review the mapping 
instructions and conditions for the field/element you identified in 
step 3. Look for:
◗ Multiple mapping instructions to the same destination
◗ Multiple conditions that could be met.

If you do not find either of the above items, the cause could be how 
the mapping instructions were sorted

Reference
For more information about sorting instructions, refer to the topic 
Sorting Utility in this chapter. 

 (Contd)
Step Action

Step Action

1 Review the Record column to find instances of the destination 
record/segment that is missing a field/element.

2 Check the destination Field column on each line in which a field/
element is missing. 

3 Record the field number whenever you see the identifier of the 
record/segment that is missing a field/element.

Note
Recording the field numbers on paper gives you a list against which 
you can check for missing fields/elements. Remember, that source 
records/segments are in sequential order on the Diagnostics report 
but the fields/elements within each source or destination record/
segment may not be.

4 Check the Comment column on that same line to determine if the 
source field/element is creating a new copy of a destination record.

5 If the Comment column contains NEW RECORD, start a separate 
list of field/element numbers.

6 When you have looked at every destination record/segment of the 
type missing a field, check the list or lists of field/element numbers 
for breaks in the sequence.

(Continued on next page)
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Finding the
cause of

unanticipated
data

Use this procedure to find the cause of unanticipated data.

7 Find each break in the sequence of field/element numbers in a 
destination record/segment of the type missing a field

8 From each break forward, look for an instance of a newly created 
destination record/segment of the type missing a field. Look first in 
the Record column and then in the Comment column.

9 Look at the mapping instructions, the Diagnostics report, and the 
input file. 

You want to determine why the mapping instructions for the source 
field/element creating the new record were executed before the 
instructions for the source field/element creating the missing 
destination field/element. 

Look for:
◗ Multiple mapping instructions to the same destination
◗ Multiple conditions that could be met.

If you do not find either of the above items, the cause could be how 
the mapping instructions were sorted

Reference

For more information about sorting instructions, refer to the topic 
Sorting Utility in this chapter. 

 (Contd)
Step Action

Step Action

1 Review the Record column to find instances of the destination 
record/segment containing the unanticipated data.

2 For each line on which you see the identifier of the record/segment 
containing the unanticipated data, check the destination Field 
column.

3 Check the Input column for each line on which you find an instance 
of the number for the field/element containing the unanticipated 
data.

(Continued on next page)
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4 Use the following table to determine your next action

If the Input column data is... Then...

What you expected to see in the 
destination field/element 

Continue your review.

Note
This indicates you have not yet 
found the line containing the 
source field/element causing the 
unanticipated data.

Not what you expected to see in 
the destination field/element 

Continue with step 5.

Note
This may or may not be the 
source field/element causing 
unanticipated data.

5 Check the Comment column on the line containing the unexpected 
data.

Note
The Comment column can contain blanks, Conditional, NEW 
RECORD, or Part <N1> of <N2>.

6 Open the map in the Visual Mapper. 

7 Check the mapping instructions that use the item in the source 
Field column of the Diagnostics report as the mapping instruction 
source. 

Look for:

◗ Mapping instructions that use a system variable.
◗ Multiple mapping instructions to the same destination
◗ Multiple conditions that could be met.

If you do not find either of the above items, the cause could be how 
the mapping instructions were sorted

Reference
See the Sorting Utility topic in this chapter for more information 
about sorting instructions. 

 (Contd)
Step Action
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Overview 0

Introduction

In this chapter This chapter describes the procedures for maintaining your Trading Partnership 
files and records.

Key Terms This table lists the key terms used in this chapter.

Term Description

category A user-definable record that enables you to group 
Trading Partnerships.

contact record A record containing the name, address, and telephone 
numbers of an individual at your trading partner�s 
business.

Group Organization 
record

A record containing all information specific to a single 
division or department in your trading partner�s 
organization. 

Interchange 
Organization record

A record containing all information specific to a single 
company.

Reconciliation ID 
record

A record containing a set of interchange and group IDs 
used with functional acknowledgments.

Standard Cross-
Reference Table

The GENTRAN:Server feature that enables you to build 
a table of standard values. GENTRAN:Server can use 
these values to find the Trading Partner record for 
certain inbound documents.

TRADACOMS 
record

A record containing all of the supplementary Trading 
Partnership information for use with TRADACOMS 
standards.

(Continued on next page)
Mapping and Translation Guide � February 2002



Introduction Working with Trading Partnerships11 - 4
Trading Partner 
record

One of the records maintained in trading partner files: 
◗ Interchange Organization record
◗ Group Organization record
◗ Trading Partnership record
◗ Contact record 
◗ Reconciliation ID record
◗ Category record
◗ TRADACOMS record.

Trading Partnership An arrangement with a specific trading partner to 
exchange information in a specific document type and 
using a particular standard version.

Trading Partnership 
code

A code you define that uniquely identifies a Trading 
Partnership record.

Trading Partnership 
record

A record containing information about one of the 
Trading Partnerships you have established. 

 (Contd)
Term Description
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Trading Partnership Records

Introduction Trading Partnership records hold information about your trading partner. 
GENTRAN:Server uses the information you define in the Trading Partnership 
records every time it processes your data. During translation, GENTRAN:Server 
inserts the information defined in the Trading Partnership records into the stream 
of data that you are sending your trading partner. Specifically, GENTRAN:Server 
uses this information when building the Interchange envelope, the Group 
envelope, and the transaction set envelopes.

This section describes all Trading Partnership records and examines the 
relationships among them.

Understanding
Trading

Partnership
records

Trading Partnership records are those records you maintain with the Trading 
Partnership Editor. The following records define a trading Partnership:
◗ Interchange Organization record
◗ Group Organization record
◗ Trading Partnership record
◗ Category record
◗ Reconciliation ID record
◗ Contact record
◗ TRADACOMS record.

The system hierarchically defines the Trading Partner records. At the highest level 
is the Interchange Organization record. Below the interchange level is the Group 
Organization record. At the lowest level is the Trading Partnership record. 

To translate data in GENTRAN:Server, you must define each of the following for 
every document that you want to process:
◗ One Interchange Organization record
◗ One Group Organization record
◗ One Trading Partnership record.

Depending on your organization�s needs, you may also define the Category, 
Reconciliation ID, and Contact, and TRADACOMS records for the Trading 
Partnership. 

(Continued on next page)
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Interchange
Organization

record

The Interchange Organization record contains information that is used when 
GENTRAN:Server creates the interchange envelope around your EDI data. 
Interchange Organization records must be unique for each interchange-level 
organization. In other words, you must have a separate Interchange Organization 
record for each interchange-level organization.

Group
Organization

record

The Group Organization record contains information that GENTRAN:Server uses 
when creating the group envelope around your EDI data. You may create multiple 
group records for a single interchange record.

Group Organization records must be unique for each group-level organization. In 
other words, there must be a separate Group Organization record for each group-
level organization.

Trading
Partnership

record

The Trading Partnership record contains basic Trading Partnership information 
such as the Trading Partnership Code, the compiled map (translation object) 
GENTRAN:Server will use when translating business documents for this partner, 
and whether the system will generate an acknowledgment. 

Trading Partnership records need not be unique for each Trading Partnership. In 
other words, two or more trading partnerships can use the same Trading 
Partnership record.

Category record The Category record is a record you create that allows you to group trading 
partnerships according to similarities of interest. You may create up to five 
category types for use with your trading partnerships.

Reconciliation ID
record

The Reconciliation ID record contains Reconciliation IDs for use in functional 
acknowledgments and CONTRLs. If the Interchange IDs and Group or Application 
IDs in your functional acknowledgments or CONTRLs are different than those 
used in the document being acknowledged, you must have a Reconciliation ID 
record in addition to a Trading Partnership record for each Trading Partnership.

Reconciliation ID records must be unique for each Trading Partnership.

(Continued on next page)
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Contact record You use contact records to store the name, address, and telephone number of a 
contact at your trading partner�s place of business. You can create separate 
Contact records at the interchange, group, and trading partner level.

Contact records must be unique for each individual with whom you communicate 
in your trading partner�s organization.

TRADACOMS
record

You create the TRADACOMS record only when exchanging documents with a 
trading partner who uses the TRADACOMS standard.

TRADACOMS records must be unique for each Trading Partnership using 
TRADACOMS standards.
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Trading Partnership 
Administration 0

The Trading Partner Administration Explorer

Introduction You carry out most day-to-day activities involving your Trading Partnership 
records through the Trading Partner Administration explorer. 

Trading Partner
Administration

explorer

This illustration shows an example of the Trading Partner Administration 
explorer for GENTRAN:Server Workstation.

(Continued on next page)

Menu bar

Toolbar

Interchange 

Group 

Trading 
Partnership

Status bar
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Host and
environment

name

 In the GENTRAN:Server for UNIX version, the title bar displays the host name 
and environment name.

Trading Partner
Administration
explorer fields
and functions

This table describes the fields and functions of the Trading Partner 
Administration explorer window.

Viewing options The Trading Partnership Administration window has four viewing options:

◗ No tree
◗ Trading Partnership records only
◗ Organization records only
◗ Entire tree

Reference
See the How to Select a Trading Partner View topic in this chapter for information 
about selecting a viewing option.

(Continued on next page)

Field Function

Menu bar Opens menus to display commands.

Toolbar Starts another function, such as the Save or Delete 
function.

Interchange Identifies an Interchange Organization record, which 
contains all information specific to a single company

Group Identifies a Group Organization record, which 
contains all information specific to a single division or 
department in your trading partner�s organization.

Trading Partnership Identifies a Trading Partnership record, which 
contains information about one of the trading 
partnerships you have established.

Status bar Displays a status message, prompt, or toolbar button 
description.
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Right mouse
button

You can click the right mouse button (right-click) to display a shortcut menu to use 
with Trading Partnership Administration.

This illustration shows the shortcut menu that appears when you click the right 
mouse button.
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How to Access Trading Partnership Administration

Opening the
Trading

Partnership
Administration

window

Use this procedure to open the Trading Partnership Administration window.

Note
You can also access the Trading Partnership Administration window by clicking 
the Trading Partnership Maintenance button on the menu bar of the Main Menu.

Step Action

1 Open GENTRAN:Server.

2 Click Edit on the Main Menu.

3 Click Trading Partnership on the Edit menu.

System Response

IF� THEN�

This is the first time anyone has 
opened Trading Partnership 
Administration

GENTRAN:Server displays the 
Preferences dialog box.

Your preferences for Trading 
Partnership Administration have 
been set

GENTRAN:Server displays the 
Trading Partnership 
Administration window.

4 Use this table to determine your next step.

IF GENTRAN:Server displays 
the�

THEN go to�

Preferences dialog box. How to Set TP Administration 
Preferences in this chapter.

Trading Partnership 
Administration window.

How to Select a Trading Partner 
View in this chapter.
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How to Select a Trading Partner View

Overview This section explains the four views available in Trading Partnership 
Administration.

Introduction You choose a view in Trading Partnership Administration based on these criteria:
◗ The number of Trading Partnership records you want to display. 
◗ The number of records you maintain.
◗ Whether you have assigned Interchange and Group Organization codes to 

your Trading Partnership records.

Four viewing
options

This table lists the available views and their functions.

No Tree When you select No Tree view, the system displays a blank screen. 

Use this view for these tasks:

◗ Searching for and editing a single Trading Partnership Record.
◗ Creating new Interchange Organizations, Group Organizations, and Trading 

Partnership records.
◗ Performing all functions quickly.

(Continued on next page)

View� Description�

No Tree An empty dialog box.

TP Only A list of Trading Partnership records.

Org Only A list of all Organization codes. Use when you have a large 
number of records.

Entire Tree A complete tree view that includes a list of all Organization and 
Trading Partner records. Includes records that are not defined 
for any Organization code.
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Illustration This illustration shows the Trading Partnership Administration using the No Tree 
view.

TP Only When you select TP Only view, the system displays a list of all Trading 
Partnership records.

Note
The TP Only view displays only Trading Partnership records, not Interchange or 
Group Organization codes.

(Continued on next page)
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Illustration This illustration shows the Trading Partnership Administration using the TP Only 
view.

Org Only When you select Org Only view, the system displays a tree containing all 
available Interchange Organization codes and those Group Organizations not 
associated with an Interchange Organization. 

Note
Initially, this view does not display the Trading Partnership records.

(Continued on next page)
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Procedure When you select an Interchange Organization code, Trading Partnership 
Administration expands the tree to display the Group Organizations.

Use this procedure to select a Trading Partnership Record.

Note
You can use this view to display only those Trading Partnership records that are 
assigned to an Interchange Organization code.

Illustration This illustration shows the Trading Partnership Administration using the Org Only 
view.

(Continued on next page)

Step Action

1 Click on the appropriate Interchange Organization code to select 
it.

2 Select the appropriate Group Organization code.

3 Select the Trading Partnership record.
Mapping and Translation Guide � February 2002



How to Select a Trading Partner View Working with Trading Partnerships11 - 16
Entire Tree view When you select the Entire Tree view, the system displays all Interchange and 
Group Organization codes and all Trading Partnership records.

Note
When you select an Interchange Organization code, the system displays the 
related Group Organization codes. When you select a Group Organization code, 
the system displays the related Trading Partnership records.

Illustration This illustration shows the Trading Partnership Administration using the Entire 
Tree view.
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How to Set TP Administration Preferences

Overview The default view of the Trading Partnership Administration window is initially set to 
Build Entire Tree.

Note
You can select another view as the default using the Trading Partnership 
Administration Preference dialog box by clicking Preferences on the Settings 
menu. However, if you are using GENTRAN:Server for UNIX, the Security 
Administrator must grant you the authority to change the setting.

Illustration The illustration shows the Trading Partnership Administration Preferences dialog 
box.

Setting the
default view

To set another view as the default, change the value of the Default Trading 
Partner view text box by clicking the down arrow and selecting one of the four 
available views:
◗ No Tree 
◗ Trading Partnership Tree Only
◗ Organization Tree Only
◗ Build Entire Tree

(Continued on next page)
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General Settings You need to define the General Settings prior to creating and editing the Trading 
Partnership Record.

(Continued on next page)

Field Function

Allow same character for 
element, subelement, and 
repeating element 
separators

Disables the warning prompt displayed when the 
same character is used for element, subelement, 
and repeating element separators. Also allows the 
same values.

Validate category values Validates the selected category against the 
database.

Note
Check the Validate category values and choose 
SELECT to display five categories. You can verify 
up to five categories in every Trading Partnership 
Record.

Allow Trading Partnership 
record without map name

Disables the warning displayed whenever you 
create a Trading Partnership record without 
assigning a map name to it, allowing you to create 
a Trading Partnership record without assigning a 
map name.

Note
If you try to create a Trading Partnership record 
without assigning it a map name and this option is 
not selected, the system displays an error 
message.
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Selecting
categories to

validate

Follow this procedure to display and use the Validate Category dialog box.

Step Action

1 Select the Validate category values option under General 
Settings.

2 Click Select.

System Response
The system displays the Validate Category Window.

3 Select the categories you want to validate.

4 Click OK.

System Response
The system returns to the Trading Partnership Administration 
Preferences dialog box.
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How to Set Default Translation Selections

Introduction You can set default (automatically assigned) translation selections for the Trading 
Partnership records you create. You set these choices for the type of translation 
(application-to-standard, application-to-application, etc.).

How the system
uses the

selections

Once you set default translation selections, GENTRAN:Server applies these 
selections to each subsequent Trading Partnership record you create that has the 
specified translation type. If you do not want a Trading Partnership to use the 
default settings, you can set them at the Trading Partnership level to override the 
default selections.

Reference
See How to Set Translation Selections for instructions on setting translation 
selections for a specific Trading Partnership.

When to use Use this procedure to set the translation selections that you normally use for one 
or more specific types of translation. 

Procedure Use this procedure to set default translation selections for a translation type.

Step Action

1 Click Translation Settings from the Settings menu.

2 Select the translation type you want to set from the submenu.

(Continued on next page)
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System Response
The system displays the Translation Options dialog box for the 
translation type you selected.

Example

Reference
See the Translation Options Dialog Boxes topic for descriptions of 
the translation options.

3 Select the default selections that you want to apply to this type of 
translation.

4  Click OK to save your changes.

 (Contd)
Step Action
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How to Search for a Trading Partnership Record

Overview This topic explains how to search for a Trading Partnership record. You can 
search for Trading Partnership records by ranges of values in various fields. You 
can also search for specific values such as:
◗ Interchange or Group IDs
◗ Organization codes
◗ Trading Partnership Codes
◗ Standard versions 
◗ Set IDs, categories, and name. 

You enter the search criteria on the Trading Partner Search dialog box. You can 
run Trading Partner Search on all views except Trading Partner Only view.

Trading Partner
Search dialog
box example

This illustration shows the Trading Partner Search dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Trading Partnership Search dialog box and their 
functions.

Note
You can select multiple fields when searching for Trading Partnership records. 
Each field that you select narrows the search and enables you to focus on a 
specific Trading Partnership.

(Continued on next page)

Field Function

Enter a range of trading 
partnership codes

Searches for Trading Partnerships with Trading 
Partnership codes that fall within the specified 
range.

Target EDI interchange and/
or group IDs

Searches for Trading Partnerships with the 
interchange or group IDs you specify.

Note

The Trading Partnership Editor accepts a dollar 
sign ($) as a wildcard indicator for this field.

Target a specific standard 
version

Searches for Trading Partnerships using a 
specific EDI standard version.

Note

The Trading Partnership Editor accepts a dollar 
sign ($) as a wildcard indicator for this field.

Target message/transaction 
set ID

Searches for Trading Partnerships with 
documents that have message or set ID you 
specify.

Note

The Trading Partnership Editor accepts a dollar 
sign ($) as a wildcard indicator for this field.

Target one or more trading 
partnership categories

Searches for Trading Partnerships based on a 
category you have defined.

Target a specific translation 
mapping table

Searches for Trading Partnerships using a 
specific compiled map or translation object (TPL 
table).

Specify the trading 
partnership name/
description

Searches for a Trading Partnership by name.

Target a specific translation 
type

Searches for Trading Partnerships using one of 
the valid translation types. The Edit button 
displays a list of choices. 
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Trading Partner
Search Results

dialog box

After you enter the search criteria, GENTRAN:Server displays the Trading Partner 
Search Results dialog box. This dialog box displays a list of all Trading 
Partnership records that meet the criteria. You then select the record that you 
want to view or edit from the list. This illustration shows an example of the Trading 
Partner Search Results dialog box.

Fields and
functions

This table lists the fields of the Trading Partner Search Results dialog box and 
their functions.

(Continued on next page)

Field Function

TP Code Lists the Trading Partnership IDs that match your search 
criteria.

Description Displays the Trading Partnership descriptions that match 
your search criteria.
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Procedure Follow this procedure to search for a Trading Partnership record.

Step Action

1 Open Trading Partner Administration.

2 Select Search from the Edit menu or click on the binocular icon.

System Response
Trading Partnership Administration displays the Trading Partner 
Search dialog box.

3 Select your search criteria by clicking the check box in front of the 
criteria you want to use.

4 Click the Edit button to display a dialog box for entering your 
search criteria.

5 Do you want to narrow your search by selecting more criteria?

◗ If YES, repeat Steps 3 and 4 to select additional search criteria.
◗ If NO, continue with Step 6.

(Continued on next page)
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6 Click OK to search your Trading Partnership records.

System Response
The Trading Partner Search Results dialog box displays the list of 
records that match your search criteria.

(Continued on next page)

 (Contd)
Step Action
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7 Use this table to determine your next step.

IF you want to� THEN�

Select all the Trading 
Partnerships in the list

Click Select All.

Unselect all the Trading 
Partnerships in the list

Click Unselect All.

Edit the Trading Partnership 
record

Select the Trading Partner Code 
from the list and click Edit.

Display the Interchange code 
associated with the Trading 
Partnership record

Select the Trading Partner Code 
from the list and click Load.

Load a Trading Partner record 
that is not associated with an 
Interchange Organization 
Record to the tree view

Select the Trading Partner Code 
from the list and click Load.

Close the Trading Partner 
Search Results dialog box

Click Cancel.

 (Contd)
Step Action
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The Trading Partnership Editor

Introduction You use the Trading Partnership Editor to create and maintain your Trading 
Partnership records. When you create a new Trading Partnership record, the 
Trading Partnership Editor guides you through the information that you need to 
define for the type of translation you select. You also use the Trading Partnership 
Editor to alter and update Trading Partnership information in existing records.

Accessing the
Trading

Partnership
Editor dialog box

Use this procedure to open the Trading Partnership Editor.

Trading
Partnership
Editor tabs

These are the Trading Partnership Editor tabs:

◗ Trading Partnership
◗ Inbound EDI Information
◗ Outbound EDI Information
◗ Runtime Information
◗ Archive Information
◗ Inbound Acknowledgment
◗ Outbound Acknowledgment
◗ Categories.

Note
The Trading Partnership Editor displays only the tabs that apply to the Trading 
Partnership record. You probably will not see all eight tabs for every record. 

(Continued on next page)

Step Action

1 Open the Trading Partnership Administration window.

2 Right-click on the Trading Partnership record you want to edit.

System Response
The system displays a menu of available functions.

3 Click Edit.

System Response

The system displays the Trading Partnership Editor dialog box.
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Trading
Partnership tab

This illustration shows an example of the Trading Partnership tab of the Trading 
Partnership Editor dialog box.

Fields and
functions

This table lists the fields of the Trading Partnership tab of the Trading Partnership 
Editor dialog box and their functions. 

Field Function

Trading 
Partnership 
Code

Defines a unique identifier for the Trading Partnership and 
document combination. The translator uses this code when 
creating the segment envelope.
◗ Size: 1-15 alphanumeric characters
◗ No spaces or special characters allowed
◗ Suggestion: Use abbreviation of trading partner�s name 

and Set ID (for example, DYNO810).

Trading 
Partnership 
Description

Provides a brief description of the Trading Partnership. 
(maximum of 30 characters)

(Continued on next page)
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(Continued on next page)

Translation 
Type

Defines the type of translation for the Trading Partnership.

Note
The Translation Type box is view only. You can select a 
translation type only when creating a new Trading 
Partnership.

Map Name Defines the compiled map (translation object) to use when 
translating data for the Trading Partnership. Only translation 
objects (TPL files) are valid selections.

Note

To search for a specific compiled map, click the Map 
Search icon to the right of the Map Name text box.

Reference
See the topic How to Choose a Different Map (Translation 
Object) in this chapter for more information.

Map description Displays the GENTRAN:Server product and version used to 
generate the map.

File Definitions 
filename

Specifies the file definition (.DDF file) that the map uses if the 
input file is an application file.

If the input file is not an application file, this box is disabled.

The browser associated with this box displays all the file 
definitions that reside in the File Definitions directory.

Note
This field links the Trading Partnership record to the file 
definition. You must complete this box when the input side of 
the map is an application format.

 (Contd)
Field Function
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Inbound EDI
Information tab

This illustration shows an example of the Inbound EDI Information tab on the 
Trading Partnership Editor dialog box.

(Continued on next page)
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Fields and
functions

This table lists the fields of the Inbound EDI Information tab of the Trading 
Partnership Editor dialog box and their functions.

Field Function

Standard version Lists the available EDI standards and versions. This is a 
key field that GENTRAN:Server uses to identify the 
Trading Partnership record.

Note

The Trading Partnership Editor accepts a dollar sign ($) as 
a wildcard indicator for this field.

Document ID Lists the available EDI document types that you may 
translate. This is a key field that GENTRAN:Server uses to 
identify the Trading Partnership record.

Note

The Trading Partnership Editor accepts a dollar sign ($) as 
a wildcard indicator for this field.

Accept 
Messages/Sets 
with error(s)

Enables you to accept messages or transaction sets 
containing compliance errors from your trading partner.

Control Numbers

Interchange Initializes the counter used for control numbers for 
business documents that you receive from your trading 
partner.

Note

If you click Maintain globally on the Runtime Information 
tab, this field is unavailable.

Validate 
sequence

Checks the Interchange control numbers to ensure that 
they are in sequence.

Group Initializes the counter used for control numbers for 
business documents that you receive from this trading 
partner.

Note

If you click Maintain globally on the Runtime Information 
tab, this field is unavailable.

(Continued on next page)
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Outbound EDI
tab

This illustration shows an example of the Outbound EDI tab of the Trading 
Partnership Editor dialog box.

(Continued on next page)

Validate 
sequence

Checks the Group control numbers to ensure that they are 
in sequence.

Message/Set Initializes the counter used for control numbers for 
business documents that you receive from this trading 
partner.

Validate 
sequence

Checks the Message or Transaction Set control numbers 
to ensure that they are in sequence.

File generation Appends a file generation number to the end of the out 
filename for TRADACOMs standards.

Validate 
sequence

Checks the File generation control numbers to ensure that 
they are in sequence.

Xref Table Displays the Standard Cross Reference dialog box.

 (Contd)
Field Function
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Fields and
functions

This table lists the fields of the Outbound EDI tab of the Trading Partnership Editor 
dialog box and their functions.

Field Function

Standard version Lists the available EDI standards and versions. This is 
a key field that GENTRAN:Server uses to identify the 
Trading Partnership record.

Note
The Trading Partnership Editor accepts a dollar sign 
($) as a wildcard indicator for this field.

Document ID Lists the available EDI document types that you may 
translate. This is a key field that GENTRAN:Server 
uses to identify the Trading Partnership record.

Note
The Trading Partnership Editor accepts a dollar sign 
($) as a wildcard indicator for this field.

Element separator Defines the character used to separate elements.

Note
You can use the same character for the element and 
subelement separators if the Allow same character 
for element, subelement and repeating element 
separators option on the Trading Partnership 
Administration Preferences dialog box is checked.

Component/sub-
element separator

Defines the character used to separate component or 
sub-elements.

Note
You can use the same character for the element and 
subelement separators if the Allow same character 
for element, subelement and repeating element 
separators option on the Trading Partnership 
Administration Preferences dialog box is checked.

Segment terminator Defines the character used to indicate the end of a 
segment.

(Continued on next page)
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(Continued on next page)

Interchange control 
header

Defines the type of header segment used for the 
Interchange envelope.

Reference
See the How to Modify the Outbound Envelope 
Segments topic in this chapter for instructions on 
editing the elements in the Interchange envelope 
segment.

Warning
You MUST click OK to save your changes or the 
segment will be blank.

Group control header Defines the type of group segment GENTRAN:Server 
uses for the Functional Group envelope.

Reference
See the How to Modify the Outbound Envelope 
Segments topic in this chapter for instructions on 
editing the elements in the group envelope segment.

Decimal mark Defines the ASCII hexadecimal character that serves 
as the decimal point in your EDIFACT data.

Release character Defines the character that allows a separator or 
terminator to be used as part of the EDIFACT data.

Example
Your element separator is a plus sign (+). The name of 
your trading partner is Toys+Joys. The release 
character prevents the translator from incorrectly 
interpreting the number of elements in this segment by 
allowing the plus sign to pass through as data and not 
as an element separator.

Syntax level Defines the level A or B separators to use in your 
EDIFACT data.

Generate UNA Enables you to create an EDIFACT UNA segment with 
user defined separators.

UNH --- Association 
assigned code

Defines the value for the UNH 0057 field, which is 
mandatory for EANCOM.

Enable enveloping Restricts outbound EDI data to a single interchange�s 
worth of data in a file.

Generate Messages/
Sets with errors

Enables you to create output that contains errors.

 (Contd)
Field Function
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Runtime
Information tab

This illustration shows an example of the Runtime Information tab of the Trading 
Partnership Editor dialog box.The options displayed on this tab depend on the 
type of translation you selected.

Fields and
functions

This table lists the fields of the Runtime Information tab of the Trading Partnership 
Editor dialog box and their functions.

Field Function

Output filename Defines the name of the file in which GENTRAN:Server will 
store the translated data.

Change 
translation 
options

Displays the Translation Options dialog box, which enables 
you to override (for this Trading Partnership) the default 
translation option that appends or does not append T or P 
to the file name.

(Continued on next page)
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Archive tab This illustration shows an example of the Archive tab of the Trading Partnership 
Editor dialog box.

(Continued on next page)

Maintain locally Enables you to maintain control numbers at the Trading 
Partnership level. This is the default setting.
Note
The Maintain globally/locally options are displayed when 
the output file is an EDI standard.

Maintain globally Enables you to maintain control numbers for an entire 
organization.

Note
The Maintain globally/locally options are displayed when 
the output file is an EDI standard.

 (Contd)
Field Function
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Fields and
functions

This table lists the fields of the Archive tab of the Trading Partnership Editor dialog 
box and their functions.

(Continued on next page)

Field Function

Create input EDI 
historical records

Enables you to store translation status information for 
inbound EDI data.

Archive input EDI 
data

Enables you to store both the translation status information 
for your inbound EDI data as well as the translated data 
itself.

Day(s) Selects the number of days to store archived data (up to a 
maximum of 365 days).

Note
The default is 365 days unless you set another value in the 
Archive/Retrieval Setup dialog box.

Create output EDI 
historical records

Enables you to store translation status information for your 
outbound EDI data.

Archive output 
EDI data

Enables you to store both the translation status information 
for your outbound EDI data as well as the translated data 
itself.

Day(s) Selects the number of days to store archived data (up to a 
maximum of 365 days).

Note
The default is 365 days unless you set another value in the 
Archive/Retrieval Setup dialog box.
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Inbound
Acknowledgment

tab

This illustration shows an example of the Inbound Acknowledgment tab of the 
Trading Partnership Editor dialog box.

Fields and
functions

This table lists the fields of the Inbound Acknowledgment tab of the Trading 
Partnership Editor dialog box and their functions.

Field Function

Settings

Expect acknowledgment for 
outbound document in:

Enables you to define a time limit for receipt of 
an inbound acknowledgment.

Day(s) Selects the number of days until receipt of an 
inbound acknowledgment is expected.

Hour(s) Selects the number of hours until receipt of an 
inbound acknowledgment is expected.

(Continued on next page)
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(Continued on next page)

Minute(s) Selects the number of minutes until receipt of 
an inbound acknowledgment is expected.

Second(s) Selects the number of seconds until receipt of 
an inbound acknowledgment is expected.

Specify alternate IDs to 
reconcile inbound 
acknowledgments

Enables you to define alternate Interchange 
and Group IDs to be used when reconciling 
inbound acknowledgments.

Interchange IDs

Yours Defines your alternate Interchange ID. 

Note

The Trading Partnership Editor accepts a 
dollar sign ($) as a wildcard indicator for this 
field.

Partner�s Defines your Trading Partner�s alternate 
Interchange ID.

Note

The Trading Partnership Editor accepts a 
dollar sign ($) as a wildcard indicator for this 
field.

Group IDs

Yours Defines your alternate Group ID.

Note

The Trading Partnership Editor accepts a 
dollar sign ($) as a wildcard indicator for this 
field.

Partner�s Defines your Trading Partner�s alternate 
group ID.

Note

The Trading Partnership Editor accepts a 
dollar sign ($) as a wildcard indicator for this 
field.

 (Contd)
Field Function
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Outbound
Acknowledgment

tab

This illustration shows an example of the Outbound Acknowledgment tab of the 
Trading Partnership Editor dialog box.

Fields and
functions

This table lists the fields of the Outbound Acknowledgment tab of the Trading 
Partnership Editor dialog box and their functions.

Field Function

Create acknowledgment for 
inbound document

Tells GENTRAN:Server to create an 
acknowledgment for an inbound document.

Type Defines the type of acknowledgment you will 
send to your trading partner.

Notes
In an X12 standard document, the type 
of acknowledgment is either a 997 or 
999 acknowledgment.

In an EDIFACT standard message, the 
type of acknowledgment is a CONTRL 
message.

(Continued on next page)
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Level Defines the level of detail used in the 
acknowledgment.
◗ Group - your trading partner will receive 

response information for each group in the 
interchange envelope.

◗ Set - your trading partner will receive 
response information for each set in the 
group envelope.

◗ Segment - your trading partner will 
receive response information for each 
segment contained in the data.

Reference
See the Setting Up Your System to 
Handle Functional Acknowledgments 
topic in the Archiving Translation Data 
chapter in the Mapping and Translation 
Guide.

Output filename Defines the file name of the translated 
acknowledgment you are sending to your 
trading partner.

Example
/opt/gentran/data/outbound.997

(Continued on next page)

 (Contd)
Field Function
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Separator/terminator information

Element separator Defines the character used to separate 
elements.

Notes
You can use the same character for the 
element and subelement separators if 
the Allow same character for element, 
subelement and repeating element 
separators option on the Trading 
Partnership Administration Preferences 
dialog box is checked.

Component/Sub-elem. 
separator

Defines the character used to separate 
component or sub-elements.

Notes
You can use the same character for the 
element and subelement separators if 
the Allow same character for element, 
subelement and repeating element 
separators option on the Trading 
Partnership Administration Preferences 
dialog box is checked.

Segment terminator Defines the unique character used to 
indicate the end of a segment.

Header Information

Interchange control header Defines the type of header segment used for 
the Interchange envelope. 

Reference
See the How to Modify the Outbound 
Envelope Segments topic in this chapter for 
instructions on editing the elements in the 
Interchange envelope segment.

Group control header Defines the type of group segment used for 
the Functional Group envelope. 

Reference
See the How to Modify the Outbound 
Envelope Segments topic in this chapter for 
instructions on editing the elements in the 
group envelope segment.

(Continued on next page)

 (Contd)
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Mapping and Translation Guide � February 2002



The Trading Partnership Editor Working with Trading Partnerships11 - 44
EDIFACT only

Decimal mark Defines the ASCII/hexadecimal character that 
serves as the decimal point for EDIFACT data.

Release character Defines the character used to indicate that 
what appears to be a separator or terminator is 
actually part of the EDIFACT data. The release 
character precedes the defined separator or 
terminator.

Example
Your element separator is a plus sign (+). The 
name of your trading partner is Toys+Joys. In 
order for the name to be interpreted correctly, 
you need a release character (?) in front of the 
element separator (Toys?+Joys). 

The release character prevents the translator 
from incorrectly interpreting the number of 
elements in this segment by allowing the plus 
sign to pass through as data and not to be 
interpreted as an element separator.

Syntax level Specifies the EDIFACT syntax level.

Note
The syntax level determines the default 
value that the system displays in the 
separator/terminator box.

(Continued on next page)

 (Contd)
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Generate UNA Tells GENTRAN:Server to create an EDIFACT 
UNA segment as part of the outbound 
EDIFACT message. Enables the separator, 
terminator, and release character boxes so 
that you can change the values.

Example
The following is an example of a UNA 
segment.

UNA : + , ? _ �

where the 

: represents the component separator

+ represents the element separator

, represents the decimal mark

_ reserved for repeating elements

? represents the release character

� represents the segment terminator

Generate acknowledgment 
based on UNB09

Checks to see if your trading partner 
requested an acknowledgment. 

Note
If the UNB09 element of the inbound 
document equals 1, then 
GENTRAN:Server sends an 
acknowledgment. 

If the UNB09 element equals 0, then 
GENTRAN:Server does not send an 
acknowledgment.

UNH --- Association assigned 
code

Defines the value for the UNH 0057 field, 
which is mandatory for EANCOM.

General information

Enable Enveloping Enables GENTRAN:Server to place multiple 
outbound documents in one envelope.

 (Contd)
Field Function
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Categories tab This illustration shows an example of the Categories tab of the Trading 
Partnership Editor dialog box.

Fields and
functions

The fields on the Categories tab are specific to your organization. Each field 
represents a category type that you can assign to the current Trading Partnership.

You must define the categories on the User Defined Category Types dialog box.

Reference
See the topic How to Create Categories in this chapter for information about 
defining Trading Partnership category types.
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Creating Trading 
Partnerships 0

The Flow of Work

Introduction GENTRAN:Server supports Trading Partnership records based on the types of 
translation.

Process The table describes the process of creating Trading Partnership records.

(Continued on next page)

Stage Description

1 Create Interchange Organization records.

Reference
See the topic How to Create an Interchange Record in this chapter  
for instructions on creating Interchange Organization records.

2 Create Group Organization records.

Reference
See the topic How to Create a Group Organization Record in this 
chapter for instructions on creating Group Organization records.
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Using wildcard
characters

When you create a Trading Partnership record, you can enter a wildcard indicator 
into any of the six key fields that the system uses to identify the record. A wildcard 
indicator instructs GENTRAN:Server to accept any value for that field during a 
search for a Trading Partnership record. Wildcard indicators enable you to create 
more generic Trading Partnership records.

The Trading Partnership Editor accepts a dollar sign ($) as a wildcard indicator for 
these fields:
◗ Your Interchange ID
◗ Your Partner�s Interchange ID
◗ Your Group/Application ID
◗ Your Partner's Group/Application ID
◗ Set ID
◗ Standard Version

Note
You can only use wildcards for the following trading partnership files:

Sending
outbound
functional

acknowledg-
ments

When you create a Trading Partnership record, you can specify whether or not to 
send an outbound functional acknowledgment to your trading partner. The 
outbound functional acknowledgment notifies your trading partner that you 
received the data they sent to you.

Reference
See the The Trading Partnership Editor topic for more information on the 
Outbound Acknowledgment tab fields and their functions.

See How to Specify Outbound Acknowledgments for instructions.
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How to Create an Interchange Record

Introduction The first stage in creating a new Trading Partnership is to create an Interchange 
Organization record. This record contains the information that uniquely identifies 
your relationship to this trading partner.

New Interchange
Organization

dialog box
example

This illustration shows an example of the New Interchange Organization dialog 
box.

Fields and
functions

This table describes the fields of the New Interchange Organization dialog box 
and their functions.

Field Function

Organization Information

 Code Defines a unique organization code.

Description Describes the Interchange Organization.
(Continued on next page)
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Note
If you maintain your control numbers globally, the control numbers you specified 
at the Interchange Organization level will track the documents you exchange with 
your trading partner.

Procedure Use this procedure to create an Interchange Organization record.

Interchange IDs

Your Interchange ID Defines your unique interchange identifier that is inserted 
into the Interchange envelope when the data is 
translated.

Partner�s 
Interchange ID

Defines your trading partner�s unique interchange 
identifier that is inserted into the Interchange envelope 
when the data is translated.

Control Numbers

Last Sent Control 
Numbers

Initializes the counter used for control numbers for your 
business documents. (Outbound only)

Last Received 
Control Numbers

Initializes the counter used for control numbers for 
business documents that you receive from this trading 
partner. (Outbound only)

 (Contd)
Field Function

Step Action

1 Open the Trading Partnership Administration Explorer.

2 Click New from the File menu.

3 Click Interchange Organization.

System Response
The system displays the New Interchange Organization dialog box.

Reference
See the New Interchange Organization dialog box example in this 
topic for more information.

(Continued on next page)
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4 Fill in the fields as necessary and click OK.

System Response
The system creates and displays a New Interchange Organization 
record in the Trading Partnership Administration Explorer.

5 GO TO How to Create a Group Organization Record next.

Note
You must create at least one Group Organization record for each 
Interchange Organization record. 

 (Contd)
Step Action
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How to Create a Group Organization Record

Introduction The second stage in creating a new Trading Partnership is to create a Group 
Organization record. GENTRAN:Server uses the information that you include in 
this record to build group-level envelopes during data translation.

You can create multiple group organizations and associate them with a single 
interchange organization.
You can group many Trading Partnership records under a single Group 
Organization record. You do not need to create a separate Group Organization 
record for each Trading Partnership record.

New Group
Organization

dialog box
example

This illustration shows an example of the New Group Organization dialog box.

(Continued on next page)
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Fields and
functions

This table describes the fields of the New Group Organization dialog box and their 
functions.

Note
If control numbers are Maintained globally, documents you exchange with a 
trading partner are tracked by the group control numbers specified at the Group 
Organization level.

Procedure Use this procedure to create a Group Organization record.

Field Function

Organization Code Defines a unique Group Organization code that is 
inserted into the Group envelope when the data is 
translated.

Organization 
Description

Describes the Group Organization.

Your Group ID Defines your unique group identifier that is inserted into 
the group envelope when the data is translated.

Partner�s Group ID Defines your trading partner�s unique Group identifier 
that is inserted into the group envelope when the data is 
translated.

Last Sent Control 
Numbers

Initializes the counter used for control numbers for your 
business documents.

Last Received 
Control Numbers

Initializes the counter used for control numbers for 
business documents that you receive from this trading 
partner.

Step Action

1 Select the Interchange Organization that you want to associate with 
this Group Organization record.

2 Click New from the File menu.
(Continued on next page)
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3 Click Group Organization.

System Response
The system displays the New Group Organization dialog box.

Reference
See the New Group Organization dialog box example in this topic 
for more information.

4 Fill in the boxes as necessary and click OK.

System Response
The system creates and displays a new Group Organization record 
in the Trading Partnership Administration Explorer.

5 GO TO How to Create a Trading Partnership Record.

 (Contd)
Step Action
Mapping and Translation Guide � February 2002



Working with Trading Partnerships How to Create a Trading Partnership Record 11 - 55
How to Create a Trading Partnership Record

Introduction The final stage in creating a new Trading Partnership is to create a Trading 
Partnership record. The information you need to provide for a Trading Partnership 
is based upon the type of translation you intend to perform.

This topic is divided into these subtopics:
◗ Creating a standard-to-standard Trading Partnership record
◗ Creating a standard-to-application Trading Partnership record
◗ Creating an application-to-standard Trading Partnership record
◗ Creating an application-to-application Trading Partnership record

Note
You use the Trading Partnership Editor to create new Trading Partnership 
records. When you create new Trading Partnership records, the Trading 
Partnership Editor collects only the information that pertains to the new Trading 
Partnership you are creating.

(Continued on next page)
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Creating a
standard-to-

standard Trading
Partnership

record

Use this procedure to create a Trading Partnership record that is based on a 
standard-to-standard translation scheme.

Step Action

1 Open Trading Partnership Administration.

2 Select the Group Organization record that you want to associate 
with this Trading Partnership.

3 Click New from the File menu.

4 Click Trading Partnership.

System Response
The system displays the Trading Partnership Wizard.

5 Complete the fields on the Trading Partnership dialog box and click 
Next.

Reference
See the Trading Partnership tab topic in this chapter for field 
descriptions. Note requirements for the Trading Partnership Code.

6 Complete the fields on the Inbound EDI Information dialog box and 
click Next.

References
See the Inbound EDI Information tab topic in this chapter for field 
descriptions.

For information about how to add an entry to the Standard Cross 
Reference Table, see the How to Add a Record to the Standard 
Cross Reference Table topic.

7 Complete the fields on the Outbound EDI dialog box and click 
Next.

References
See the Outbound EDI tab in this chapter for field descriptions.

See the How to Modify the Outbound Envelope Segmentstopic in 
this chapter for instructions on editing the interchange or group 
envelope segments.

8 Complete the fields on the Runtime Information dialog box and 
click Next.

Reference
See the topic Runtime Information tab in this chapter for field 
descriptions.

(Continued on next page)
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Creating a
standard-to-

application
Trading

Partnership
record

Use this procedure to create a Trading Partnership record that is based on a 
standard-to-application translation scheme.

9 Complete the fields on the Archive dialog box and click Next.

Reference
See the topic Archive tab in this chapter for field descriptions.

10 Complete the fields on the Inbound Acknowledgment dialog box 
and click Next.

Reference
See the topic Inbound Acknowledgent tab in this chapter for field 
descriptions.

11 Complete the fields on the Outbound Acknowledgment dialog box 
and click Next.

References
See the topic Outbound Acknowledgment tab in this chapter for 
field descriptions.

See the topic How to Specify Outbound Acknowledgments in this 
chapter to generate outbound acknowledgments.

12 Select appropriate categories for this Trading Partnership and click 
the Finish button.

Reference
See the topic Categories tab in this chapter for field descriptions.

Note
The Categories dialog box is displayed only if categories are 
currently defined.

 (Contd)
Step Action

Step Action

1 Open Trading Partnership Administration.

2 Select the Group Organization record that you want to associate 
with this Trading Partnership.

3 Click New from the File menu.
(Continued on next page)
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4 Click Trading Partnership.

System Response
The system displays the Trading Partnership wizard.

5 Complete the fields on the Trading Partnership dialog box and click 
Next.

Reference
See the topic Trading Partnership tab in this chapter for field 
descriptions. Note requirements for the Trading Partnership Code.

6 Complete the fields on the Inbound EDI Information dialog box and 
click Next.

Reference
See the topic Inbound EDI Information tab in this chapter for field 
descriptions.

For information about how to add an entry to the Standard Cross 
Reference Table, see the How to Add a Record to the Standard 
Cross Reference Table topic.

7 Complete the fields on the Runtime Information dialog box and 
click Next.

Reference
See the topic Runtime Information tab in this chapter for field 
descriptions.

8 Complete the fields on the Archive dialog box and click Next.

Reference
See the topic Archive tab in this chapter for field descriptions.

9 Complete the fields on the Outbound Acknowledgment dialog box 
and click Next.

References
See the topic Outbound Acknowledgment tab in this chapter for 
field descriptions.

See the topic How to Specify Outbound Acknowledgments in this 
chapter to generate outbound acknowledgments.

System Response
If categories are currently defined, the system displays the 
Categories dialog box.

(Continued on next page)

 (Contd)
Step Action
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Creating an
application-to-

standard Trading
Partnership

record

Use this procedure to create a Trading Partnership record that is based on an 
application-to-standard translation scheme.

10 If the Categories dialog box is displayed, select appropriate 
categories for this Trading Partnership.

Reference
See the topic Categories tab topic in this chapter for field 
descriptions.

11  Click the Finish button.

 (Contd)
Step Action

Step Action

1 Open Trading Partnership Administration.

2 Select the Group Organization record that you want to associate 
with this Trading Partnership.

3 Click New from the File menu.

4 Click Trading Partnership.

System Response
The system displays the Trading Partnership wizard.

5 Complete the fields on the Trading Partnership dialog box and click 
Next.

Note
You must complete the File Definitions filename box.

Reference
See the Trading Partnership tab topic in this chapter for field 
descriptions. Note requirements for the Trading Partnership Code.

(Continued on next page)
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Creating an
application-to-

application
Trading

Partnership
record

Use this procedure to create a Trading Partnership record that is based on an 
application-to-application translation scheme.

6 Complete the fields on the Outbound EDI dialog box and click 
Next.

References
See the Outbound EDI tab topic in this chapter for field 
descriptions.

See the How to Modify the Outbound Envelope Segments topic in 
this chapter for instructions on editing the interchange or group 
envelope segments.

7 Complete the fields on the Runtime Information dialog box and 
click Next.

Reference
See the topic Runtime Information tab in this chapter for field 
descriptions.

8 Complete the fields on the Archive dialog box and click Next.

Reference
See the topic Archive tab in this chapter for field descriptions.

9 Select appropriate categories for this Trading Partnership and click 
the Finish button.

Reference
See the topic Categories tab in this chapter for field descriptions.

Note
The Categories dialog box is displayed only if categories are 
currently defined.

 (Contd)
Step Action

Step Action

1 Open Trading Partnership Administration.

2 Select the group organization record that you want to associate 
with this Trading Partnership.

3 Click New from the File menu.
(Continued on next page)
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4 Click Trading Partnership.

System Response
The system displays the Trading Partnership wizard.

5 Complete the fields on the Trading Partnership dialog box and click 
Next.

Note
You must complete the File Definitions filename box.

Reference
See the topic Trading Partnership tab in this chapter for field 
descriptions. Note requirements for the Trading Partnership Code.

6 Complete the fields on the Runtime Information dialog box and 
click Next.

Reference
See the topic Runtime Information tab in this chapter for field 
descriptions.

7 Select appropriate categories for this Trading Partnership and click 
the Finish button.

Reference
See the topic Categories tab in this chapter for field descriptions.

Note
The Categories dialog box is displayed only if categories are 
currently defined.

 (Contd)
Step Action
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How to Specify Outbound Acknowledgments

Introduction This topic explains how to use the Outbound Acknowledgment tab to generate 
outbound acknowledgments for documents you receive from a trading partner. 

When to use Complete the Outbound Acknowledgment tab when a trading partner requests an 
acknowledgment in response to a document they sent you.

Generating
outbound

acknowledg-
ments for X12

documents

Use this procedure to generate outbound acknowledgements for this trading 
partner. 

(Continued on next page)

Step Action

1 Select the check box Create acknowledgement for inbound 
document.

2 From the Type drop-down list, select the type of acknowledgment 
you are sending to your trading partner.

3 From the Level drop-down list, select the appropriate 
acknowledgment level.

4 Type the path name you want to use for the output file.

5 From the Element separator drop-down list, select the element 
separator.

6 From the Component/Sub-elem. drop-down list, select the 
component or sub-element separator.

7 From the Segment terminator drop-down list, select the segment 
terminator.

8 From the Interchange control header drop-down list, select the 
interchange control header.

9 Accept the default value for the group control header.

10 Do you want to envelope multiple outbound acknowledgments?

◗ If YES, select the Enable Enveloping check box and continue 
with Step 11.

◗ If NO, continue with Step 11.

11 Click OK to save your changes.
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Generating
outbound

acknowledg-
ments for
EDIFACT

message types

Use this procedure to generate outbound acknowledgements for this trading 
partner. 

Step Action

1 Select the check box Create acknowledgement for inbound 
document.

2 Accept the CONTRL default in the Type box.

3 From the Level drop-down list, select the appropriate 
acknowledgment level.

4 Type the path name you want to use for the output file.

5 From the Decimal mark drop-down list, select the decimal mark.

6 From the Syntax level drop-down list, select the syntax level.

Note
If a syntax level above UNOB is needed, specify syntax level 
B, then indicate the actual syntax level by clicking Edit by the 
Interchange control header and typing the desired value in 
the syntax identifier field (UNOC, UNOD�UNOG).

7 Do you want to generate a UNA segment?
◗ If YES, select the Generate UNA check box and continue with 

Step 8.

System Response
The system displays and enables the Element separator, 
Component/sub-elem. separator, Segment terminator, 
and release character box.

◗ If NO, continue with Step 13.

8 Do you want to change the Separator/Terminator information?

◗ If YES, continue with the next step.
◗ If NO, GO TO Step 12.

(Continued on next page)
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9 Do you want to change the value of the element separator?
◗ If YES, from the Element separator drop-down list, select the 

Element separator; continue with the next step.
◗ If NO, continue with the next step.

CAUTION
Checking the Generate UNA box enables the element 
separator box, so that you can change the default value. 
Before you change the default value, you must verify 
that your trading partner can process the new value.

10 Do you want to change the value of the component or sub-
element?

◗ If YES, from the Component/Sub-elem. drop-down list, select 
Component/Sub-elem. separator; continue with the next step.

◗ If NO, continue with the next step.

CAUTION
Checking the Generate UNA box enables the 
Component/Sub-elem. box, so that you can change the 
default value. Before you change the default value, you 
must verify that your trading partner can process the 
new value.

11 Do you want to change the value of the segment terminator?

◗ If YES, from the Segment terminator drop-down list, select 
the Segment terminator; continue with the next step.

◗ If NO, continue with the next step.

CAUTION
Checking the Generate UNA box enables the Segment 
terminator box, so that you can change the default value. 
Before you change the default value, you must verify 
that your trading partner can process the new value.

(Continued on next page)

 (Contd)
Step Action
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12 Do you want to change the value of the release character?
◗ If YES, from the Release character drop-down list, select the 

release character; then continue with the next step.
◗ If NO, continue with the next step.

CAUTION
Checking the Generate UNA box enables the Release 
character box, so that you can change the default value. 
Before you change the default value, you must verify 
that your trading partner can process the new value.

13 Do you want to generate an acknowledgment based upon the 
incoming UNB09 value? 

◗ If YES, select the Generate acknowledgment upon UNB09 
request check box and continue with the next step.

◗ If NO, continue with the next step.

14 Do you want to define the value for the UNH 0057 field?

◗ If YES, type the value in the UNH --- Associated assigned code 
text box; continue with the next step.

Note
The UNH 0057 field is mandatory for EANCOM.

◗ If NO, continue to the next step.

15 From the Interchange control header drop-down list, select the 
Interchange control header.

16 Do you want to accept the default value for the group control 
header.

◗ If YES, continue with the next step.
◗ If NO, from the Group control header drop-down list, select the 

group control header value; continue with the next step.

CAUTION
Before you change the default value, you must verify 
that your trading partner can process the new value.

(Continued on next page)

 (Contd)
Step Action
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17 Do you want to envelope multiple outbound acknowledgments?
◗ If YES, select the Enable Enveloping check box and continue 

with the next step.
◗ If NO, continue with the next step.

18 Click OK to save your changes.

 (Contd)
Step Action
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Using Standard Cross 
Reference Tables 0

Overview

Introduction Some GENTRAN:Server components, such as the translator, look in the Trading 
Partnership record to determine which compiled map (translation object) to use 
for translation. To find the correct Trading Partnership record, GENTRAN:Server 
examines each inbound file to determine the six key pieces of information needed 
to find the Trading Partnership record. These are the six key fields:
◗ Your Interchange ID
◗ Trading Partner�s Interchange ID
◗ Your Group ID
◗ Trading Partner�s Group ID
◗ Document (Set) ID
◗ Standard Version

Standard version
as key field

If the files that a trading partner sends you contain values in the standard version 
field that GENTRAN:Server does not recognize, the system cannot find the 
Trading Partnership record.

Note
GENTRAN:Server may find the Trading Partnership record if you used a dollar 
sign ($) as a wildcard indicator for the Standard version field on the Inbound EDI 
tab of the Trading Partnership record.

Purpose of the
Standard Cross
Reference Table

The Standard Cross Reference Table is a GENTRAN:Server feature that enables 
you to specify the standard version that you want GENTRAN:Server to use when 
it finds certain values in the inbound document�s standard version fields. 
GENTRAN:Server then uses the standard version reference in the table and the 
other key fields to find the Trading Partnership record.

(Continued on next page)
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Example
Your trading partner uses an older version of the EDIFACT standards. The 
inbound documents this trading partner sends you have 0 in the message release 
number field and 0 in the release number field. (These are the fields 
GENTRAN:Server uses to determine the standard version.) When the translator 
checks these fields for the standard version, it will try to find a Trading Partnership 
record for standard version 00000 for the trading partner�s Interchange and Group 
IDs.

You create an entry in the Standard Cross Reference Table. The entry cross 
references the message release number "0" and release number "0" with 
standard version 001911. This entry directs the translator to use standard version 
001911 in a subsequent search if it cannot find a Trading Partnership record for 
standard version 00000 in its first search.

Translation
types

You can use the Standard Cross Reference Table to locate Trading Partnership 
records that are based on these translation types:

◗ Standard-to-application
◗ Standard-to-standard
◗ Standard-to-XML (if you have the XML translation option)

Standard Cross
Reference Table

files

The GENTRAN:Server installation process installs an empty Standard Cross 
Reference Table automatically. The files are DISAM files named xtable.dat and 
xtable.idx. GENTRAN:Server stores the files in the directory that holds your 
Trading Partner files.

GENTRAN:Server provides load and unload utilities to move the xtable.dat and 
xtable.idx files.

Reference
See the Moving Files chapter of the GENTRAN:Server for UNIX Maintenance and 
Troubleshooting Guide or the Moving Files chapter of the GENTRAN:Server for 
Workstation Maintenance and Troubleshooting Guide for information about the 
load and unload utilities. 

Standard Cross
Reference Table

entry

You access the table from the Inbound EDI tab of the Trading Partnership record. 
Each entry you make to the table is unique to the Interchange ID and Group ID of 
your trading partner. When GENTRAN:Server checks the table, first it looks for 
the Interchange ID and Group ID and then for the standard version cross-
reference under these IDs.

(Continued on next page)
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Standard Cross
Reference Table

report

GENTRAN:Server provides the xtablerpt command to create a report that shows 
all the entries in the Standard Cross Reference Table.

Reference
See the Command Reference chapter in the GENTRAN:Server Technical 
Reference Guide for instructions.
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 How to Add a Record to the Standard Cross Reference 
Table

Introduction A record in the Standard Cross Reference Table connects two standard version 
values:

◗ An invalid standard version. This is the value or values that you expect 
GENTRAN:Server to extract from the inbound documents from a particular 
interchange and group ID. 

◗ A valid standard version. This is the standard version that you want 
GENTRAN:Server to use as one of the six key fields it uses to find the Trading 
Partnership record for the interchange and group ID.

Standard Cross
Reference dialog

box-EDIFACT

This illustration shows the Standard Cross Reference dialog box for an EDIFACT 
standard.

(Continued on next page)
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Standard Cross
Reference dialog

box-X12/ANSI

This illustration shows the Standard Cross Reference dialog box for an X12/ANSI 
standard.

Fields and
functions

This table lists the fields of the Standard Cross Reference dialog box and their 
functions.

Field Function

Your interchange ID Displays your interchange ID

Partner�s interchange ID Displays your trading partner�s interchange ID

Your group ID Displays your group ID.

Partner�s group ID Displays your trading partner�s group ID.

Standard Version Displays the standard version used as a key field 
to identify this Trading Partnership record. This is 
the value you selected from the Standard 
version box on the Inbound EDI Information tab.

X12/ANSI Standard Selects X12/ANSI as the standard type.
(Continued on next page)
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Before you begin You access the Standard Cross Reference feature from the Inbound EDI tab of 
the Trading Partnership record. You can add an entry to the table at the time you 
create the Trading Partnership record or when you edit the record.

(Continued on next page)

EDIFACT Standard Selects EDIFACT as the standard type.

Tradacom Standard Reserved for future use. Disabled in the current 
release.

Message number/
Standard Version

EDIFACT documents
Specifies the value in the inbound document�s 
Message number field. GENTRAN:Server uses 
this value and the Release number value to 
determine the standard version from an inbound 
document. This is one of the values you are 
cross-referencing to the valid standard version 
so that GENTRAN:Server can find the Trading 
Partnership record.

X12/ANSI and Tradacom 
documents
Specifies the value in the inbound document�s 
Standard Version field. GENTRAN:Server uses 
this value to determine the standard version from 
an inbound document. This is the value you are 
cross-referencing to the valid standard version 
so that GENTRAN:Server can find the Trading 
Partnership record.

Release number EDIFACT documents

Specifies the value in the inbound document�s 
Release number field. GENTRAN:Server uses 
this value and the Message number value to 
determine the standard version from an inbound 
document. This is one of the values you are 
cross-referencing to the valid standard version 
so that GENTRAN:Server can find the Trading 
Partnership record.

X12/ANSI and Tradacom 
documents
This field is disabled for these standards.

 (Contd)
Field Function
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Procedure Use this procedure to add an entry to the Standard Cross Reference Table from 
an open inbound Trading Partnership record.

Step Action

1 Click the Inbound EDI Information tab of the Trading Partnership 
record.

(Continued on next page)
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2 Click the Xref Table button.

System Response
The system displays the Standard Cross Reference dialog box.

3 Verify that the interchange ID, group ID, and standard version 
information are correct.

4 Select the type of standard:

◗ X12/ANSI Standard
◗ EDIFACT Standard

System Response
The dialog box expands and displays additional text boxes.

(Continued on next page)

 (Contd)
Step Action
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Standard Cross
Reference Table

report

To create a report that shows all the entries in the Standard Cross Reference 
Table, use the xtablerpt command.

Reference
See the Command Reference chapter in the GENTRAN:Server Technical 
Reference Guide for instructions.

5 Use this table to determine your next step.

IF the standard type is� THEN enter the�

X12/ANSI Value that GENTRAN:Server 
will find in the Standard 
version field of the trading 
partner�s inbound documents

EDIFACT Values that GENTRAN:Server 
will find in the Message 
number and Release number 
fields of the trading partner�s 
inbound documents

6 Click OK to add the new entry to the Standard Cross Reference 
Table.

 (Contd)
Step Action
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How to Edit a Standard Cross Reference Record

Procedure Use this procedure to edit a Standard Cross Reference record from an open 
inbound Trading Partnership record.

Step Action

1 Click the Inbound EDI Information tab of the Trading Partnership 
record.

(Continued on next page)
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2 Click the Xref Table button.

System Response
The system displays the Standard Cross Reference dialog box.

3 Modify the record.

4 Click OK to save your changes to the Standard Cross Reference 
Table.

 (Contd)
Step Action
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How to Delete a Standard Cross Reference Record

Introduction This topic explains how to delete a Standard Cross Reference record.

CAUTION
GENTRAN:Server maintains Standard Cross Reference records at 
the Group Organization level. When you delete a Standard Cross 
Reference record for one Trading Partnership in a specific Group 
Organization, you delete the Standard Cross Reference record for 
every Trading Partnership in the Group Organization. 

Procedure Use this procedure to delete a Standard Cross Reference record from an open 
inbound Trading Partnership record.

Step Action

1 Click the Inbound EDI Information tab of the Trading Partnership 
record.

(Continued on next page)
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2 Select a different standard version from the Standard version 
drop-down box.

System Response
The system displays a prompt to delete the cross reference record.

3 Click Yes.

System Response
The system displays the Inbound EDI tab.

4 Click OK to save your changes to the Trading Partnership record.

 (Contd)
Step Action
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Creating Optional 
Records 0

Overview

Introduction Contact records and Category records are optional Trading Partnership records.

Contact records Contact records are used to hold names, addresses, and phone numbers of the 
people you communicate with in your trading partner�s organization.

Category
records

The category feature enables you to group your Trading Partner records by 
common category. It is a flexible feature that you can use organize your Trading 
Partner records in your own way.
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Edit Organization Contact Dialog Box

Edit
Organization

Contact dialog
box example

This illustration shows an example of the Edit Organization Contact dialog box.

Fields and
functions

This table describes the fields of the Organization Contact dialog box and their 
functions.

Field Function

Contact Name Defines the name of the person to contact.

Address Line 1 Defines the street address of the contact.

Address Line 2 Defines a second street address (room or mail stop) of 
the contact.

City Defines the city.

State Defines the state or province (2 characters).

Zip Defines the zip code.
(Continued on next page)
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Country Defines the country.

Phone 1 Defines a phone number and extension.

Phone 2 Defines a second phone number and extension.

Fax Defines the fax number of the contact.

Email Defines the e-mail address of the contact.

Comments Provides a method to record additional information about 
this contact.

 (Contd)
Field Function
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How to Create Contact Records

Introduction Use Contact records to maintain information about personnel in your trading 
partner's organization. You can create unique contact records at interchange 
organization, group organization, and Trading Partnership levels.

Procedure Use this procedure to create a new Contact record.

Step Action

1 Open the Trading Partnership Administration explorer window.

2 Select the Interchange Organization, Group Organization, or the 
Trading Partnership record to which you want to add contact 
information.

3 Click Contact from the Edit menu.

System Response
The system displays the Edit Organization Contact dialog box.

Reference
See the Edit Organization Contact Dialog Box in this topic for more 
information.

4 Fill in the fields as necessary and click OK.
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How to Create Categories

Introduction It is often useful to group Trading Partner records by common category. After you 
define categories, you can use them as selection criteria for viewing, changing, or 
deleting Trading Partnership records.

You define the categories according to similarities of interest. You may define up 
to five category types. After you define categories, the category types appear on 
the Trading Partnership editor�s Categories tab.

Example

You create a category called INDUSTRY so that you can group trading partners 
by industry. Next, you create values for different types of industries, such as retail, 
manufacturing, or warehousing. You then use these values to locate relevant 
records when you need to search for a particular group of Trading Partnerships.

Procedure Use this procedure to define Trading Partnership category types.

Step Action

1 Click Categories� from the Settings menu.

System Response
The system displays the User Defined Category Types dialog box.

2 Enter the following information for each category you are setting 
up:

◗ Category�The prompt that you want to appear on the 
Partnership Categories dialog box.

◗ Value�Appropriate values for each category.

3 Click OK to save your categories.
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Modifying Trading 
Partnership Records 0

Overview

In this section This section explains how to:
◗ Edit Trading Partnership records
◗ Modify outbound envelope segments
◗ Choose a different map for a Trading Partnership record
◗ Delete a Trading Partnership record
◗ Print Trading Partnership records
◗ Change the translation option for a Trading Partnership record.

About file
locking in UNIX

version

In GENTRAN:Server for UNIX, the Security subsystem locks Trading Partnership 
records when you open them for editing. When a file is locked, GENTRAN:Server:

◗ Prevents you from opening it in another session when you run multiple 
sessions on your desktop.

◗ Stops another user from opening the file for editing and displays a message to 
let the user know that the file is not available for editing, but does allow the 
user to view the file. 

GENTRAN:Server locks these Trading Partnership files:

◗ Trading Partner record
◗ Group Organization record
◗ Interchange Organization record

GENTRAN:Server does not lock these files; so, you must take care not to edit the 
same file in a parallel session or on another desktop.
◗ Files edited in the File Browser
◗ Trading Partnership Category files
◗ Trading Partnership Contact files.

Note
If the same file is edited in two different parallel sessions, the last changes saved 
overwrite earlier changes from another session.
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How to Edit Trading Partnership Records

Introduction This topic explains how to edit a Trading Partnership record.

Procedure Use this procedure to edit Trading Partnership records.

Reference
If you need to search for the record you want to edit, see the topic How to Search 
for a Trading Partnership Record in this chapter.

Step Action

1 Open Trading Partnership Administration and display the Trading 
Partnership records.

2 Select the Trading Partnership that you want to modify.

3 Right-click and select Edit from the menu.

System Response
If the Trading Partnership record is not being used by another user 
or process, the system displays the Trading Partnership record.

4 Click the tab that contains the information you want to change.

5 Modify the Trading Partnership record and click OK.
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How to Modify the Outbound Envelope Segments

Introduction You can modify the values of the elements in the interchange and group envelope 
segments that GENTRAN:Server inserts in the envelope segments of a Trading 
Partnership�s:
◗ Outbound EDI documents
◗ Outbound Functional Acknowledgments.

Standards
compliance

The elements in the interchange and group envelope segments depend on the 
standard, the standard version, or (for EDIFACT) the syntax level. 
GENTRAN:Server bases the options it displays for the elements on the 
information you specify.

Example 1
If you specify X12/ANSI standard version 4020 and later, GENTRAN:Server 
displays �Repeating Element Separator� and a drop-down list of valid values for 
element ISA11 on the Interchange Information dialog box. For standard versions 
prior to 4020, GENTRAN:Server displays �Interchange Standards ID� in the ISA11 
element field.

Example 2
If you specify UN/EDIFACT Syntax Version 4 for UNB element 0002 on the 
Interchange Header Information dialog box, GENTRAN:Server shows an 8-digit 
format (for example, 19991129) for element 0017, Date of Preparation, on the 
UNB and UNG dialog boxes.

(Continued on next page)
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Modifying the
envelope

segments for
outbound EDI

documents

Use this procedure to modify the envelope segments of outbound EDI documents 
for a Trading Partnership.

Step Action

1 Open the Trading Partnership record that you want to modify.

Reference
See How to Search for a Trading Partnership Record or How to Edit 
Trading Partnership Records for instructions on opening Trading 
Partnership records.

2 Click the Outbound EDI tab.

(Continued on next page)
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3 Click the Edit button of the Interchange control header or Group 
control header field.

System Response
The system displays the Information dialog box for the segment 
you selected from the drop-down box. The standard version and 
EDIFACT syntax level determine which elements are displayed on 
the dialog box.

This illustration is for the ISA envelope segment for X12/ANSI 
standard version 4020.

4 Modify the element or elements you want to change.

Reference
See your Standards documentation for the element definitions of 
the interchange and group control header segments.

(Continued on next page)

 (Contd)
Step Action
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Modifying the
envelope

segments for
outbound

Functional
Acknowledg-

ments

Use this procedure to modify the envelope segments of outbound functional 
acknowledgments for a Trading Partnership record.

5 Click OK.

Warning
You MUST click OK on this dialog box to save your changes.

System Response
The system displays the Outbound EDI tab.

6 Click OK to save your changes.

Warning
You MUST click OK on the Outbound EDI tab to save your changes 
to the envelope segment.

 (Contd)
Step Action

Step Action

1 Open the Trading Partnership record that you want to modify.

Reference
See How to Search for a Trading Partnership Record or How to Edit 
Trading Partnership Records for instructions on opening Trading 
Partnership records.

(Continued on next page)
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2 Click the Outbound Acknowledgment tab.

3 Click the Edit button of the Interchange control header or Group 
control header field.

System Response
The system displays the Information dialog box for the segment 

4 Modify the element or elements you want to change.

Reference
See your Standards documentation for the element definitions of 
the interchange and group control header segments.

5 Click OK.

System Response
The system displays the Outbound Acknowledgment tab.

6 Click OK to save your changes.

Warning
You MUST click OK on the Outbound Acknowledgment tab to save 
your changes to the envelope segment.

 (Contd)
Step Action
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How to Choose a Different Map (Translation Object)

Introduction When working with your Trading Partnership records, you may want to change the 
compiled map (translation object) you use to translate data. To locate a compiled 
map, you enter the search criteria into the Compiled Map Search dialog box.

Compiled Map
Search dialog

box

This illustration shows the Compiled Map Search dialog box. You access this 
dialog box via the Trading Partnership tab of the Trading Partner Editor.

Note
You can search only for maps that match the type you selected on the Trading 
Partnership tab of the Trading Partnership Editor.

Fields and
functions

This table describes the fields of the Compiled Map Search dialog box and their 
functions.

Field Function

Map type Selects the type of compiled map (translation object) to 
search for.

Notes
If you selected a translation type on the Trading 
Partnership tab, then this field is already selected when 
you open the Map Search dialog box.

If you did not specify a Translation type on the Trading 
Partnership dialog box, the Compiled Map Search dialog 
box displays �All� in this field.

(Continued on next page)
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Procedure Use this procedure to search for the compiled map (translation object) you want to 
use for a specific Trading Partnership.

Standard version Selects a specific EDI standard version.

Message ID / 
Transaction Set

Select a specific EDI document or transaction set.

 (Contd)
Field Function

Step Action

1 Open the Trading Partnership Administration explorer window.

2 Select the Trading Partnership record you want to modify.

3 Select the Trading Partnership tab.

4 Click the binoculars icon next to the Map name box.

System Response
The system displays the Compiled Map Search dialog box.

5 Complete the search fields and click OK.

System Response
The system displays Map Search Results dialog box, which 
displays a list of the compiled maps that match the criteria you 
entered.

6 Select the compiled map (translation object) you want to use with 
the Trading Partnership and then click OK.

System Response

The system replaces the map name specified on the Trading 
Partnership tab with the map you selected.
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How to Delete Trading Partner Records

Introduction This topic describes the procedure for deleting Interchange Organization, Group 
Organization, and Trading Partnership records.

Caution
When you delete an Interchange Organization record, you also delete all Group 
Organization and Trading Partnership records in that Interchange Organization.

When you delete a Group Organization record, you also delete all Trading 
Partnership records in that Group Organization.

Procedure Use this procedure to completely remove Trading Partner records from 
GENTRAN:Server.

Step Action

1 Open the Trading Partner Administration explorer.

2 Use this table to determine your next step.

IF you want to 
delete� THEN select the� AND click�

an Interchange 
Organization record

interchange Delete from the Edit 
menu.

a Group 
Organization record

group Delete from the Edit 
menu.

a Trading 
Partnership record

Trading Partnership Delete from the Edit 
menu.

System Response
The system asks you to confirm your intention to delete this item.

3 Click OK to confirm the deletion.
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How to Print Trading Partnership Reports

Introduction This topic describes how to print Trading Partnership records.

When to use Use this procedure when you want to:
◗ Review the information that you defined in a Trading Partnership
◗ Check for errors
◗ Provide Trading Partnership information to other individuals or organizations.

Procedure Use this procedure to print a Trading Partnership record.

Step Action

1 Open the Trading Partner Administration Explorer.

2 Select the Interchange Organization, Group Organization, or 
Trading Partner record that you want to print.

3 Click Print from the File Menu.

System Response
GENTRAN:Server displays the Trading Partnership Print dialog 
box.

4 Click OK to print the selected record.
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Translation Options Dialog Boxes

Introduction This topic describes the Translation Options dialog boxes for the various types of 
translation (standard-to-application, standard-to-standard, etc.).

You can use these dialog boxes to set particular default translation options for 
your Trading Partnership records, or to set options for an individual Trading 
Partnership record.

Reference
To set default translation options for one or more translation types, see How to Set 
Default Translation Selections.

To set translation options for an individual Trading Partnership, see How to Set 
Translation Selections.

Standard to
Application
Translation

Options dialog
box

This illustration shows the Standard to Application Translation Options dialog box.

(Continued on next page)
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Standard to
Standard

Translation
Options dialog

box

This illustration shows the Standard to Standard Translation Options dialog box.

Application to
Standard

Translation
Options dialog

box

This illustration shows the Application to Standard Translation Options dialog box.

(Continued on next page)
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Application to
Application
Translation

Options dialog
box

This illustration shows the Application to Application Translation Options dialog 
box.

(Continued on next page)
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Fields and
functions

This table describes all the possible fields of the Translation Options dialog box 
and their functions. The available values to choose from within the Options and 
Compliance checking sections of the Translation Options dialog box depend upon 
the type of translation selected and the type of map file used.

Field Function

Input Compliance 
checking

Checks the incoming data for compliance to EDI 
standard versions.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

Output compliance 
checking

Checks the outgoing data for compliance to EDI 
standard versions.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

Do not append Does not append a test or production flag to the end of 
the file name.

Append �T� (Test) Appends the letter T to the end of the file name to mark it 
as a test file.

Append �P� 
(Production)

Appends the letter P to the end of the file name to mark it 
as a production file.

Append ISA15 or 
UNB-0035

Appends the value of ISA15 or UNB0035 to the end of 
the file name.

Generate release 
characters

Generates the character that allows a separator or 
terminator to be used as part of the EDIFACT data.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

(Continued on next page)
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Enable Compliance 
Checking

Checks EDI data for compliance against the EDI 
Standard .CND file and the map.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

Validate ID codes Validates the ID codes from the EDI data against the 
.CDS standard file.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

Validate CTT totals Checks the incoming data for valid CTT totals.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

No output if 
application error

Does not generate an output file if there are errors in the 
application.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

Enable debugging Lists the segment IDs to screen during translation and 
generates the Diagnostics Report.

Do not write audit 
record

Stops the translator from writing an audit record.

Generate VAT 
Report

Saves EDIFACT VAT information from TAXCON 
messages.

Generate CTT Generates the CTT outbound segment.

Note
This translation option is available only when you are 
translating data with a Visual Mapper (*.vmp) map file 
type.

 (Contd)
Field Function
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How to Set Translation Selections

Introduction This topic explains how to set certain translation selections for a specific Trading 
Partnership.

Note
The selections you choose in the Trading Partnership record override any default 
selections you may have set.

Reference
See How to Set Default Translation Selections for instructions on setting 
translation selections that your system automatically assigns when you create a 
new Trading Partnership record for a specific translation type.

Procedure Use this procedure to set default translation selections for a translation type.

Step Action

1 Open the Trading Partnership record that you want to change.

2 Click the Runtime Information tab.

Reference
See the topic The Trading Partnership Editor in this chapter for 
more information on the Runtime Information tab.

(Continued on next page)
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3 Click the Change translation options button.

System Response
The system displays the Translation Options dialog box for the 
translation type selected for this Trading Partnership record.

Example

Note
The selections on the dialog box depend on the type of translation.

4 Select the default selections that you want to apply to this type of 
translation.

5  Click OK to save your changes.

 (Contd)
Step Action
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Making Mass Changes

The Mass Change Facility

Introduction You use the Mass Change facility to modify multiple Interchange Organization, 
Group Organization, or Trading Partnership records at a time. The Mass Change 
facility is accessed from the Trading Partnership Administration window.

The access path
for Mass Change

This illustration shows an example of how to access the Mass Change facility 
from Trading Partnership Administration.

How to access
Mass Change

Use this procedure to access the Mass Change facility.

Step Action

1 Open Trading Partnership Administration.

2 Click the Interchange, Group, or Trading Partnership record you want 
to modify.

3 Click Tools on the menu bar.

4 Click Mass Change on the Tools menu.
(Continued on next page)
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5 Use this table to determine your next action.

To change... Click...

An Interchange Organization 
record

Interchange Organization

A Group Organization record Group Organization

A Trading Partnership record Trading Partnership

System Response
The TP Mass Change facility then displays the dialog box appropriate 
for the item you selected.

Reference
See the following topics in this chapter for more information about the 
different TP Mass Change options:

◗ How to Change Interchange Organization Records
◗ How to Change Group Organization Records
◗ How to Change Trading Partnership Records

 (Contd)
Step Action
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How to Change Interchange Organization Records

Introduction Changes to Interchange Organization records can be necessary in certain 
circumstances. You can use Mass Change to modify some or all of your 
Interchange Organization records at once, rather than one at a time. 

The Interchange
Organization

Mass Change
dialog box

This illustration shows an example of the Interchange Organization Mass Change 
dialog box.

Fields and
functions

This table lists the fields of the Interchange Organization Mass Change dialog box 
and their functions.

Field Function

Interchange IDs

Change Your ID Indicates that you are changing your interchange 
ID to the identifier you type in the box.

Change Partner�s ID Indicates that you are changing your trading 
partner�s interchange ID to the identifier you type 
in the box.

(Continued on next page)
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How to change
multiple

Interchange
Organization

records

Use this procedure to change multiple Interchange Organization records at one 
time.

Control numbers

Last sent Initializes the counter used for control numbers 
for your business documents.

Last received Initializes the counter used for control numbers 
for business documents that you receive from 
this trading partner.

OK Saves the changes you made on this dialog box.

Cancel Closes this dialog box without saving your 
changes.

 (Contd)
Field Function

Step Action

1 Open Trading Partnership Administration.

2 Click Tools on the menu bar.

3 Click Mass Change on the Tools menu.
(Continued on next page)
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4 Click Interchange Organization on the Mass Change menu.

System Response
The TP Mass Change facility then displays the Interchange 
Organization Mass Change dialog box.

5 Use the table below to determine your next action

If you want to change... Then click the check box for...

Your ID Change Your ID and enter a new 
value into the text box

A Partner�s ID Change Partner�s ID and enter a 
new value into the text box

The last control number sent Last sent and enter a new value in 
to the text box.

The last control number 
received

Last received and enter a new 
value into the text box.

WARNING
If you click the check box for an item but do not enter a 
new value, the system will delete the existing value for that 
item. 

(Continued on next page)
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6 Click OK.

System Response
The system displays the Interchange Organization Search dialog box. 

7 Use the table below to select the search criteria.

If you want to search a... Then click the...

Range of Interchange IDs Enter Range option. 

Single Interchange ID Target EDI Interchange ID option.

8 Click Edit.

System Response
The system prompts for a range of Interchange IDs or a specific ID, 
depending on your selection in Step 5.

(Continued on next page)
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Step Action
Mapping and Translation Guide � February 2002



Working with Trading Partnerships How to Change Interchange Organization Records 11 - 109
9 Enter the Start and End codes or the specific ID(s) of the 
Interchange(s) you want to search and click OK.

System Response

The system then searches for and displays a list of records matching 
the code or codes entered

10 Use the table below to select the Interchange ID or IDs to which you 
want to apply the changes.

To select... Do this...

A single ID Click the ID, then click OK.

All IDs displayed Click Select All, then click OK.

Multiple items Hold the CTRL key down and click 
each ID you want to select. Then, 
release the CTRL key and click OK.

System Response
The system prompts you to confirm the requested changes.

11 Click Yes.

System Response
The system then changes the selected Interchange Organization 
records, creates a log file (masschange.log), and returns to Trading 
Partnership Administration.

 (Contd)
Step Action
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How to Change Group Organization Records

Introduction Changes to Group Organization records are not common, but they can be 
necessary in certain circumstances. You can use the TP Mass Change facility to 
change some or all of your Group Organization records at once, rather than one at 
a time. 

The Group
Organization

dialog box

This illustration shows an example of the Group Organization Mass Change 
dialog box.

How to change
multiple Group

Organization
records

Use this procedure to change multiple Group Organization records at one time.

Step Action

1 Open Trading Partnership Administration.

2 Click Tools on the menu bar.

3 Click Mass Change on the Tools menu.
(Continued on next page)
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4 Click Group Organization on the Mass Change menu.

System Response
The TP Mass Change facility then displays the Group Organization 
Mass Change dialog box.

5 Use the table below to determine your next action

If you want to change... Then click the check box for...

Your ID Change Your ID and enter a new 
value into the text box.

A Partner�s ID Change Partner�s ID and enter a 
new value into the text box.

The last control number sent Last sent and enter a new value in 
to the text box.

The last control number 
received

Last received and enter a new 
value into the text box.

WARNING
If you click the check box for an item but do not enter a 
new value, the system will delete the existing value for that 
item. 

(Continued on next page)
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6 Click OK.

System Response
The system displays the Group Organization Search dialog box.

7 Use the table below to select the search criteria.

If you want to search a... Then click...

Range of Group IDs Enter Range. 

Single Group ID Target EDI Group ID.

8 Click Edit.

System Response
The system prompts for a range of Group IDs or a specific ID, 
depending on your selection in Step 1.

(Continued on next page)
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9 Enter the Start and End codes or the specific ID(s) of the Groups you 
want to search and click OK.

System Response
The system then searches for and displays a list of records matching 
the code or codes entered.

10 Use the table below to select the Group ID or IDs to which you want to 
apply the changes.

To select... Do this...

A single ID Click the ID, then click OK.

All IDs displayed Click ALL, then click OK.

Multiple items Hold the CTRL key down and click 
each ID you want to select. Then, 
release the CTRL key and click OK.

System Response
The system prompts you to confirm the requested changes.

11 Click Yes.

System Response
The system then changes the selected records, creates a log file 
(masschange.log), and returns to Trading Partnership Administration.

 (Contd)
Step Action
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How to Change Trading Partnership Records

Introduction The Mass Change facility uses a dialog box very similar to the one used to create 
new Trading Partnership records. The difference is a check box located to the left 
of items on the dialog box. You can use Mass Change to modify only those items 
that have a corresponding check box.

The Mass
Change Trading

Partnership
dialog box

This illustration shows an example of the Trading Partnership Mass Change 
dialog box.

(Continued on next page)
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How to Access
the

Mass Change
Trading

Partnership
dialog box

Use this procedure to open the Mass Change Trading Partnership dialog box.

Step Action

1 Open the Trading Partnership Administration window.

2 Click Tools on the menu bar.

3 Click Mass Change on the Tools menu.

System Response
The system displays a submenu of record types.

4 Click Trading Partnership on the Mass Change menu.

System Response
The system displays an introductory dialog box to the Trading 
Partnership Mass Change function.

(Continued on next page)
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(Continued on next page)

5 Click or enter the translation type of the Trading Partnership 
records you want to change.

6 Click Continue.

System Response
The system then displays the Mass Change Trading Partnership 
dialog box. 

You are now ready to select the values you want to change.

Reference
See the procedure under the topic Modifying Trading Partnership 
Records for more information about selecting values to change. 

 (Contd)
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How to change
Trading

Partnership
records

Use this procedure to change multiple Trading Partnership records at one time. 

Note
This procedure begins with the Trading Partnership Mass Change dialog box 
active. 

Reference 
See How to Access the Mass Change Trading Partnership dialog box for more 
information about activating this dialog box. 

Step Action

1 Click the tab containing the information you want to change.

2 Click the first item you want to change and enter the new value.

Warning

If you click the check box for an item but do not enter a new value, 
the system will delete the existing value for that item. 

Note
Some items have an Edit button to the right of the text box. Click the 
Edit button to display a dialog box listing additional items that you 
can change.

You can then click the items you want to change and enter the 
appropriate values. Click OK when you are ready to return to the 
previous screen or dialog box.

3 Repeat Steps 5 and 6 until you finish marking all of the items you 
want to change.

(Continued on next page)
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4 Click OK.

System Response

The system displays the Trading Partnership Search dialog box. 

5 Click the check box of the selection criteria you want to use, then 
click the associated Edit button.

System Response
The system displays a secondary selection dialog box for the chosen 
criteria. 

6 On the secondary dialog box, click the criteria you want to use and, 
where required, enter the value of the criteria.

Example
If you chose to select based on a range of numbers, you must enter 
a beginning and ending value.

(Continued on next page)
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7 Click OK.

System Response
The system displays the Trading Partner Search Results dialog box.

8 Use the table below to select the Trading Partners to which you want 
to apply the changes.

To select... Do this...

A single Trading Partner Click the Trading Partner, then click 
OK.

All Trading Partners 
displayed

Click Select All, then click OK.

Multiple items Hold the CTRL key down and click each 
Trading Partner you want to select. 
Then, release CTRL and click OK.

System Response
The system prompts you to confirm the requested changes.

9 Click Yes. 

System Response
The system then changes the selected records, creates a log file 
(masschange.log), and returns to Trading Partnership 
Administration. 

 (Contd)
Step Action
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Overview 0

Introduction

In this chapter This chapter covers running translation from the Translate menu.

This chapter explains:
◗ Inbound and outbound translation
◗ The Translate Menu
◗ The Translation process
◗ How to envelope output data that is in a standard format
◗ How to set up and run translations from the Translate menu
◗ How to view a translation summary.

Running
translation from
a script or batch

file

To run translation automatically, include the lftran command in a batch file or 
script.

To run translations on a schedule, enter the lftran translation command and the 
appropriate parameters into a batch file or script, and then run the batch file or 
script in an unattended mode via the Task Scheduler.

References
For information about using the Task Scheduler to run batch files and scripts, see 
the chapter Using the Task Scheduler in this guide.

For information about the lftran command, see the chapter Command Reference 
in the GENTRAN:Server Technical Reference Guide.

About
translation

Data translation is the primary function of GENTRAN:Server. Data translation 
takes business data in one computer-readable form and transforms it into another 
form.

During translation GENTRAN:Server executes the instructions defined in the:

◗ Translation object or compiled map
◗ Trading Partnership record
◗ Translation batch file, script, or translation dialog boxes. 

(Continued on next page)
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Setting
translation

options

You can set translation options in several ways:
◗ Set default translation options for a particular type of translation in Trading 

Partnership Administration
◗ Set specific translation options for a particular Trading Partnership record. 

These override any default settings.
◗ Set options for a specific input file when you run translation from the Translate 

menu. These override any other settings.

Key terms This table describes key terms used in this chapter.

Term Description

archive The process of copying and saving EDI data that has 
been processed.

audit record A temporary audit file named edistat.i or edistat.o, 
created during translation, which contains the directory 
path and file name for the EDI data received or 
generated. The record does not contain the actual EDI 
data.

data file The file that contains the inbound or outbound data.

envelope The process of combining like interchanges.

functional 
acknowledgment 
(FA)

The standard transaction set used to acknowledge 
receipt of a transmission. The functional 
acknowledgment tells you if a document was received 
and processed by your trading partner and whether it 
contained EDI standard compliance errors. Likewise, the 
functional acknowledgment you send to your trading 
partner relays the same information to them.

historical record The index files named edihist.dat and edihist.idx that 
store the location of the archived EDI data. The files are 
built from the audit records that translation produces. 
Together, they are the permanent audit file.

history audit 
directory

The EDI History Audit (hisaud) directory used to store 
permanent history files.

(Continued on next page)
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inbound translation A translation in which the input format of the source 
document is either an EDI standard format or an XML 
format that you use to exchange documents with a 
trading partner.

Note
Inbound translation using an XML format is available 
only if you have the XML translation option.

outbound translation A translation in which the input format of your source 
document is either an application format or an XML 
format that you defined for your internal application 
documents.

Note
Inbound translation using an XML format is available 
only if you have the XML translation option.

reconciliation The process of viewing functional acknowledgments, 
viewing data with the status of Errors, and correcting the 
EDI data.

status audit 
directory

The EDI Status Audit directory (stataud) used to store 
temporary audit files (edistat.i and edistat.o) and the 
history audit data.

Trading Partnership 
Code

A user-defined code that uniquely identifies a Trading 
Partnership record.

translation The conversion of data from one format to another.

 (Contd)
Term Description
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Inbound and Outbound Translation

Introduction Translation is either inbound or outbound. The dialog boxes, translation objects, 
and options you use during translation differ for each type of translation. 

Inbound
translation

In an inbound translation, the source or input document is in a data transmission 
format. The data transmission format can either be an EDI standard or, if you have 
the XML translation option, an XML format that your trading partner uses to send 
you documents. These are the types of maps normally used in inbound 
translation:

◗ Standard-to-standard
◗ Standard-to-application

XML translation option

If your trading partner sends you files in XML format and you have the XML 
translation option, you can also run these types of inbound translation.

◗ Standard-to-XML (if you have the XML translation option)
◗ XML-to-application (if you receive the XML input documents from your trading 

partner)
◗ XML-to-XML (if you receive the XML input documents from your trading 

partner)
◗ XML-to-standard (if you receive the XML input documents from your trading 

partner)

ODBC translation option

If you have the ODBC translation option, you can define the output application file 
as an ODBC database format.

For example:

◗ Standard-to-application (ODBC)

(Continued on next page)
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Outbound
translation

In an outbound translation, the source or input document is in a data format that 
you use for your internal applications. The input format of the source documents is 
either an application format or, if you have the XML translation option, an XML 
format that you defined for your internal application documents. These are the 
types of maps normally used in outbound translation:

◗ Application-to-application
◗ Application-to-standard

XML translation option

If you have the XML translation option, you can also run these types of outbound 
translations

◗ Application-to-XML
◗ XML-to-standard (if you send the output documents to your trading partner)
◗ XML-to-XML (if you send the output documents to your trading partner)

ODBC translation option

If you have the ODBC translation option, you can define the input application file 
as an ODBC database format.

For example:
◗ Application (ODBC)-to-standard
◗ Application (ODBC)-to-XML
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The Translate Menu

Translate menu This illustration shows the Translate menu.

Translation
menu options
and functions

This table describes the options of the Translate menu and their functions.

Option Function

Documents Translates both input data files that are coming in to 
your system and input files that are leaving your 
system. 

Inbound data files are in a standard format and are 
usually translated to your application format. Outbound 
data files are usually in your application format and are 
usually translated into an EDI standard format.

Note
If you have the XML translation option, then your 
inbound data files can also be in XML format and 
translated into an XML format.

Translation Summary Displays selected information about translations. 
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The Translation Process

Introduction This topic describes the GENTRAN:Server data translation process. You can use 
translation to: 
◗ Test a translation object (compiled map)
◗ Convert data to send to a trading partner
◗ Convert data received from a trading partner.

Translation
process flow

This illustration shows the translation process flow if all options are used. 

(Continued on next page)
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Example:
Inbound

translation
process stages

This example describes the typical stages in the default inbound translation 
process for X12 data that is being translated to application data. 

(Continued on next page)

Stage Description

1 GENTRAN:Server determines the Trading Partnership Code.

2 GENTRAN:Server reads the Trading Partnership record.

3 GENTRAN:Server determines whether outbound 
acknowledgments are required.

◗ If YES, the system generates a Trading Partnership enveloping 
signature that includes an ACK component for each transaction 
set and then continues with Stage 4.

◗ If NO, the system continues with Stage 4.

4 The system translates the sets, generates the functional 
acknowledgments (if required), and generates the output data. 

5 The system generates the inbound EDI audit record for the set (if 
your system is configured to archive EDI data) and then continues 
with the next stage.

6 Are there more sets to process?
◗ If YES, repeat Stages 1 through 5.
◗ If NO, continue with Stage 7.

7 GENTRAN:Server locks the Trading Partnership record.

8 GENTRAN:Server:

◗ Generates the interchange, group, and set headers
◗ Replaces the enveloping signature with the generated 

headers.

9 GENTRAN:Server generates the outbound audit records for the 
functional acknowledgments.

10 GENTRAN:Server unlocks the Trading Partnership records.
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Example:
Outbound

translation
process stages

This table describes the typical stages in the default outbound translation process 
for an application-to-standard translation.

Stage Description

1 GENTRAN:Server determines the Trading Partnership Code.

2 GENTRAN:Server reads the Trading Partnership record.

3 GENTRAN:Server generates a Trading Partnership enveloping 
signature for the transaction set.

4 GENTRAN:Server translates the set and generates the output 
data, which includes the enveloping signature. 

5 Are there more sets to process?

◗ If YES, repeat Stages 1 through 4.
◗ If NO, continue with Stage 6.

6 GENTRAN:Server uses the Trading Partnership enveloping 
signature to find and lock the Trading Partnership records.

7 GENTRAN:Server generates the interchange, group, and set 
headers.

8 Are the header segments mapped?

◗ If YES, merge the mapped header with the one generated in 
Stage 7 and then continue with Stage 9.

◗ If NO, continue with Stage 9.

9 GENTRAN:Server uses the enveloping signature to envelope the 
output data.

10 GENTRAN:Server updates the control numbers in the Trading 
Partnership records.

11 GENTRAN:Server generates the outbound audit records.

12 GENTRAN:Server unlocks the Trading Partnership records.
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Enveloping Outbound 
Data 0

EDI Envelopes

Envelope
segments

The EDI transaction sets and functional acknowledgments that you send to a 
trading partner must include envelope segments. The purpose of an envelope is 
to ensure that the sender and receiver of the transactions are properly identified 
and routed properly.

Each envelope level contains two data segments:

◗ A header segment to identify the beginning of the envelope
◗ A trailer segment to signal its end.

Levels There are three possible levels of envelopes:

◗ Interchange envelope
◗ Group envelope
◗ Transaction set envelope

The interchange and transaction set envelopes are mandatory for all standards. 
The group envelope is optional (or not used at all) for many EDI standards.

One interchange envelope can contain multiple groups. One group can contain 
multiple transaction sets of the same type.

Interchange
envelope

The interchange envelope is the outer envelope. The header segment usually 
contains data elements that specify who the sending party is and the final 
destination.

Example
The ISA segment is an interchange envelope segment for the ASC X12 standard.

(Continued on next page)
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Group envelope The group envelope is the second-level envelope. 

The group header segment begins a group. Within the group segments are data 
fields that identify the type of transactions contained in the group, the sender and 
receiver�s application IDs, the transmission date, control number, and other 
standard reference data.

Example
The GS segment is the functional group envelope segment for the ASC X12 
standard.

Transaction set
envelope

Each transaction is surrounded by a transaction envelope. All detail segments are 
stored in between the transaction set header and trailer segments.

Example
The ST segment is the transaction envelope for ASC X12 standard.
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Location of Enveloping Information

Introduction GENTRAN:Server builds the interchange, group, and transaction set envelopes 
from information defined in specific Trading Partnership records. During the 
enveloping process, GENTRAN:Server inserts the envelope information into the 
stream of data that you are sending your trading partner. 

Record/envelope
information table

This table shows the records that GENTRAN:Server uses to envelope outbound 
EDI data and lists the type of enveloping information each record contains.

Record Enveloping Information

Interchange Organization 
record

◗ Your unique interchange identifiers, which 
are inserted into the Interchange envelope.

◗ Your trading partner�s unique interchange 
identifiers, which are inserted into the 
Interchange envelope.

◗ The counter used for control numbers for 
your outbound business documents.

◗ The counter used for control numbers for 
inbound business documents that you 
receive from this trading partner.

Group Organization record ◗ A unique Group Organization code that is 
inserted into the Functional Group 
envelope.

◗ Your unique group identifier that is inserted 
into the Functional Group envelope.

◗ Your trading partner�s unique Group 
identifier that is inserted into the Group 
envelope.

◗ The counter used for control numbers for 
your business documents.

◗ The counter used for control numbers for 
inbound business documents that you 
receive from this trading partner.

(Continued on next page)
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Reference
See the How to Modify the Outbound Envelope Segments topic in this chapter for 
instructions on editing the elements in the Interchange envelope segment.

Outbound EDI tab of the 
Trading Partnership record

◗ The type of header segment used for the 
Interchange envelope.

◗ The type of group segment used for the 
Functional Group envelope.

Outbound Acknowledgment 
tab of the Trading Partnership 
record

◗ The type of header segment used for the 
Interchange envelope.

◗ The type of group segment used for the 
Functional Group envelope.

◗ The check box that turns the envelope 
program for outbound acknowledgments 
on and off.

 (Contd)
Record Enveloping Information
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Enveloping Options

Introduction You have two options for enveloping your outbound EDI data:
◗ Envelope transactions as part of the translation process
◗ Collect output transactions and delay enveloping until a later time

Setting
enveloping

options

You set enveloping options in the lftran command:
◗ In a translation script or batch file, or
◗ From the Translation Options dialog box if you run translation in attended 

mode from the Translate menu

Reference
See Setting Enveloping Options in a Script or Batch File or Setting Envelope 
Options from the Translate Menu.

Enveloping
during

translation

This table shows the stages in the enveloping process.

Stage Description

1 The translator determines that the translation output will be in an 
EDI standard format.

2 During translation, the lftran program adds an envelope signature 
line to the beginning of each set and generates an output file.

3 The lftran program uses the envelope signature lines in the output 
file to locate and lock the appropriate Trading Partnerships records.

4 If lftran is unable to lock the Trading Partnership records, it 
produces a lock file.
◗ If the translation output does not include functional 

acknowledgments, the sets that were not enveloped are written 
to boxout.lok in the temp directory.

◗ If the translation output includes functional acknowledgments, 
the sets and functional acknowledgments that were not 
enveloped are written to sigout.lok in the temp directory.

(Continued on next page)
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(Continued on next page)

5 The lftran program uses the envelope signature and the 
information in the Trading Partnership records to generate 
interchange, group, and set header segments.

6 If lftran encounters an error (other than a lock) that prevents it from 
generating the envelope segments, it produces an error file.

◗ If the translation output does not include functional 
acknowledgments, the sets that were not enveloped are written 
to boxout.err in the temp directory.

◗ If the translation output includes functional acknowledgments, 
the sets and functional acknowledgments that were not 
enveloped are written to sigout.err in the temp directory.

7 If the header segments are mapped, the system merges the 
mapped header with the generated header segment.

8 The system:

◗ Uses the header and trailer segments to envelope the data in 
the outbound EDI file

◗ Generates the audit record
◗ Updates the control numbers in the Trading Partnership 

records.

9 The system releases the locked Trading Partnership records.

10 The system looks for more sets. If it finds more sets, it repeats the 
process. If it does not find any more sets to translate, the 
translation process stops.

Note
The translation scripts supplied with GENTRAN:Server include 
commands to save *.lok files so that you can reprocess them.

Reference
For solutions on processing the sigout.lok file, see the readme file 
and supplementary white papers for this release of 
GENTRAN:Server.

 (Contd)
Stage Description
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Delayed
enveloping

This table shows the stages in the delayed enveloping process.

Stage Description

1 The translator determines that the translation output will be in an 
EDI standard format.

2 The lftran program runs with the H0 option to add a delayed 
envelope signature line to the beginning of each set in the output 
data. The program does not add envelope segments to the output 
data.

Note
The lftran program can run many times throughout the day.

3 The system collects the output data.

4 The lftran program runs with the H1 option at a later time, usually 
according to a schedule. The program processes the collected 
output data, using the envelope signature lines to locate and lock 
the appropriate Trading Partnerships records.

5 If lftran is unable to lock the Trading Partnership records, it 
produces a lock file. The system writes the sets and functional 
acknowledgments that were not enveloped to sigout.lok in the temp 
directory.

6 The lftran program uses the envelope signature and the 
information in the Trading Partnership records to generate 
interchange, group, and set header segments.

7 If lftran encounters an error that prevents it from generating the 
envelope segments, it produces an error file. 

The system writes the sets and functional acknowledgments that 
were not enveloped to sigout.err in the temp directory.

8 If the header segments are mapped, the system merges the 
mapped header with the generated header segments.

(Continued on next page)
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9 The system:
◗ Uses the header and trailer segments to envelope the data in 

the outbound EDI file
◗ Generates the audit record
◗ Updates the control numbers in the Trading Partnership 

records.

10 The system releases the Trading Partnership records and waits for 
the next translation and enveloping cycle.

Note
The translation scripts supplied with GENTRAN:Server produce a 
boxout.lok file. If you want to reprocess the sets in this file, you 
must modify the translation script to re-route the file.

Reference
For solutions on processing the sigout.lok file, see the readme file 
and supplementary white papers for this release of 
GENTRAN:Server.

 (Contd)
Stage Description
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Setting Enveloping Options in a Script or Batch File

Introduction In production mode, you will probably run the lftran command with translation and 
enveloping options in a script or batch file.

Settings for the
translation script

This table describes the lftran option you must set in your script or batch file.

Handling the
lftran output

The translation scripts supplied with GENTRAN:Server produce a boxout.lok file. 
If you want to reprocess the sets in this file, you must modify the translation script 
to re-route the file through the translation and enveloping process.

For solutions on processing the sigout.lok file, see the readme file and 
supplementary white papers for this release of GENTRAN:Server.

Combining like
interchange

envelopes

If you want to combine like interchange envelope segments into one interchange 
envelope segment after translation, you must include the envelope command in a 
batch file or script. However, if you are translating with the H1 option and the input 
files are organized by Trading Partnership code, you can omit the envelope 
command.

Reference
See the description of the envelope command in the GENTRAN:Server Technical 
Reference Guide for details.

IF you want to� THEN�

Envelope the EDI transaction 
sets during translation

Do not set an enveloping option in lftran, 
because this is the default enveloping action.

Collect translated files to 
envelope later (delay 
enveloping)

Configure your system to run the lftran 
program twice:

◗ First with the H0 option to generate the 
output file with the signature lines. You can 
run this option throughout the day.

◗ Later with the H1 option to lock the Trading 
Partnership records, generate the 
envelope segments from the signature 
lines in the collected output files, and then 
envelope all the collected data.
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Setting Envelope Options from the Translate Menu

Introduction If you run translation from the Translate menu, you can set the envelope options 
along with other translation selections on the Translation Options dialog box.

Procedure Use this procedure to set enveloping options from the Translate menu.

Step Action

1 Click Documents on the Translate menu. 

System Response
GENTRAN:Server displays the Translate Documents dialog box.

Reference
See The Translate Documents Dialog Box for a description of the 
fields on this dialog box.

2 Select the type of input file.
(Continued on next page)
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3 Select Translate document and then click the Translation 
Options button.

System Response
GENTRAN:Server displays the Translation Options dialog box.

Reference
See The Translation Options Dialog Box for a description of the 
fields on this dialog box.

4 Select the enveloping options.

IF you want to� THEN�

Envelope the EDI transaction 
sets now

Do not select an enveloping 
option.

Collect translated files to 
envelope later

Select the H0 option to generate 
an output file that has Trading 
Partnership signatures.

Envelope collected output files 
so that the EDI transactions are 
ready to send

Select the H1 option to lock the 
Trading Partnership records and 
then generate the envelope 
segments from the signatures in 
the output files.

(Continued on next page)
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Step Action
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3 Select Translate document and then click the Translation 
Options button.

System Response
GENTRAN:Server displays the Translation Options dialog box.

Reference
See The Translation Options Dialog Box for a description of the 
fields on this dialog box.

4 Select the enveloping options.

IF you want to� THEN�

Envelope the EDI transaction 
sets now

Do not select an enveloping 
option.

Collect translated files to 
envelope later

Select the H0 option to generate 
an output file that has Trading 
Partnership signatures.

Envelope collected output files 
so that the EDI transactions are 
ready to send

Select the H1 option to lock the 
Trading Partnership records and 
then generate the envelope 
segments from the signatures in 
the output files.

(Continued on next page)
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5 Are you running the H1 option with data produced from the H0 
option?
◗ If YES, continue with the next step.
◗ If NO, go to Step 7.

6 Do you want to combine like interchanges into a single interchange 
immediately after translation?

◗ If YES, click the Envelope standard output data check box to 
enable the envelope program.

◗ If NO, continue with the next step.

Reference
See the GENTRAN:Server Technical Reference Guide for 
information about the envelope command.

7 Select the other translation options that you want the system to use 
for this translation; then click OK to save your changes and return 
to the Translate Documents dialog box.

CAUTION
If you set the translation options both here and in the 
Trading Partnership record, GENTRAN:Server uses 
those set in the Trading Partnership record if it finds a 
conflict. If you set nonconflicting options in both places, 
the lftran program uses both sets of options. 

8 Set any remaining options you want to use for this translation on 
the Translate Documents dialog box and then click OK to start 
translation.

 (Contd)
Step Action
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Setting Up Translation 0

Introduction

Before you begin Before you can run a translation in GENTRAN:Server, you need to be sure that all 
of the input files for the process are available. Those files include:
◗ Translation object or compiled map
◗ Trading partnership records
◗ Input data file 

References This table provides reference information for the items listed. 

For... See...

Procedures for creating a Trading 
Partnership record for outbound 
translation

Working with Trading Partnerships in 
this guide.

Procedures for creating a Trading 
Partnership record

Working with Trading Partnerships in 
this guide.
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The Translate Documents Dialog Box

Introduction This topic describes the Translate Documents dialog box. The Translate 
Documents dialog box enables you to:
◗ Select the input file you want to translate
◗ Set formatting options for the input document
◗ Set translation options for the input document
◗ Set archiving options
◗ Enable enveloping when the output file is in a standard format.

Illustration This illustration shows the Translate Documents dialog box for an input document 
in a standard format.

(Continued on next page)
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Fields and
functions

This table describes the Translate Documents dialog box and their functions. The 
available options depend upon the type of input file selected.

Field Function

Input file name

Standard file Specifies that the input file is in an EDI standard file 
format (inbound).

Application file Specifies that the input file is in an application file 
format (outbound).

XML File Specifies that the input file is in XML file format.

Note
This option is enabled only if you have the 
GENTRAN:Server XML translation option.

Database Specifies that the input file is in a database format.

Input file name box Used to enter the path and name of the file you 
want to translate. 

Notes
Do not enter environmental variables in this field.

You can use the Browse button to locate the file.

Browse Opens a search dialog box, which enables you to 
browse the folders to locate the input file name.

Override default output 
path and file name

Overrides the default location to store the translated 
data. The default location is specified in the Trading 
Partnership record. 

Note 
You should not enter environmental variables in this 
field.

 An ASCII flat file Writes the result of the translation to an ASCII flat 
file when this option and the Override default 
output path and filename is selected.

A database Writes the result of the translation to a database file 
when this option and the Override default output 
path and filename is selected.

(Continued on next page)
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File name box When the An ASCII flat file option is selected, this 
box enables you to enter the file and directory 
where you want GENTRAN:Server to store the 
translated data. 

Browse Opens a search dialog box, which enables you to 
browse the folders to locate the ASCII flat file or 
database file.

Options

Format input document Prepares the inbound EDI data for translation by 
replacing segment terminators with newline 
characters. 

Notes
Formatting is required for inbound EDI translation.

This option is not available if you specified that the 
input file is in XML format.

Formatting Options Displays the Formatting Options dialog box to allow 
you to fully control the formatting process.

Notes
This option is not available if you specified that the 
input file is in XML format.

Reference
See the Formatting Options dialog box topic.

Translate document Runs the translation process on the input file. When 
not checked, you can format, envelope, or archive 
previously translated data.

Translation Options Displays the Translation Options dialog box, which 
enables you to choose from many command line 
translation options.

Note 
The system displays the default translation options 
in the box next to this button.

References
See The Translation Options Dialog Box topic.

See the lftran topic in the Command Reference 
chapter of the GENTRAN:Server Technical 
Reference Guide for a list of all options.

(Continued on next page)
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Archive Data Archives the EDI data and the status. 

Note 
To use the functional acknowledgment features, 
you must archive the data with each translation.

This option is not available if you specified that the 
input file is in XML format.

Archive Options Displays the Archive Options dialog box, which 
enables you to choose ediarc command line 
options for the archiving inbound translation.

Notes
The system displays the default archive options in 
the box next to this button.

This option is not available if you specified that the 
input file is in XML format.

Reference
See The Archive Options Dialog Box topic.

Envelope standard 
output data

Combines like interchanges for outbound functional 
acknowledgments created during an inbound 
translation.

Combines like interchanges into one envelope 
during outbound translation.

Notes 
This option is not available if you specified that the 
input file is in XML format.

You can use delayed enveloping instead of this 
option.

 (Contd)
Field Function
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The Formatting Options Dialog Box

Formatting
Options dialog

box

This illustration shows the Formatting Options dialog box. This dialog box controls 
how the input file is reformatted for output

Formatting
Options fields
and functions

This table describes the fields in the Formatting Options dialog box and their 
functions. 

Note
The letters in parentheses are the edifrmat command line parameters that 
correspond to the description for each check box

Field Function

Append to output file Appends the results of the format process to 
previous output instead of overwriting the output.

Output debug information Creates a list to help resolve issues you are having 
with inbound translation.

The list shows the sets and segments you are 
translating and is stored in edifrmat.log under the 
reports directory.

(Continued on next page)
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Pass through extended 
characters

Leaves unchanged any extended ASCII 
characters found in the input file. 

Comment
If you do not check this option, edifrmat changes 
all extended ASCII characters to blanks.

Format GENCOD data Retains original segment terminator instead of 
substituting new line terminator. Used for routing 
EDIFACT, GENCOD, or VDA data with product 
levels GENTRAN:Server with PCM or higher.

Note
The translator requires new line terminated data. 
This option is used only with data managers to 
route data that uses segment terminators.

Error on lowercase 
characters

Generates an error when lowercase characters are 
found within the input file.

Separate interchanges 
with newlines

Places newline characters between interchanges 
within the input data.

Strip all new-line 
delimiters

Removes all newline characters from the input file.

Verify set and group 
counts

Verifies the set and group counts found in the 
incoming data.

The set count is compared to the number 
contained in the group trailer (for example, in the 
GE or UNE segments).

The group count is compared to the number 
contained in the interchange trailer (for example, in 
the IEA, EG, ICE, or UNZ segments).

 (Contd)
Field Function
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The Translation Options Dialog Box

Setting
translation

options

If you want to use the same translation options for all your Trading Partnerships, 
you can set translation options as parameters on the translation command. If you 
want to use different translation options for some Trading Partnerships, set up 
translation options in the Trading Partnership record. (See Working with Trading 
Partnerships in this guide.) If you set translation options in both places, the 
program uses both sets of options unless they conflict. If some options conflict, 
GENTRAN:Server uses those set in the Translation Options dialog box.

Note
GENTRAN:Server saves the options from the last run. You do not have to enter 
them again for subsequent runs unless you want to make additional changes.

Translation
Options dialog

box

This illustration shows the Translation Options dialog box. This illustration is for 
inbound translation. The available options are different for outbound translation.

(Continued on next page)
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Translation
Options fields
and functions

This table describes the fields of the Translation Options dialog box and their 
functions.

(Continued on next page)

Field Function

Select Options Enables you to select parameters for the 
translation process.

Reference
See the table in the Select Options list topic in 
the online help system for a description of the 
available choices.

Trading Partnership Code 
defined in application/file 
definition file

Enables you to specify the application file or 
file definition that defines the location of the 
Trading Partnership code in the data you are 
translating. For outbound translation only.

Override database Data 
Source Name

For Visual Mapper only, enables you to 
replace the ODBC DSN used to create the 
application file with the one you want to use for 
the current translation.

Note
Your GENTRAN:Server system must have the 
optional ODBC translation capabilities.

Allow multiple attempts to 
access a locked Trading 
Partnership record

Sets the number of attempts 
GENTRAN:Server can make to access a 
locked Trading Partnership record. If the file is 
still locked after the specified number of 
attempts, the translation process fails.

Number of attempts at 1 
second intervals

Sets the number of lock attempts.

Specify Trading Partnership 
Code

Specifies the Trading Partnership Code to be 
passed to the translator during translation. Use 
this option when the Trading Partnership Code 
is not present in the application data and the 
entire file can be translated using one Trading 
Partnership Code and one map. For outbound 
translation only.

Specify Trading Partnership 
Code placement

Specifies the location of the Trading 
Partnership Code within the input file. For 
outbound translation only.
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Select Options
list

For a complete and current description of the choices available in the Select 
Options list, view the Select Options list topic in the online help system.
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The Archive Options Dialog Box

Archive Options
dialog box

This illustration shows the Archive Options dialog box. This dialog box controls 
how the input file is archived

Archive Options
fields and
functions

The options listed on this dialog box are based on the type of input file. The 
ediarc command line parameter is listed in parentheses for each option.

Reference
See the Command Reference chapter of the GENTRAN:Server Technical 
Reference Guide for a list of the ediarc parameters and variables.
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Running Inbound and 
Outbound Translation 0

How to Run Inbound Translation

Introduction This topic explains how to run an inbound translation from the Translate menu. 

Note
You must be using a map with either an EDI standard or, if you have the XML 
translation option, XML as the format of the source document.

Multiple
sessions

If you have GENTRAN:Server for UNIX and are running multiple sessions of the 
client, you can run translation in only one client session for each host and 
environment combination. You can translate documents in more than one parallel 
session as long as each session is for a different host and environment 
combination.

If you attempt to translate documents when another session that is logged in to 
the same host and environment is already translating, GENTRAN:Server displays 
a message to let you know that the process is currently running and asks that you 
try again later.

If you have GENTRAN:Server Workstation and are running multiple sessions on 
your desktop, you can run translation in only one session.

Procedure Use this procedure to perform an inbound translation from the Translate menu.

Step Action

1 Click Documents on the Translate menu. 

System Response
GENTRAN:Server displays the Translate Documents dialog box.

2 Select the type of input file:

◗ Standard base file
◗ XML file (available only if you have the XML translation option)

(Continued on next page)
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3 Use one of the following methods to specify the input file name.
◗ Enter the full path and file name into the text box.
◗ Click Browse to display the Translation Input File dialog box, 

browse through the directories and select a file name, and 
then click OK.

4 Use this table to decide your next step.

IF you want to� AND� THEN�

Store the data in 
the location 
specified in the 
Trading 
Partnership record

The input file is in EDI 
Standard format

GO TO Step 7.

Store the data in 
the location 
specified in the 
Trading 
Partnership record

The input file is in XML 
format

Note
The XML format is 
available only if you have 
the XML translation 
option.

GO TO Step 8.

Store the data in a 
different location

The output file is an ASCII 
flat file format

GO TO Step 5.

Store the data in a 
different location

The output file is a 
database file

GO TO Step 6.

5 Click Override default output path and filename and then select 
the ASCII flat file option. Enter the full path and file name of the 
ASCII flat file into the text box.

Note
You can also click Browse to display the Translation Output File 
dialog box to select a file name.

6 Click Override default output path and filename and then click 
the database option.

(Continued on next page)
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7 Do you want to format the input file?
◗ If YES, select Format input document, click the Formatting 

Options button, and select the options you want to use.

Reference
See The Translation Options Dialog Box topic for 
descriptions of the options.

Comments
This step is recommended for all X12 data.

You must run the formatting process if you run the 
translation process.

◗ If NO, continue with the next step.

8 Do you want to set translation options for the input file?

◗ If YES, select Translate document and click the Translation 
Options button to display the Translation Options dialog box. 
Set the translation options you want to use; click OK to return 
to the Translate Documents dialog box.

◗ If NO, continue with the next step.

9 Do you want to archive the EDI data?
◗ If YES, continue with the next step
◗ If NO, continue with the Step 11.

10 Select Archive Data and then click the Archive Options button to 
select the archiving options you want to use. 

11 Is the input file in XML format?

◗ If YES,GO TO Step 13.
◗ If NO, continue with Step 12.

Note
The XML format is available only if you have the XML translation 
option.

12 Do you want to combine like interchanges for outbound Functional 
Acknowledgments created during an inbound translation?
◗ If YES, select Envelope standard output data.
◗ If NO, continue with the next step.

(Continued on next page)
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After translation Once you are sure the translation object translates the data correctly, you can 
check in the map and translation object.

13 Click OK to run the selected processes. 

System Response
GENTRAN:Server translates the inbound data file, stores the 
resulting data in the appropriate file(s), and displays a process log.

14 Check the process logs for errors. 

System Response
GENTRAN:Server places all the transaction sets that were 
processed without error into your output file.

Process logs
The process logs are in the rpt directory.

◗ The boxin.err log contains data with compliance errors.
◗ The dtLog.err file contains the error codes and their 

descriptions of errors pertaining to data transformation.
◗ The xlcntl.err log contains errors and related information 

pertaining to Trading Partnership records and files used during 
translation.

◗ The edifrmat.not file contains non-EDI characters that 
appeared before the Interchange header or after the 
Interchange trailer.

◗ The edistat.irr file contains archiving errors for inbound EDI 
data.

◗ The edistat.orr file contains archiving errors for outbound 
acknowledgments.

 (Contd)
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How to Run Outbound Translation

Introduction This topic explains how to run an outbound translation from the Translate menu.

Notes
For outbound translation, you must be using a map with either an application or, if 
you have the XML translation option, an XML file as the source document.

Multiple
sessions

If you have GENTRAN:Server for UNIX and are running multiple sessions of the 
client, you can run translation in only one client session for each host and 
environment combination. You can translate documents in more than one parallel 
session as long as each session is for a different host and environment 
combination.

If you attempt to translate documents when another session that is logged in to 
the same host and environment is already translating, GENTRAN:Server displays 
a message to let you know that the process is currently running and asks that you 
try again later.

If you have GENTRAN:Server Workstation and are running multiple sessions on 
your desktop, you can run translation in only one session.

Procedure Use this procedure to run an outbound translation.

Step Action

1 Click Documents on the Translate menu. 

System Response
GENTRAN:Server displays the Translate Documents dialog box.

2 Select the type of input file:

◗ Application file
◗ XML file (available if you have the XML translation option)
◗ Database (available if you have the ODBC translation option) 

(Continued on next page)
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3 Use one of the following methods to specify the input file name.
◗ Enter the full path and file name into the text box.
◗ Click Browse to display the Translation Input File dialog box. 

Browse through the directories and select a file name. Click 
Open.

System Response
The path and file name display in the input file name text box.

4 Use this table to decide your next step.

IF you want to� THEN�

Store the data in the location 
specified in the Trading 
Partnership record

Skip to step 5.

Store the data in a different 
location

Click Override default output 
path and filename and then click 
either the ASCII flat file or 
database option. If you select 
ASCII flat file, enter the full path 
and file name into the text box.

Notes
You can also click Browse to 
display the Translation Output 
File dialog box to select a file 
name.

You must have the ODBC 
translation option to use the 
database option.

5 Do you want to set translation options for the input file?

◗ If YES, click the Translate document option and then click 
the Translation Options button to set the translation options 
you want to use.

Continue with Step 6.
◗ If NO, GO TO Step 7.

(Continued on next page)
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6 Use this table to determine how to indicate on the Translation 
Options dialog box the location of the Trading Partnership Code.

IF the Trading Partnership 
Code is� THEN�

In the first 16 positions of each 
record in the input data file

The translator can find the 
Trading Partnership Code. Go to 
Step 7.

The same for all of the data in 
the input file

Click Specify Trading 
Partnership Code and then click 
the binoculars symbol (Browse 
button) to select the Trading 
Partnership code. 

Marked in the first record of the 
file definition

Click Trading Partnership Code 
defined in Application/File 
Definition and then select the file 
that describes its position from 
the drop-down list.

Note
When you specify a file definition 
and translate with the A option, 
the file definition should either 
have a field in the first record 
named TPCODE to mark the 
Trading Partner Code field, or 
have application/Trading 
Partnership rules defined to 
determine the Trading Partner 
Code. The name is case-
sensitive.

Not marked in the file definition Click Specify Trading 
Partnership Code Placement 
and then complete the Position 
and Length boxes to point to the 
position within the input data.

7 Do you want to archive the EDI data?
◗ If YES, select Archive Data and then click the Archive 

Options button to select the archiving options you want to use. 
◗ If NO, continue with the next step.

(Continued on next page)
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After translation If you used the archive feature during translation, you can correct any errors in the 
archived file and send the data again. See  Archiving Data in this guide for 
instructions.

After testing a translation object
Once you are sure the translation object translates the input file correctly, you can 
check in the map and translation object.

8 Do you want to combine like interchanges into a single 
interchange?
◗ If YES, select Envelope standard output data.
◗ If NO, continue with the next step.

9 Click OK to start the translation. 

System Response
GENTRAN:Server translates the data file, stores the resulting data 
in the appropriate file(s), and displays a process log.

10 Check the process log for errors. 

System Response
GENTRAN:Server places all the transaction sets that were 
processed without error into your output file.

Process logs
The process logs are in the rpt directory.

◗ The boxout.err log contains data with compliance errors.
◗ The dtLog.err file contains the error codes and the descriptions 

of errors pertaining to data transformation.
◗ The xlcntl.err log contains errors and related information 

pertaining to Trading Partnership records and files used during 
translation. 

◗ The edifrmat.not file contains non-EDI characters that 
appeared before the Interchange header or after the 
Interchange trailer.

◗ The edistat.irr file contains archiving errors for inbound EDI 
data.

◗ The edistat.orr file contains archiving errors for outbound 
acknowledgments.
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How to Modify the Outbound Envelope Segments

Introduction You can modify the values of the elements in the interchange and group envelope 
segments that GENTRAN:Server inserts in the envelope segments of a Trading 
Partnership�s:
◗ Outbound EDI documents
◗ Outbound Functional Acknowledgments.

Standards
compliance

The elements in the interchange and group envelope segments depend on the 
standard, the standard version, or (for EDIFACT) the syntax level. 
GENTRAN:Server bases the options it displays for the elements on the 
information you specify.

Example 1
If you specify X12/ANSI standard version 4020 and later, GENTRAN:Server 
displays �Repeating Element Separator� and a drop-down list of valid values for 
element ISA11 on the Interchange Information dialog box. For standard versions 
prior to 4020, GENTRAN:Server displays �Interchange Standards ID� in the ISA11 
element field.

Example 2
If you specify UN/EDIFACT Syntax Version 4 for UNB element 0002 on the 
Interchange Header Information dialog box, GENTRAN:Server shows an 8-digit 
format (for example, 19991129) for element 0017, Date of Preparation, on the 
UNB and UNG dialog boxes.

(Continued on next page)
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Modifying the
envelope

segments for
outbound EDI

documents

Use this procedure to modify the envelope segments of outbound EDI documents 
for a Trading Partnership.

Step Action

1 Open the Trading Partnership record that you want to modify.

Reference
See How to Search for a Trading Partnership Record or How to 
Edit Trading Partnership Records for instructions on opening 
Trading Partnership records.

2 Click the Outbound EDI tab.

(Continued on next page)
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3 Click the Edit button of the Interchange control header or Group 
control header field.

System Response
The system displays the Information dialog box for the segment 
you selected from the drop-down box. The standard version and 
EDIFACT syntax level determine which elements are displayed on 
the dialog box.

This illustration is for the ISA envelope segment for X12/ANSI 
standard version 4020.

4 Modify the element or elements you want to change.

Reference
See your Standards documentation for the element definitions of 
the interchange and group control header segments.

(Continued on next page)
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(Continued on next page)

5 Click OK.

Warning
You MUST click OK on this dialog box to save your changes.

System Response
The system displays the Outbound EDI tab.

6 Click OK to save your changes.

Warning
You MUST click OK on the Outbound EDI tab to save your changes 
to the envelope segment.

 (Contd)
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Modifying the
envelope

segments for
outbound

Functional
Acknowledg-

ments

Use this procedure to modify the envelope segments of outbound functional 
acknowledgments for a Trading Partnership record.

Step Action

1 Open the Trading Partnership record that you want to modify.

Reference
See How to Search for a Trading Partnership Record or How to 
Edit Trading Partnership Records for instructions on opening 
Trading Partnership records.

2 Click the Outbound Acknowledgment tab.

3 Click the Edit button of the Interchange control header or Group 
control header field.

System Response
The system displays the Information dialog box for the segment 

4 Modify the element or elements you want to change.

Reference
See your Standards documentation for the element definitions of 
the interchange and group control header segments.

(Continued on next page)
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5 Click OK.

System Response
The system displays the Outbound Acknowledgment tab.

6 Click OK to save your changes.

Warning
You MUST click OK on the Outbound Acknowledgment tab to save 
your changes to the envelope segment.

 (Contd)
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Generating a Translation 
Summary 0

Translation Summary Report

Introduction If you archive your translation data, you can generate a Translation Summary of 
data about selected translations. 

Translation
Summary

This illustration shows an example Translation Summary.

(Continued on next page)
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Translation
Summary
contents

The Translation Summary contains the following information for the selected 
interchanges, one functional group to a line:
◗ Trading Partnership Code
◗ Trading partner's Interchange ID for this interchange
◗ Interchange control number
◗ Group control number
◗ Set ID
◗ Translation date
◗ Number of sets translated
◗ Number of characters translated

The summary also shows grand totals for the number of sets and the number of 
characters.
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Translation Summary Ranges Dialog Box

Illustration This illustration shows the Translation Summary Ranges dialog box.

Fields and
functions

This table describes the fields of the Translation Summary Ranges dialog box and 
their functions.

Field Function

Inbound (From Std) Specifies that the summary will include only inbound 
translations.

Outbound (To Std) Specifies that the summary will include only outbound 
translations.

Trading Partner Specifies the Trading Partner Code for which to display 
translations.

Comment
If you enter a Trading Partner Code, do not specify a 
Set ID.

Set ID Specifies the Translation Set ID for which to display 
translations. 

Comment
If you leave this field blank, all sets are included.

If you enter a Set ID, do not specify a Trading Partner 
Code.

(Continued on next page)
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Start Date Specifies the earliest date for which to display 
translations. 

Comment
If you leave this field blank, all translations are included 
back to the earliest one.

End Date Specifies the last date for which to display translations.

Comment
If you leave this field blank, all translations are included 
up to the most recent.

 (Contd)
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How to Generate a Translation Summary

Procedure Use this procedure to generate a Translation Summary.

Step Action

1 Click Translation Summary from the Translate menu.

System Response
The Translation Summary Ranges dialog box appears.

2 Click either Inbound or Outbound.

3 Use this table to specify the translations to include in the report.

IF you want to include� THEN�

Translations from only one 
particular Trading Partnership

Enter the Trading Partner 
Code.

Translations of only one particular 
document

Enter the Set ID.

Translations after a particular date Enter the Starting Date.

Translations up to a particular 
date

Enter the Ending Date.

4 Click OK.

System Response
GENTRAN:Server displays the Translation Summary. 

If GENTRAN:Server finds no data to report, it creates an empty file 
and displays a report containing only a title.

If GENTRAN:Server finds data, you can scroll from left to right and 
from top to bottom as necessary to see the entire report.

5 Do you want to print the Translation Summary?

◗ If YES, click Print.
◗ If NO, continue with next step.

6 Click Close to close the Translation Summary dialog box.
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Overview 0

Introduction

About archiving The GENTRAN:Server archiving feature for EDI translation enables you to store a 
copy of inbound and outbound EDI document status information that is created 
during translation, and the actual EDI documents. Through the archive setup 
windows, you choose the types of records to be archived. 

Once data is archived, you can:
◗ Examine archived inbound and outbound data
◗ Edit the archived outbound data
◗ Extract archived outbound data and prepare it to resend it to the trading 

partner
◗ Reconcile functional acknowledgments 
◗ Move data to media or to another machine.

In this chapter This chapter shows you how to:

◗ Choose the default archiving options and run the archiving program
◗ Work with archived data, including reconciling functional acknowledgments
◗ Move archived data with the archive utilities.

Key terms This table describes key terms used in this chapter.

Term Description

archive The process of copying and saving EDI data that has 
been processed.

data file The file that contains the inbound or outbound data.

EDI History Audit 
directory

The directory used to store permanent history files and 
EDI data.

EDI Status Audit 
directory

The directory used to store temporary translation audit 
files (edistat.i and edistat.o).

(Continued on next page)
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ediarc The GENTRAN:Server program that controls 
archiving.

functional 
acknowledgment (FA)

The standard transaction set used to acknowledge 
receipt of a transmission. The functional 
acknowledgment tells you if a document you sent was 
received and processed by your trading partner. It also 
can tell you if your document contained EDI standards 
compliance errors.

historical record The index files named edihist.dat and edihist.idx that 
store the location of the archived data. The files are 
built from the temporary translation audit files. 
Together, they form the permanent audit file.

reconciliation The process of viewing functional acknowledgments, 
viewing data with certain statuses, such as Error, Late, 
or Waiting, and correcting the EDI data.

status record A temporary audit file named edistat.i or edistat.o, 
created during translation, which includes the directory 
path and file name for the EDI data received or 
generated. The record does not contain the actual EDI 
data.

 (Contd)
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The Archive Menu

Archive menu This illustration shows the Archive menu.

Archive menu
options and

functions

This table describes the options of the Archive menu and their functions.

Option Function

Setup Options Sets the archive and retrieval system defaults for EDI 
translation, which may be overridden by the Trading 
Partnership Record.

Open Archive Accesses archived EDI data for viewing, editing, or 
extracting.

Purge Archive Removes EDI historical records and stored data that is 
older than the retention period.

Unload Archive Files Creates an ASCII file (edihist.unl) from the contents of 
an EDI historical file. You can then move the ASCII file 
to another machine or to media.

New/Create Archive 
Files

Creates two historical files named eidhist.dat and 
edihist.idx. These files are used to prepare for moving 
archived data from another machine or from media. 
You populate these files by archiving EDI data or by 
loading an ASCII file created from the contents of an 
Archive historical file. 

Load Archive Files Loads the EDI historical files (edihist.dat/.idx) from 
ASCII file data (edihist.unl).
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The Archive Process

Introduction The ediarc program controls archiving for EDI translation data. Archiving begins 
when the translation process produces status records. The subsequent stages in 
the process depend on how you set up archiving for your system.

Archiving
process

This table describes the archive process when all archiving options are activated.

(Continued on next page)

Stage Description

1 During translation, GENTRAN:Server creates temporary audit files 
named edistat.i (inbound) and edistat.o (outbound) and places them 
in the EDI Status Audit directory. 

For each set translated, these audit files include pointers to the 
directory path and file name for the EDI data received or generated.

2 If you configure your archiving system to save historical records, 
ediarc posts the status records to the historical files, edihist.dat and 
edihist.idx, which reside in the EDI History Audit directory.

3 If you configure your archiving system to save EDI data files, ediarc 
checks the archive switches in the Trading Partnership record to 
determine which sets to archive and their purge dates. ediarc then 
copies the EDI data files into a directory hierarchy in the EDI History 
Audit directory.

Reference
See the topic How archived files are named in this chapter.

4 If functional acknowledgments were created during the translation, 
ediarc posts their status to the edihist.idx and edihist.dat files and 
copies the EDI data file to the EDI History Audit directory.

5 If the data was archived successfully, GENTRAN:Server deletes the 
temporary status records edistat.i and edistat.o. If an error occurred 
during archiving, the temporary files are kept for debugging under the 
names edistat.irr and edistat.orr. 

6 GENTRAN:Server writes error messages to the file xlcntl.err, which is 
in the wrktemp subdirectory under the directory specified for User 
Files.
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How archived
files are named

The file name format for archived files is as follows:
edihist\yyyy\mm\dd\hh\nnnnnnnn.ext

Where:

◗ �edihist� represents the name of the EDI History directory.
◗ �yyyy\mm\dd\hh� represents the year, month, day, and hour the data was 

translated.
◗ �nnnnnnnn� is the system-generated 8-character file name.
◗ �.ext� represents the file name extension.

� If you do not select a data compression utility during setup, the exten-
sion is .arc. 

� If you select a data compression utility during setup, the extension is 
determined by the compression utility. (.zip for Pkzip files, .z for 
packed, and .Z for compressed.)

Example

Assume that the EDI History Audit directory is named edihist. The data file was 
translated on January 3, 1997, at 11 a.m. and compressed with Pkzip.

Ediarc copies the file and names it:

edihist\1997\01\03\11\00000001.zip 
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Setting Up EDI Translation 
Archiving 0

Introduction

About this
section

This section explains how to set up your archiving system. It contains these 
topics:
◗ Specifying the audit directories
◗ Choosing EDI archive options
◗ Selecting a data compression utility.

Before you begin To ensure the accuracy of archiving and functional acknowledgment 
reconciliation, you must have unique control numbers across all documents for a 
trading partner. This is because the archiving program does not archive duplicate 
records; if two different records have the same control numbers, the archiving 
program rejects the second as a duplicate. 

The best way to ensure unique control numbers is to use Organization records 
and maintain control numbers globally. This causes GENTRAN:Server to 
automatically assign unique, sequential control numbers to all documents for a 
single trading partner.

Reference
See How to Create a Group Organization Record in this guide for information 
about using Organization records.

WARNING
If you do not use Organization records and maintain control numbers 
globally, you must check each Trading Partnership record with the 
same Interchange IDs and edit the control numbers. Add a unique, 
sequential prefix (for example, 1, 2, 3, ..., n) to each control number 
so the control numbers are unique.
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How to Specify the Translation Audit Directories

Introduction How your organization specifies the EDI translation audit directories depends on 
whether you are running GENTRAN:Server for UNIX (client/server) or the 
GENTRAN:Server Workstation version.

Decision table
for Creating

Audit Directories

Use this decision table to determine the number and types of audit directories you 
need to create for the different versions of GENTRAN:Server.

Audit directories
for the UNIX

version

If you are running GENTRAN:Server for UNIX, your system Security Administrator 
specified the EDI Status and EDI History Audit directories on the host when your 
security file was established. Check with your Security Administrator to make sure 
these directory paths are in place before you run ediarc.

The EDI Status Audit directory is your working directory. The EDI History Audit 
directory stores the path and file name to every archived file. 

You can view the paths to these directories by selecting Setup Directories from 
the Settings menu, but you cannot change the paths. The Security Administrator 
can change the paths with the Security Administration software installed on the 
UNIX host.

Reference
See the Maintenance and Troubleshooting Guide for more information.

(Continued on next page)

IF you work in a... THEN create...

Single-user environment in which one 
user runs translation and archives 
data

One audit directory that serves as both 
the EDI Status Audit directory and the 
EDI History Audit directory.

Multi-user environment in which 
several users create maps, but only 
one user runs translation and archives 
data

One audit directory that serves as both 
the EDI Status Audit directory and the 
EDI History Audit directory.

Multi-user environment in which 
several users run translation and 
archive data

One EDI History Audit directory that is 
the same for all users.

A private EDI Status Audit directory for 
each user.
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Audit directories
for the

Workstation
version

The Workstation version provides for two types of audit directories: 
◗ EDI Status Audit stores your audit files, edistat.o and edistat.i, temporarily. 
◗ EDI History Audit stores the full path and file name to every archived file.

If you are running the Workstation version of GENTRAN:Server, you must 
designate the paths to these directories before you run ediarc.

How to specify
the audit

directories in the
Workstation

version

Use this procedure to specify the audit directories in the Workstation version.

Step Action

1 Click Settings on the menu bar.

2 Click Setup Directories on the Settings menu. 

System Response
GENTRAN:Server displays the Setup Directories dialog box.

3 Type the full path name for the EDI Status Audit directory in the EDI 
Status Audit box; then type the full path name for the EDI History 
Audit directory in the EDI History Audit box.

4 Click OK to save your changes.
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Archive/Retrieval Setup Dialog Box

Introduction The Archive/Retrieval Setup dialog box is used to set the archiving options for EDI 
translation data and to select a data compression utility to compress your archived 
data. The dialog box has two tabs:
◗ EDI tab
◗ Compression tab

EDI tab This illustration shows the EDI tab.

(Continued on next page)
Mapping and Translation Guide � February 2002



Archive/Retrieval Setup Dialog Box Archiving Data13 - 12
EDI tab fields
and functions

This table describes the EDI tab fields and their functions.

Field Function

Save History

Save Inbound Status 
Records

Archives inbound EDI status records by converting 
them to historical records and adding them to the 
permanent audit history files, edihist.dat and 
edihist.idx.

Include Inbound Data Archives inbound data files.

Retain data for ___ 
days

Sets the minimum number of days after which inbound 
data files are eligible for purging. After this number of 
days, the inbound data files and the associated 
historical records i the permanent audit file are eligible 
for purging.

Save Outbound 
Status Records

Archives outbound status records by converting them 
to historical records and adding them to the permanent 
audit files, edihist.dat and edihist.idx.

Include Outbound 
Data

Archives outbound data files.

Retain data for 
__days

Sets the minimum number of days outbound data files 
are kept. After this number of days, the outbound data 
files and associated historical records in the permanent 
audit file are eligible for purging.

Acknowledge Transactions

Expect 
Acknowledgment for 
Outbound Data in

Signals system to expect acknowledgments for 
outbound data in the specified days, hours, minutes, 
and seconds.

Days Sets the number of days in which to expect 
acknowledgment for outbound data.

Hours Sets the number of hours in which to expect 
acknowledgment for outbound data.

Minutes Sets the number of minutes in which to expect 
acknowledgment for outbound data.

(Continued on next page)
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Compression tab This illustration shows the Compression tab on the Archive/Retrieval Setup dialog 
box.

Compression tab
fields and
functions

This table describes the fields of the Compression tab and their functions.

Seconds Sets the number of seconds in which to expect 
acknowledgment for outbound data.

Acknowledge 
Inbound Data

Causes the system to send acknowledgments to 
trading partners when it receives inbound data.

 (Contd)
Field Function

Field Function

None Indicates whether compression is on or off.

Pkzip (Workstation Only) Specifies PKWARE�s PKZIP as the compression 
utility. You must include PKZIP in your PATH 
statement.

(Continued on next page)
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Compress (Unix Only) Specifies Compress as the compression utility. 
Compress is available on every UNIX system.

Pack (Unix Only) Specifies Pack as the compression utility. Pack is 
available only on some UNIX systems and 
compresses data tighter than Compress.

 (Contd)
Field Function
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How to Set EDI Translation Archiving Options

Introduction To set up EDI translation archiving and retrieval options to fit your business needs, 
you begin by selecting Setup Options from the Archive menu to display the 
Archive/Retrieval window. You use the EDI tab on this window to choose the 
records you want the system to archive.

Archiving
options

On the EDI tab, you choose to have the system perform one or more of the 
following tasks:
◗ Create status records (edistat.i and edistat.o)
◗ Archive inbound status records, outbound status records, or both (create the 

edihist.dat and edihist.idx files from the edistat.i and edistat.o records)
◗ Archive inbound data files, outbound data files, or both
◗ Keep data files for a specified number of days
◗ Look for functional acknowledgments for outbound data in a specified number 

of days, hours, minutes, and seconds
◗ Acknowledge inbound data files. 

Option
dependencies

Archiving starts with the creation of status records, edistat.o and edistat.i, during 
translation. These status records are eventually posted to edihist.dat and 
edihist.idx, the historical records. The historical records store the location of the 
archived data. Therefore, to archive and retrieve data files, you must activate both 
the status record and historical record option. 

Where default
settings are

stored

The Archive/Retrieval system default settings for EDI translation are stored in the 
configuration file arcopt.cfg. This file is in the edihist directory of each 
environment.

(Continued on next page)
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Relationship to
Trading

Partnership
record

GENTRAN:Server uses the EDI Archiving settings as default settings when you 
set up a new Trading Partnership record, but enables you to override them for any 
Trading Partnership record.

To determine which records to archive during processing, GENTRAN:Server 
checks the archive options of the Trading Partnership record.

Reference
See How to Create a Trading Partnership Record in this guide for information.

Selecting
archiving

options

Use this procedure to select the default archiving and retrieval options for your 
system.

Step Action

1 Click Setup Options on the Archive menu.

System Response
GENTRAN:Server displays the EDI tab on the Archive/Retrieval 
Setup dialog box. 

2 Click inbound and/or outbound in the Save History section to 
select the type of status records you want to save. You may select 
both types.

Example
To archive inbound status records, click Save Inbound Status 
Records.

System Response
The Include Data field for the type of status record you selected 
becomes available.

3 Do you want to archive the data as well as the status record?

◗ If YES, click Include Inbound Data or Include Outbound 
Data and type the number of days to keep the data in the 
Retain data for ___ day(s) field.

◗ If NO, continue with Step 5. 
(Continued on next page)
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4 Do you want your system to expect functional acknowledgments for 
outbound data?
◗ If YES, click Expect Ack for Outbound Data in and type the 

number of days, minutes, hours and seconds.
◗ If NO, continue with Step 6.

Comment
When you create a new Trading Partnership, GENTRAN:Server 
uses the choice you make in this step as the default setting.

5 Do you want to acknowledge inbound data?

◗ If YES, click Acknowledge Inbound Data and then continue 
with the next step.

◗ If NO, continue with Step 6.

Comment
When you create a new Trading Partnership, GENTRAN:Server 
uses the choice you make in this step as the default setting.

6 Click OK to save the settings.

 (Contd)
Step Action
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How to Select a Data Compression Utility

Introduction Archived data can consume large amounts of disk space. To help control disk 
space, you may use a compression utility to reduce the size of your archived 
documents.

Before you begin GENTRAN:Server does not include compression utilities. If you want to compress 
your archived data, you must have installed one of the compression utilities that 
GENTRAN:Server supports:
◗ Pkzip
◗ Compress
◗ Pack

Important note
After the utility is installed, you must add the utility to your user path.

How
compression

works

When you select a compression utility, GENTRAN:Server records your selection 
in a configuration file. During archiving, GENTRAN:Server checks this file to 
determine which compression utility to use and then starts the compression utility.

File extensions
of compressed

data

These are the file extensions for compressed and non-compressed data:

(Continued on next page)

Utility File Extension

Pkzip .zip

Pack .z

Compress .Z

Not compressed .arc
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Selecting a
compression

utility

Use this procedure to select a compression utility.

Changing the
compression

utility

You may choose a different compression utility at any time or turn compression 
off. If you choose a different utility, GENTRAN:Server uses the new selection from 
the point at which you made the change; it does not change previously 
compressed data.

Step Action

1 Click Setup Options from the Archive menu.

System Response
GENTRAN:Server displays the EDI tab of the Archive/Retrieval 
Setup dialog box. 

2 Select the Compression tab.

3 Select the compression utility you have installed.

4 Click OK to save your selection.
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How to Run the Archive Program

Introduction You can start ediarc, the program that controls EDI translation archiving, from:
◗ The command line
◗ A batch file or script you run from the Task Scheduler 
◗ The Archive Data option on the Translate Outbound Documents and 

Translate Inbound Documents dialog boxes.

When to archive
data

The best time to archive EDI translation data is immediately after all inbound and 
outbound translations, before the data file is purged or moved.

WARNING
To prevent loss of data, make sure that you run the archive program 
before you delete or move a data file. 

Starting ediarc
from a batch file

or script

You may run ediarc from a UNIX or DOS batch file and use the Task Scheduler to 
run ediarc on a schedule.

Reference

See the chapter Using the Task Scheduler in this guide for information about 
using the Task Scheduler.

(Continued on next page)
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Starting ediarc
from the

command line

Use this procedure to start ediarc from the command line.

Reference

See Command Reference in the GENTRAN:Server Technical Reference Guide 
for more information about the ediarc command.

Step Action

1 Go to the UNIX command line.

2 Type the ediarc command, a space, parameter to indicate inbound 
or outbound, a space, the -cp parameter, and the full path to the 
configuration file, envprim.cfg. Then press ENTER.

Command statement

ediarc -i/o -cp[configuration path]

Example for UNIX version
ediarc -i -cp[configuration path]

Example for Workstation version
ediarc -o -cp[configuration path]

System Response
If you configured your archiving system to save EDI data files, 
ediarc: 

◗ Checks the archive switches in the Trading Partnership record 
to determine which sets to archive and their locations

◗ Copies the EDI data files into a directory hierarchy in the EDI 
History Audit directory

◗ Posts the edistat.i and/or edistat.o record to the permanent 
audit history files, edihist.dat and edihist.idx

◗ Deletes the edistat.i and/or edistat.o record. 
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How to Use the Audit System Variable 

Introduction If you want to store a special source value in the audit record, you can map one or 
more source values to a special pre-defined system variable, $USRBUF. Mapping 
to this variable does not affect the output of your map.

GENTRAN:Server writes the values for the $USRBUF variable to the User Buffer 
field in the audit record (edistat.i/o, and edihist.dat/idx). 

Reference
See the edistat.i/o, edihist.dat/idx topic in the File Record Layouts chapter of the 
GENTRAN:Server Technical Reference Guide for the layout of the audit record.

Mapping to the
User Buffer field

in the Audit
record

Use this procedure to write the value of the source item in $USRBUF to the User 
Buffer field in the audit record. 

Step Action

1 In your map, create a mapping GROUP that includes:

◗ The source item whose value you want to write to the User 
Buffer field

◗ A destination item.

CAUTION
If you map $USRBUF to a destination item to which you 
are mapping other data, GENTRAN:Server may create a 
second copy of the destination item.

2 Click on the source element or application field to which you want 
to assign the $USRBUF variable.

Note
Select an item that you will not be mapping to. 

3 Click Synonyms on the Edit menu.

System Response
GENTRAN:Server displays the Open a Synonym List for Editing 
dialog box.

(Continued on next page)
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Reference
See the chapter Working with Mapping Instructions in this guide for more 
information about mapping instructions.

4 Click Synonym List is specific to this map, then click OK.

System Response 
GENTRAN:Server displays the Synonym Editor. 

5 Create a synonym by typing the wildcard (*) symbol in the Original 
Value column and $USRBUF in the Substitute Value column.

6 Click Save List on the File menu. 

System Response
GENTRAN:Server saves the synonym list and creates a mapping 
instruction similar to this:

MAP specific synonym of source S3 to D5

7 Verify that the system created the mapping instruction as follows:
◗ Double-click the source item.
◗ Double-click the destination item.
◗ Click the right mouse button and click Mapping Instruction 

Toolbar to display the Mapping Instructions window.

CAUTION
The mapping instruction shows a synonym of a source 
item mapped to a destination item, not to the $USRBUF 
variable. Do not change this mapping instruction. 

 (Contd)
Step Action
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Working with Archived 
Data 0

Introduction

In this section This section explains how to retrieve and work with archived EDI translation data. 
It includes these topics:
◗ How to search for archived information
◗ How to view information about archived data
◗ How to view and reconcile functional acknowledgment errors
◗ How to extract archived documents (for resending to a trading partner or for 

editing)
◗ How to purge data.

Relationship of
topics

You must conduct a search for archived information before you can view archived 
data, reconcile functional acknowledgments, or extract archived documents so 
that you can resend them or edit them.
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How to Search for an Archived Document

Introduction Before you can view or retrieve archived EDI translation data, you must first 
search for the records and files by entering search criteria on the EDI Document 
Search dialog box.

EDI Document
Search dialog

box

This illustration shows the EDI Document Search dialog box.

(Continued on next page)
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EDI Document
Search fields

and functions

This table describes the fields on the EDI Document Search dialog box and their 
functions. 

Field Function

Trading Partner Code Specifies the Trading Partner Code to use in the 
search. 

To search for a Trading Partner Code, click the 
binoculars icon to display the Trading Partner Search 
dialog box.

Doc. Reference No. Specifies the document reference number to search 
for, if the data came from GENTRAN:Server product 
level PCM or higher. Leave this field blank if you are 
searching for documents that came from 
GENTRAN:Server Workstation.

Message/Set ID Specifies the message or set ID to use in the search 
(such as 104 Air Shipment Information or BANSTA 
Banking Status Message). Leave blank to view all sets.

Starting 
(CCYYMMDD)

Specifies the first translation date to use in the search. 
Leave blank to see a range of archived data that 
begins with the earliest translation date in the file.

Ending 
(CCYYMMDD)

Specifies the last translation date to use in the search. 
This field defaults to the current date.

Document status Specifies the functional acknowledgment status for 
documents with a functional acknowledgment. 

Interchange IDs

Yours Specifies your company�s interchange ID.

Partner�s Specifies your trading partner�s interchange ID.

Data Control Numbers

Interchange Control 
No.

Specifies the interchange control number to use in the 
search.

Group Control No. Specifies the group control number to use in the 
search.

Transaction Set 
Control No.

Specifies the transaction set control number to use in 
the search.

(Continued on next page)
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Searching for
EDI Documents

Use this procedure to search for an EDI document or documents.

Restrict Search To

Inbound EDI 
Documents

Selects Inbound EDI Document as the type of 
documents to search.

Outbound EDI 
Documents

Selects Outbound EDI Document as the type of 
documents to search.

Display Results With

Summary Information 
Only

Selects collapsed mode as the display mode.

Reference
For information about display modes, see the How to 
View Set-Level Information topic.

Full Document Details Selects expanded mode as the display mode.

Reference
For information about display modes, see the How to 
View Set-Level Information topic.

Search Starts the search.

Cancel Cancels the search request.

 (Contd)
Field Function

Step Action

1 Click Open Archive on the Archive menu.

System Response
The system displays the EDI Document Search dialog box.

2 Type the search criteria for the document or documents.

Reference
For field descriptions, see the EDI Document Search fields and 
functions topic in this chapter.

(Continued on next page)
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3 Click Search.

System Response
GENTRAN:Server finds records in the edihist.dat and edihist.idx 
files that match the search criteria and displays the results on the 
Document Search Results window.

If you select Summary Information only, the window displays the 
first record for each interchange/group combination that meets the 
search criteria. If you select Full Document details, the window 
displays a list of all records that meet the search criteria.

4 Use this table to determine your next step.

IF you want to� THEN go to�

Sort the search results by TP 
Code, Interchange Date, or 
another column

How to Sort Document Search 
Results in this chapter.

View record information How to View Set-Level 
Information in this chapter.

View functional 
acknowledgment errors or 
change a document�s status

How to View Functional 
Acknowledgment Errors in this 
chapter.

Extract data to:
◗ View it
◗ Edit it and prepare it to 

resend to your trading 
partner 

How to Extract Archived EDI 
Documents in this chapter.

 (Contd)
Step Action
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How to Sort Document Search Results

Introduction When you search for an archived document, the results displayed on the 
Document Search Results dialog box are sorted by the trading partner�s 
interchange ID. This topic explains how to change the sorting order.

View modes You can view GENTRAN:Server document search results in two modes:
◗ Summary Information Only, which displays only the first records for each 

interchange/group combination that meet the search criteria
◗ Full Document Details (expanded), which displays all the records that meet 

the search criteria.

Document
Search Results

dialog box

This illustration shows the Document Search Results dialog box in full document 
detail (expanded) mode.

(Continued on next page)
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Document
Search Results

fields and
functions

This table describes the fields on the Document Search Results dialog box and 
their functions. 

(Continued on next page)

Field Function

TP Code Displays the Trading Partner Code associated with the 
record.

TP Interchange ID Displays the trading partner�s interchange ID.

Interchange Ctl No. Displays the interchange control number associated 
with the record.

Interchange Date Displays the date and time of the interchange.

Group Ctl No. Displays the Group Control Number associated with 
the record.

No. of Sets Displays the number of transaction sets in the record.

Close Closes the Document Search Results dialog box.

Extract Starts the data extraction process.

Reference
See How to Extract Archived EDI Documents for 
instructions.

Info... Displays information about the selected record. If the 
selection is a transaction set, the system displays the 
history window for the record. If the selection is a 
group, the system displays the Group Information 
window.

Reference
See How to View Set-Level Information for 
instructions.

New Search Displays the EDI Document Search dialog box, which 
enables you to start a new search.

Help Displays help text for the Document Search Results 
dialog box.
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Sorting search
results

Use this procedure to change the sorting order of the records displayed on the 
Document Search Results dialog box.

Step Action

1 Conduct a document search by following the instructions in the 
How to Search for an Archived Document topic.

System Response
GENTRAN:Server displays the Document Search Results 
window in either summary mode or expanded mode.

2 Click on the column header that you want to use to sort the records.

System Response
The system sorts the records in ascending order of the column you 
selected.

3 Do you want to sort the records in reverse order?

◗ If YES, click the same column header again.
◗ If NO, continue with Step 4.

Note
Each subsequent click on a header reverses the sorting order, 
toggling between ascending and descending order.

4 Use this table to determine your next step.

IF you want to� THEN�

Extract archived data See How to Extract Archived EDI 
Documents in this chapter.

View archived data See How to View Set-Level 
Information in this chapter.

Start a new search Click New Search.

Close the Document Search 
Results dialog box

Click Close.
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How to View Set-Level Information

Introduction You can view this information about archived data at the set-level:
◗ Identification
◗ Translation
◗ Processing
◗ Archive
◗ Acknowledgment

Reference
To view information at the group level, see How to View Group Information in this 
chapter.

Viewing set-level
information

Use this procedure to view archived EDI translation data at the set level.

Step Action

1 Conduct a document search in Full Document Details (expanded) 
mode by following the instructions in the How to Search for an 
Archived Document topic.

System Response
GENTRAN:Server displays the Document Search Results window.

Example

(Continued on next page)
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(Continued on next page)

2 Move the focus to the record you want to view and then click Info.

System Response
GENTRAN:Server displays the history window for the selected 
record.

3 Click the tab for the type of information you want to see.

Tab Description

Identification The basic information used to identify the 
document, such as the Trading Partner 
Code, control numbers, document reference 
number, and the interchange and group IDs.

Acknowledgment 
Information

Information about a functional 
acknowledgment transaction, such as the 
date and time the functional 
acknowledgment was received, the 
document status, message type, and error 
data.

Translation 
information

Information about the transaction, such as 
the date and time, status, result, segment 
terminator, and number of segments and 
characters.

Processing 
Information

The date after which the document is eligible 
for purging.

Archive Information The file name of the archived file, the archive 
directory path to the file, and (if you are 
viewing set information) a number that tells 
you where the set starts in the data file.

 (Contd) 
(Contd) Action
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Identification tab This illustration shows the Identification tab.

Identification tab
fields and

functions table

This table describes the Identification tab fields and their functions.

(Continued on next page)

Field Function

Trading Partner Specifies the Trading Partner code.

Interchange Ctl Specifies the document�s interchange control number.

Group Ctl Specifies the document�s group control number.

Trans. Set Ctl Specifies the document�s transaction set control number.

Document Ref Specifies the document reference number (only if from 
GENTRAN:Server product level PCM and higher).

Name Specifies the trading partner�s name.

Set/document ID Specifies the set or document identifier.

Interchange created Specifies the date and time the interchange was 
translated.

Group created Specifies the date and time the group was translated.
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Acknowledgment
Information tab

This illustration shows the Acknowledgment Information tab.

Acknowledgment
Information tab

fields and
functions table

This table describes the Acknowledgment Information tab fields and their 
functions.

Field Function

Ack. expected Indicates whether a functional acknowledgment is 
expected. Yes indicates one is expected. No indicates 
that a functional acknowledgment is not expected.

Ack. date/time Specifies the date and time at which the functional 
acknowledgment was expected.

Document Status Specifies the document status. Valid responses 
include Accepted with No Errors, Partially Accepted 
with Errors, Rejected, and Waiting.

Message type Specifies the transaction type: 997, 999, or CONTRL.
(Continued on next page)
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(Continued on next page)

Change document 
status

Indicates whether the Document Status field is 
updated when the functional acknowledgment is 
verbal.
◗ Verbal OK - A verbal acknowledgment arrived; no 

errors in document
◗ Verbal Error - A verbal acknowledgment arrived; 

document contains errors 

View Errors Indicates whether the system extracts a functional 
acknowledgment record from the archive and displays 
the related error information in the Errors section of the 
window

First Prompts the system to display information about the 
first error in the archive

Next Prompts the system to display information about the 
next error in the archive

Previous Prompts the system to display information about the 
previous error in the archive

Last Prompts the system to display information about the 
last error in the archive

Errors Prompts the system to display information about an 
error. The type of information displayed depends on 
the type of error.

Example

If the error is at the segment level, the Errors section 
displays the Segment ID in addition to the Error 
Number and Error Text.

 (Contd)
Field Function
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Translation
Information tab

This illustration shows the Translation Information tab.

Translation
Information tab

fields and
functions table

This table describes the Translation Information tab fields and their functions.

(Continued on next page)

Field Function

Date/time Specifies the translation date and time.

Translation Result Indicates the status of translation, such as �OK� or an 
error type number.

Seg. Terminator Specifies the character used to separate segments.

No. Segments Specifies the number of segments in the set.

No. Characters Specifies the number of characters in the set.
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Processing
Information tab

This illustration shows the Processing Information tab.

Processing
Information tab

fields and
functions table

This table describes the Processing Information tab fields and their functions.

(Continued on next page)

Field Function

Purge Date Specifies the date on which the document is eligible for 
purging.

User Defined Info Currently unused. Reserved for future use.
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Archive
Information tab

This illustration shows the Archive Information tab.

Archive
Information tab

fields and
functions table

This table describes the Archive Information tab fields and their functions.

Field Function

Archive File Name Specifies the archived file.

Archive Directory Specifies the archive directory.

Archive Offset If you are viewing information for a set, this field 
Specifies the number that indicates where the set 
starts in the data file.

The EDI Extract program uses this information to 
extract the archived data. 
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How to View Group Information

Introduction The Group Information dialog box displays basic information used to identify a 
document. You can access this dialog box from the Document Search Results 
dialog box.

Group
Information
dialog box

This illustration shows the Group Information dialog box.

Group
Information

dialog box fields
and functions

This table describes the Group Information fields and their functions.

Field Function

Trading Partner Displays the Trading Partner code.

Interchange Ctl Displays the document�s interchange control number.

Group Ctl Displays the document�s group control number.

Interchange created Displays the date and time the interchange was 
translated.

Group created Displays the date and time the group was translated.

Interchange IDs Displays your interchange ID and your trading 
partner�s interchange ID.

(Continued on next page)
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Viewing group
information

Use this procedure to view group information.

Group IDs Displays your group ID and your trading partner�s 
group ID.

No. of Transaction 
Sets

Displays the number of transaction sets in this Group 
document.

Change doc. status Updates the Document Status field for all transaction 
sets in this group when the functional acknowledgment 
is expected.
◗ Verbal OK - A verbal acknowledgment arrived. No 

errors in document.
◗ Verbal Error - A verbal acknowledgment arrived. 

Document contains errors.

Note
This field is disabled for inbound documents.

 (Contd)
Field Function

Step Action

1 Conduct a document search (in Summary mode) by following the 
instructions in the How to Search for an Archived Document topic.

System Response
GENTRAN:Server displays the Document Search Results window.

2 Move the focus to the group-level record you want to view and then 
click Info.

System Response
GENTRAN:Server displays the Group Information window.

3 Do you want to set the status for all transaction sets in this group to 
Verbal Ok or Verbal Error?
◗ If YES, continue with Step 4. 
◗ If NO, go to Step 6.

(Continued on next page)
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4 Select the new status from the Change document status choices 
and then click OK to save your changes.

Note
If you try to change document status on a group for which an 
acknowledgment was not expected, the system ignores the status 
change.

System Response
GENTRAN:Server displays a confirmation prompt.

5 Click Yes to confirm your changes.

6 Click Cancel to close the Group Information dialog box.

System Response
GENTRAN:Server returns to the Document Search Results dialog 
box.

 (Contd)
Step Action
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Reconciling Functional 
Acknowledgments (FAs) 0

Overview

Definitions A functional acknowledgment (FA) that you receive is an inbound document 
that contains the status of outbound data you sent to a trading partner.

A functional acknowledgment that you send is an outbound document in 
response to a document you received from a trading partner.

Purpose The purpose of functional acknowledgments is to provide you with:

◗ The status of a sent or received document (rejected, accepted, or accepted 
with errors).

◗ The information necessary to reconcile the historical records maintained in 
edihist.dat.

◗ Error information related to a sent or received document.

Types of FAs This table lists the types of functional acknowledgments and describes each type. 

◗ The receiving company uses one of these functional acknowledgment 
transaction sets to communicate the results of a transmission back to the 
sending company. 

◗ For each functional group sent, the acknowledgment details what transactions 
were received and if there were any segment or data element syntax errors 
according to the related standard.

Type Description

997 The X12 functional acknowledgment transaction set.

999 The UCS functional acknowledgment transaction set.

CONTRL The Edifact and Odette functional acknowledgment transaction 
set.

(Continued on next page)
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Functional
acknowledgment

levels

Functional acknowledgments are always associated with a transaction group (a 
collection of transactions).

The functional acknowledgments that GENTRAN:Server handles have three 
different levels of detail:

◗ Group, which indicates if a group of like documents contained errors

◗ Set, which indicates if an individual transaction set contained errors

◗ Segment/Element, which indicates the exact segment and element 
containing an error.

Control numbers
in a functional

acknowledgment

The archiving program does not archive duplicate records, so if two different 
records have the same control numbers, the archiving program rejects the second 
as a duplicate. See the Setting Up EDI Translation Archiving topic. 

Reconciliation If you send or receive functional acknowledgments, you need to reconcile errors 
regularly.

The process of reconciling functional acknowledgments is similar to the process 
of reconciling your bank statement: you review the status of documents that you 
have sent and received, and then resolve any discrepancies.

You must archive EDI data (including any functional acknowledgments) after each 
translation to use the functional acknowledgment reconciliation feature. 

Network For TRADACOMS-formatted messages only, GENTRAN:Server 

can receive and reconcile both IBM® and INS® network 
acknowledgments.

 (Contd)
Type Description
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Setting Up Your System to Handle Functional 
Acknowledgments

Introduction You must request functional acknowledgments from your trading partner before 
sending EDI data. If you receive documents from a trading partner, you should 
ask if they want functional acknowledgments from you and at what level they want 
to receive them.

Configuring your
system

To configure your system to send acknowledgments to all trading partners when 
you receive inbound data, select the Acknowledge Inbound Data option on the 
EDI tab of the Archive/Retrieval window.

To configure your system to expect acknowledgments from all trading partners for 
outbound data, complete the Expect Ack for Outbound Data in option on the 
EDI tab of the Archive/Retrieval window.

References
See the EDI tab for a description of the acknowledgment options.

Configuring a
Trading

Partnership
record

You can configure the functional acknowledgment settings at the Trading 
Partnership level. These settings override your system settings for the individual 
trading partner.

To configure your system to send acknowledgments to a specific trading partner 
when you receive inbound data from that trading partner, select the Create 
acknowledgment for inbound document option from the Outbound 
Acknowledgment tab of the Edit Trading Partnership dialog box.

To configure your system to expect acknowledgments from a specific trading 
partner for outbound data, complete the Expect acknowledgment for outbound 
document in option on the Inbound Acknowledgment tab of the Edit Trading 
Partnership dialog box.

Reference
See Outbound Acknowledgment tab for a description of the inbound document 
acknowledgment options on this tab of the Edit Trading Partnership dialog box.

See Inbound Acknowledgent tab for a description of the outbound document 
acknowledgment options on this tab of the Edit Trading Partnership dialog box.
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Reconciliation Process

Stage table This table describes the reconciliation process.

Stage Description

1 When you receive a functional acknowledgment from a trading 
partner, the reconciliation program collects these items:

◗ Sender�s Interchange ID
◗ Receiver�s Interchange ID
◗ Sender�s Group/Application ID
◗ Receiver�s Group/Application ID
◗ Group control number
◗ Set/message control number
◗ Set/Message ID.

2 GENTRAN:Server searches the files edihist.dat and edihist.idx for a 
record that matches the acknowledgment.

IF a match is� THEN GENTRAN:Server�

Found Reconciles the functional acknowledgment and 
assigns the appropriate status to the document. 
Valid responses include Accepted with No 
Errors, Partially Accepted with Errors, or 
Rejected.

Not found Reports a reconciliation error in the xlcntl.err 
file.

Note

The inability to find a match may be because 
the original document was not archived, the 
original document was purged, or a problem 
exists with the functional acknowledgment.

(Continued on next page)
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3 Click View Errors on the Acknowledgment Information tab of the 
document history window.

System Response

GENTRAN:Server retrieves the first functional acknowledgment 
error associated with the selected document. 

The system then displays information about the error in the Errors 
section of the tab. The tab has scroll buttons that enable you to view 
other errors associated with the document. 

 (Contd)
Stage Description
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How to View Functional Acknowledgment Errors

Introduction You view functional acknowledgment information, including error information, on 
the Acknowledgment Information tab of the document history window.

Acknowledgment
 Information tab

This illustration shows the Acknowledgment Information tab.

Procedure Use this procedure to view functional acknowledgment errors for a document.

Step Action

1 Display the document history window by following the procedure in 
the Viewing set-level information topic.

2 Click the Acknowledgment Information tab.
(Continued on next page)
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3 Click View Errors.

Note
This button is disabled if the received functional acknowledgment 
was at the group or set level.

System Response

GENTRAN:Server displays information about the first functional 
acknowledgment error associated with the document in the Errors 
box.

4 To scroll through information about other errors for this document, 
click Next, Previous, and/or Last.

 (Contd)
Step Action
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How to Change the Document Status

Introduction If you receive a verbal acknowledgment, you can change the status of an 
outbound document to �Verbal OK� or �Verbal Errors� from the:
◗ Document Search Results window
◗ Acknowledgment Information tab of the document history window
◗ Group Information window.

You can change the status of:

◗ All transaction sets in a group from either the Document Search Results 
window or the Group Information window

◗ Individual transaction sets from either the Document Search Results window 
or the Acknowledgment Information tab.

Using the
Document

Search Results
window

Use this procedure to enter a verbal acknowledgment from the Document Search 
Results window. You can change the status of all transaction sets in a group or the 
status of individual transaction sets.

Step Action

1 Conduct a search for outbound documents by following the 
instructions in the How to Search for an Archived Document topic.

System Response
GENTRAN:Server displays the Document Search Results window.

2 Move the focus to the record for which you want to enter a verbal 
acknowledge status and right-click.

System Response
GENTRAN:Server displays a popup window.

Note
At the group level, the Set Verbal Error and Set Verbal OK items are 
always enabled in the popup window.

At the set level, if the current status is either Set Verbal Error or Set 
Verbal OK, the current status is disabled in the popup menu. If the 
current status is Not Expected, both items are enabled.

(Continued on next page)
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Using the
Acknowledgment
 Information tab

Use this procedure to change the status of an individual transaction set in an 
outbound document.

(Continued on next page)

3 Select the new status from the menu.
◗ Verbal OK - A verbal acknowledgment arrived; no errors in 

document
◗ Verbal Error - A verbal acknowledgment arrived; document 

contains errors

CAUTION
If the record is a group-level entry, the system will apply 
the status you select to all transaction sets in this group.

System Response
GENTRAN:Server displays the Change status confirmation dialog 
box.

4 Click Yes to confirm the change in status.

 (Contd)
Step Action

Step Action

1 Display the document history window for an outbound transaction set 
by following the procedure in the How to View Set-Level Information 
topic.

2 Click the Acknowledgment Information tab.

3 Select the new document status by clicking on one of the following 
options in the Change Doc. Status section of the tab:
◗ Verbal OK - A verbal acknowledgment arrived; no errors in 

document
◗ Verbal Error - A verbal acknowledgment arrived; document 

contains errors

System Response
GENTRAN:Server displays a confirmation dialog box.

4 Click Yes to save your changes.

System Response
GENTRAN:Server applies the status you selected and displays the 
Document Search Results dialog box.
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Using the Group
Information

window

Use this procedure to enter a verbal acknowledgment for all transaction sets in a 
group from the Group Information window.

EDI errors When you reconcile outbound documents, you may want to correct errors in the 
EDI data and resend the document to your trading partner.

Reference
See the Editing an archived EDI document in this chapter.

Step Action

1 Conduct a search for outbound documents by following the 
instructions in the How to Search for an Archived Document topic.

System Response
GENTRAN:Server displays the Document Search Results window.

2 Move the focus to the group-level record you want to view and click 
Info.

System Response
GENTRAN:Server displays the Group Information window.

3 Select the new status from the Change document status choices.
◗ Verbal OK - A verbal acknowledgment arrived; no errors in 

document
◗ Verbal Error - A verbal acknowledgment arrived; document 

contains errors

4 Click OK to save your changes.

System Response
GENTRAN:Server displays the Change status confirmation dialog 
box.

5 Click Yes to confirm the changes.

System Response
GENTRAN:Server applies the status you selected to all transaction 
sets in this group and displays the Document Search Results dialog 
box.
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Miscellaneous 
Procedures 0

How to Extract Archived EDI Documents

Introduction There are three reasons to extract archived EDI translation data files:
◗ View the data
◗ Edit erroneous EDI data and prepare it to send it to your trading partner
◗ Prepare EDI data that your trading partner did not receive so that you can 

resend it.

The Extract EDI Archive tab enables you to extract archived documents.

Extract EDI
Archive dialog

box

This illustration shows the Extract EDI Archive dialog box.

Extract EDI
Archive fields
and functions

table

This table describes the Extract EDI Archive fields and their functions.

Field Function

What to extract Specifies the type of data to extract.

Interchange Prompts the system to select interchange data.

Functional Group Prompts the system to select functional group data.

(Continued on next page)
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Extracting
archived data

Use this procedure to extract archived data.

Transaction set Prompts the system to select transaction set data.

For what purpose Indicates the reason for extracting the data.

View only Prompts the system to extract data only for viewing.

Edit Specifies that the extracted data will be edited.

 (Contd)
Field Function

Step Action

1 Conduct a document search for the document you want to extract.

Reference
See How to Search for an Archived Document in this chapter.

2 Place the focus on the record you want to extract and then click 
Extract.

System Response
GENTRAN:Server displays the Extract EDI Archive dialog box.

3 In the What to Extract area, click the type of data to extract: 
Interchange, Functional Group, or Transaction Set.

4 In the For What Purpose section, click the reason for extracting the 
data.

(Continued on next page)
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5 Click OK.

System Response

IF you selected� THEN�

View only The system displays the archived 
document in the File Browser so that you 
can view it.

Edit The system displays the archived 
document in the File Browser so that you 
can edit it.

To continue, see How to Prepare 
Documents to Resend in this chapter.

 (Contd)
Step Action
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How to Prepare Documents to Resend

Introduction The resend program repackages archived outbound or inbound data so that you 
can send it. The program replaces new lines with character terminators and 
increments the control numbers to those you specify.

Resending Outbound Data

You can edit archived outbound data that contains errors and then send the 
corrected data to your trading partner. In this case, you want to increment the 
control numbers so that the archiving program does not reject the document as a 
duplicate.

You may also resend archived outbound data that your trading partner never 
received. In this case, you may use the same control numbers as the original 
document.

Resending Inbound Data

You may also resend inbound data. This data is saved as a newline-terminated 
file. The Override Control Numbers option is unavailable when you are 
resending inbound data. 

When resending inbound data, you must use the File Browser to edit the control 
numbers before saving the file. This prevents the duplication of audit records in 
the archive when you retranslate the file inbound.

Resend EDI
Document dialog

box

This illustration shows the Resend EDI Document dialog box.     

(Continued on next page)
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Resend EDI
Document dialog

box fields and
functions

This table describes the fields of the Resend EDI Document dialog box and their 
functions.

(Continued on next page)

Field Function

Override Control
 Numbers

Prompts the system to activate the New Control 
Numbers fields.

Original Control Numbers

Interchange Specifies the current interchange control number of the 
archived data.

Group Specifies the current group control number of the 
archived data.

Trans. Set Specifies the current transaction set control number of 
the archived data.

New Control Numbers

Note
You must increment the original control numbers to archive new, corrected data.

Interchange Defines the new interchange control number.

Group Defines the new group control number.

Trans. Set Defines the new transaction set control number.

Save as Defines a file name for a copy of the archived data.
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Editing an
archived EDI

document

Use this procedure to correct EDI data that contains errors so that you can send 
the corrected version to your trading partner.

Step Action

1 Extract the document for editing.

Reference
See Extracting archived data in this chapter.

System Response
GENTRAN:Server displays the document in the File Browser.

2 Use these instructions to edit the document.

IF you want to� THEN�

Insert characters Click at the insertion point and type 
the characters.

Copy selected text to the 
clipboard

Click Copy on the Edit menu.

Paste text on the clipboard 
into the document

Click at the insertion point and then 
click Paste on the Edit menu.

Select the entire document Click Select All on the Edit menu.

Search for characters, words, 
or phrases

Click Find on the Edit menu. Then, 
enter the search string.

Search for the next 
occurrence of a search item

Click Find Next on the Edit menu.

Replace selected text Click Replace on the Edit menu. 
Then type the replacement text.

Print the document Click Print on the File Menu.

Save the changes to the 
document

Click Save on the File menu.

Save a copy of the document 
under a new path or name

Click Save As on the File menu. 
and enter the new path and file 
name.

3 Click Save on the File menu to save your changes.
(Continued on next page)
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4 Click Close on the File menu.

System Response
GENTRAN:Server displays the Resend EDI Document dialog box.

5 Do you want to assign new control numbers to the extracted 
outbound data?

◗ If YES, click Override Control Numbers. Then, type the new 
control numbers in the New Control Numbers boxes. To reuse 
an original number, leave a box blank.

◗ If NO, continue with Step 6. 

WARNING
The Override Control Numbers option is unavailable for 
inbound data. 

Note
If you do not assign new control numbers to outbound data and it 
has already been sent, the recipient�s archive program views the 
edited document as a duplicate and does not archive it. 

6 Type a destination path and file name for the data.

Note
If you type only a filename, the program uses $ENV_ROOT as the 
default directory.

(Continued on next page)

 (Contd)
Step Action
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(Continued on next page)

7 Click OK.

System Response
If you resent outbound EDI data, the resend program modifies the 
archived outbound data, replacing new lines with character 
terminators and replacing the original control numbers with the new 
ones you specified.

If you resent inbound data, the system creates a new file using the 
name typed in step 6.

8 If you want to archive this data, run ediarc.

Reference
For more information, see the topic How to Run the Archive 
Program earlier in this chapter.

9 Resend the document by following the procedures your company 
has established for sending EDI documents.

 (Contd)
Step Action
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Preparing an
unedited

archived EDI
document for

resending

Use this procedure to prepare to resend an archived document that your trading 
partner did not receive.              

Step Action

1 Extract the document for editing.

Reference
See Extracting archived data in this chapter.

System Response
GENTRAN:Server displays the document in the File Browser 
window.

2 Click Close on the File menu.

System Response
GENTRAN:Server displays the Resend EDI Document dialog box.

3 Do you want to assign new control numbers to the extracted data?

◗ If YES, click Override Control Numbers. Then, type the new 
control numbers in the New Control Numbers boxes. To reuse 
an original number, leave a box blank.

◗ If NO, continue with Step 5. 

Note
If you do not assign new control numbers, the archive program 
views the unedited document as a duplicate and does not archive 
it. This is fine if you have not made changes. 

(Continued on next page)
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4 Do you want to save the data to a different path or file name?
◗ If YES, type the new path and file name in the Save As box.
◗ If NO, continue with Step 6.

Note
If you do not type a new path and file name, the program uses 
edixtrct.tmp as the default file name.

5 Click OK.

System Response
The resend program modifies the archived data, replacing new 
lines with character terminators and replacing the original control 
numbers with the new ones you specified.

6 Resend the document by following the procedures your company 
has established for sending EDI documents.

 (Contd)
Step Action
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How to Purge Data

Introduction Leaving large amounts of data in the archive files slows down the retrieval 
process when you view or edit data. You should remove the stored data from the 
audit/archive directory regularly. Determine the interval based on management of 
your disk space and your company�s policies. 

Running the
purge program

The purge program enables you to purge data based on criteria you select. You 
may start the purge program from:
◗ The archive menu
◗ The command line
◗ A batch file or script through the Task Scheduler.

In this section, you learn to run the purge program from the Archive menu.

Comment
The data purge process may require a long time to run. You may want to run it 
from a batch file or script during off hours through the Task Scheduler.

When you schedule edipurge to run during the off hours, you must verify that the 
system will not be running ediarc at the same time. 

References
To select data for purging with a command line program, use the edipurge 
command. See the GENTRAN:Server Technical Reference Guide for more 
information about edipurge.

To run the purge program from the Task Scheduler, see the chapter Using the 
Task Scheduler in this guide.

(Continued on next page)
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The Archive
Purge dialog box

This illustration shows the Archive Purge dialog box for archived translation data.

Archive Purge
dialog box fields

and functions

This table describes the fields of the Archive Purge dialog box and their functions.

Field Function

Trading Partner Code Determines the Trading Partner Code associated with 
the data you want to purge. Leave blank to purge data 
from all trading partners.

Interchange Control 
Number

Specifies the Interchange Control Number of the data 
you want to purge. Leave blank to select all 
interchanges.

Group Control 
Number

Specifies the Group Control Number of the data you 
want to purge. Leave blank to select all groups.

Set ID Specifies the Set ID of the data you want to purge. 
Leave blank to select all transaction sets.

FA Status Specifies the functional acknowledgment status of the 
data you want to purge. Leave blank to purge all sets.

(Continued on next page)
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Purging data Use this procedure to purge archived data.

Search Date Range

Starting 
(CCYYMMDD)

Specifies the earliest translation date of the data to be 
purged. Leave blank to purge a range of data 
beginning with the earliest data available. 

Ending 
(CCYYMMDD)

Specifies the latest translation date of the data you 
want to purge. 

Restrict Search To

Inbound EDI 
Document

Restricts purging to only inbound EDI documents.

Outbound EDI 
Document

Restricts purging to only outbound EDI documents.

After Purging

Reduce EDI History 
File Size

Compresses the EDI History file after documents are 
purged.

Note
The EDI History file is not available to the ediarc 
program during the compression process.

 (Contd)
Field Function

Step Action

1 Verify that the ediarc program is not running.

2 Click Purge Archive on the Archive menu.

System Response
GENTRAN:Server displays the Archive Purge dialog box.

3 Type the criteria of the data you want to purge.

Leave a field blank to select all the documents in that criteria 
category.

Example
Leave the Set ID text box blank to purge all sets.

(Continued on next page)
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4 Click OK.

System Response
GENTRAN:Server purges the records from the EDI History Audit file, 
and also purges the archived data files if no other records point to 
the data file. 

When the process is complete, GENTRAN:Server displays a list of 
the records and data files that were purged.

5 Use this table to determine your next step.

IF you want to� THEN�

Print the list of purged records 
and data files

Click Print.

Exit the Purge Archive Files 
window

Click OK.

 (Contd)
Step Action
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Overview 0

Task Scheduler Basics

Introduction You can use GENTRAN:Server�s Task Scheduler to run tasks (DOS batch files or 
UNIX scripts) automatically on a schedule you specify. 

You may find it convenient to run translations and other GENTRAN:Server 
functions from a batch file or script. You can schedule batch files or scripts to 
perform functions unattended during off-hours.

The Task Scheduler is available in both the GENTRAN:Server for UNIX (client/
server) version and the Workstation version. However, each version handles a 
scheduled file differently.

Task Scheduler
example

You might create a batch file or script to run outbound translation, and then use 
the Task Scheduler to run it every night at 11:00 p.m.

GENTRAN:Server
for UNIX version

If you are running GENTRAN:Server for UNIX, the Task Scheduler sends the 
scheduled files to the host and executes the UNIX crontab command. The UNIX 
crontab command adds the file to the cron spool area. The UNIX cron program 
activates the timer.

The location of crontab and the UNIX program cron varies among the types and 
version of the UNIX operating system.

Example
Here is a sample path:

/var/spool/cron/crontab/muser

Note
The muser file, which represents the server where cron runs, needs permission to 
run cron. 

(Continued on next page)
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Workstation
version

The Workstation version of GENTRAN:Server has its own timer, mtimer. You may 
activate this executable file by:
◗ Clicking Run Task Scheduler on the Tools menu
◗ Configuring mtimer.exe to start when your computer starts.

When you use the Task Scheduler to schedule a file, the Task Scheduler saves 
the file to crontab.dat. Then, when you activate mtimer, mtimer reads the 
crontab.dat file and processes the files based on the schedule you established in 
the Task Scheduler.

In this chapter This chapter contains relevant points about creating batch files or scripts 
containing the GENTRAN:Server command-line and operating-system 
commands you want to perform. You will also learn how to use the Task 
Scheduler to specify the date and time you want the batch file or script to run and 
important points about running the batch files and scripts. 

Key terms This table lists the key terms used in this chapter.  

(Continued on next page)

Term Description

batch file A file that contains command-line commands and 
DOS commands.

cron A UNIX operating-system utility that runs 
commands and scripts according to a preset 
schedule. This is the executable file that activates 
the timer in GENTRAN:Server for UNIX.

ediarc The GENTRAN:Server program that controls 
archiving.

edifrmat The utility that removes segment terminator and 
replaces it with a new-line terminator.

envelope The utility that combines like interchanges.

mtimer A feature you can use to start, stop, or resume 
unattended processes in the Workstation version of 
GENTRAN:Server.

script file A file that contains command-line commands and 
UNIX commands.
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The Flow of
Work

This table describes the process of scheduling a batch file or script.

Stage Description

1 Create a batch file or script file that contains the GENTRAN:Server 
commands and operating-system commands that you want to run on 
a schedule. 

2 Use the Task Scheduler to schedule execution of the batch file or 
script by specifying the path and name of the batch file or script and 
the date and time you want it to run.

3 Use this table to determine the next action.

IF operating 
environment is... THEN...

GENTRAN:Server for 
UNIX

GENTRAN:Server automatically uses cron 
to activate the process unless prohibited 
from doing so by your system administrator. 

GENTRAN:Server 
Workstation

You must use the Run Task Scheduler 
command to start the timer (mtimer).
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DOS Batch Files and UNIX Script Files

Introduction For use with GENTRAN:Server, DOS batch files or UNIX scripts generally contain 
a combination of operating-system commands and GENTRAN:Server command-
line commands. When you create a batch file or script, you enter the commands in 
the order you want to execute them. 

Reference
See the chapter Command Reference in the GENTRAN:Server Technical Guide 
for information on command syntax and options.

Used for
unattended
translation

Perhaps one of the most common uses for batch files or scripts within 
GENTRAN:Server is for unattended inbound and outbound translation.

About
unattended

inbound
translations

To run inbound translations unattended, you create a batch file or script that 
includes commands to do some or all of the following:

◗ Delete files created in the previous translation (mandatory unless you want 
GENTRAN:Server to append these results to the results of the previous 
translation).

◗ Remove non-EDI data from the input file (mandatory; this is the edifrmat 
utility).

◗ Translate the EDI data (mandatory).
◗ Envelope the outbound functional acknowledgment or CONTRL (optional).
◗ Archive the EDI data exactly as it was received (optional).
◗ Archive the outbound functional acknowledgments (optional).
◗ Create and print a Translation Summary Report (optional).
◗ Delete or rename intermediate files created in this run (mandatory).

(Continued on next page)
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About
unattended

outbound
translations

To run outbound translations unattended, you create a batch file or script that 
includes commands to do some or all of the following:
◗ Delete files created in the previous translation (mandatory unless you want 

GENTRAN:Server to append these results to the results of the previous 
translation).

◗ Translate the data into EDI or XML data (mandatory).

Note
If you have the XML translation option, then the data can also be 
translated into XML.

◗ Combine like interchanges for EDI data (optional; this is the envelope utility).
◗ Archive the EDI data exactly as it was sent (optional).
◗ Create and print a Translation Summary Report (optional).
◗ Delete or rename intermediate files created in this run (mandatory).
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Sample GENTRAN:Server Batch Files (Workstation 
Version)

Introduction If you are running the Workstation version of GENTRAN:Server, 
GENTRAN:Server batch files run from the Task Scheduler and mtimer. 

How
GENTRAN:Server

batch files differ
from DOS files

GENTRAN:Server batch files differ from DOS files in the following ways:

◗ GENTRAN:Server batch files can execute only GENTRAN:Server and DOS 
command-line commands, working from the top of the file to the end.

◗ GENTRAN:Server batch files cannot contain conditions or pointers (for 
example, GOTO). However, you can nest DOS batch files in 
GENTRAN:Server batch files. Nested DOS batch files execute properly, 
including conditions and pointers. You cannot, however, include Windows 
GENTRAN:Server commands (lftran and mtimer) in DOS batch files that are 
nested in GENTRAN:Server batch files.

◗ To adhere to the syntax of the mtimer scripting language, for the Workstation 
version you must precede each DOS command in unnested or top-level batch 
files with 'DOS'.

About these
samples

The following batch files are intended as examples only. File names used here 
suggest possible naming conventions. In your work, select one file naming 
convention and use it consistently.

Keep in mind that you can create one batch file to perform multiple tasks or 
handle multiple standard types.

(Continued on next page)
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Sample 1: Batch
file for inbound

purchase orders

The sample batch file below deletes files previously created, runs inbound 
translation on X12 purchase orders, archives the received EDI data and the 
functional acknowledgment sent, and then deletes the edifrmat input file.

(Continued on next page)

Batch file line Function

DOS del \server\temp\xlcntl.err Deletes the translation log file 
xlcntl.err.

DOS del val4po.dat Deletes previous lftran translation 
output.

edifrmat \server\data\val4.in boxin.edi 
-l 

Runs the edifrmat program. This 
program prepares the data for 
translation.

lftran boxin.edi -if val4po.dat Runs the lftran program. This 
program translates the data.

Comment
lftran uses the six key fields in the 
inbound document to locate the 
Trading Partnership record.

envelope Runs the envelope program. This 
program combines like interchanges.

ediarc -I Archives the inbound data using the 
ediarc program.

ediarc -O Archives the outbound data using the 
ediarc program.

DOS del \server\data\val4.in Deletes the temporary file(s) that the 
edifrmat program creates.
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Sample 2: Batch
file for inbound

purchase orders

This sample deletes previously created files, runs inbound translations on 
EDIFACT purchase orders, archives the received EDI data and the CONTRL 
sent, and then deletes the edifrmat input file.

(Continued on next page)

Batch file line Function

DOS del \server\temp\xlcntl.err Deletes the translation log file 
xlcntl.err.

DOS del boxin.po Deletes previous lftran translation 
output.

edifrmat \server\data\val4.in boxin.edi 
-l

Runs the edifrmat program. This 
program prepares the data for 
translation.

lftran boxin.edi -i Runs the lftran program. This 
program translates the data.

Comment
lftran uses the 6 key fields in the 
inbound document to locate the 
Trading Partnership record.

envelope Runs the envelope program. This 
program combines like interchanges.

ediarc -I Archives the inbound data using the 
ediarc program.

ediarc -O Archives the outbound data using the 
ediarc program.

DOS del \server\data\val4.in Deletes the temporary file that the 
edifrmat program creates.
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Sample 3: Batch
file for outbound

invoices

The sample batch file below deletes files from previous executions, runs outbound 
translations on X12 invoices, and archives the EDI data sent.

Sample 4: Batch
file for outbound

invoices

This sample deletes files from previous executions, runs outbound translations on 
EDIFACT invoices, and archives the EDI data sent.

Batch file line Function

DOS del \server\temp\xlcntl.err Deletes the translation log file xlcntl.err.

DOS del boxin.edi Deletes previous lftran translation 
output.

lftran \server\data\boxin.udf 
-oT[TPCODE]

Runs the lftran program. This program 
translates data.

envelope Runs the envelope program. This 
program combines like interchanges.

ediarc -O Archives the outbound data using the 
ediarc program.

Batch file line Function

DOS del \server\temp\xlcntl.err Deletes the translation log file xlcntl.err.

lftran \server\data\boxin.udf
-oT[TPCODE]f edat

Runs the lftran program. This program 
translates the data.

envelope Runs the envelope program This 
program combines the interchanges.

ediarc -O Archives the outbound data using the 
ediarc program.
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Sample UNIX Scripts

Introduction If you are running GENTRAN:Server for UNIX, you use UNIX scripts for inbound 
and outbound translation. This topic contains samples of UNIX scripts you can 
schedule using the Task Scheduler.

Note
As in UNIX, commands in scripts are case-sensitive.

About these
samples

The following scripts are intended as examples only. File names used here 
suggest possible naming conventions. In your work, you should select one file 
naming convention and use it consistently.

Keep in mind that you can create one script to perform multiple tasks or handle 
multiple standard types.

Sample 1: UNIX
script for
inbound

purchase orders

The sample UNIX script below deletes previously created files, runs inbound 
translation on X12 purchase orders, archives the received EDI data and the 
functional acknowledgment sent, and deletes the edifrmat input file.

Script line Description

rm /usr/server/temp/xlcntl.err Removes the translation log file xlcntl.err.

rm value4po.dat Removes previous lftran translation 
output.

edifrmat /usr/server/data/
value_4.in boxin.edi -l

Runs the edifrmat program. This program 
prepares the data for translation.

lftran boxin.edi -if value4po.dat -cp Runs the lftran program. This program 
translates the data.

Comment
lftran uses the 6 key fields in the inbound 
document to locate the Trading 
Partnership record.

envelope Runs the envelope program. This 
program combines like interchanges.

(Continued on next page)
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Sample 2: UNIX
script for
inbound

purchase orders

This sample deletes previously created files, runs inbound translations on 
EDIFACT purchase orders, archives the received EDI data and the CONTRL 
sent, and deletes the edifrmat input file.

(Continued on next page)

ediarc -I Archives the inbound data using the 
ediarc program.

ediarc -cp /user/server/temp Archives the outbound data using the 
ediarc program.

rm /usr/server/data/val4.in Removes the temporary file that the 
edifrmat program creates.

 (Contd)
Script line Description

Script line Description

rm /usr/server/temp/xlcntl.err Removes the translation log file 
xlcntl.err.

rm boxin.po Removes previous lftran translation 
output.

edifrmat /usr/server/data/value_4.in 
boxin.edi -l

Runs the edifrmat program. this 
program prepares the data for 
translation.

lftran boxin.edi -i boxin.in -cp /user/
server/temp

Runs the lftran program. This 
program translates the data.

Comment
lftran uses the 6 key fields in the 
inbound document to locate the 
Trading Partnership record.

envelope Runs the envelope program This 
program combines like interchanges.

ediarc -I -cp /usr/server/temp Archives the inbound data using the 
ediarc program.

ediarc -O -cp /usr/server/temp Archives the outbound data using the 
ediarc program.

rm /usr/server/data/val4.in Removes the temporary file that the 
edifrmat program creates.
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Sample 3: UNIX
script for
outbound

invoices

The sample UNIX script below deletes files from previous executions, runs 
outbound translation on X12 invoices, and archives the EDI data sent.

Sample 4: UNIX
script for
outbound

invoices

This sample UNIX script deletes files from previous executions, runs outbound 
translations on EDIFACT invoices, and archives the EDI data sent.

Script line Description

rm /usr/server/temp/xlcntl.err Removes the translation log file 
xlcntl.err.

rm boxin.edi Removes previous lftran translation 
output.

lftran /usr/server/data/boxin.udf 
-oT[TPCODE]f boxin.in -cp /user/
server/temp

Runs the lftran program. This 
program translates the data.

envelope Runs the envelope program. This 
program combines like interchanges.

ediarc -O -cp /usr/server/temp Archives the outbound data using the 
ediarc program.

Script line Description

rm /usr/server/temp/xlcntl.err Removes the translation log file 
xlcntl.err.

rm dat.edi Removes previous lftran translation 
output.

lftran /usr/server/data/boxin.udf 
-oT[TPCODE]f dat.edi -cp /user/
server/temp

Runs the lftran program. This 
program translates the data.

envelope Runs the envelope program. This 
program combines like interchanges.

ediarc -O -cp /usr/server/temp Archives the outbound data using the 
ediarc program.
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Task Scheduler Dialog Box

Introduction You use the Task Scheduler to specify the batch file or script you want to run and 
the date and time at which you want it to execute. 

Opening the
Task Scheduler

To open the Task Scheduler, click Schedule Tasks on the Tools menu.

The Task
Scheduler dialog

box

This illustration shows the Task Scheduler dialog box. 

Task Scheduler
dialog box fields,

functions, and
values

This table describes the Task Scheduler dialog box text fields that you use to enter 
information about the batch file or script and the execution date and time. 

Field Function Values

Minute Specifies the minute 0 through 59

Hour Specifies the hour (24-hour clock) 0 through 23

Day Specifies the day of the month 1 through 31

Month Specifies the month
(Continued on next page)

JAN through 
DEC
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Note
Use the asterisk (*) to include all values in a field. For example, if you want to run 
a batch file every day of the week, enter an asterisk into the Weekday box. To run 
the task every month of the year, enter an asterisk into the Month box.

Examples of
scheduling a

task

This table shows schedules for example batch files A, B, and C. 

◗ A runs everyday, at 15 minutes past every hour.
◗ B runs every Monday at 8 p.m.
◗ C runs on the thirtieth (30th) of each month at 8:30 a.m.

(Continued on next page)

Weekday Specifies the day of the week SUN through 
SAT

Filename Specifies the path and batch file or script 
name

Edit Opens the Edit Task Scheduler Entry dialog 
box so that you can change the date or time 
value or the filename.

Add Opens the Add Task Scheduler Entry dialog 
box so that you can add a task to the 
scheduler

Delete Removes a selected entry from the Task 
Scheduler

 (Contd)
Field Function Values

Batch File Minute Hour Day Month Weekday

A 15 * * * *

B 0 20 * * MON

C 30 8 30 * *
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About scheduling
tasks in the

GENTRAN:Server
for UNIX version

When you close the Task Scheduler after scheduling tasks, GENTRAN:Server 
sends the file to the host and executes the UNIX crontab command. This adds the 
file to the cron spool area. This UNIX operating system cron program activates 
the timer.

CAUTION
Closing the Task Scheduler overwrites any existing crontab file and 
deletes tasks previously scheduled outside of GENTRAN:Server. You 
should check for previously scheduled tasks and, if necessary, 
schedule GENTRAN:Server tasks outside of GENTRAN:Server.

Reference 
See the topic How to Run Scripts (UNIX Version) in this chapter for instructions on 
how to use crontab to check scheduled tasks and how to schedule 
GENTRAN:Server tasks outside of GENTRAN:Server.
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Add Task Scheduler Entry Dialog Box

Introduction The Add Task Scheduler dialog box is used to add a batch file or script to the 
scheduler.

Illustration This illustration shows the Add Task Scheduler dialog box.

Fields and
functions

This table lists the fields of the Add Task Scheduler dialog box dialog box and their 
functions.

Field Function Values

Minute Specifies the minute 0 through 59

Hour Specifies the hour (24-hour clock) 0 through 23

Day Specifies the day of the month 1 through 31

Month Specifies the month JAN through 
DEC

Weekday Specifies the day of the week SUN through 
SAT

Filename Specifies the path and batch file or script 
name

alphanumeric 
characters
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Procedures 0

How to Add a Batch File or Script to the Scheduler

Introduction This topic describes how to use the Task Scheduler to indicate the day and time 
you want to execute a batch file or script.

Scheduling a
batch file or

script

Use this procedure to schedule a batch file or script. 

 
 Step Action

1 Click Schedule Tasks on the Tools menu.

System Response 
The system displays the Task Scheduler dialog box. 

Reference 
See the topic Task Scheduler Dialog Box in this chapter for 
instructions and a description of features.

(Continued on next page)
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2 Click the Add button. 

System Response
The system displays the Add Task Scheduler Entry dialog box.

3 From the drop down list, select the appropriate time and date value. 

4 Click the Filename text box and enter the full path and file name of 
the batch file or script.

Note
Alternatively, you can click Browse to display the Select File dialog 
box that enables you to search for the file.

5 Click OK to save your changes.

 (Contd) 
 Step Action
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How to Edit a Scheduled Entry 

Introduction You can use the Task Scheduler to change the date or time values or the file 
name entered.

Changing an
entry

Use this procedure to change a schedule entry. 

Step Action

1 Open the Task Scheduler.

System Response 
The system displays the Task Scheduler dialog box. 

Reference 
See the topic Task Scheduler Dialog Box in this chapter for 
instructions and a description of features.

2 Select the entry you want to edit.
(Continued on next page)
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3 Click the Edit button. 

System Response
The system displays the Edit Task Scheduler Entry dialog box.

Note
See the topic Add Task Scheduler Entry Dialog Box for a description 
of the fields for the Edit Task Scheduler Entry dialog box.

4 Select a value from the drop down menu in the field you want to edit.

5 Type the full path and filename of the batch file or script.

Note
You can also click the Browse button to display the Select File dialog 
box that enables you to search for the file.

6 Click OK to save your changes.

 (Contd)
Step Action
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How to Delete an Entry from the Scheduler

Introduction This topic explains how to delete a scheduled task from the Task Scheduler.

Deleting a task Use this procedure to delete a scheduled task. 

Step Action

1 Open the Task Scheduler.

Reference 
See the topic Task Scheduler Dialog Box in this chapter for 
instructions and a description of features.

2 Click anywhere on the row that contains the task you want to delete.

3 Click Delete.

System Response
The system displays the Delete Entry dialog box.

4 Do you want to delete the entry?

◗ If YES, click Yes.

System Response
The system removes the task from the Task Scheduler.

◗ If NO, click No.

System Response
The systems returns to the Task Scheduler dialog box.
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How to Run Scripts (UNIX Version) 

Introduction GENTRAN:Server for UNIX automatically uses cron to run a scheduled script at 
the specified time. 

Note
Your system administrator can prohibit a scheduled script from running. 

Using crontab to
check scheduled

tasks

To check the tasks you currently have scheduled outside of GENTRAN:Server, 
enter the following command at a UNIX prompt from any directory:

crontab -l

Scheduling
GENTRAN:Server

tasks outside of
GENTRAN:Server

Use this procedure to schedule GENTRAN:Server tasks outside of 
GENTRAN:Server. 

Step Action

1 Copy the current list of your tasks by entering the following UNIX 
command from any directory:

��������
����������

Where jobs.txt is a temporary file for storing tasks. 

2 Use any text editor to edit the file, adding your GENTRAN:Server 
tasks to the current task list.

3 Save the file.

4 To overwrite the current task list, enter the following command:
���������������
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MTimer and Workstation Batch Files 

Introduction This topic discusses the use of mtimer in processing GENTRAN:Server 
Workstation batch files with the Run Task Scheduler tool.

Reference
After you read this topic, see the topic How to Run Scheduled Tasks (Workstation 
Version) in this chapter for step-by-step instructions.

About mtimer For Windows platforms, you must have mtimer running at the time you want to 
run the unattended processes specified in the Task Scheduler. 

Example
To run batch files daily, you must either activate mtimer daily or leave it on. You 
can leave mtimer on only if you leave your computer on with Windows running. 
You can close GENTRAN:Server without affecting mtimer.

The system displays the mtimer window whenever mtimer is on. This window 
displays currently scheduled jobs. The system displays only the title bar if no jobs 
are scheduled. 

The Task
Scheduler

mtimer dialog
box

This illustration shows an example of the Task Scheduler mtimer window. 

The mtimer window displays each scheduled task on a separate line. Each line 
contains the date and time as well as the batch file or script scheduled to run. 

(Continued on next page)

Click here to 
display menu

Double-click to 
stop mtimer
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About mtimer
files

When you activate mtimer, GENTRAN:Server creates three files. This table 
describes the files. 

MTimer Log
dialog box

This illustration shows the MTimer Log dialog box.

File Description

unop.ran Contains a list of tasks completed during this active 
session. Unless you elect to suspend processing, 
GENTRAN:Server deletes this file when you stop 
mtimer.

unop.log Contains the list of completed tasks. GENTRAN:Server 
appends to this file with each new mtimer session, 
instead of deleting or overwriting it. This means it can 
grow very large. You should watch its size and 
periodically delete this log file manually.

You can view this log on the MTimer Log dialog box 
while mtimer is running.

unop.err Contains operating-system error messages in response 
to errors in the DOS commands included in your batch 
file.
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How to Run Scheduled Tasks (Workstation Version)

Introduction This topic contains step-by-step instructions for running scheduled tasks from the 
GENTRAN:Server Tools menu in the Workstation version of GENTRAN:Server.

CAUTION
When you close Windows, mtimer automatically suspends job 
processing. 

Procedure Use this procedure to run scheduled tasks and activate mtimer. 

Step Action

1 Click Run Task Scheduler on the Tools menu.

System Response
GENTRAN:Server displays a message box that asks whether you 
want to run the tasks scheduled to run on the current date, but prior to 
the current time.

(Continued on next page)
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2 Use this table to determine your action.

IF you want to... THEN select...

Run all jobs, including those scheduled to run 
prior to the current time

Yes

Run only those jobs scheduled to run from the 
current time forward

No

System Response 
The system displays the Tasks Scheduler - mtimer window.

3 Do you want to display the unop.log file in the MTimer Log dialog 
box?
◗ If YES, click the Show Log button.
◗ If NO, continue with the next step.

4 Do you want to stop mtimer?

◗ If YES, GO TO How to Stop and Resume mtimer.
◗ If NO, you are finished.

 (Contd)
Step Action
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How to Stop and Resume mtimer

Introduction This topic contains instructions for stopping (or suspending), and resuming 
mtimer in the Workstation version of GENTRAN:Server.

About stopping
or suspending

mtimer

At any time during processing, you can either stop mtimer or suspend job 
processing.

If you suspend job processing, GENTRAN:Server retains a list of the completed 
tasks. You have the option of resuming mtimer at any time in the future. When 
you resume mtimer, processing begins where it left off.

Stopping or
suspending

mtimer

Use this procedure to stop or suspend mtimer. 

CAUTION
When you close Windows, mtimer automatically suspends job 
processing.   

Step Action

1 Double-click the control box bar in the mtimer window.

System Response 
If there are jobs to be processed, GENTRAN:Server displays the 
following message. 

Note
The system does not display this message if there are no jobs to be 
processed.

(Continued on next page)
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Note
When you suspend mtimer, the system retains the unop.log and unop.err files. 
However, if you stop mtimer and delete the list of completed tasks, 
GENTRAN:Server deletes the unop.ran file. This means that, the next time you 
activate mtimer, the system runs jobs that were already run.

Resuming
mtimer

Use this procedure to resume mtimer after you have suspended processing.

2 Use this decision table to determine your action.

IF you want to� THEN click�

Suspend job processing. 

Suspending job processing retains the list of 
completed tasks. When you activate mtimer again, 
the system only runs tasks not completed 
previously. 

Yes

Stop mtimer and delete the list of completed tasks.

The next time you activate mtimer, the system 
runs all tasks. This includes tasks run previously. 

No

 (Contd)
Step Action

Step Action

1 Click Run Task Scheduler on the Tools menu.

Note 
You can also type mtimer at the command line.

System Response 
GENTRAN:Server displays a message box asking whether you 
want it to resume the schedule at the point at which it stopped. 

(Continued on next page)
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2 Use this decision table to determine your action.

IF you want to�
THEN 
select�

AND 
GENTRAN:Server�

Have GENTRAN:Server 
read the unop.ran file and 
resume job processing 
where it last stopped

Yes resumes processing, 
omitting the files listed 
in the unop.ran file.

You are finished.

Run the job processing 
from the beginning, even 
if it means running 
completed jobs again

No displays a message 
box that asks whether 
you want to run the 
tasks scheduled to run 
prior to the current 
time.

Continue with the next 
step.

3 When this dialog box is displayed, use the decision table below to 
determine your action.

IF you want to� THEN select�

Run the jobs scheduled to run today prior 
to the current time.

Yes

Run only those jobs scheduled to run from 
the current time forward.

No

System Response 
The system opens the Task Scheduler mtimer window.

 (Contd)
Step Action
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Glossary

Glossary
active window The window that the next action will affect by the next action or that will receive 
the next data.

While you can have two or more windows open at a time in the Windows 
operating system, only one window can be the active window at any given time. 
The title bar of the active window is highlighted.

alphanumeric
data

Data of data type alphanumeric (AN) or identifier (ID); i.e., text strings with 
characters A-Z, a-z, and 0-9.

alphanumeric
expression

An expression that results in alphanumeric data. Also called a string expression. 

application The business software generating the business information that you are sending 
or receiving via EDI.

application data
file

The electronically stored data that GENTRAN:Server loads into or extracts from 
your application software.

application
description

Your company�s description of the records and fields in an ASCII file used for your 
data.

Application
Editor

The GENTRAN:Server tool that enables you to describe your application data.

ASCII American Standard Code for Information Interchange.
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ASCII is a standard character set that enables the communication of data 
between disparate computer devices. The standard ASCII character set consists 
of 96 displayed upper- and lowercase characters and 32 non-displayed control 
characters. EDI uses the ASCII extended character set, which includes foreign 
language, technical, and block graphics characters in addition to the 128 
characters in the standard ASCII character set.

archive The process of copying and saving processed EDI data.

archive data Interchange data that was saved for the purpose of enabling you to recreate 
conditions at a specific point in time.

You can use archive data to trace the introduction of an error in the data and/or to 
retrieve an original version to effectively undo all changes made since that version 
was saved.

arithmetic
expression

An expression that results in numeric data.

attributes The values you assign to describe a record or field.

audit data Data about interchanges that enables you to track, check, and reconcile 
interchanges and the functional acknowledgments you receive.

To ensure the accuracy of archiving and reconciliation, you must have unique 
control numbers across all documents for a single trading partner. The best way to 
do this is to use Organization records and maintain control numbers globally.

AutoCreate
Application
Description

A GENTRAN:Server tool that automatically creates an application description 
from a specified implementation guide.

The resulting application description always has variable length fields.

If you are planning to use both the AutoTrim tool and the AutoCreate Application 
Description tool, use AutoTrim first.
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AutoMap The GENTRAN:Server feature that compares specified source and destination 
files and creates a map between them based on criteria such as field or element 
name, record or segment tame, and loop structure.

AutoTrim A GENTRAN:Server tool that automatically creates an implementation guide by 
customizing a standard document according to sample application data you 
supply.

If you plan to use both AutoTrim and AutoCreate, use AutoTrim first.

batch file A file command-line commands and DOS commands.

binary A representation of numbers to the base 2.

categories A user-definable record that enables you to group Trading Partnerships.

central audit
directory

The EDI History Audit directory GENTRAN:Server uses to store permanent 
history files.

check box A square to the left of an option in a dialog box. When you select the option, the 
square contains an X. You click the check box to select the option or to cancel the 
selection.

click To quickly press and release a mouse button. Unless otherwise specified, clicking 
refers to pressing and releasing the left mouse button.

client The computer in a client/server network that acts as the interface between the 
user and the server.
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client/server A computer network architecture in which data is stored and processing is 
performed on the server, which users access through the interface provided on 
the client.

clipboard A temporary storage buffer in Windows for use when cutting or copying 
information from a Windows application and pasting it in the same or a different 
Windows application.

collapsed view Within the Visual Mapper, displays all the segments, but hides all the elements, 
composite elements, and sub-elements.

column For databases, a unit of information contained in a database table.

A column is a field in a database record.

command A text string that initiates a specific action.

compliance
checking

The automatic checking of an interchange for completeness.

If you request that the translator do compliance checking, it looks at the control 
numbers in the headers and trailers that bracket the set, group, and interchange. 
If the control number in the header matches that in the trailer, the translator 
assumes that the set, group, or interchange is complete.

In addition, compliance checking does the following:
◗ Checks that data fields do not fall short of minimum field lengths or exceed 

maximum field lengths
◗ Checks that loops are not used more often than the maximum use value 

allows
◗ Checks that dates use valid formats
◗ Checks that all data uses valid formats for the data type

composite
element

An element composed of two or more sub-elements.
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conditional
expression

A complete 'When' expression that may be part of a longer mapping condition.

CONTRL
message

A functional acknowledgment in the EDIFACT and ODETTE standards.

Contact Code A user-defined code that identifies a contact individual within the trading partner 
organization.

While a Contact Code does not have to be unique in your system, it must be 
unique among Contact Codes within in a specific set of Interchange and Group 
IDs.

Types of identifiers sometimes chosen for Contact Codes are as follows:

◗ Document type
◗ Title
◗ Telephone number

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: Up to 15 characters

Example: Purchase_order

contact name The name of the contact individual within a trading partner organization.

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: Up to 35 characters

Example: Sam_Huston

Contact File A file consisting of records containing identifying information about the individuals 
you telephone, fax, write, or e-mail in the organizations with which you do 
business.

The Contact File, consisting of contact.dat and contact.idx, contains Contact 
records.
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contact record A record containing the name, address, and telephone numbers of an individual in 
your trading partner�s organization.

You can have Contact records for some, all, or none of your trading partners. In 
addition, you can have multiple Contact records for a single Trading Partnership. 
Contact records reside in the Contact File.

control box The box or icon that enables you to close the window; to control such window 
attributes as the size and location; to minimize or maximize the window, or to 
switch to other open applications through the task list.

The control box is in the top left corner of the window.

control envelope The standard header and trailer segments GENTRAN:Server uses to identify 
transaction sets, functional groups, and interchanges.

Control envelopes ensure complete and accurate translation of data.

control number The number that identifies part or all of a document.

Control numbers enable the translator to determine whether or not the document/ 
message GENTRAN:Server is translating is complete. There are three types of 
control numbers
◗ Set control numbers
◗ Group control numbers
◗ Interchange control numbers

You and your partner pass the appropriate control numbers in the headers and 
trailers that bracket the set, group, and interchange. If the control number in the 
header matches that in the trailer, the translator assumes that the set, group, or 
interchange is complete.

You can maintain Interchange and group control numbers either globally or locally.

Control numbers are sometimes called envelope control numbers.

Allowable Characters: Letters (A-Z, a-z) and numbers (0-9)

Allowable Length: Up to 14 characters

Example: 199400001
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cron A UNIX operating system utility that runs commands and scripts according to a 
preset schedule. This is the executable file that activates the timer in the client/
server version of GENTRAN:Server.

CTT segment A special segment containing the transaction set totals for an X12 document.

There are two commonly used types of CTT elements in the CTT segment. The 
translator can generate both automatically. Depending upon the type of 
document, you may want to use only the first element or both elements 01 and 02. 
They are
◗ CTT01
◗ CTT02

CTT totals Hash totals of items in the detail section of certain X12 transaction sets. CTT 
totals can include the following:
◗ Count of occurrences of a specific segment

This is a count of the lines in the detail section, called CTT01.

◗ Hash total of the contents of a specific element
This is a hash total of the values in the lines in the detail section, called 
CTT02. A hash total ignores signs and decimal points.

cursor An icon that indicates the currently active location in a window.

The insertion point and the mouse pointer are both cursors.

data Business information that is suitable for computer processing.

database driver Special software to format data for a specific database application.

In GENTRAN:Server, the database driver determines the directory path of data 
sources as well as the database type.

data element
dictionary

The section of the EDI standards documentation that explains the purpose and 
syntax of each data element that the standard uses.
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data element
dictionary

number

The number identifying a data element in the data element dictionary.

data file The file that contains the inbound or outbound data.

data format Qualifiers that describe the arrangement or placement of data.

Data formats enable users to further define their input and/or output data, for 
example specifying:

◗ Whether to right justify or to left justify the data
◗ Whether or not to pad empty places
◗ Whether or not to remove null characters

data type The type of data in a field (for example, alphanumeric, binary, numeric, date, 
time).

date-time data Data of data type date (DT) or time (TM); i.e., data expressing a date and/or time.

date-time
expression

An expression that results in date-time data.

default A value that GENTRAN:Server automatically assigns.

default synonym A value that GENTRAN:Server uses when none of the other substitution 
conditions are satisfied.

To indicate a default synonym, enter an asterisk (*) in the Original Value column.

As long as none of the other substitution conditions are satisfied, 
GENTRAN:Server uses the default synonym in the destination document even if 
the item that was to determine the substitution is not present.
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delimiter A symbol GENTRAN:Server uses to separate data items in an application file.

dialog box An application window through which you enter information into the application.

directory path The name of the directory and any directories above it, including the drive.

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: Up to 59 characters

Example: .\maps

display box A box that displays information.

You cannot edit information in a display box, but you can edit information in a text 
entry/display box.

document
standards

The data dictionary and syntax describing agreed-upon standard formats for 
commonly-used business documents (for example, invoices and purchase 
orders).

Sometimes, document standards are simply called standards.

document
translator

The EDI software that translates electronic document files from one format to 
another, typically from an application format to a standard-data format and vice 
versa.

Sometimes, document translators are simply called translators.

double-click To quickly press and release a mouse button twice in quick succession.

Unless otherwise specified, double-clicking refers to pressing and releasing the 
left mouse button twice.

drop-down list
box

A list box containing all available choices and with a down arrow on the side.
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To use a mouse to make a selection from a drop-down list box, click on the down 
arrow to open the list box and then click on the desired value.

To use the keyboard to make a selection from a drop-down list box, press the 
down arrow key to move the focus (highlighting) to the selection and then press 
TAB.

Alternatively, select the current information and type the desired value over it.

Windows drop-down list boxes are similar to DOS choice lists.

EDI Electronic Data Interchange.

Application-to-application transfer of key business transaction information in a 
standard format via a computer-to-computer communication link.

ediarc The GENTRAN:Server program that controls archiving.

EDIFACT Electronic Data Interchange For Administration, Commerce, and Transport.

EDIFACT has been developed by the United Nations as a standard for 
international EDI.

edifrmat The GENTRAN:Server feature that formats the data you receive from your trading 
partner. It removes non-EDI characters and changes segment terminators to new 
line characters.

EDI standard A format to regulate syntax, structure, and content of transaction data.

element A piece of data in a segment. Elements are analogous to fields in an application 
description. Elements are variable-length fields.

element
minimum and

maximum length

The minimum and maximum number of characters allowable for a data element.
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In the standard, the minimum and the maximum are separated with a slash, with 
the minimum always appearing first.

element
reference

designator

An alphanumeric code that identifies the segment and the position of this element 
within the segment.

For example, N101 is an element reference designator, where 
N1identifies this as the N1 segment within the 
document and 01 identifies this element as the first 
element in the N1 segment.

element
separator

A special indicator that marks the beginning of a new data element.

A character used to signal the end of each element in a segment.

Because EDI standards use variable-length elements, element separators are 
necessary to determine where one element ends and the next begins. The 
character used as an element separator should not be used for any other purpose 
in the file unless it is preceded by a release character.

The X12, TDCC, AND UCS standards often use asterisks (*) element separators.

The EDIFACT, ODETTE, and TRADACOMS standards often use plus signs (+) as 
element separators.

element type The type of data an element passes.

Possible element type codes vary with the standard, but they may include some 
or all of the following:

◗ AN (or A) alphanumeric
◗ B binary
◗ DT date
◗ ID identifier
◗ Nn numeric with implicit decimal point
◗ Rn numeric with explicit decimal point
◗ TM time

envelope a)The process of combining like interchanges.
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b) Data segments that separate different types of data and carry address 
information.

c) A GENTRAN:Server tool that compresses multiple like interchanges into one.

error message An indication that GENTRAN:Server is unable perform this process or has 
stopped performing the current process.

Do not confuse this message with an informational message, prompt, or warning 
message.

expanded view Within the Visual Mapper, expanded view displays all elements, composite 
elements, and sub-elements, as well as all segments.

expert mode A special mode for running GENTRAN:Server for use by EDI users who want 
more control when creating or editing mapping instructions.

The standard mode is the default mode in GENTRAN:Server. You must select 
expert mode on the User Setup dialog box or you remain in standard mode. 
However, once you select the expert mode, you remain in that mode until you 
clear the selection even if you close GENTRAN:Server and open it again. To open 
the User Setup dialog box, Click User Setup on the Preferences menu on either 
the Main or the Visual Mapper Toolbar.

FA
Reconciliation

Report

A report that enables you to check the reconciliation of functional 
acknowledgments that were sent and received.

An FA Reconciliation Report shows the following information for the selected 
interchanges, one functional group to a line:

◗ Translation date (for outbound interchanges) or received date (for inbound 
interchanges)

◗ Trading Partnership Code
◗ Trading partner�s Interchange ID for this interchange
◗ Set ID
◗ Group control number
◗ Date functional acknowledgment was received (for outbound interchanges) or 

generated (for inbound interchanges)
◗ Status
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To generate an FA Reconciliation Report, select the FA Reconciliation command 
from the Deploy menu and then select either the Inbound command (if you want to 
view inbound interchanges) or Outbound command (if you want to view outbound 
interchanges). To select the interchanges you want to include in the report, enter 
the desired criteria in the FA Reconciliation Ranges dialog box that appears. The 
report appears in a report window. To print the report, press F6.

To use a batch file or script to generate and print an FA Reconciliation Report, 
include the fareport command. Command line processing displays totals for each 
status type.

fast entry mode A quick, but not graphical, mode for mapping items.

The fast entry mode enables you to type in the source field/element, the 
destination field/element, and then press RETURN to create the mapping 
association. This can be very fast if you are familiar with your data and if you are 
making only a few mapping associations in the map.

The tree mode is graphical and intuitive, but slower.

field A discrete piece of data in a record, such as a quantity or a unit price.

field minimum
and maximum

length

The minimum and maximum number of characters allowable for a field.

file extension A suffix that appears to the right of the period (.) in a complete file name.

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: From 1 to 3 characters

Example: dat

While file extensions are not required, they are particularly useful in identifying the 
type of file (that is, out for output, txt for text, dat for data, etc.).

The complete file name is

(File name).(File extension)

A complete file name must be unique in its directory.
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file generation
number

A number GENTRAN:Server uses to identify files in EDIFACT; similar to an 
interchange control number in X12.

The file generation number resides in the actual document rather than in the 
envelope segments. The interchange control number resides in the envelope 
segments.

file name A name that identifies a file. The file name appears to the left of the period (.) in a 
complete file name.

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: From 1 to 8 characters

Example: 2002X850

File names are required.

The complete file name is

(File name).(File extension)

While file extensions are not required, either the file name or the complete file 
name must be unique in the directory. If you have two files with the same name 
and in the same directory, you must use different file extensions for the files.

flat file A non-database user-defined file.

focus An indication that a certain window or screen element is active. The next action 
will affect the active item.

Screen elements include text and buttons. The title bar on the window with the 
focus is different from the title bar on other windows. The system highlights the 
text you select with the focus. Highlighted text has a different color background or 
appears in reverse video (that is, light text on a dark background). A button you 
select with the focus usually has a darker outline around it.

In GENTRAN:Server, you select the record/segment or field/element you want to 
edit by moving over it. When you make a selection, the system displays a thick 
box around the record/segment or field/element and the related attributes. This 
indicates the location of the focus.
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functional
acknowledgment

(FA)

The standard transaction set GENTRAN:Server uses to acknowledge receipt of a 
transmission. The functional acknowledgment tells you if your trading partner 
received and processed a document you sent. It also can tell you whether your 
document contained EDI standards and compliance errors.

functional group One or more transaction sets of the same type, from the same sender, to the 
same receiver, that GENTRAN:Server groups for transmission.

The functional group is referred to the group level envelope or the group 
envelope. This is distinct from the functional group that is part of a trading partner 
organization.

Generic
Synonym Editor

The GENTRAN:Server tool that enables you to create and/or edit lists of terms 
and the terms you want to substitute for them when translating with various maps.

Do not confuse with Specific Synonym Editor.

generic
synonym list

A synonym list that any map can use.

globally
maintained

control numbers

Control numbers that GENTRAN:Server uses when there are two or more Trading 
Partnership records for the same trading partner.

Globally maintained control numbers are unique for a single trading partner. 
GENTRAN:Server assigns the control numbers sequentially, regardless of the 
document you send to the trading partner. GENTRAN:Server stores globally 
maintained control numbers in the Organization records. The Interchange 
Organization record stores the last interchange control number sent and received, 
while the Group Organization records store the last group control numbers sent 
and received.

Group/
Application ID

A user-defined identifier for the sending or receiving organization at the functional 
group level.

The Trading Partner Agreement should specify the Group/Application IDs that 
GENTRAN:Server should use to identify the functional group level organizations 
of both parties to the agreement.

Types of identifiers sometimes chosen for Group/Application IDs are as follows:
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◗ Telephone number
◗ Department number
◗ Department name
◗ Duns number

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: From 1 to 35 characters

Example: 313_555_1212

Do not confuse with the Group/Application ID with the Group Organization Code.

Group control
header

Segment identifier for the header for the envelope containing the group control 
number.

Allowable Characters: Letters (A-Z, a-z) and numbers (0-9)

Allowable Length: From 1 to 3 characters

Example: GHR

Group envelope One or more transaction sets of the same type, from the same sender, and to the 
same receiver, that GENTRAN:Server groups for transmission.

Sometimes, the group envelope is called the group level envelope or the 
functional group envelope.

Group
organization

A division or functional group within a trading partner organization.

The group organization record includes the Group/Application IDs for you and 
your trading partner. This is where GENTRAN:Server stores the globally 
maintained group control numbers.

Group
Organization

Code

A code identifying a division or functional group within a trading partner 
organization.

The Group Organization Code is sometimes called the Group/Application 
Organization Code.

Types of codes sometimes chosen for Group Organization Codes are as follows:
◗ Regions
◗ Functions
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Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: From 1 to 15 characters

Example: East_Division

Do not confuse the Group Organization Code with the Group/Application ID. 

Group
Organization

record

A record containing identifying information about a group organization, as well as 
the group control number most recently received from or sent to that group 
organization.

There must be one Interchange Organization record for every Group Organization 
record. There must be one or more Group Organization records for every 
Interchange Organization record. Along with Interchange Organization records, 
Group Organization records reside in the Organization File.

The group organization record includes the Group/Application IDs for you and 
your trading partner. This is where GENTRAN:Server stores the globally 
maintained group control numbers.

header The first segment of a transaction set, functional group, or interchange. A header 
segment begins and a trailer segment ends each transaction set, functional 
group, and interchange envelope.

historical record The index files named edihist.dat and edihist.idx that store the location of the 
archived data. The files are built from the status records that translation produces. 
Together, they are the permanent audit file.

implementation
guide

A specially-edited form of a standard that meets the requirements of a particular 
Trading Partnership.

inbound
translation

Translation in which the source document is either a standard or an 
implementation guide.

informational
message

Text containing feedback about, or the status of, the process just completed.

Do not confuse with an error message, prompt, or warning message.
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insertion point A bar or other icon indicating where the next text will appear or the next action will 
take effect.

interchange A collection of transaction sets or messages.

An interchange is the exchange of a specified document with a specified trading 
partner and using a specified standard version. An interchange consists of an 
interchange header, any number of transaction sets, any number of functional 
groups, and an interchange trailer.

The use of functional groups is optional in the EDIFACT and TDCC standards.

interchange
acknowledgment

An optional segment in an X12 interchange to acknowledge receipt of an 
unrelated interchange. An interchange acknowledgment does not take the place 
of a functional acknowledgment.

interchange
control header

Segment identifier for the header for the envelope containing the interchange 
control number.

Allowable Characters: Letters (A-Z, a-z) and numbers (0-9)

Allowable Length: From 1 to 3 characters

Example: HDR

Interchange ID A user-defined identifier for the sending or receiving organization at the 
interchange level.

The Trading Partner Agreement should specify the Interchange IDs 
GENTRAN:Server uses to identify the interchange level organizations of both 
parties to the agreement.

Types of identifiers sometimes chosen for Interchange IDs are as follows:
◗ Telephone number
◗ Duns number

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: From 1 to 35 characters

Example: General_Radio

Do not confuse with Interchange Organization Code.
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Interchange
organization

A trading partner at the organization level. An interchange organization must 
contain groups.

An Interchange Organization record contains Interchange IDs for both you and 
your partner. This is where GENTRAN:Server stores the globally maintained 
interchange control numbers.

Interchange
Organization

Code

A code identifying the interchange level of a trading partner organization.

Types of codes sometimes chosen for Interchange Organization Codes are as 
follows:
◗ Abbreviations
◗ Acronyms

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and underscores (_)

Allowable Length: From 1 to 15 characters

Example: GZ

Do not confuse with Interchange ID.

Interchange
Organization

record

A record containing all information specific to a single company.

join The link that joins or connects one database table to another.

Joins form the relationships for a relational database. A join goes out of a field 
(that is, database column) in a record (that is, database table) and into a field in a 
higher-level (preceding) record.

While a record can have any number of joins coming into it from lower-level 
records, a record can have only one join going out of it to a higher-level record. 
Joins coming into a record can attach to the same or to a different field. In the 
Application Editor, the icon for a field from which a join goes out of a record 
appears yellow.

In GENTRAN:Server, joins are required only for databases used with outbound 
translation.
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label A unique identifier that GENTRAN:Server generates for every source and 
destination field/element in a map.

The label consists of a letter indicating whether this is a source (S) or a 
destination (D) item and a sequential number indicating the location of this item in 
the source or destination. Examples of labels are:
◗ S1
◗ S54
◗ D30
◗ D12

list box In a dialog box, a list from which you can make one or more selections.

When using a mouse to make a selection from a list box, click on the desired item. 
If you want to select an item and immediately close the dialog box, double-click on 
the desired value.

When using the keyboard to make a selection from a list box, you usually press 
the arrows keys to move the focus (highlight) to the desired item and press TAB.

You can also select the current information and type the desired item name or 
value over it.

Windows list boxes are similar to DOS choice lists.

local audit
directory

The EDI Status Audit directory in which GENTRAN:Server stores temporary audit 
files (edistat.i and edistat.o) and EDI data.

locally
maintained

control numbers

Control numbers that GENTRAN:Server uses when there is only one Trading 
Partnership record for a partner.

Locally maintained control numbers are unique for a single Trading Partnership 
record. GENTRAN:Server assigns the control numbers sequentially for each 
document type sent to each trading partner. GENTRAN:Server stores locally 
maintained control numbers in the Trading Partnership record.

logical
expression

An expression that results in a logical value; either false (= 0) or true (not =0).
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loop A sequence of related items that repeat within a transaction set.

macro A collection of commands that you use within GENTRAN:Server to simplify and 
organize mapping instructions.

many-to-many
mapping

A method of mapping two or more source fields/elements to two or more 
destination fields/elements.

The mapping GROUP for a many-to-many mapping contains two or more source 
items and two or more destination items. Some examples of many-to-many 
mappings include the following:
◗ Using the contents of one source item as the condition that determines 

whether or not the value(s) in the other source item(s) maps into the 
destination items.

◗ Using the contents of one source item as the condition that determines which 
of the other source items map into which of the destination items.

many-to-one
mapping

A method of mapping two or more source fields/elements to one destination field/
element.

The mapping GROUP for a many-to-1 mapping contains two or more source 
items and only one destination item. Some examples of many-to-one mappings 
include the following:
◗ Using the value in one source item as the condition that determines whether 

or not the value in a second source item maps into the destination item.

This is the most common type of many-to-1 mapping.

◗ Concatenating part or all of the value in one source item with part or all of the 
value in another source item and mapping the result into the destination item.

map A file that contains the relationships between:
◗ The segments and elements of a standard EDI document and the data fields 

on your application,
◗ The segments and elements of two different standards, or 
◗ The records and files of two different applications.

Map File The <mapname>.vmp file that contains a defined map. 
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mapping The process of associating data fields or elements in your source document to 
corresponding data fields or elements in your destination document.

mapping
association

The process of associating data fields or elements in your source document to 
corresponding data fields or elements in your destination document.

mapping
compiler

A compiler that converts a Map File into a Mapping Table.

mapping
condition

Qualifying term used in some mapping instructions to indicate when 
GENTRAN:Server should perform the mapping part of the instruction and when 
the instructions should be ignored. Mapping conditions begin with �When�.

mapping
expression

A complete 'Map to' expression that may be part of a longer mapping.

For example, the following are mapping expressions:

◗ Map S3 to D4
◗ Map S7 to D12
◗ Map S11 to D3

mapping GROUP A specific association between source and destination data.

mapping
instruction

A set of information that controls special operations on mapped data during 
translation.

mapping mini-
report

A list of the mapping GROUPs to which the selected item belongs and lists of all 
items in each GROUP.

To see a mapping mini-report, you select a mapped item.
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mapping
operation

Action you can currently perform to create mapping instructions.

When you first open the Mapping Instructions window, your available mapping 
operations are as follows:
◗ Add a mapping
◗ Add a condition

To see the list of currently available operations, click the Operations list box.

mapping table
file

The file that contains the result of compiling a Map File. The file extension is .TBL 
for a map file. See TBL File.

marking The process of flagging a line that you want to work with. 

mass change The process of changing multiple Trading Partnership records at one time by 
using a model TP record.

master file The original, source version of a file.

maximize button A button that enables you to enlarge the window to fill the entire screen.

The maximize button is in the top, extreme right side of the window. The minimize 
button is to the left of the maximize button.

menu A list of related commands.

Menu bar The row of menu names that runs across the top of a window immediately under 
the title bar.

message An EDIFACT term referring to a collection of segments that together represent a 
standard business document.
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X12 terminology refers to a message as a transaction set.

minimize button A button that enables you to shrink the window to an icon.

The minimize button is in the top, right side of the window with the title bar to the 
left and either the maximize or the restore button to the right.

Model TP record A template for Trading Partnership records. The Model Trading Partnership record 
should contain default values for as many fields as possible.

While Base Trading Partnership records are used with maps, Model TP records 
are not. Use either Model TP records or Base Trading Partnership records, when 
performing mass adds or mass changes. 

mouse A device that enables you to point to or select one or more items on a computer 
screen.

mouse button A button that is under one of your fingers when you put your hand on a mouse.

A mouse can have two or three buttons, but GENTRAN:Server uses only the left 
and right mouse buttons.

mouse pointer The icon that specifies where the action of the mouse will take effect.

The mouse pointer is sometimes called the mouse cursor.

mtimer The GENTRAN:Server feature you use to start, stop, and resume unattended 
processes in the Workstation version of GENTRAN:Server.

Navigator A GENTRAN:Server tool that uses interviews or dialogs to lead you through the 
process of Visual Mapping.

The Navigator is a quick and easy way to perform the tasks involved in EDI. While 
it is beneficial for all users, those users new to EDI will find the Navigator 
especially helpful.
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numeric data Data of data type numeric (N or Nn) or real (R or Rn); i.e., real or integer numbers 
with characters 0-9, perhaps including plus signs (+), minus signs (-), and/or 
decimal points (.).

ODBC Open Database Connectivity.

Developed by Microsoft Corporation, ODBC provides standardized database 
access methods and tools.

ODETTE Organization for Data Exchange by TeleTransmission in Europe.

ODETTE is a standard developed in the United Kingdom for use in the automobile 
industry.

one-to-many
mapping

A method of mapping the contents of a simple source field/element into two or 
more destination fields/elements.

The mapping GROUP for a 1-to-many mapping contains only one source item 
and two or more destination items. Some examples of 1-to-many mappings 
include the following:
◗ Mapping the contents of the source item to two or more destination items 

without alteration.
◗ Mapping the contents of the source item to two or more destination items with 

alterations in some cases.
◗ Mapping part of the contents of the source item to two or more destination 

items with or without alteration.
◗ Mapping part of the contents of the source item to one destination item and 

part to another destination item with or without alteration.
◗ Mapping the source item to one destination item when the source value 

satisfies one condition and to another destination item when the source value 
satisfies another condition.

one-to-one
mapping

A method of mapping the contents of a source field/element into a destination 
field/element.

The mapping GROUP for a 1-to-1 mapping contains only one source item and 
one destination item. To create a 1-to-1 mapping, map the contents of the source 
item to the destination item with or without alteration.
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When you map the entire contents of a source item unchanged into a destination 
item, this is the simplest possible type of mapping.

option button A round button used to select one option from a mutually exclusive set of options.

Organization File A file consisting of records containing identifying information about the 
interchange and group organizations with which you do business.

The Organization File, consisting of org.dat and org.idx, contains the following 
types of records:

◗ Interchange Organization records
◗ Group Organization records

You cannot have more than one active Organization File in your 
GENTRAN:Server installation. To maintain one or more inactive Organization 
Files, store them each in a separate directory (with or without an inactive Trading 
Partnership File and Contact File). To make the inactive Organization File active, 
use the File Locations command on the Preferences menu to make its directory 
the default directory for trading partner files. Any other trading partner files in the 
new default directory become active at the same time.

Organization
maintenance

The process of creating and maintaining the Organization File, which contains 
identifying information about each of the organizations with which you do 
business.

outbound
translation

Translation in which your source document is application data.

production data Data exchanged for the purpose of conducting business as opposed to data 
exchanged to test maps and other files.

Do not confuse with test data.

prompt A request for additional information that GENTRAN:Server needs in order to 
continue the process.
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Do not confuse with an error message, informational message, or warning 
message.

push button A symbol or icon that initiates some action when you click it.

reconciliation The process of viewing functional acknowledgments, viewing data with the status 
of Errors, and correcting the EDI data.

Reconciliation ID
record

A record containing a set of interchange and group IDs used with functional 
acknowledgments.

record A defined sequence of related fields.

record ID The field that identifies the record to GENTRAN:Server.

release
character

A character that indicates that the following character is to be treated as text, 
rather than as a control character.

For example, if you are using a dollar sign ($) as the release character and a plus 
sign (+) as an element separator, text reading as follows:

total of 9 + 3

should read as follows:

total of 9 $+ 3

Release characters are used only with EDIFACT, TRADACOMS, and ODETTE 
standards.

requirement
designator

The single-character code used in the data element dictionary and segment 
directory to indicate whether the use of an element or segment is floating (F), 
conditional (C), mandatory (M), optional (O), or relational (X).
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Requirement designators also appear in application descriptions to indicate 
whether the use of a record or a field is conditional (C), mandatory (M), optional 
(O), or relational (X).

The meanings of these designators are as follows:

Floating This data type is only for an element on the NOTE 
(NTE) segment, indicating that it may appear anywhere 
in the transaction set between the transaction set 
header and the transaction set trailer.

Conditional The presence of the item depends on the presence of 
specific other items or values.

Mandatory The item must be present.
Optional The presence of the item is at the option of the sending 

party.

Relational This is a complex conditional relationship requiring the 
presence of an item based on the presence of others in 
its pair or group, the exclusion of an item based on the 
presence of another item, the presence of an item 
based on the absence of other items in its group, or the 
presence of at least one other item in a group based on 
the presence of the first item in the group.

Not all standards use all requirement designators.

restore button A button that enables you to restore the window to its original size, which is 
neither an icon nor full-screen size.

{bmc RESTRBUT.BMP}Restore button

The restore button is in the top, right side of the window with the minimize button 
to the left.

row For databases, a single database record in a collection of database records.

script file A file that contains command-line commands and UNIX commands.

scroll bar Horizontal and vertical bars that enable you to move the image around in the 
window.
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The vertical scroll bar is on the right side of the window, and the horizontal scroll 
bar is at the bottom of the window. The scroll bars appear only if there is additional 
information that cannot be seen. To use the vertical scroll bar to move the image 
down with respect to the window, click on the up arrow. To use the vertical scroll 
bar to move the image up with respect to the window, click on the down arrow. To 
use the horizontal scroll bar to move the image left with respect to the window, 
click on the right arrow. To use the horizontal scroll bar to move the image right 
with respect to the window, click on the left arrow.

Each scroll bar contains an elevator button that indicates where the currently 
displayed image is with relation to the entire image. To use the elevator button to 
move the image around in the window, move the mouse pointer to the elevator 
button and press the left mouse button. Moving the mouse then moves the 
elevator button in the same vertical or horizontal direction as long as you hold 
down the left mouse button.

segment A defined sequence of related elements. Segments are analogous to records, 
which are used in application descriptions. A segment begins with a segment ID 
and ends with a segment terminator.

segment
directory

The section of a standards book that lists, describes, and specifies the use of the 
segments in building sets used by that standard.

segment ID In a segment, the first two or three characters that uniquely identify the segment.

For example, ST is the segment ID for the segment used as a transaction set 
header. DTM is the segment ID for the segment used to give the date or time.

segment
terminator

A special indicator that marks the end of a variable-length record or segment.

The character used to designate the end of a segment.

Because EDI standards use variable-length segments, segment terminators are 
necessary to determine where one segment ends and the next begins. The 
character used as a segment terminator should not be used for any other purpose 
in the file.

The new line character (Hex 0A) is sometimes used as a segment terminator.
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server The computer in a client/server network that performs the system security, data 
storage, and major computing tasks.

Set/Message ID A code, found in the standards, that uniquely identifies the type of document for 
which data is being translated.

For X12, TDCC, UCS, and VICS Standards,

Allowable Characters: Numbers (0-9)

Allowable Length: 3 characters

Example: 810

For EDIFACT, ODETTE, and TRADACOMS Standards,

Allowable Characters: Letters (A-Z)

Allowable Length: 6 characters

Example: INVOIC

shaded item An unavailable item (for example, a command or a Toolbar button) in a window or 
dialog box.

shortcut key A key combination that enables you to use the keyboard to select a command, 
menu, push-button, radio button, or check box quickly.

The shortcut key combination includes the Alt key plus the key for the 
underscored letter or letters. You must keep the Alt key pressed while typing the 
other keys.

simple element An element that cannot be divided into sub-elements.

specific
synonym list

A synonym list used in a specific map.

speed key A key or key combination that enables you to use the keyboard to select a 
command quickly.
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Function keys can be speed keys, as can key combinations using the Ctrl key plus 
letter keys.

SQL Standard Query Language.

Standard Query Language consists of standardized database commands to 
generically connect, select, query, and/or process the data in databases.

SQL Command
File

A file containing the database driver that the translator is to use (if it is not 
overridden at runtime).

The SQL Command File also contains the SQL commands to select or extract the 
data to be translated from the proper database tables. Using the join information, 
GENTRAN:Server extracts the data from the database and puts it into a 
hierarchical order (in a temporary answer set) that the translator can easily 
process.

standard A major data format model used for EDI (for example, X12, EDIFACT). Includes 
the rules and guidelines for formatting or structuring electronically transmitted 
documents.

standard data
file

The electronically stored data conforming to the syntax rules of the EDI document 
standards.

Standard data files always have the .std extension.

standard
description

The standard version files available in GENTRAN:Server.

standard format A format intelligible to computerized data management systems.

Standard/IG
Editor

The GENTRAN:Server feature that enables you to edit standards and create 
implementation guides.
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Whether you edit a standard or an implementation guide, the edited result is an 
implementation guide.

standard mode The default mode for running GENTRAN:Server for use by EDI users who want to 
quickly and easily create or edit mapping instructions.

The standard mode is the default mode in GENTRAN:Server. You remain in 
standard mode until you select the expert mode on the User Setup dialog box. 
Once you select expert mode, you must clear the selection before 
GENTRAN:Server will return to standard mode. To open the User Setup dialog 
box, click User Setup on the Preferences menu located on the Main or the Visual 
Mapper Toolbar.

Standard
Version

The version and release number of the EDI standard you agree to use for a 
Trading Partnership.

StatusBar A band that contains informational messages and data about the current status of 
the application in the window.

The StatusBar is along the bottom of a window.

status record A temporary audit file name edistat.i or edistat.o, that GENTRAN:Server creates 
during the translation process. This file contains the directory path and file name 
for the EDI data you receive or generate. The record does not contain the actual 
EDI data.

sub-element An element that is a component of another element.

sub-element
separator

A character used to signal the end of each sub-element in an element.

EDI standards use variable-length sub-elements and must sub-element 
separators to identify where one sub-element ends and the next begins. If the 
character you use as a sub-element separator is used for any other purpose in the 
file, you must precede it with a release character.

Sub-elements are used only in X12, TDCC, and UCS standards. While EDIFACT, 
ODETTE, and TRADACOMS standards have the same concept, they call them 
simply components of a composite element.
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synonym A character string GENTRAN:Server will substitute for a given application field or 
data element value.

Synonym Editor The GENTRAN:Server feature that enables you to create or edit change synonym 
lists. 

synonym list A list of terms and their equivalent substitutes for a given application field or data 
element value that GENTRAN:Server uses for mapping an applicable value.

There are two types of synonym lists -- generic and specific. You can set up a 
generic synonym list once and then use it to substitute values in many maps. You 
can use a specific synonym list to substitute values in only one specific map.

A synonym list contains pairs of values: Original value and substitute value. The 
original value, substitute value, or both can contain spaces.

Each synonym list can have a up to 10,000 rows.

The Synonym Editor is case-sensitive.

system variable A type of buffer to and from which you can map values.

A system variable has a value of zero (0) until you map a value to it.

In the Mapping Instructions window, you automatically create a system variable by 
naming it. The name must start with a dollar sign ($). GENTRAN:Server 
automatically adds the dollar sign for you when in standard mode.

You must remember to include the dollar sign when in expert mode, with no 
spaces between that and the rest of the name.

Allowable Characters: Letters (A-Z, a-z), numbers (0-9), and dollar sign

Allowable Length: From 2 to 20 characters (including the dollar sign)

Example: $specialvalue

table For databases, the description or layout of a database record.
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Task Scheduler A tool in GENTRAN:Server that you use to specify a batch file and the date and 
time for execution of that batch file.

In Windows, use mtimer to start a search for the specified batch file. Mtimer also 
searches for the wait, or the specific date and time of the scheduled file execution. 
To use mtimer, click Activate Mtimer on the Deploy menu. The Deploy menu is 
found on the Main Menu.

In UNIX, mtimer is not used. Instead, GENTRAN:Server writes the schedule to 
the file crontab.dat in your current working directory. GENTRAN:Server 
automatically uses cron to activate the process unless your system administrator 
prohibits it from doing.

Using Task Scheduler in UNIX deletes any tasks currently scheduled from outside 
of GENTRAN:Server.

To retain jobs currently scheduled from outside of GENTRAN:Server, you must 
first copy the crontab file. (It is in the /usr/spool/cron/crontabs directory and has 
your user name as the file name.) You then add your GENTRAN:Server tasks and 
save the file. Finally, use the UNIX crontab command to overwrite the earlier file.

TBL File The Mapping Table File that contains the result of compiling a Map File. 
GENTRAN:Server creates this file in the map directory.

TDCC Transportation Data Coordinating Committee.

The TDCC was an early (1960s) standards-setting committee established to 
assist American transportation organizations in coordinating EDI standards for air, 
motor, rail, and ocean transportation.

temporary file A file on the client that GENTRAN:Server uses during editing and compiling.

test data This is data you exchange solely to test the maps and files created for a new 
Trading Partnership.

Do not confuse with production data.

text box A box into which you enter alphanumeric text to provide data that the application 
requires.
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Thesaurus
Editor

The GENTRAN:Server feature you use to create or change Thesaurus lists.

thesaurus list A list of element names that you want GENTRAN:Server to consider a match for 
the original element name when using AutoMap.

Title bar The bar containing the name of the window.

The title bar is at the very top of the window between the control box and the 
minimize and maximize buttons. When the window is the active window, the title 
bar is displayed in a color different from other windows (the color depends upon 
the color scheme selected in the Windows Control Panel).

To move the window around on the screen, move the mouse cursor to the title bar, 
hold down the left mouse button, and then move the mouse. You will see the 
movements of the window matching those of your hand.

Toggle To reverse the state of a command.

If it is Off, it turns On. If it is On, it turns Off.

Toolbar A bar containing buttons that enable you to initiate common actions quickly.

You must use the mouse to select a button on the toolbar. To initiate an action with 
a toolbar button, simply move the mouse pointer onto the button and click the left 
mouse button.

TRADACOMS The acronym for TRAding DAta COMmunicationS. TRADACOMS was developed 
by the Article Number Association in the United Kingdom as a standard for EDI.

TRADACOMS
record

A record containing all the supplementary Trading Partnership information for use 
with TRADACOMS standards.
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trading partner The company, division, or group with whom you are exchanging business data via 
EDI.

Trading partner
administration

The process of creating and updating as necessary the files that contain 
information related to your trading partners.

The TP admin (trading partner administration) files include
◗ Trading Partnership File
◗ Organization File
◗ Contact File

Trading Partner
Agreement

An agreement between trading partners outlining the terms of EDI.

A typical Trading Partner Agreement states the following:

◗ The EDI standards that each trading partner will use
◗ The documents that the trading partners will exchange
◗ The method of communication
◗ Any security procedures
◗ How each trading partner receives, accepts, or rejects transmissions

Trading partner
files

Those files holding information about trading partners, specifically

◗ Trading Partnership File
◗ Organization File
◗ Contact File

GENTRAN:Server always stores these three files in the same directory -- the 
default directory for trading partner files.

Trading Partner
record

One of the five records maintained in Trading Partner files:

◗ Trading Partnership record
◗ Interchange Organization record
◗ Group Organization record
◗ Contact record
◗ TRADACOMS record
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Trading
Partnership

An arrangement with a specific organization to exchange information in a specific 
document type and using a particular standard version.

Trading
Partnership

Code

A user-defined code that uniquely identifies a Trading Partnership record. 
Normally, the Trading Partnership record describes a unique trading partner and 
document combination. The Trading Partnership Code must contain from 1-15 
alphanumeric characters. Spaces and special characters are NOT allowed.

Trading
Partnership File

A file consisting of records containing information about the Trading Partnerships 
you establish.

The Trading Partnership File, consisting of tp.dat and tp.idx, contains Trading 
Partnership records.

You can have only one active Trading Partnership File in your GENTRAN:Server 
installation. To maintain more than one Trading Partnership files, store each 
inactive file in a separate directory (with or without an inactive Organization file 
and Contact file). To make an inactive Trading Partnership File active, you make 
its directory the default directory for trading partner files. Use the File Locations 
command on the Preferences menu to change the default directory. 

Trading
Partnership

record

A record containing information about one of your established Trading 
Partnerships.

Trading
Partnership

search

When searching for one or more Trading Partnership records, a string you enter to 
match a string in one of the fields in Trading Partnership records.

Enter an asterisk (*) to indicate that GENTRAN:Server should consider all 
remaining characters in a string to be a match.

Enter a question mark (?) to indicate that GENTRAN:Server should consider any 
character in this position in the string a match.

trailer The segment you use to identify the end of a transaction set, functional group, or 
interchange.

The trailer contains identifying information such as the control number that 
matches the header control number, segment count for transactions sets, 
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transaction set count for functional groups, or functional group count for an 
interchange.

transaction set A set of segments which convey information equivalent to one document, such as 
a purchase order.

X12 term referring to a collection of segments that together represent a standard 
business document.

EDIFACT terminology refers to a transaction set as a message.

transaction set
ID

The string that uniquely identifies a transaction set or business document in a 
specific standard.

X12 uses three-character IDs (for example, 850 identifies a purchase order). 
EDIFACT uses six-character IDs (for example, INVOIC identifies an invoice).

transaction set
tables

The section of a standards book that describes how you can use segments within 
a transaction set.

Typically a transaction set listing groups the segments into three tables: the 
header table, the detail table, and the summary table.

translation The conversion of data from one format to another.

Translation
Summary Report

A report that shows the following information for the selected interchanges, one 
functional group to a line:

◗ Trading Partnership Code
◗ Trading partner�s Interchange ID for this interchange
◗ Interchange control number
◗ Group control number
◗ Set ID
◗ Translation date
◗ Number of sets translated
◗ Number of characters
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In addition, this report shows a grand total for the number of sets and the number 
of characters in all interchanges included in the report.

To generate a Translation Summary report, select Translation Summary on the 
Deploy menu. GENTRAN:Server then displays the Translation Summary Ranges 
dialog box. Select the interchanges you want to include in the report and click OK. 
GENTRAN:Server then generates the report and displays it in a report window. To 
print the report, click Print on the report window.

To use a batch file or script to generate a Translation Summary Report, include 
the transrpt command.

tree mode A graphical and intuitive mode for mapping items.

The tree mode displays items in a vertical list, with their IDs, names, and 
attributes. If the list displays only records/segments, you can select the Expand All 
command on the View menu to display the fields/elements as well. If the list 
displays both records/segments and fields/elements, you can select the Collapse 
All command on the View menu to see fields/segments only. (This is useful for 
understanding the loop structures in your data.)

If you display both sides of a map in tree mode and expanded, you can create 
mapping GROUPs by simply clicking the left mouse button on the item(s) on the 
source side, clicking the left mouse button on the item(s) on the destination side, 
and clicking the right mouse button. GENTRAN:Server puts an M in the icon of 
every item (that is, {bmc MAP1ICON.BMP}) in the GROUP to indicate it is part of 
a mapping.

The fast entry mode can be quicker, but it is not graphical or intuitive.

trigram Three-letter combination used for searches.

The AutoMapper searches for field/element matches by using various strings of 
three contiguous letters in the field/element names. For this reason, the 
AutoMapper will not find matches for two-letter field/element names. You should 
avoid two-letter field/element names whenever possible.

UCS Uniform Communications Standard.

The UCS is an X12 subcommittee on document standards for the grocery industry 
in the US.
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user-defined file A file containing the application data that is input to the translator for outbound 
translation.

VAN Value Added Network. A communications service that acts as a clearing house for 
EDI trading partners.

VAT Report Value Added Tax report.

A VAT report is required by Great Britain.

VICS Voluntary Interindustry Communications Standards.

VICS has been developed as a standard for EDI in the retail industry.

Visual Mapper The GENTRAN:Server feature you use to create a map visually. The mapper 
displays the source document on the left side of the window and the destination 
document on the right.

warning
message

An indication of a possible problem that does not stop processing.

Do not confuse with an error message, informational message, or prompt. 

wildcard A universal match for Trading Partnership record searches.

To indicate a wildcard for one of the following fields in a Trading Partnership 
record, enter a dollar sign ($):
◗ Your Interchange ID
◗ Your Partner�s Interchange ID
◗ Your Group/Application ID
◗ Your Partner's Group/Application ID
◗ Set ID
◗ Standard Version
Mapping and Translation Guide � February 2002



Glossary  41
WINS Warehouse Information Network Standards.

WINS is an X12 subset that applies to grocery warehouses and refrigeration 
warehouse document standards.

working file A file that GENTRAN:Server stores in the user�s working directory on the server 
while the user has it checked out for editing.

working file
directory

The directory GENTRAN:Server creates on the server to hold the files that a user 
is editing.

X12 The ANSII subcommittee devoted to developing document standards for EDI in 
the US.

X12 also refers to the standards developed by the committee.

zero-to-one
mapping

A method of entering a constant into a destination field/element.

The mapping GROUP for a 0-to-1 mapping contains no source items and only 
one destination item. To create a 0-to-1 mapping, map text or a number to the 
destination item.

Sometimes, a 0-to-1 mapping is called a literal.
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Index

Index
 (mapping operator) 9-21
- (mapping operator) 9-20

Symbols
 9-21, 9-22
$USRBUF 7-16, 13-22
& (mapping operator) 9-23
( ) (mapping operator) 9-22
* (mapping operator) 9-20
+ (mapping operator) 9-19
.app (file extension) 3-16
/ (mapping operator) 9-19
= (mapping operator) 9-20
> (mapping operator) 9-22
>= (mapping operator) 9-21

Numbers
1-to-1 mapping statement 9-60

creating 9-53, 9-60
definition 9-53, 9-60

A
Acknowledgment Information tab (History dialog 
box) 13-35, 13-48
Add New String and TP Code Cross Reference di-
alog box 5-23
adding 3-31
all in loop (mapping operator) 9-23
Alphanumeric expression

definition of 8-2, 9-3
and (mapping operator) 9-23
Application description 3-3

adapting an existing 3-16
before you begin 3-17
introduction 3-16
locating and recognizing 3-16
procedure flow diagram 3-17

building from an ASCII file
procedure flow diagram 3-21

building from an existing ASCII file 3-21
introduction 3-21

building manually 3-24

components 3-5
introduction 3-5
record loops 3-5

creating 3-11
creating from a standard or implementation guide

before you begin 3-19
introduction 3-19
procedure flow diagram 3-19

deciding how to create 3-15
decision table 3-15
methods 3-15

definition 3-4
definition of 2-2
deleting 3-51
loading when editor is closed 2-10
loading when editor is open 2-10
locating 3-16
managing 3-50

deleting 3-51
introduction 3-50
listing all 3-50
renaming 3-50

manually building
procedure flow diagram 3-25

modifying 3-28
action table 3-28
before you begin 3-28
introduction 3-28

output files 3-3
printing 3-53

procedure 3-53
renaming 3-50
view

collapsed 2-13
expanded 2-14

viewing list of existing 3-50
why you need to create 3-3

Application document
description 3-3
example 3-3

Application Editor 2-2, 3-13
definition 3-4
example 2-4, 3-13
introduction 3-13
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Index 2
Application Editor window
parts of 2-6

application file
configuration process for Trading Partnership 
rules 5-3

application file/TP Code cross reference
deleting 5-31

application file/TP Code cross-reference
editing 5-29

Application TP Cross Reference dialog box 5-20
Application TP Rules dialog box 5-6
application Trading Partnership rules 5-5

configuring for (overview) 5-4
application/TP Code rules

how the system uses 5-33
Application/TP Cross Reference Table

building 5-25
Application/TP Cross Reference table 5-24

adding entries to 5-25
editing an entry 5-29

apptptbl.dat/idx 5-5
appxref.dat/idx 5-24
Archive Information tab (History dialog box) 13-39
Archive menu 13-5
Archive Purge dialog box 13-64
Archive tab 11-37

fields and functions 11-38
archived data

editing 13-58
extracting 13-53
extracting documents 13-54
file name format for 13-7
how to search for an archived document 13-25
preparing to resend 13-56
preparing unedited for resending 13-61
purging 13-63, 13-65
selecting for purging 13-65
viewing information about 13-32
viewing set-level information 13-32

archiving
configuration file for default settings 13-15
definition 13-3
in a multi-user environment 13-9
introduction to 13-3
options 13-15
process 13-6
program, running ediarc 13-20
selecting default options 13-16
setting up 13-8
using a data compression utility 13-18
when to archive translation data 13-20

arcopt.cfg 13-15
Arithmetic expression

definition of 8-2, 9-3
ASCII file

description 3-10
example 3-10
manually describing 3-24

before you begin 3-24
introduction 3-24
procedure flow diagram 3-25

attribute 2-2
Attributes

definition 2-28, 3-4
example 2-28
field 3-6
how to set 2-29
record 3-5
where to set 2-28

Audit record
mapping to User Buffer field in 7-16, 13-22

AutoMap
definition 7-2
definition of 8-3, 9-3
using to create mapping associations 8-28

AutoMap Options dialog box 8-26
fields and functions 8-27

AutoTrim
definition 6-9
using to create an IG 6-9
when to use 6-9

B
batch file

definition 14-3
running on a schedule 14-24
sample 14-7
scheduling 14-18

Batch Total 6-21
boxin.err 12-38
boxout.lok 12-15, 12-18, 12-19
building

Application/TP cross reference table 5-25

C
Categories tab 11-46
Category

creating 11-84
record 11-6

Category record 11-80
central audit directory

definition 13-3
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Index  3
changing
multiple Group Organization records 11-110

Characters (in mapping instructions) 9-10
clipboard 2-17
Collapsed view

example 2-13
Compile Maps dialog box 8-43
Compiled Map Search dialog box 11-92

fields and functions 11-92
Compiler

how it orders mapping instructions 8-40
Compiling

choosing a platform 8-39
closed map 8-43
closed maps 8-44
open map 8-42
ways to 8-40

Composite element
adding 6-15

procedure 6-18
definition 6-3, 6-15
definition of 2-2
deleting 6-26
discarding 6-26

Compress compression utility 13-18
compressed data

file extensions of 13-18
Compression tab (Archive Retrieval Setup dialog 
box) 13-13
compression utility

changing 13-19
selecting 13-19

Conditional expression
definition of 8-3, 9-3

Conditional expressions
execution order 9-10
linking with AND or OR 9-9
rules for using 9-9
using parentheses in 9-9

configuring for application files 5-3
Contact record 11-7, 11-80

creating 11-83
control numbers

functional acknowledgments and 13-8
Converting flat files to Synonym lists 7-25
count over source loop (mapping operator) 9-24
creating

Trading Partnerships 11-47

cron
definition 14-3
how Task Scheduler uses 14-2
how the Task Scheduler uses 14-23

cross reference
deleting 5-31

cross references
sorting 5-28

cross-reference
editing 5-29

CTT segment 6-26
Cutting 2-20

description of 2-20

D
data compression utility

selecting for archived documents 13-18
data file

definition 13-3
data found in (mapping operator) 9-24
Data separator 3-26

non-printable
default values 3-26

printable
default values 3-26

Data type
definition 3-4

decrement date_time (mapping operator) 9-25
Default value

retaining for a destination field 3-33
Default value for a destination field 6-22
Define TP Cross Reference dialog box 5-21

sorting entries 5-28
defining

application Trading Partnership rules 5-11
Deleting

description of 2-20
deleting

application/TP code cross reference 5-31
Trading Partnership rules 5-18

deleting a Standard Cross Reference record 
11-78
Delimiter

allowable values 3-26, 3-49
changing 3-47

dialog boxes 3-47
introduction 3-47

character
changing 3-47

definition 3-4
designating 3-39
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Index 4
Destination field
default value 3-33

Destination items
mapping system variables to 9-57

Discarded items
activating 2-22, 6-28
viewing 2-22, 6-28
Visual Mapper 6-28

Discarding
description of 2-20

Discarding vs. deleting 6-26
document search results

display modes 13-29
Document Search Results dialog box 13-29
documentation conventions 1-vii
does_not_equal (mapping operator) 9-25
dollar sign ($) 11-23, 11-32, 11-34, 11-40, 11-48, 
11-67
dtLog.err 12-38

E
EDI document

searching for 13-27
EDI Document Search dialog box 13-25
EDI History Audit directory 13-9
EDI Status Audit directory 13-9
EDI tab (Archive Retrieval dialog box 13-15
EDI tab (Archive Retrieval Setup dialog box) 
13-11
ediarc 13-20

and audit directories 13-9
definition 13-4, 14-3
starting from a batch file or script 13-20
starting from command line 13-21

EDIFACT Syntax Version 4 11-87, 12-43
edifrmat

definition 14-3
edipurge command 13-63
edistat.in 13-6
edistat.orr 13-6
Edit Box

description of 2-7
Edit Organization Contact dialog box 11-81

fields and functions 11-81
editing

Trading Partnership rules 5-17
editing a Standard Cross Reference record 11-76
Editor

closing 2-9
definition of 2-2

opening from Main menu 2-9
Editor symbols 2-8
Element

adding 2-18, 6-15
adding optional attributes 6-20

introduction 6-20
copying 2-18
cutting vs. deleting 6-29
definition 6-3, 6-15
definition of 2-2
deleting 2-23, 6-29
discarded

activating 6-28
viewing 6-28

discarding (inactivating) 6-27
discarding or deleting 6-26
inactivating and deleting 6-26

cautions 6-26
introduction 6-26

ways to discard 6-26
Element attributes

changing 6-19
Element edit box 6-15

fields and functions table 6-16
Elements

moving 2-17
envelope

definition 14-3
equals (mapping operator) 9-26
Evaluated expression

role of 9-5
Expanded view

example 2-14
Expert entry mode (mapping instructions) 9-8
Extract EDI Archive dialog box 13-53

F
Field

adding 2-18, 3-33
before you begin 3-35
introduction 3-33
procedure 3-36
record edit boxes 3-33
requirements 3-33

copying 2-18
definition 3-4, 3-5
definition of 2-2
deleting 2-23
length 3-6
marking 2-16
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Field attributes
changing 3-43

fixed-length 3-43
introduction 3-43

Field edit box
fields and functions table 3-34
fixed-length field 3-33
variable-length field 3-33

field edit box 3-33
Fields

moving 2-17
file definition

and TPCODE field 12-41
File Definition Filename 11-30
File lines (in an editor)

selecting 2-15
Flow of work

stage table 6-7, 6-31
Focus

illustration 2-15
moving

in Application Editor 2-15
Formatting Options dialog box 12-29
functional acknowledgment

control numbers and 13-44
definition 13-4, 13-43
levels 13-44
purpose 13-43
reconciliation 13-8, 13-44
reconciliation process 13-46
types 13-43
viewing and reconciling 13-43
viewing errors 13-48

Functional Group Totals transaction set 6-21, 6-22

G
Generic synonym list 7-3

creating 7-7
definition 7-2
deleting 7-9

generic synonym list
modifying 7-8

Generic synonym lists 7-6
generic synonym of source (mapping operator) 
9-26
greenwich date_time (mapping operator) 9-26
group envelope segments

modifying 11-87
Group Organization record 11-5, 11-6

creating 11-52, 11-53
deleting 11-94

Group Organization records
making mass changes to 11-110

Group Organization Search dialog box 11-112
Group/Application ID, wildcard 11-48

H
historical record

definition 13-4

I
identification string

case sensitive 5-19
displaying picture 5-16
unique requirement 5-19

Identification tab (History dialog box) 13-34
Implementation guide 8-4

creating
overview 6-2

creating by modifying a standard 6-10
definition of 2-3
introduction 6-2
loading when editor is closed 2-11
loading when editor is open 2-10
modifying a standard to create

introduction 6-10
printing

introduction 6-35
standards supported 6-2
using AutoTrim to create 6-9

Implementation guide (IG)
definition 6-3

Inbound Acknowledgment tab 11-39
fields and functions 11-39

inbound documents
translate 12-25

Inbound EDI tab 11-31
inbound translation

process 12-9
running from the Translate menu 12-35

increment date_time (mapping operator) 9-27
interchange envelope 11-6
interchange envelope segments

modifying 11-87
Interchange ID, wildcard 11-48
Interchange Organization Mass Change dialog 
box 11-105

fields and functions 11-105
Interchange Organization record 11-5, 11-6

creating 11-49, 11-50
deleting 11-94
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Interchange Organization records
making mass changes to 11-105

Interchange Organization Search dialog box 
11-108

K
key fields (for Trading Partner record search) 
11-67

L
lftran 14-7
linking

rules to a Trading Partnership Code 5-19
List editor window

fields and functions 7-5, 7-20
Literal mapping statement 9-57

creating 9-58
definition 9-49

Literal value
mapping to a system variable 9-49

Logical expression
definition of 8-3, 9-3

Loop
adding 2-25, 3-40

before you begin 3-40
introduction 3-40

appearance 2-24
definition 3-4, 3-5
definition of 2-3
deleting with components 2-27
deleting with records 3-46
designating 6-23

before you begin 6-23
dissolving association 2-26
example 6-23
introduction 6-23
modifying 3-45, 6-25

deleting with records 3-46
loop count 3-45
removing loop only 3-45

removing 3-45
Loop count

changing 3-45

M
Macro

definition of 8-3, 9-3
Macros

adding to expressions and other macros 9-43
creating for use in a mapping instruction 9-40
in mapping instructions 9-38

rules for using in mapping instructions 9-11
using in mapping instructions 9-46
using to simplify mapping instructions 9-39

Many-to-1 mapping statement 9-62
creating 9-55, 9-62
definition 9-55, 9-62

Map
creation process 8-5
definition of 8-3
deleting 8-46
displaying 8-35
editing 8-34
overview 8-2
printing 8-47
ways to create 8-5

map
changing for a Trading Partnership record 11-92
searching for 11-92

Map destination file
editing 8-22

Map destination information
editing 8-19

Map File 8-7, 8-39
definition of 8-3, 9-3, 10-2
editing 8-20

Map source file
editing 8-22

Map source information
editing 8-19

Mapping
definition of 8-3, 9-3, 10-2
flow of work 8-5, 8-11

Mapping associations
creating in fast-entry mode 8-32
creating in tree mode 8-30
creating manually 8-30
creating with AutoMap 8-26

Mapping condition
definition of 8-3, 9-4, 10-2
role of 9-5

Mapping evaluated expression
role of 9-5

Mapping expression
definition of 8-3, 9-4, 10-2
using "not" in 9-64

Mapping GROUP
adding 8-36
adding an item to 8-37
definition of 8-3, 9-4, 10-2
deleting 8-37
deleting an item from 8-38
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Mapping GROUPs
editing 8-35

Mapping instruction
definition of 8-3, 9-4, 10-2

Mapping instructions 8-2
basic concepts 9-4
creating 9-46
creating for mapping GROUP 9-47
default sort order 9-18
examples 9-13
exercise 9-66
how compiler orders 8-40
options 9-12
overview 9-3
rules 9-9
rules for characters 9-10
rules for operations 9-10
system variables in 9-16
types 9-5

Mapping Instructions window 9-6
displaying 9-46
entry modes 9-8
fields and functions 9-6
opening 9-8
push-buttons 9-7

Mapping operator
 9-21, 9-22
- 9-20
( ) 9-22
* 9-20
+ 9-19
/ 9-19
= 9-20
> 9-22
>= 9-21
all in loop 9-23
and 9-23
count over source loop 9-24
data found in 9-24
decrement date_time 9-25
does_not_equal 9-25
equals 9-26
generic synonym of source 9-26
greenwich date_time 9-26
increment date_time 9-27
list of 9-19
max value of source loop 9-28
min value of source loop 9-29
not 9-29
one in loop 9-30

or 9-30
place 9-30
portion of text 9-31
put 9-32
record_count of destination on loop level 9-33
source_element 9-34
spaces 9-34
specific synonym of source 9-35
sum over source loop 9-35
system date_time 9-36
trading partner 9-36
using 9-19
zeros 9-37

Mapping statement
1-to-1 9-53, 9-60
creating a 1-to-1 9-53, 9-60
creating a many-to-1 9-55, 9-62
many-to-1 9-62

Mapping substitution
role of 9-5

Mapping Table File 8-7
definition of 8-3

Mapping Table Files 8-39
Mapping Tables 8-39
Mapping worksheet 8-4
Maps

compiling 8-39
compiling closed 8-44

Mark
definition of 2-3

Marking 2-16
definition 3-4

Marks
inserting 2-16
removing 2-16

Mas File
definition of 8-3

mass change
multiple Interchange Organization records 
11-106
Trading Partnership Records 11-114
Trading Partnership records 11-117

Mass Change facility 11-103
how to access 11-103

Mass Change Trading Partnership dialog box 
11-116

accessing 11-115
mass changes 11-103
max value of source loop (mapping operator) 9-28
min value of source loop (mapping operator) 9-29
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Mini-report
displaying 8-14
sample 8-14
Visual Mapper 8-14

mtimer 14-7, 14-24
activating 14-26
definition 14-3
resuming after stopping 14-29
stopping 14-28

mtimer dialog box 14-24
mtimer files 14-25

N
New Group Organization dialog box 11-52
New Interchange Organization dialog box 11-49
not (mapping operator) 9-29
Novice entry mode (mapping instructions) 9-8

O
one in loop (mapping operator) 9-30
Open Generic Synonym List dialog box 7-6
Open Thesaurus List dialog box 7-19
Opening

Application Editor 2-1
Operations (in mapping instructions) 9-10
Option dialog box 6-20

fields and functions table 6-21
for other standards 6-20
for X12 and UCS standards 6-20

Optional attributes
adding to an element 6-20
introduction 6-20

or (mapping operator) 9-30
outbound acknowledgment

generating for EDIFACT message types 11-63
generating for X12 documents 11-62
setting automatic generation of 11-62

Outbound Acknowledgment tab 11-41
fields and functions 11-41

outbound document
changing status of 13-50

outbound documents
translate 12-25

Outbound EDI tab 11-33
fields and functions 11-34

outbound envelope segments
modifying 11-87

outbound translation
process 12-10
running from the Translate menu 12-39

P
Pack compression utility 13-18
Pkzip compression utility 13-18
place (mapping operator) 9-30
portion of text (mapping operator) 9-31
preferences

setting Trading Partner Administration 11-17
Print Standard dialog box 6-35
Processing Information tab (History dialog box) 
13-38
purge archives program

ways to run 13-63
put (mapping operator) 9-32

R
Recompiling 8-38
reconciliation

definition 13-4
Reconciliation ID record 11-6
Record

adding 2-18, 3-29
introduction 3-29
record edit box 3-29
requirements 3-29

copying 2-18
definition 3-4
definition of 2-3
deleting 2-23
discarding 2-21
view

expanding 2-14
record 3-31
Record attributes

changing 3-42
introduction 3-42

Record edit box 3-29
fields and functions table 3-29, 3-30

Record ID
definition 3-4
describing layout 3-8

Record ID field 3-7
designating 3-39

introduction 3-39
record ID field 3-39
Record ID layout 3-7
record_count of destination on loop level (map-
ping operator) 9-33
Records

definition 3-5
moving 2-17

Repeating Element Separator 11-87, 12-43
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Resend EDI Document dialog box 13-56
Resend program 13-56
Retain Field Value 6-21
Runtime Information tab 11-36

fields and functions 11-36

S
schedule

deleting a task from 14-22
modifying 14-18, 14-20

scheduling tasks
flow of work 14-4

script
running on a schedule 14-23
scheduling 14-18

script file
definition 14-3

SE segment 6-26
Segment

adding 2-18, 6-12
introduction 6-12

changing attributes 6-14
copying 2-18
cutting vs. deleting 6-29
definition 6-3
definition of 2-3
deleting 2-23, 6-29
discarded

activating 6-28
viewing 6-28

discarding 2-21
discarding (inactivating) 6-27
discarding and deleting 6-26
inactivating and deleting 6-26

cautions 6-26
introduction 6-26

repeating
introduction 6-23

ways to discard 6-26
Segment edit box 6-12

fields and functions table 6-12
Segments

moving 2-17
repeating 6-23

Select Maps to Compile dialog box 8-44
Set ID, wildcard 11-48
sigout.err 12-17
sigout.lok 12-15, 12-16, 12-17, 12-18, 12-19
Simple element

definition 6-3
Sort Mapping Instructions utility 9-18
Source items

mapping to system variables 9-53
source_element (mapping operator) 9-34
spaces (mapping operator) 9-34
Specific synonym list 7-3

creating 7-10
definition 7-2
deleting reference to 7-14
modifying 7-12
working with a 7-10

specific synonym of source (mapping operator) 
9-35
ST segment 6-26
Standard

definition 6-3
definition of 2-3
loading when editor is closed 2-12
modifying to create an IG 6-10

introduction 6-10
printing

introduction 6-35
Standard Cross Reference dialog box 11-70
Standard Cross Reference record

and Group Organization level 11-78
deleting 11-78
editing 11-76

Standard Cross Reference Table
adding a record 11-70
file name 11-68
overview 11-67
purpose 11-67
translation types used with 11-68

standard version
as key field 11-67

Standard Version, wildcard 11-48
Standard/IG Editor 2-2, 6-5

definition 6-3
definition of 2-3
example 2-5
fields and functions table 6-6
introduction 6-5

Standard/IG Editor window 6-5
parts of 2-6

status record
definition 13-4

StatusBar
description of 2-7
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Sub-element
adding 6-15

procedure 6-18
definition 6-3, 6-15
definition of 2-3

sum over source loop (mapping operator) 9-35
Symbol

composite element
with displayed sub-elements

in Standard/IG Editor 2-8
Symbols

Application Editor window 2-8
synmv 7-25
Synonym

definition 7-2
using a default 7-15

Synonym and Thesaurus Editors 7-2, 7-4
Synonym and thesaurus lists 7-2
Synonym Editor

definition 7-2
Synonym Editor window 7-4
Synonym list

definition 7-2
when to use 7-3

Synonym lists, converting to flat files 7-25
Synonym value

setting default 7-15
system date_time (mapping operator) 9-36
System variables

creating for use in mapping instructions 9-16
how values are set 9-16
in mapping instructions 9-16
mapping literal values to 9-49
mapping multiple source items to 9-55
mapping source items to 9-53
mapping to a destination item 9-57
mapping to system variables 9-64
marking with $ 9-17
naming 9-16
using as source and destination 9-64
using different variables in source and 
destination 9-65
using existing 7-16, 13-22
using same variable in source and destination 
9-65

T
Task Scheduler

deleting a task from 14-22
opening 14-14
overview 14-2
running ediarc from 13-20

Task Scheduler dialog box 14-14
TBL File

definition of 8-4
Thesaurus Editor

definition 7-2
Thesaurus Editor window 7-19
Thesaurus list 7-3, 7-18

creating 7-21
definition 7-2
deleting 7-23
modifying 7-22
when to use 7-3, 7-18

Thesaurus lists
working with 7-21

TP Code
field requirements 11-29

TPCODE field 12-41
TRADACOMS record 11-7
trading partner (mapping operator) 9-36
Trading Partner Administration

setting preferences 11-17
Trading Partner Administration Explorer 11-8
Trading Partner record

deleting 11-94
Trading Partner Search dialog box 11-22
Trading Partner Search Results dialog box 11-119
Trading Partnership

creating 11-47
records that define 11-5

trading partnership
overview 11-3

Trading Partnership Administration Preference 
dialog box 11-17
Trading Partnership category

defining types 11-84
Trading Partnership Code 3-7

definition 3-4
describing layout 3-8
guidelines for linking identification string to 5-19
linking application file Trading Partnership rules 
to 5-19
naming requirements 11-29

Trading Partnership Code and record ID layout
introduction 3-7
with dnld personality 3-9
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Trading Partnership code and record ID layout
methods of describing 3-8

Trading Partnership Code field 3-8
marking 3-38

before you begin 3-38
introduction 3-38

Trading Partnership Editor 11-28
Archive tab 11-37
Categories tab 11-46
Inbound Acknowledgment tab 11-39
Inbound EDI tab 11-31
Outbound Acknowledgment tab 11-41
Outbound EDI tab 11-33

fields and functions 11-34
Runtime Information tab 11-36

fields and functions 11-36
Trading Partnership tab 11-29

fields and functions 11-29
wildcards 11-48

Trading Partnership Mass Change dialog box 
11-114
Trading Partnership Record

searching for 11-22
Trading Partnership record 11-5, 11-6

archiving settings and 13-16
creating 11-55
creating a standard-to-application 11-57
creating a standard-to-standard 11-56
creating an application-to standard 11-59
creating an application-to-application 11-60
creating optional 11-80
editing 11-86
printing reports 11-95
setting translation selections in 11-101

Trading Partnership records
making mass changes to 11-114, 11-117

Trading Partnership rules 5-3
adding 5-13
application file 5-5
application file table 5-5
defining for an application file 5-4
definition 5-5
deleting 5-18
displaying position in an identification string 
5-16
editing 5-17
guideslines for building 5-5
purpose 5-4
starting the definition process 5-11

Trading Partnership Search dialog box
fields and functions 11-23

Trading Partnership tab 11-29
fields and functions 11-29

Translate Documents dialog box 12-25
Translate menu 12-7
translation

introduction to 12-2
introduction to setting up 12-24
process 12-8
running inbound 12-35
running outbound 12-39
setting default selections 11-20
setting options 11-20

translation audit directories 13-9
specifying 13-9

translation data
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